
Creating a Web image from FrontPage 
 

You can create Web images in Microsoft FrontPage by using Microsoft Image Composer. Your image 
can combine shapes, other image files, and the various effects available on the tool palettes in Image 
Composer. After you are done creating your image, you can open it in FrontPage. When you include 
the image in a FrontPage Web, the sprites in your composition are flattened into a single-image .gif or 
.jpg file, depending on the number of colors used in the composition. 

1 In FrontPage Editor, open the Web page you want to add a new image to. 

2 On the FrontPage Tools menu, click Show Image Editor. This starts Image Composer, where you 
can begin a new composition for your Web page. 

3 In Image Composer, create the image for your Web page. 

4 After you finish your composition, select all the sprites that make up the composition. 

5 In Image Composer, on the Edit menu, click Copy. 

6 In FrontPage Editor, use the Paste command to insert the composition into your Web page. This 
action automatically converts the selection into a .gif or .jpg file. 

If you want to save the image as an Image Composer file (.mic), click Save As on the Image 
Composer File menu, and then enter a name for the file. 

7 On the File menu, click Exit, and then finish your work in FrontPage. 
 

Tip    For an easy way to save an image for use on a Web site, use the Save for the Web Wizard in 
Image Composer. The wizard provides guidance on file formats and size tradeoffs for images 
destined for display on a Web page. Select the sprite you want to save for the Web, then click Save 
for the Web on the File menu.  

Notes 
 

• If Image Composer does not start when you click Show Image Editor, you may need to set it as 
the default image editor by clicking Options on the Tools menu in FrontPage Explorer.  

• If you want to preserve the flexibility that multiple sprites provide, you can save the image as an 
Image Composer file (.mic). However, if you make changes to the .mic file, you need to resave it 
as the .gif or .jpg file used in your Web. 

 
 

Editing a Web image from FrontPage 
 

You can edit a Web image in a FrontPage Web by using Microsoft Image Composer. You can alter 
the image with shapes, other image files, and the various effects available on the tool palettes in 
Image Composer. After you are done editing your image, you can return it to FrontPage. When you 
return the image to FrontPage, the sprites in your composition are combined into a single-image .gif 
or .jpg file or flattened to the original format of the file. 

1 In the FrontPage Editor, open the Web page that contains the image you want to edit. 

2 Double-click the image to start Image Composer. 

3 Edit the image in Image Composer. 

4 On the File menu, click Save. 

5 Go back to FrontPage Editor to finish your work in FrontPage. 
 

Notes 

• If Image Composer does not start when you double-click your image, you may need to set it as the 
default image editor by clicking Options on the Tools menu in FrontPage Explorer.  

• If you want to preserve the flexibility that multiple sprites provide, you can also save the image as 
an Image Composer file (.mic). However, if you make changes to the .mic file, you need to resave 
it as the .gif or .jpg file used in your Web. If you save the image with another name, you must add 



this new file to the Web in FrontPage. The original file remains in the Web, but is not referenced in 
the Web page. 

 
 

Selecting the color palette used by an image in FrontPage 
 

You can select the colors used by an image in your Web page by changing the color format palette in 
Microsoft Image Composer. Some images have color formats that look great in one Web browser, but 
do not look good in all of them. To match the colors available with most Web browsers, use the Web 
(Dithered) color palette provided by Image Composer. This way, you can ensure that your page looks 
its best in most common Web browsers. By changing color palettes, you don't lose your old image 
and color palette. Image Composer doesn't remove the original image, but adds a new file with the 
new color palette to your Web and Web page. The old image with its original palette remains in your 
Web. 

1 In FrontPage, open the page that has the image you want to change. 

2 Double-click the image. 

3 In Image Composer, click Save As on the File menu. 

4 In the Save As dialog box, if you have selected Compuserve GIF (*.gif) as the file type, click Web 
(Dithered) in the Color format box, and then click Save. 
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abut 

See touch edges. 

 

airbrush 

A paint effect that sprays the current color shown in the Color Swatch onto the selected sprite. 

 

align 

To line up two or more sprites in relation to a given point of reference, such as their outer edges, 
corners, or centers. 

 

alpha channel 

One of the four channels (red, green, blue, and alpha) that defines the total color of the sprite. The 
alpha channel carries information about the degree of opacity for each pixel. 

 

amplitude 

The height or depth of a wave pattern. 

 



anti-aliasing 

See smoothing. 

 

aspect ratio 

The ratio of width to height of an image. For example, an aspect ratio of 2:1 indicates that the width is 
twice the height. Aspect ratio generally refers to the image area (contained by the bounding box) 
rather than the image itself. It is an important factor in maintaining correct proportions when an image 
is printed, resized, or inserted into a document. 

 

balance 

The overall distribution of color to produce a harmonious whole. 

 

bas relief 

An effect that makes the sprite appear to have been carved in low relief and lit to accent the surface 
modulations of the sprite. For an example of this effect, see Bas Relief. 

 

bilinear 

A type of warp that refits a sprite to its bounding box after you adjust the position of one or more 
corners of the box. For details, see Bilinear. 

 

biquadratic patch 

A mesh of curves laid over a sprite that describes how each point in the sprite should be warped. In 
Microsoft Image Composer, the interactive warps show these patches as a crisscross of lines and 
points that can be moved to control the warp. 

 

blur 

An effect that softens the edges of the pixels throughout the sprite, resulting in an unfocused look. For 
an example of this effect, see Blur. 

 

bounding box 

The area that defines the perimeter of a sprite, typically displayed by lines and handles. 

 

brightness 

A color attribute that defines the quality of radiance or luminosity of a color and is determined by the 
radiant energy of a color. This attribute is used in the HSV color model. 

See also hue and saturation. 

 



broken tile 

An effect that gives a sprite the appearance of being composed of small, irregularly shaped chips set 
into a flat surface. For an example of this effect, see Broken Tile. 

Called Mosaic in Microsoft Image Composer 1.0. 

 

bulge 

An effect that swells the middle area of a sprite, as if it were wrapped around a concave or convex 
hemisphere. For an example of this effect, see Bulge. 

 

burn 

A photographic effect that adds more light to a specific portion of a sprite than to the rest of the sprite. 
For details, see Using the dodge-burn tool. 

 

channel 

A medium for transferring color information to the pixels of a display monitor. Microsoft Image 
Composer uses four channels for color information. Three channels carry red, green, and blue. One 
channel known as the alpha channel carries information about the degree of opacity for each pixel. 

 

closed polygon 

A shape defined by a series of lines that includes a curve connecting its first and last editing points. 
You can create a closed polygon by selecting the Close check box on the Shapes tool palette. 

 

color 

The hue perceived for different wavelengths in the portion of the electromagnetic spectrum to which 
the human eye responds. Colors, as people see them, range from violet at the high-frequency end of 
the visible-light band to red at the low-frequency end. 

In computer video, color is influenced by both hardware and software. The hardware consists of a 
color monitor and a controlling video card or adapter. The monitor contains the equipment that 
displays images on the screen, and the video card or adapter generates the signals that produce the 
images and colors. The colors themselves are “rendered” within the computer and video card as 
combinations of bits, each combination representing a distinct shade or intensity of color that is 
destined for a single pixel on the screen. 

See also color model. 

 

color bounding box 

A color enhancement that applies the current color shown in the Color Swatch to all the pixels of the 
selected sprite including the pixels within its bounding box. For an example of this effect, see Color 
Bounding Box. 

Called Color over in Microsoft Image Composer 1.0. 



 

color controls 

A set of controls in the Color Tuning palette that lets you adjust the brightness, contrast, hue, and 
saturation of the selected sprite’s colors. 

 

color fill  

A button on the toolbar that lets you change the opaque pixels in the selected sprite to the current 
color. 

 

color lift (colorlift) 

See select color region. 

 

color map 

See map color. 

 

color model 

A method for representing color. Colors can be described using several different color models: HSV 
(hue, saturation, and value); CMYK (cyan, magenta, yellow, and black); and RGB (red, green, and 
blue). Microsoft Image Composer uses the RGBA (red, green, blue, and alpha) color model, which 
includes transparency information.  

Called color space in Microsoft Image Composer 1.0. 

 

color over 

See color bounding box. 

 

color palette 

A set of specific colors that can be saved with a composition or as a separate .pal (palette) file. 

 

color picker 

A dialog box that allows you to select a new current color to apply to new sprites, patterns, and fills. 
You can also define a custom color palette using this dialog box. 

 

color ramp 

A range of colors where each color gradually blends into the next color. For example, a blue ramp 
gradually blends hues of blue from pure black to pure blue. 

The color matrix in the True Color tab of the Color Picker dialog box is another example of a color 



ramp. 

 

color shifting 

See color controls. 

 

color space 

See color model. 

 

color swatch 

A square of color in the toolbox that displays the current color. You can click the Color Swatch to 
display the Color Picker dialog box. 

 

colorize 

See dye. 

 

compensation curve 

A curve that displays the relative brightness or darkness of the dark, middle, and light regions of a 
sprite. 

 

complement color 

See negative. 

 

complement shape 

See stencil. 

 

composition 

A Microsoft Image Composer document made up of one or more sprites displayed in the Image 
Composer workspace. 

 

composition guide 

See composition space. 

 

composition guides 

A set of nonprinting lines that you use to resize the composition space. 



 

composition space 

A portion of the Microsoft Image Composer workspace that defines the area of a composition. This 
area and the sprites within it are included with a composition when the file is printed, exported, or 
saved to other file formats. 

Called Composition Guide in Microsoft Image Composer 1.0. 

 

conté crayon 

A sketch effect that adds highly texturized, soft strokes to the sprite on a rough-textured background 
using the colors you select. The dark areas in the original sprite use the current color shown in the 
Color Swatch. Midtones and highlights use tints of the composition space’s color. For an example of 
this effect, see Conté Crayon. 

 

contrast 

The degree of difference between the lightest and darkest parts of a sprite. 

 

copy region 

To derive a new sprite from an existing sprite, based on the current selection. For example, you can 
use Select color region to select an area of the same color, and then use Copy region to create a 
new sprite from the selected pixels. 

Called Extract in Microsoft Image Composer 1.0. 

 

cosine function 

Based on the mathematical cosine function, this feature distorts a sprite by compressing and 
expanding the areas of a sprite according to the axis and symmetry settings. For example, if you set 
the y-axis only, the bottom of the sprite appears expanded with increased compression toward the 
top. If you set the x-axis only, the right side of the sprite appears expanded with increased 
compression toward the left. For examples, see Rectangular effect variations. 

 

cracked varnish 

An effect that covers the selected sprite with a high-relief, plaster-like surface, producing a fine 
network of cracks that follow the contours of the sprite. For an example of this effect, see Cracked 
Varnish. 

Called Craquelure in Microsoft Image Composer 1.0. 

 

craquelure 

See cracked varnish. 

 



create 

To create a shape in the current color in a composition. 

Called Render in Microsoft Image Composer 1.0. 

 

crop 

To cut off part of an image, such as unneeded sections or extra white space around its borders. 
Cropping is used to refine or clean up an image for placement in a composition or document. 

 

crosshatch 

A sketch effect that adds fine-hatched strokes to a sprite without affecting its existing colors. This 
effect adds texture and roughens the edges of the colored areas while preserving the features of the 
original sprite. For an example of this effect, see Crosshatch. 

 

current color 

The color displayed on the Color Swatch below the toolbox. The current color is used when you 
create a new sprite and when you add fills and patterns to the current sprite. You can change the 
color by choosing Color Picker from the Tools menu or by clicking the Color Swatch. 

 

curve 

A tool on the Shapes and Cutout palettes that you use to create a freeform shape made up of a 
series of curves. The resulting shape contains multiple editing points that you can use to adjust the 
overall shape of the sprite. For details, see Curve. 

Called Spline in Microsoft Image Composer 1.0. 

 

custom color palette 

A set of colors on a palette with 1 to 256 specific color entries. 

 

destination sprite 

The sprite that is modified based on parameters determined from the source sprite. 

 

display system 

The combination of monitor, video adapter, and display software that shows a final composition. 

 

distort 

A set of effects that twist a sprite out of its original proportions. 

Called Warps and Warp Transforms in Microsoft Image Composer 1.0. 



 

dithering 

A method of controlling how colors specified by a composition are approximated on a display system 
or in a file format that does not have the specified color available. Custom palettes allow you to 
choose from four types of dithering: solid (for no dithering), error diffusion, random, and pattern. 

 

dodge 

A photographic effect that adds less light to a specific portion of a sprite than to the rest of the sprite. 

 

dominant sprite 

In a selection set of more than one sprite, the sprite that is used as the source sprite in operations 
that require a source sprite and a destination sprite, such as alignment, texture transfers, and 
ordering. The dominant sprite is distinguishable from other sprites in the selection set by the solid 
black handles on its bounding box. 

 

dry brush 

A paint effect that simplifies a sprite into areas of common color. Reapplying this effect further 
reduces color detail. For an example of this effect, see Dry Brush. 

 

dye 

To apply the current color shown in the Color Swatch to the selected sprite without affecting its dark 
and light values. Dyeing a sprite changes the color values of all its pixels, with the exception of pure 
black or white pixels. 

Called Colorize in Microsoft Image Composer 1.0. 

 

dynamic range 

The difference in intensity between the brightest and darkest pixels in a sprite. 

 

edge (hard to soft) 

To blur the borders of a sprite by fading its outermost pixels to full transparency. A soft edge blurs 
more of the pixels on a sprite’s border to achieve a more gradual distinction between a sprite and its 
background; a hard edge blurs fewer pixels to achieve a crisper border. 

Called Feather in Microsoft Image Composer 1.0. 

 

edges (color) 

The borders between areas of a sprite with different color or brightness. When an effect such as 
Color Edges is applied to a sprite, the edges of the sprite are highlighted, and the areas which have 
a similar color or brightness are colored with pure black. 



 

effects 

The features and tools offered by Microsoft Image Composer for changing the look of sprites in your 
composition. 

 

emboss 

An effect that gives the selected sprite a slightly raised, three-dimensional appearance. For an 
example of this effect, see Emboss. 

 

erase 

To remove the color from a selected region of a sprite so that the region becomes transparent. 

 

explode 

To separate grouped sprites and place all of the individual sprites in one selection set. If groups of 
sprites were combined into one group, ungrouping does not preserve their previous grouping. 

Compare with ungroup. 

 

extract 

See copy region. 

 

eyedropper 

A button on the True Color tab of the Color Picker and Choose Color dialog boxes that allows you 
to select a color shown on your desktop as the current color. Using the Eyedropper, you can specify 
a single color or an averaged color from a range of colors. 

 

feather 

See edge (hard to soft). 

 

filter 

One of several effects that changes a sprite by performing a weighted combination of the original 
value of each pixel with the original values of its neighboring pixels, and then storing the resulting 
values in the sprite. Some examples of filters are Soften, Blur, Outline, Sharpen, and Sharpen Lite. 

 

flat file 

A file in which there is no embedded structure information governing the ordering or grouping of 
sprites in a composition. Flat files contain only the portion of a composition that lies within the 



composition space, or a single sprite if you use Save Selection As. Common flat file formats include 
.bmp and .gif files. 

 

flatten 

To permanently combine selected sprites to produce a single sprite. 

Compare with group. 

 

flip 

To change the orientation of a sprite horizontally, vertically, or in both directions. 

 

frequency 

The number of times a wave pattern repeats in a given interval. 

 

fresco 

An effect that adds short, rounded dabs of paint to a sprite. For an example of this effect, see Fresco. 

 

gamma 

The nonlinear brightness response of a monitor or other imaging device. For a description of Gamma 
settings in Microsoft Image Composer, see Gamma tab. 

 

gradient 

A gradual blend of shades, usually from one color to another color, or from one shade to another 
shade of the same color. 

 

grayscale 

An effect that converts a color sprite to shades of gray. For an example of this effect, see Grayscale. 

Called Luminance in Microsoft Image Composer 1.0. 

 

group 

To designate all currently selected sprites as a single sprite within a composition. In addition to 
arranging a group of sprites as a single sprite, you can also arrange the stack order of the grouped 
sprites. You can align a group with another sprite, lock it to prevent it from being moved, and ungroup 
the sprites so that you manipulate them individually. 

Compare with flatten. 

 



halftone screen 

An effect that renders a sprite as a continuous-tone image made up of evenly-spaced rings (circles), 
dots, or lines. For an example of this effect, see Halftone Screen. 

 

histogram 

A bar graph presenting the distribution of intensity in a sprite. The horizontal axis represents the 
range of intensity, from the lowest setting on the left side of the graph to the highest setting on the 
right side of the graph. The vertical axis represents the number of pixels in the sprite and their given 
intensity levels. 

 

HSV color model 

A method for describing colors that uses the attributes of hue, saturation, and value (brightness) to 
specify a color. 

 

hue 

The color attribute that most readily distinguishes one color from other colors and that is determined 
by the frequency of the wave of light in the visible spectrum. This attribute is used in the HSV color 
model. 

See also saturation and brightness. 

 

HWB color model 

A method for describing colors that uses the attributes of hue, whiteness, and blackness to specify a 
color. 

 

impressionist 

A set of additional effects available in Microsoft Image Composer from the Plug-Ins menu. For 
details, see Impressionist plug-in overview. 

 

intensity 

The strength of a color, especially the degree to which it lacks its complement color. If intensity alone 
is chosen as a color, it is shown as shades of gray, with no hue. 

 

intensity map 

See map intensity. 

 

interactive scaling 

The process of scaling an image by directly manipulating it in a specific direction or to a specific size. 



 

keep transparency 

An option to include the alpha channel, which contains tranparency information, with images that are 
saved as .tif, .tga, or .png files. 

 

linear knee function 

An effect that changes portions of a sprite by compressing and expanding areas based on 
percentage, axis, and symmetry settings. For example, if you set the linear knee percent at 70% and 
the axis to Y only, the top 70% of the sprite is expanded and the bottom 30% is compressed. If you 
set the linear knee percent at 70% and the axis to X only, 70% of the area on the left of the sprite is 
expanded and 30% on the right is compressed. If you change the axis to include both X and Y, then 
the top left is expanded 70% and the bottom right is compressed. For examples, see Rectangular 
effect variations. 

 

lock tool 

An option on the Paint palette and Shapes palette that maintains the current tool selection as you 
move from one sprite to another. 

Called Sticky in Microsoft Image Composer 1.0. 

 

lossless 

A method of compression that retains all image data in a graphics file. Lossless data compression 
usually reduces a file to no less than half of its original size. 

Compare with lossy. 

 

lossy 

A method of compression that removes redundant pixels in an image so that the original image is 
altered to some degree. In most cases, however, the difference is indistinguishable. Lossy data 
compression can reduce a file to 1/50th of its original size. 

Compare with lossless. 

 

luminance 

See grayscale. 

 

make transparent 

A color enhancement that makes a sprite translucent by decreasing the opacity of its pixels. For an 
example of this effect, see Transparent. 

Called Wash in Microsoft Image Composer 1.0. 

 



map color 

A texture transfer that copies the color values of a source sprite to the opaque pixels of a destination 
sprite. The brightness of the destination sprite is unchanged. For an example, see Map Color. 

Called Color map in Microsoft Image Composer 1.0. 

 

map intensity 

A texture transfer that uses the intensity values of one sprite to change another sprite without 
changing the original colors of the other sprite. For an example, see Map Intensity. 

Called Intensity map in Microsoft Image Composer 1.0. 

 

map saturation 

A texture transfer that changes the saturation values of a sprite based on another sprite’s intensity. 
For an example of this effect, see Map Saturation. 

Called Saturation map in Microsoft Image Composer 1.0. 

 

map transparency 

A texture transfer that changes the transparency of a sprite based on the intensity of another sprite. 
For an example of this effect, see Map Transparency. 

Called Transparency map in Microsoft Image Composer 1.0. 

 

marquee 

See bounding box. 

 

mask 

A new sprite that is derived from another sprite in order to insulate part of the original image from 
changes. The area that is “masked” is thus protected from editing. For details, see Creating a mask. 

 

mesa 

An effect that gives a sprite the three-dimensional appearance of having its center pushed in or 
pushed out. For an example of this effect, see Mesa. 

 

monochrome 

A photograph or drawing containing a single hue or color, typically grayscale. 

 

mosaic 

An effect that gives a sprite the appearance of being composed of small, square tiles laid down on a 



flat surface. For an example of this effect, see Mosaic. 

Called Patchwork in Microsoft Image Composer 1.0. 

See also broken tile. 

 

 

negative 

A photographic effect that changes all of the colors in a sprite to their complements, resulting in a 
color negative. For an example of this effect, see Negative. 

Called Complement color in Microsoft Image Composer 1.0. 

 

OLE object 

An object, such as an image file, that can be linked or embedded to a compound document, such as 
a spreadsheet or document created with word processing software, by means of OLE. OLE, which is 
an acronym for Object Linking and Embedding, is a way to transfer and share information among 
applications.  

When an object is linked to a compound document, the document contains only a reference to the 
object; any changes made to the contents of a linked object appear in the compound document. 
When an object is embedded in a compound document, any changes made to the contents of the 
original object will not appear in the compound document unless the embedded object is updated. 

 

opacity 

The quality and degree to which light cannot pass through pixels. A low opacity value makes pixels 
more transparent; a high value makes pixels more opaque. 

In Microsoft Image Composer, opacity is specified as a percentage. For instance, a sprite with an 
opacity value of 100% is composed of totally opaque pixels, so that another sprite cannot be seen 
through it. 

You can specify opacity by using an opacity slider. Many tool palettes and dialog boxes provide an 
opacity slider, as shown here. Some features allow you to change the opacity values for specific 
pixels within the sprite. 

 

 

opaque 

The quality of a sprite’s pixels that defines the ability of light to pass through them. If a sprite is 
completely opaque, light does not pass through it. 

See also opacity and transparent. 

 

open-ended polygon 

A multisided shape that does not have a line connecting its first and last editing points. You can 
create an open-ended polygon by clearing the Close check box on the Shapes tool palette. 



 

order 

The placement of a sprite in the stack relative to other sprites. For details, see Arranging sprites 
overview. 

 

paint daub 

A suite of effects that renders a selection using a variety of paintbrush styles and sizes. For an 
example of these effects, see Paint Daubs. 

 

paintbrush 

A tool in the Paint palette that you use to paint the current color onto a sprite by dragging the pointer. 

 

palette 

See color palette or tool palette. 

 

palette knife 

An effect that adds rough, irregular patches of color to a sprite as if they were applied by a palette 
knife. 

 

pan  

A tool that you use to move a composition within the Microsoft Image Composer workspace. 

 

pencil 

A tool in the Paint palette that you use to draw a line in the current color by dragging the pointer. 

 

pixel 

A single unit of measurement on your screen that relates to the rectilinear grid used by display 
hardware to paint images on your screen. These units, which often appear as tiny dots, compose the 
pictures displayed by your screen. The color capability of each pixel is determined by the video card 
installed in the display system. 

 

plug-ins 

Separate programs that you can use to edit sprites in your composition. If located in one of the two 
plug-in directories, these programs are available from the Plug-Ins menu. 

 



posterize 

To reduce the number of color shades in a sprite and add dark lines along the edges. 

 

radial sweep 

An effect that sweeps a sprite’s radius, or half of its diameter, around its center point to create a disc. 
For an example of this effect, see Radial Sweep. 

 

recess 

An effect that highlights the lower-right edges of a sprite and darkens its upper-left edges to make the 
sprite appear indented, or recessed. For an example of this effect, see Recess. 

Compare with relief. 

 

relief 

An effect that highlights the upper-left edges of a sprite and darkens its lower-right edges to make the 
sprite appear raised. For an example of this effect, see Relief. 

Compare with recess. 

 

render 

See create. 

 

reticulation 

See sandpaper. 

 

RGB channels 

The color channels that carry information to determine the color of a pixel. Red, green, and blue are 
the three basic colors that are mixed to create a variety of colors. 

 

RGB color model 

A color-mixing model or method of describing the colors available on a display system. RGB (red, 
green, blue) uses the additive primaries method, mixing percentages of red, green, and blue to get 
the desired color. In this model, mixing no amount of RGB produces black and mixing the full amount 
of RGB produces white. 

 

RIP 

An abbreviation for Raster Image Processor. A device that converts vector graphics or text into a 
raster (bitmapped) image. 



 

rotate 

To turn a sprite about its center. 

 

sampling 

A portion of a sprite that is representative of the whole. In Microsoft Image Composer, the Radial 
Sweep effect uses a sampling of a sprite to create the effect. 

 

sandpaper 

A photographic effect that renders the darker areas of a sprite with dense clumps of dark emulsion 
and the lighter areas with stippled grain. For an example of this effect, see Sandpaper. 

Called Reticulation in Microsoft Image Composer 1.0. 

 

saturation 

The amount of color, or fullness, in a specified hue. 

 

saturation map 

See map saturation. 

 

scaling 

The process of enlarging or reducing an image. 

 

select color region 

A tool that selects a color region in a sprite so that you can cut out or erase that region. Cutting out a 
color region creates a new sprite, whereas erasing a color region makes the pixels in that region 
transparent. 

Called Colorlift in Microsoft Image Composer 1.0. 

 

selection  

A tool that you use to select a sprite in a Microsoft Image Composer composition. 

 

selection set 

A selection set is a temporary collection of currently selected sprites, used to apply a function to all 
selected sprites at one time instead of applying a function to each sprite individually. As soon as you 
click another sprite, the selection set disappears. Grouped sprites, by comparison, are more 
permanent and let you nest groups within groups. 



 

sharpen 

A photographic effect that makes a sprite look more distinct by increasing the contrast between 
neighboring pixels. For an example of this effect, see Sharpen. 

 

sharpen lite 

A more subtle, or “lite,” version of the Sharpen effect. For an example of this effect, see Sharpen 
Lite. 

 

sine function 

Based on the mathematical sine function, this feature distorts a sprite by compressing and expanding 
the areas of a sprite according to the axis and symmetry settings. For example, if you set the y-axis 
only, the top of the sprite appears expanded with increased compression toward the bottom. If you set 
the x-axis only, the left side of the sprite appears expanded with increased compression toward the 
right. For examples, see Rectangular effect variations. 

 

skew 

A type of warp that tilts a sprite by shearing its opposing sides in opposite directions around its center. 
For details, see Skew. 

 

smear 

A paint tool that blends the sprite’s current colors, appearing as if you smeared fresh paint with your 
finger. For details, click the Smear button in Paint tools overview. 

 

smoothing 

The blurring of the jagged, “stairstep” appearance in graphical elements such as lines, curves, circles, 
and particularly in fonts. Jagged edges occur when the resolution of an image is too coarse to 
achieve the appearance of smoothness. Thus, smoothing can blur the roughness of a jagged line by 
shading or coloring neighboring pixels. This technique makes the transition between light and dark (or 
between two colors) less distinct and therefore less visible, at the cost of making it look more blurry. 

Called Anti-aliasing in Microsoft Image Composer 1.0. 

 

snip 

A texture transfer that erases the opaque pixels in a sprite which are overlapped by the opaque pixels 
in another sprite, thus producing a cutout in the shape of the overlapping sprite. For an example of 
this effect, see Snip. 

 

source sprite 



The sprite that is used as the basis for modifying another sprite. 

 

spatter 

A paint effect that applies a pointillist style to a sprite using a spatter airbush technique. For an 
example of this effect, see Spatter. 

 

spline 

See curve. 

 

spoke 

A line from the center of a disk to its circumference. 

 

spoke inversion 

An effect that inverts every spoke of an imaginary disk that just fits within a sprite. For an example of 
this effect, see Spoke Inversion. 

 

sponge 

A paint effect that roughly dabs or blots the colors in a sprite. For an example of this effect, see 
Sponge. 

 

sprite 

A single image object, composed of pixels, whose area is defined by its bounding box. The sprite’s 
shape is determined by its nontransparent pixels. To add a sprite to your composition, you can insert 
a file, create a shape, or add text. 

 

stack 

The ordering of sprites, from front to back, in a composition. Also known as z-order. 

 

stencil 

A tool on the Cutout palette that creates a reverse copy of a sprite. The new sprite consists of an 
opaque image of the original sprite’s transparent pixels. The opaque image in the new sprite uses the 
current color shown in the Color Swatch. For details, see Stencil. 

Called Complement shape in Microsoft Image Composer 1.0. 

 

sticky 

See lock tool. 



 

sumi-e 

A paint effect that gives a sprite the appearance that it was painted with a wet brush heavily loaded 
with ink, resulting in rich blacks with soft, blurry edges on a textured, highly absorbent ground such as 
rice paper. For an example of this effect, see Sumi-e. 

 

template brush 

A brush that takes the shape of the selected sprite. When you use a template brush in a composition, 
that sprite is the paintbrush shape. 

 

texture transfer 

A set of effects that transfer the texture of one sprite onto another sprite. 

Called Sprite to sprite in Microsoft Image Composer 1.0. 

 

tile 

A texture transfer that applies repeated copies of a sprite to the opaque pixels of another sprite. For 
an example of this effect, see Tile. 

 

tint 

A color enhancement that applies a transparent wash of the current color shown in the Color Swatch 
to the selected sprite. For an example of this effect, see Tint. 

 

toolbar 

A narrow panel of buttons that typically appears below the menu bar and contains the buttons for 
performing standard composition tasks, such as saving a composition, cutting and pasting sprites, or 
previewing a composition with another color palette. You can drag the toolbar to the left, right, or 
bottom edge of the window, or you can drag it into the workspace so that it floats in its own window. 

 

toolbox 

A narrow panel of buttons that typically appears on the left side of the Microsoft Image Composer 
window and contains the buttons for opening the tool palettes. You can drag the toolbox to the top, 
right, or bottom edge of the window, or you can drag it into the workspace so that it floats in its own 
window. 

 

tool palette 

A window that displays a set of options and controls that you can choose to add or change sprites in 
your composition. For example, the Shapes tool palette provides you with the tools for adding new 
shapes to your composition. 



 

touch edges 

To align two sprites so that their edges meet. 

Called Abut in Microsoft Image Composer 1.0. 

 

transfer 

Texture transfers that replace the opaque pixels of one sprite with those of an overlapping sprite. For 
examples of these effects, see Transfer Shape and Transfer Full. 

 

transparency map 

See map transparency. 

 

transparency threshold 

The value of the alpha channel below which transparent pixels in a composition will be converted to 
full transparency when the composition is saved as a .gif file, or to the transparent color in other file 
formats. 

 

transparent 

The quality of a sprite’s pixels that defines the ability of light to pass through them. If a sprite is 
completely transparent, light passes through it completely which makes the sprite invisible. 

See also opacity and opaque. 

 

true color 

In Microsoft Image Composer, the full 24 bit-per-pixel color specification that produces the maximum 
range of colors that can be differentiated by the human eye. There are over 16 million colors available 
on the True Color palette. Image Composer always stores your composition in True Color when you 
save it as an .mic file. However, you can save or view your composition using a custom color palette. 

 

TWAIN 

The name of a standard range of scanner drivers. Like printer drivers, TWAIN scanner drivers enable 
any program that supports the TWAIN interface to control your scanner. The TWAIN interface allows 
you to make adjustments to an image before you scan it. For example, you can alter an image’s 
resolution, brightness, and contrast before loading and saving it. 

 

two-point perspective 

The technique of representing the spatial relation of objects as they might appear to the eye. You can 
apply two-point perspective in Microsoft Image Composer by using the Perspective warp. 



 

underpainting 

A paint effect that roughly paints the image of the sprite on an underlying surface texture, and then 
paints the image of the sprite again over the first image. For an example of this effect, see 
Underpainting. 

 

ungroup 

To separate a group of sprites into a selection of sprites. If groups of sprites were combined into one 
group, ungrouping returns them to their previous groups. 

Compare with explode. 

 

vortex 

An effect that twists a sprite around its center while maintaining the orientation of the pixels at its 
borders. For an example of this effect, see Vortex. 

 

warp 

A distortion of a sprite’s overall appearance. The Arrange palette contains three types of warp: 
Perspective, Skew, and Bilinear. 

 

wash 

See make transparent. 

 

watercolor 

An effect that paints a sprite in a watercolor style that uses a medium brush loaded with water and 
color. For an example of this effect, see Watercolor. 

 

water paper 

See wet paper. 

 

web palette 

A palette that contains 216 colors and does not allow dithering. The safety palette is intended for line 
art or solid-colored art that you want to publish to the Web. 

 

wet paper 

A paint effect that renders a sprite with blotchy daubs of color that appear to have been painted on 
damp paper. For an example of this effect, see Wet Paper. 



Called Water paper in Microsoft Image Composer 1.0. 

 

workspace 

The entire area available to use when creating a composition. The workspace includes the 
composition space, the area around it, and any windows you have open showing parts of the 
composition. 

 

x-axis 

The horizontal reference line on an image that has horizontal (width) and vertical (height) dimensions. 

 

y-axis 

The vertical reference line on an image that has horizontal (width) and vertical (height) dimensions. 

 

z-order 

The numerical position of a sprite in the stack of sprites, ordered from front to back, that makes up a 
composition. 

 

zoom 

To change the magnification level of your view. When you zoom to a level higher than 100%, less of 
the workspace is visible and the images on it appear larger. When you zoom to a level lower than 
100%, more of the workspace is visible and the images on it appear smaller. 

 

What is Microsoft Image Composer? 
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Microsoft Image Composer is an application for creating compositions for display on Web sites, 
CD-ROMs, games, or other on-screen destinations. Use existing images in a wide variety of formats 
or create new art. Image Composer offers a combination of powerful tools, a huge workspace, and 



sample images to help anyone produce professional-looking images. The following figure shows a 
composition created with Image Composer. 

 

Image Composer was designed for experimentation. You can apply effects easily, view the results, 
and then modify or undo those effects to achieve the result you seek. You enjoy the following 
advantages when you work with Image Composer: 

• Industry-standard file formats. 

You can use Image Composer to work with a wide variety of popular file formats, including TIFF 
(.tif), CompuServe GIF (.gif), Portable Network Graphics (.png), Targa (.tga), JPEG (.jpg), Adobe 
Photoshop (.psd), and more. For scanned images, Image Composer supports the TWAIN 
interface. 

• Simplified interface. 

In addition to standard menus and toolbars, Image Composer functions are divided into groups and 
placed on tool palettes. For example, all paint tools are grouped on the Paint palette. 

• Popular plug-in sets. 

Image Composer includes the Impressionist plug-in with dozens of effects and filters, and supports 
the use of popular plug-ins that adhere to the Adobe Photoshop Plug-In Interface standard. 

• Hundreds of sample images. 

Browse the images in the Sample Sprites Catalog by clicking Sample Sprites Catalog on the 
Help menu and insert them into your composition. These images include scenes of nature, 
animals, plants, textures, buttons, and more. 

• Wizards for creating buttons and for saving files 

Creating buttons takes just a few mouse clicks with the Button Wizard. Choose from a variety of 
shapes, colors, and textures. Save compositions for Web sites by using the Save for the Web 
wizard. 

 
 

Using Image Composer online Help 
 

The Help system consists of the following parts: 

• Context-sensitive Help. Brief help on a particular tool or dialog box is available in the following 
ways: 

• Clicking the question mark button on the tool bar, moving the pointer to a tool or control (not a 
label or an icon), and clicking. 

• Clicking Help in a dialog box. 

• Pressing F1 or SHIFT + F1 to get context Help at the most specific level available. 

• Image Composer Tutorial. A series of task-oriented lessons teach many Image Composer tools 
and techniques. Click Learning Microsoft Image Composer, then click Tutorial on the Help 
menu to open the tutorial. 

• Introduction to Image Composer. An overview of Image Composer for new users. This 
introduction is available the first time that Image Composer is started after being installed. For 
subsequent viewing, click Learning Microsoft Image Composer, then click Introduction to 
Microsoft Image Composer on the Help menu. 

• Procedure Help. A series of steps that you follow to perform a specific task. Procedure help is 
available from the Help menu by clicking Microsoft Image Composer Help Topics and then 
clicking the procedure you want. 

• Common Tasks Help. Topics for the ten most common actions in Image Composer are available 
directly from the Help menu by clicking Common Tasks. 

• ToolTips. Brief names for tools and controls that do not have labels. To use this help, move the 
pointer over the control you want help for and pause. 



• Reference Help. Topics based on sample images you can create with each category of tools. 
Reference help is available from the Help menu by clicking Microsoft Image Composer Help 
Topics and then clicking the Reference book in the Help Contents window. 

• Hint Messages. This help appears automatically when you are required to follow a specific 
sequence or act on a specific object. You can disable hint messages at any time from within the 
hint message dialog box. 

• Status Bar Text. Brief descriptions of commands and other elements appear on the left side of the 
status bar (the bar at the bottom of the Image Composer window). 

• Sample Sprites Catalog. A complete help system containing thumbnail pictures of the sample 
sprites and their locations. 

 

Working with compositions 
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The basic building block of a Microsoft Image Composer composition is the image object known as a 
sprite. A composition can have one sprite, one hundred sprites, or more. Because a sprite is an 
object, you can move it anywhere in a composition just as easily as you move an icon on your 
desktop. When you insert an image into Image Composer, it immediately becomes a sprite.  For 
more information on sprites, see What is a sprite? 

You work with your compositions in the Image Composer workspace. The workspace includes the 
composition space, plus an infinite amount of space beyond the composition space. You can use this 
design space as a place to temporarily store your finished or experimental sprites. 

The composition guides help you adjust the size and location of the composition space within the 
workspace. You can resize the composition space for a particular work session or set a default size 
and color for all compositions. For details, see The composition space. 

You also can open more than one view window for a composition. For example, you can have one 
window showing your composition in true color at 100% size, a window showing the composition 
reduced to 20%, and a window showing the composition with a custom color palette. You can use the 
Image Composer view window as a virtual camera that you can move around through an infinite 
scene. For more information on opening multiple views, see Creating multiple views of a composition. 

 

The composition space 
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The composition space in Microsoft Image Composer has two purposes: 

• It helps you lay out a composition by providing a virtual drawing board that you can place sprites 
on. You can then use the workspace, which surrounds the composition space, as a temporary 
storage area for the sprites you want to lay out. 

 



• It defines the content of a composition that you save in a flat file format, such as a Windows bitmap 
(.bmp) or GIF (.gif) file. Saving a composition in such a format flattens the image and crops it so 
that only the portion of the composition that rests on the composition space is saved. 

 

When you save a composition as a Microsoft Image Composer (.mic) file, you save everything in 
the workspace, including the sprites that lie outside the composition space. For more information 
about saving compositions, see Opening and Saving Files Overview. 

 
 

Resizing the composition space 
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You can adjust the size of the composition space before or after you add sprites to your composition. 
For example, you can resize the composition space to match the size of an image you want to create 
for a Web page and then add sprites to your composition. Or you can add sprites to a composition 
first and then resize the composition space so that it contains just the portion of the composition that 
you want to save in a flat file format. 

When you save a composition as a flat file, the size and location of the composition space are 
important because only the portion of the composition that is bounded by the composition space will 
be saved. When you save a composition in Microsoft Image Composer (.mic) format, the entire 
workspace is saved, so you can use the composition space exclusively to help you lay out and align 
sprites. 

The composition space cannot be smaller than 3 x 3 pixels or larger than 4096 x 4096 pixels. 

 To resize the composition space 

1 Position the pointer over a composition guide. 

To resize the composition space in two directions, position the pointer over one of its corners.  

Tip   If the composition guides are hidden, click Composition Guides on the View menu to 
display them. 

2 Drag the composition guide to its new location: 

• To move both of the horizontal composition guides or both of the vertical composition guides, 
hold down CTRL while dragging. 

• To move all four composition guides, hold down CTRL while dragging a corner of the composition 
space. 

• To maintain the current aspect ratio, hold down SHIFT while dragging a corner. 
 

3 Release the mouse button. 
 
 

Changing the appearance of the composition space 
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You can set the width, height, and color of the composition space for each new composition or for the 
current composition only. You can also save the current settings as the new default or revert those 
settings to the default settings you last saved. 

For example, if you plan to create many compositions for a Web page with a specific background 
color, you can change the default color of the composition space to that color. 

 To change the appearance of the composition space 

1 On the File menu, click Composition Setup. 

2 Click the Current Composition tab to change the settings for the current composition only. 

– or – 

Click the New Composition Defaults tab to change the settings for all new compositions. 

3 Change the current settings: 
 

To: Do this: 
 

Change the width Specify a new value in the Width box. 
The width is measured in pixels. 

Change the height Specify a new value in the Height box. 
The height is measured in pixels. 

Change the color Click Edit. Then choose a new color in 
the Color Picker dialog box. 

Revert to the default settings for 
the current composition 

Click Use Default on the Current 
Composition tab. 

Use the current settings for all 
new compositions 

Click Use Current on the New 
Composition Defaults tab. 

 

4 Click Apply to apply these settings, or click OK to apply these settings and close the dialog box. 
 
 

What is a sprite? 
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A sprite is an image object with shape and transparency. A composition includes every sprite that you 
have created or modified, regardless of whether you can see it on workspace. 

Each time you insert an existing image into a composition, regardless of its source, that image 
automatically becomes a sprite. When you create a new image with Microsoft Image Composer, that 
new image is created as a sprite. You can move sprites anywhere in a composition and arrange them 
as you choose. 

When you click a sprite, you see that it is surrounded by a bounding box. The bounding box provides 
reference points for various effects and tools. The following figure shows a sprite and its bounding 
box. The sprite contains shape, the ball, and transparency, the area between the ball and the 
bounding box. In this figure, the eight ball itself is set for 100% opacity (completely opaque); the clear 
area outside the ball extending to the bounding box is set for 0% opacity (completely transparent). 

 

The bounding box has handles in each corner and on each line. Use these handles to resize a sprite, 
rotate it, and more. 

As you use a tool or apply an effect, its action is applied to the sprite, or sprites, you currently have 
selected. The bounding box handles indicate which group of tools is currently selected. The following 
figure shows examples of different bounding boxes, as they relate to a specific tool or effect. 



Crop/Extend bounding box, Paint bounding box, and Color Tuning bounding box 

 

Sprites can be completely independent, combined in temporary selection sets, or combined in 
permanent groups. You can apply various tools, effects, and filters to either single sprites or 
temporary selection sets of sprites but not to groups. 

The position of a sprite in a composition is determined by where you place it on the workspace and 
when you added that sprite to the composition. Each new sprite is positioned on a stack of sprites. As 
each new sprite becomes part of a composition, it is placed on top of the stack. For more information, 
see Ordering Sprites. 

 

Opacity and transparency 
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The shape of a sprite is determined by the opacity of the image being represented and by the 
transparent space around it. However, the transparency of a sprite is not limited to the space 
surrounding it. 

A sprite is defined by four channels that contain settings for red, green, blue, and alpha. The red, 
green, and blue channels define the amount of each color used in the sprite from 0 (none of the color 
used) to 255 (maximum amount of the color used). The alpha channel defines the degree of opacity 
of a sprite from zero (completely transparent) to 100 (completely opaque). 

You can use the alpha channel as if it were another color. Many effects contain a setting for opacity, 
which sets the transparency of the effect anywhere from completely transparent (0%) to completely 
opaque (100%). For example, you can set the opacity of the Erase tool to partially erase a portion or 
a sprite and allow the sprite behind it to show through. The following is a composition that makes use 
of transparency. 

 

 

 Ordering sprites 
 

A composition has three dimensions: height, width, and depth. The depth is represented by the stack, 
also referred to as the z-order. When a new sprite is added to a composition, whether by inserting an 
existing image or by creating a new image, that sprite is placed on top of the stack. 

You can move sprites anywhere in the workspace. As you do so, they remain in their order in the 
stack until you specifically change the order. 

The placement of sprites in the composition space does not necessarily reflect their order in the 
stack. Two sprites can be next to each other in a composition and yet be at opposite ends of the 
stack. The following figure shows the relationship of sprites in a stack. The numbers in the sprites 
show their position in the stack. 

 

 

Selecting sprites, tools, and colors 



 

An important concept in working with Microsoft Image Composer is selection. While you design your 
composition, many of the actions you perform and the sprites you perform them on are determined by 
the following selections: 

• Current tool. This is the tool that you most recently clicked in the toolbox, the toolbar, or the active 
palette. You can make any tool the current tool by clicking it. For more information, see The 
toolbox and tool palettes. 

• Current color. This is the color that is displayed in the Color Swatch. You can make any color the 
current color by clicking the Color Swatch and choosing a different color in the Color Picker 
dialog box. For more information, see Setting the current color. 

• Current selection. These are the sprites you have selected by clicking them. The current selection 
can be a single sprite, a set of sprites, or a group of sprites. You can make any sprite the current 
sprite by clicking it, or you can make a set of sprites the current selection by pressing CTRL as you 
click each sprite. You can also select many sprites by clicking the Arrow tool and then dragging a 
rectangle around them. 

 

The selected sprite has a set of handles around it that lets you rotate or resize the sprite. When you 
hover over a handle, the pointer changes to show you what will happen when you drag that handle: 

 

Tips 

• To maintain the selected sprite’s aspect ratio when you resize it, press SHIFT as you drag a corner 
handle. 

• You can rotate or resize a set of selected sprites or a group of sprites after you flatten the 
selection. However, flattening a selection permanently combines the selected or grouped sprites 
and thus cannot be undone. 

 

Selecting a dominant sprite for multi-sprite operations 

When your current selection contains more than one sprite, the sprite whose bounding box has solid 
handles, black by default, is the dominant sprite. When the bounding box of the dominant sprite 
overlaps other sprites, the solid color handles can be different colors, such as blue and black.  

The dominant sprite is used as the source sprite in operations that require more than one sprite, such 
as alignment, ordering, of selection sets, and texture transfers: 

• When you align a set of sprites, they are aligned with the dominant sprite. 

• When you order a set of sprites, the Bring Before and Send Behind commands on the shortcut 
menu apply to other sprites in the selection set relative to the dominant sprite.  

• When you transfer textures between sprites, properties such as the color and shape of the 
dominant, or source, sprite are copied to the destination sprite. 

 

You can select a dominant sprite in the following ways: 

• Clicking a sprite, then pressing SHIFT and clicking other sprites to create a selection set. The first 
sprite you click is the dominant sprite. For texture transfers in which two sprites must be selected, 
the first sprite you click is the dominant, or source, sprite. 

• Clicking a sprite in an existing selection set. 

• Using the TAB key to cycle through sprites in a selection set. Each time you press TAB, the 
dominant sprite is the current sprite. 

 

In a selection set, you can identify the dominant sprite by the solid black handles that surround it. The 
handles that surround the destination sprites are hollow. 

 

Notice that a sprite does not need to be at the top of the stack in order to be the source sprite. 



 

Selecting grouped sprites 

When you select a grouped sprite, the handles that surround it are hollow because you cannot rotate 
or resize the sprites in the group until you ungroup them. 

 

However, a grouped sprite can be the source sprite in a multiple selection. 

 

Note   Certain operations, such as cutting out, applying effects, and applying texture transfers, 
cannot be performed on grouped sprites. 
 
 

Creating multiple views of a composition 
 

You can have only one composition open at a time in Microsoft Image Composer. However, you can 
view that composition in many windows so that you can see different portions of it at one time. 

 

For example, you can open a new window on a composition, and then: 

• Set the zoom level of the first window so that the entire composition fits in it, and then zoom in on a 
specific area in the second window. When you make detailed changes to the second window, the 
first window will show you how those changes affect the entire composition. 

• Attach the True Color palette in the first window, and attach the Web (Dithered) palette in the 
second window. When you make color corrections in the first window, the second window will show 
you how the colors will appear in a Web browser. To see how your composition will look without 
dithering in a Web browser, attach the Web (Solid) palette in the second window, or open a third 
window and attach the Web (Solid) palette. 

 

Any changes you make to the composition in one window automatically appear in the other open 
windows. 

 To create multiple views of a composition 

1 On the Window menu, click New Window. This action opens a second window for the 
composition. 

2 On the Window menu, click Tile. This action resizes both windows so that the first window 
occupies the upper half of the workspace, and the second window occupies the lower half of the 
workspace. 

 

You can resize and arrange the windows so that they occupy the left and right halves of the 
workspace, or you can maximize one window and reduce the other window so that it rests on top of 
the first window. You can also cascade or maximize both windows, and you can switch between them 
by pressing CTRL+TAB. 

 

The toolbox and tool palettes 
 

By using tools in the toolbox, you can create your own style, or emulate an historic style. For 
example, you can use the paint tools to emulate the bright colors and strong brush strokes of a 
nineteenth century master like Cezanne, or create a monochrome wash drawing in the suiboku-ga 
style of the fourteenth century sumi-e master Sesshu Toyo. 

Tool palettes are out of view until you activate them by clicking a tool on the toolbox or by selecting a 
tool from the Tools menu. To hide or display a tool palette, press F2, or click Toggle Palette View on 



the View menu. You can dock a tool palette by using the Dock Tool Palette command on the View 
menu to return a tool palette to the lower left corner of the workspace.  You undock a tool palette by 
moving it. You also can move a tool palette anywhere in Image Composer and its position is retained 
until you move it. 

In Image Composer, tools palettes are organized by related tasks. For example, the Effects tool 
palette contains dozens of tools for sketching, painting, and more. You activate a tool palette by 
clicking a tool on the toolbox. The following list describes each tool palette. 

• The Arrange tool palette contains tools to arrange, resize, rotate, flip, and change the order of 
sprites in the stack. Tools to crop or extend the bounding box of a sprite are also included, as are 
three interactive warp tools.  

• The Cutout tool palette contains tools to create masks, shadows, and any other cutouts in a 
variety of shapes. In addition, you can use the Select Color Region tool to create a new sprite of a 
single color from an existing sprite or to extract the texture of a sprite. 

• The Text tool palette contains tools to create text sprites using  the set of scaleable fonts that are 
installed on your computer. 

• The Shapes tool palette contains tools to create new sprites in geometric shapes or in freeform 
shapes you create with the Curve or Polygon tool.  

• The Paint tool palette contains tools to apply various paint effects, such as spraying a color with an 
airbrush or painting a color with a brush you choose from dozens of sizes and shapes. 

• The Effects tool palette contains tools to add effects to sprites, including arts and crafts, color 
enhancement, outlines, photographic, and other effects. 

• The Texture Transfer tool palette contains tools to transfer the content of pixels in one sprite to 
another. 

• The Color Tuning tool palette contains tools for making adjustments to the contrast, brightness, 
hue, and saturation of colors, and for making adjustments to highlights and shadows, and dynamic 
range. 

• The Color Picker dialog box provides access to true color palettes and to custom reduced-color 
palettes. You activate the Color Picker by clicking the Color Swatch. You also can right-click to 
activate a more compact color picker. In addition, you can drag a color from the main color swatch 
to color swatches on the tool palettes, such as those for shadow color and edge color in the 
Outlines category on the Effects palette, or from the color chips on the tool palettes to the main 
Color Swatch. 

 
 

Using shortcut menus 
 

Shortcut menus appear when you click the right mouse button anywhere in the workspace. The 
commands available on each shortcut menu depend on the context in which you right-click the 
mouse. For example, if you right click in the workspace outside the composition space, the shortcut 
menu contains commands that affect the view of the workspace. If you right click a text object, the 
shortcut menu contains commands relevant to working with text objects, such as Object Smoothing.  

 

 

Applying, undoing, and resetting actions 
 

Three basic actions within Microsoft Image Composer are common to almost all procedures. They 
include the following: 

   Apply 

Located on tool and color palettes, this button applies the action you choose. The action will be 



applied to your current composition when you click Apply. 

   Undo 

Located on the toolbar and Edit menu, Undo reverses the last unsaved Apply action. 

    Reset or Defaults or Use Defaults. 

Restores the sliders to their original positions and sets the values to their default settings. These 
buttons can be found on the Effects and Color Tuning palettes. 

 

Arrange tool palette 

 

 

Paint tool palette 

 

 

Text tool palette 

 

 

Shapes tool palette 

 

 

Cutout tool palette 

 

 

Color Tuning tool palette 

 

 

Color Picker 

 

 

Effects tool palette 

 

 

Texture Transfer palette 



 

 

Microsoft Technical Support for Image Composer 
 

Technical support for Microsoft Image Composer is provided as part of the technical support available 
for Microsoft FrontPage. For more information, refer to the technical support section of the Microsoft 
FrontPage Help file or Getting Started with Microsoft FrontPage 98. 

 

Keyboard Shortcuts 
 

You can use keyboard shortcuts to work more efficiently in Microsoft Image Composer. 

To Press 
 

Select all the sprites in a composition. CTRL+A 

Copy the selected sprites to the Clipboard. CTRL+C 

Duplicate the selected sprites. CTRL+D 

Explode the selected group. CTRL+E 

Flatten the selected sprites. CTRL+F 

Group the selected sprites. CTRL+G 

Lock or unlock the position of a sprite. CTRL+L 

Fill the selected sprites with the current color. CTRL+M 

Create a new composition. CTRL+N 

Open an existing composition. CTRL+O 

Print the current composition. CTRL+P 

Save the current composition. CTRL+S 

Clear the current selection. CTRL+T 

Ungroup the selected group. CTRL+U 

Paste a sprite that has been copied or cut. CTRL+V 

Close the composition. CTRL+W 

Cut the selected sprites. CTRL+X 

Reverse the last action. CTRL+Z 

Quit Microsoft Image Composer. ALT+F4 

Display the Pan pointer. ALT+0 

Display the Selection tool. ALT+1 

Display the Arrange palette. ALT+2 

Display the Cutout palette. ALT+3 

Display the Text palette. ALT+4 

Display the Shapes palette. ALT+5 

Display the Paint palette. ALT+6 

Display the Effects palette. ALT+7 

Display the Texture Transfer palette. ALT+8 

Display the Zoom pointer. ALT+9 

Display the Color Tuning palette ALT+EQUAL SIGN (=) 

Display the properties of a sprite. ALT+ENTER 



Display a Help topic or the Help Contents tab. F1 or SHIFT+F1 

Display or hide a palette. F2 

Reposition the selection in the center of the active 
view window. 

F8 

Cancel the current operation. ESC 

Delete the current selection. DELETE 

Hide selection outline, selection handles, and 
composition guides. 

SPACEBAR 

Select sprites in the order that they appear in the 
stack. 

TAB 

Return the view focus to the composition space. HOME 

Return the selected sprite to its saved home position. CTRL+HOME 

Instruct Image Composer to remember the home 
position of the sprite. 

ALT+HOME 

Move the selection one unit to the left. LEFT ARROW 

Move the selection one larger unit to the left. CTRL+LEFT ARROW 

Move the selection one unit to the right. RIGHT ARROW 

Move the selection one larger unit to the right. CTRL+RIGHT ARROW 

Move the selection up one unit. UP ARROW 

Move the selection up one larger unit. CTRL+UP ARROW 

Move the selection down one unit. DOWN ARROW 

Move the selection down one larger unit. CTRL+DOWN ARROW 

Zoom in one level. PLUS SIGN (+) 
(numeric keypad) 

Zoom out one level. MINUS SIGN (-) 
(numeric keypad) 

 
 

Opening and saving files overview 

{button 
,AL("A_MANAGING
_Working_with_Sup
ported_File_Types;In
serting files and 
images overview;")} 
Related Topics 

 

In Microsoft Image Composer, you can open or save your file in many popular graphics file formats, 
including: 

• Windows Bitmap (.bmp) 

• Kodak FlashPix (.fpx) 

• CompuServe Graphics Interchange Format (.gif) 

• Joint Photographic Experts Group (.jpg) 

• Microsoft Image Composer (.mic) 

• Microsoft Picture It! (.mix) 

• Portable Network Graphics (.png) 

• Adobe Photoshop 3.0 (.psd) 

• Targa (.tga) 



• Tagged-Image Format File (.tif, .tiff) 
 

If you save your work as an Image Composer composition (an .mic file), all sprites remain 
independent of one another when you reopen the file. You can also retain individual sprites by saving 
to a .psd file. Saving in any other file format flattens a composition, which means that you cannot 
manipulate the sprites as separate objects when you reopen the file. 

You can elect to save an entire composition or specific sprites in the composition. In addition to 
standard Save and Save As commands, the File menu offers these options. 

To Use this command 
 

Save a flattened copy of a particular selection.  Save Selection As 

Save a copy of the active composition. This 
option differs from Save As in that it saves a 
copy of the composition without affecting the 
active file name. 

Save Copy As 

Use a wizard that helps you save files for the 
Web. 

Save for the Web 

 
 

Saving files in different formats 

{button 
,AL("A_MANAGING
_Overview")} 
Overview 

 

{button ,JI(`',`MANAGING_BMP_Format')}  Saving BMP files 

{button ,JI(`',`MANAGING_FPX_Format')}  Saving FPX files 

{button ,JI(`',`MANAGING_GIF_Format')}  Saving GIF files 

{button ,JI(`',`MANAGING_JPEG_format')}  Saving JPEG files 

{button ,JI(`',`MANAGING_MIC_Format')}  Saving MIC files 

{button ,JI(`',`MANAGING_MIX_Format')}  Saving MIX files 

{button ,JI(`',`MANAGING_PNG_Format')}  Saving PNG files 

{button ,JI(`',`MANAGING_PSD_Format')}  Saving PSD files 

{button ,JI(`',`MANAGING_TGA_Format')}  Saving TGA files 

{button ,JI(`',`MANAGING_TIFF_Format')}  Saving TIFF files 
 

Tip   If you plan to display a composition on a Web page, you can save it as a .gif or .jpg file. To 
learn how to optimize your files for the Web, click Save for the Web on the File menu. 
 
 

Saving BMP files 

BMP format information 

 

BMP is the standard Windows raster, or bitmapped, image file format. Image Composer saves .bmp 
files as a single sprite in true color or with a custom color palette, such as Gray Ramp, Web 
(Dithered), or Web (Solid). 

 To save a file in BMP format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 



sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click Windows (*.bmp). 

5 In the Color format list, click the color palette you want.  

6 If you want to map the alpha data in your composition to a specific color, select the Alpha as color 
check box. If the check box is clear, the sprite’s alpha channel maps to the color of the 
composition space when you save the file.  

7 Click Save. 
 
 

Saving FPX files 

FPX format information 

 

Kodak FlashPix (.fpx) is the file format used on Kodak Image Magic System FlashPix CDs. Image 
Composer saves .fpx files as a single sprite in true color only. 

 To save a file in FPX format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click FlashPix (*.fpx). Note that in the Color format list, True Color is the 
only available option. 

5 Click Save. 
 
 

Saving GIF files 

GIF format information 

 

GIF (Graphics Interchange Format) is a compressed, lossy file format that is designed to minimize 
transfer time over phone lines. Image Composer saves .gif files as a single sprite with an 8-bit (or 
less) custom color palette, such as Gray Ramp, Web (Dithered), or Web (Solid). 

 To save a file in GIF format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click CompuServe (*.gif). 

5 In the Color format list, click the option you want. Because .gif files are limited to 256 or fewer 
colors, True Color is unavailable. 

• Transparent color. You can designate a palette color as the transparent color of the 
composition or selection to be saved in .gif or .png files. If you select this check box, you can 
assign a color for the transparent color by clicking the color chip. To determine which pixels are 
changed to the designated transparent color, move the Threshold slider or enter a value 
between 0 and 255 in the Threshold box. For more information, see Adjusting the threshold of a 
.gif or .png file. 

• Properties for each particular option you choose appear to the right of the Color format list. 



6 Click Save. 
 

Notes 

• If you save a file in GIF format, you may notice some deterioration in quality when you reopen it. 
This is because internally, Image Composer stores images in true color (32-bit) formats, and GIF 
images are limited to 256 colors (8-bit).  

• If you intend to display your work on the Web, consider saving it as a GIF file. Generally speaking, 
this format works well for images that use few colors or large blocks of solid color, or for images 
that have a transparent background. Image Composer has a wizard that can help you quickly 
optimize your files for the Web. To use it, click Save for the Web on the File menu. 

 
 

Saving JPEG files 

JPEG format information 

 

JPEG (Joint Photographic Experts Group) is a 24-bit file format that is designed to compress 
photographs for use on the Web. Through use of a compression algorithm, JPEG creates moderately 
sized image files by discarding data inessential to the display of a sprite. In Image Composer, you can 
specify the amount of compression you want to apply to an image. Image Composer saves .jpg files 
as a single sprite in true color only. 

 To save a file in JPEG format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite in a composition, select the sprite, and then click Save Selection As. 

2 On the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 On the Save as type list, click JPEG (*.jpg). Note that in the Color format list, the only option 
available is True Color. 

When you select JPEG (*.jpg), the compression options become active. If you select the 
Compression check box, you can adjust the Amount slider or enter a number between 1 and 100 
in the Amount box to determine the amount of compression you want. Be aware, however, that 
because JPEG is lossy, higher compression settings can result in lowered image quality when the 
image is reopened.  

5 Click Save. 
 

Note   If you intend to display your work on the Web, consider saving it as a JPEG file. Generally 
speaking, this file format works well for photographic images, or for illustrations that use many colors 
or have smooth gradations of color. Image Composer comes has a wizard that can help you quickly 
optimize image files for the Web. To use it, click Save for Web on the File menu. 
 
 

Saving MIC files 

MIC format information 

 

MIC is the native Microsoft Image Composer file format. Unlike file formats that flatten sprites, the 
MIC format retains the individual sprites in the composition so that you can reopen and continue to 
work on your composition later. MIC files also retain workspace settings such as color palettes and 
composition space color. Image Composer saves .mic files in true color only. 

 To save a file in MIC format 

1 On the File menu, click Save As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 



3 In the File name box, type a name for the file. 

4 In the Save as type list, click Microsoft Image Composer (*.mic). Note that in the Color format 
list, the only option available is True Color. 

5 Click Save. 
 

Tip   Saving to file formats other than .mic or .psd permanently flattens sprites and crops any sprites 
that lie outside the composition space. For this reason, you may want to save your work as a .mic file 
before saving to other formats so you have a copy of the individual sprites in case you need them 
later. 

 

Saving MIX files 

MIX format information 

 

MIX is the Microsoft Picture It! file format. Image Composer saves .mix files as a single sprite in true 
color only. 

 To save a file in MIX format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click Microsoft Picture It! (*.mix).  

5 Click Save. 

 

Saving PNG files 

PNG format information 

 

PNG is the Portable Network Graphics file format. Although many Web browsers cannot yet display 
PNG files without a special plug-in, this file type is rapidly growing in popularity on the Web. Because 
.png files are lossless, there is no image degradation when the image is compressed. Image 
Composer saves .png files as a single sprite in true color or with a custom color palette, such as Gray 
Ramp, Web (Dithered), or Web (Solid). 

 To save a file in PNG format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click Portable Network Graphics (*.png). 

5 In the Color format list, click the option you want. True Color is the default setting. 

• Keep transparency. You can save a sprite with or without the alpha channel. When the Keep 
transparency check box selected, Image Composer saves the sprite as an RGBA image. Keep 
transparency is selected as the default setting. 

• Transparent color. You can designate a palette color as the transparent color of the 
composition or selection to be saved in .gif or .png files. If you select this check box, you can 
assign a color for the transparent color by clicking the color chip. To determine which pixels are 
changed to the designated transparent color, move the Threshold slider or enter a value 



between 0 and 255 in the Threshold box. For more information, see Adjusting the threshold of a 
.gif or .png file. 

• Properties for each particular option you choose appear to the right of the Color format list. 
 

6 Click Save. 
 
 

Saving PSD files 

PSD format information 

 

PSD is the Adobe Photoshop 3.0 image format. In Image Composer, sprites in a .psd file are 
converted and saved as Photoshop layers. You can choose to save the composition space as a 
background layer. You can also save sprites that lie outside the composition space. Image Composer 
saves Photoshop files in true color only. 

 To save a file in PSD format 

1 On the File menu, click Save As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click Adobe Photoshop 3.0 (*.psd). 

5 Click Save. 

The Photoshop (.psd) File Save Options dialog box appears. 

6 In the Photoshop (.psd) File Save Options dialog box, select the options you want for your .psd 
file, and then click OK. 

 
 

Saving TGA files 

TGA format information 

 

Images saved in the TGA (Targa) format in Microsoft Image Composer are stored as a single sprite in 
the True Color color format only.  

 To save a file in TGA format 

1 On the File menu, click Save As. 

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the file. 

4 In the Save as type list, click Targa (*.tga). Note that in the Color format list, the only option 
available is True Color. Within this confine, however, you have several options: 

• Keep transparency. You can save a sprite with or without the alpha channel. When a sprite is 
saved with the Keep transparency option selected, it is stored as an RGBA image. Keep 
transparency is selected as the default setting. 

• Write premultiplied alpha. When the Keep transparency check box is selected, you can 
select the Write premultiplied alpha check box to save the image as a premultiplied RGBA 
(Red, Green, Blue, Alpha) image. Note that not all programs can read premultiplied RGBA 
images. 

• Alpha as color. Select this check box to map the alpha channel transparency information of a 
composition or selection to a single color. If you clear the Alpha as color check box, your 
composition or selection blends with the background that is set as the color of the composition 
space. If you select the Alpha as color check box, you can assign the color by clicking the color 
chip. Also, the Threshold slider is active. Use this slider or enter a number between 0 and 255 
in the Threshold box to adjust the transparency level.  



• Compression. You can store TGA files as compressed, but you cannot vary the amount of 
compression. TGA uses a run-length encoding compression algorithm. 

 

5 Click Save. 
 
 

Saving TIFF files 

TIFF format information 

 

The Tagged-Image File Format, or TIFF, is a preferred format because it is is lossless. In Microsoft 
Image Composer, TIFF files are saved as a single sprite. 

 To save a file in TIFF format 

1 On the File menu, click Save As.  

This option saves all sprites that lie within the composition space. If you want to save a specific 
sprite, select it, and then click Save Selection As. 

2 In the Save in list, click the drive location and folder where you want to save the file. 

3 In the File name box, type a name for the document. 

4 In the Save as type list, click TIFF (*.tif, *.tiff). Note that in the Color format list, the only option 
available is True Color. Within this confine, however, you have several options: 

• Keep transparency. You can save a sprite with or without the alpha channel. When a sprite is 
saved with the Keep transparency option selected, it is stored as an RGBA image. Keep 
transparency is selected as the default setting. 

• Write premultiplied alpha. When the Keep transparency check box is selected, you can 
select the Write premultiplied alpha check box to save the image as a premultiplied RGBA 
(Red, Green, Blue, Alpha) image. Note that not all programs can read premultiplied RGBA 
images. 

• Alpha as color. You can choose to map the alpha channel transparency information of a 
composition or selection to a single color. If you clear the Alpha as color check box, your 
composition or selection blends with the background that is set as the color of the composition 
space. If you select the Alpha as color check box, you can assign the color by clicking the color 
chip. Also, the Threshold slider is active. Use this slider or enter a number between 0 and 255 
in the Threshold box to adjust the transparency level. 

• Compression. You can compress TIFF files, but you cannot vary the amount of compression. 
TIFF uses a high-quality compression algorithm called LZW, which removes redundant pixel 
patterns to decrease the size of the file. 

 

5 Click Save. 
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Selecting alpha as color 
 

When you select the Alpha as color check box, Microsoft Image Composer replaces all pixels that 
have alpha values greater than the value specified in the Threshold box with the sprite color. 



Conversely, all pixels that have alpha values less than the value specified are replaced with the color 
specified in the color chip to the right of the Alpha as color check box. You can change or modify this 
color by clicking the color chip, which displays the Color Picker. 

• To adjust the threshold level, move the Threshold slider or enter a number between 0 and 255 in 
the Threshold box. Then click Save. 

 
 

Adjusting the threshold of a .gif or .png file 
 

When you select the Transparent color check box, Microsoft Image Composer replaces all pixels 
that have a transparency level below the threshold with the color you selected in the color chip next to 
the Transparent color check box. These pixels appear transparent when you open an image file. All 
pixels with a transparency level above the threshold setting are displayed in their original opaque 
color. 

• To adjust the threshold level, move the Threshold slider or enter a number between 0 and 255 in 
the Threshold box. Then click Save. 

 
 

RGBA 

The acronym RGBA stands for the color channels red, green, blue, and alpha. A sprite or 
composition saved in this format stores color information in all three colors plus alpha, which stores 
the opacity level. 

 

Introduction to the Tutorial 
 

Welcome to Microsoft Image Composer. This tutorial provides the basic skills to work successfully 
with Image Composer. You will create a logo for the Web site of an imaginary flower shop. The 
company, name, and/or data used in screen and sample outputs are fictitious. 

The finished logo 

 

To benefit the most from this tutorial, you should be familiar with the ideas discussed in Working with 
Compositions. The topics in this tutorial were designed to be worked on in order. Click the browse 
arrows on the Help window button bar to move through the topics in order. The topics in this tutorial 
are grouped into the following parts: 

Part 1: Organizing and Modifying Sprites 

Part 2: Creating the Logo Background and Name 

Part 3: Preparing the Logo for the Web 

The next topic is Preparing for the Tutorial. 

 

Preparing for the Tutorial 
 

You can use the tutorial topics as you would a regular Help topic, including printing topics. You might 
want to set your options in the Help window so that the Help window stays on top of all other windows 
while you work with the tutorial.  

If you set the Help window on top, you might want to minimize the window at times to accomplish 
certain tasks, then return the Help window to its regular size. Image Composer must be running for 
you to work with the tutorial. 



 To make the Help window stay on top 

1 On the Help window button bar, click Options. 

2 Click Keep Help on Top. 

3 Click On Top. 
 

This tutorial is self-paced. Use the browse buttons on the Help button bar to navigate, or click on the 
title of the next topic at the bottom each topic to proceed. 

You can stop the tutorial at any time simply by closing the Help window. If you want to stop before 
completing the tutorial, you should save your composition. For more information, see Saving a 
Composition. 
 

The dashed lines in the workspace, known as composition guides, are visible by default. To simplify 
the workspace, hide the composition guides. 

 To hide the composition guides 

• On the View menu, click Composition Guides if this menu choice is preceded by a checkmark.  

If no checkmark is visible before this menu choice, the composition guides are already hidden. 
 

The next topic is Part 1:  Organizing and Modifying the Logo Flowers. 

 

Part 1: Adding and Modifying Sprites 
 

In this portion of the tutorial, you will work with images in the Microsoft Image Composer workspace. 
This part of the tutorial teaches the basics of selecting, moving, and resizing images, and introduces 
several of the tools you use to adjust the color of the image and add a specific artistic look. 

The next topic is Inserting Images. 

 

Inserting Images 
 

You can insert an image from a file stored on your hard disk, from a compact disc, or from a photo 
compact disc. For the first step in creating this logo, you will insert images from your hard disk. 
Inserting files from other media is similar. 

 To insert the logo images from a file on your hard disk 

1 On the Insert menu, click From File. 

2 In the Inserts an image file dialog box, navigate to the directory into which you installed Image 
Composer, \Program Files\Microsoft Image Composer\Tutorial by default.  

If you do not find this directory, you might have to run the Setup program and install the sample 
sprites. 

3 In the list of folders, double-click Tutorial. 

4 In the Files of type box, click TIFF (*.tif,*.tiff). 

5 Hold down the CTRL key, and click Tulip.tif, Hibiscus.tif and Daisy.tif. 

6 Click OK. 
 

You now have three different flowers on your workspace. The flower sprites are stacked on top of one 
another in the upper left corner of the workspace window. They are in the order in which you inserted 
them into the composition. This order is the position of each sprite in the Image Composer stack. 

To work with the flower sprites, you must separate them. To separate them, you first must select 
them. 

The next topic is Selecting Sprites. To take a break, save your composition now. 



 

Selecting Sprites 
 

When you inserted the last flower sprite (the tulip) into your Image Composer composition, it 
automatically became the selected sprite. The bounding box surrounding the tulip indicates that it is 
the selected, or current, sprite. Nearly everything you do in Image Composer affects the current 
sprite. 

 To select a flower sprite 

1 Move the pointer over the sprite you want to select, in this case the hibiscus, and click the end of 
one of the petals. 

The bounding box now extends to the ends of the hibiscus petals. The hibiscus is still partially 
hidden by the tulip sprite because the tulip sprite is above the hibiscus sprite in the stack. 

2 Select the tulip sprite by clicking in the middle of the tulip. 

Because the tulip sprite is at the top of the stack of sprites, clicking the middle of it makes the tulip 
the selected sprite. 

 

You might find that you want to select a sprite that is hidden from view behind another sprite. To 
select a hidden sprite, you can cycle through the stack. 

 To cycle through the stack 

• Press the TAB key. 

Each time you press the TAB key, a new sprite is selected relative to its position in the stack. By 
pressing the key repeatedly, the selection moves through the entire stack in order, so you can stop 
when you see the bounding box of the sprite you want to select. 

The bounding box has resize handles at three of the four corners and on each side. The upper right 
corner contains a handle for rotating a sprite. Because Image Composer inserts new sprites into the 
corner of the workspace window, some of the handles of the sprites you have inserted are not visible. 
You must move the sprite to see all the handles. 

The next topic is Moving Sprites. To take a break, save your composition now. 

 

Moving Sprites 
 

One of Image Composer’s most important features is the ease of moving sprites. Because sprites are 
objects, you can move an image of a flower as easily as you can pick up and move a real flower.  

To demonstrate the extent of Image Composer’s workspace as you move sprites, you will move the 
composition space to the lower right corner of the workspace window and move the sprites, as shown 
in the following figure. Use the following procedures to become familiar with manipulating sprites. 

Using the workspace 

 

 To adjust the view in the workspace window 

• Click the vertical scroll bar once below the slider. 
 

When you moved the composition space, you saw that the gray area that surrounds it, known as the 
workspace, extends well beyond the composition space.  

The composition space provides a reference for your composition and determines the boundaries of a 
composition for certain file formats. You can move sprites onto the composition space and off it as 
you experiment with your composition. Click the vertical scroll bar once above the slider to center the 
composition space. 



 To move the sample sprites 

1 Drag the tulip sprite onto right side of the composition space. 

2 Drag the hibiscus sprite onto the composition space to the left of  the tulip. 

3 Drag the daisy sprite onto the left side of the composition space. 
 

You currently have three flower sprites to work with. You can easily add more sprites to your 
composition by duplicating the sprites you have inserted. 

The next topic is Duplicating Sprites. To take a break, save your composition now. 

 

Duplicating Sprites 
 

Duplicating sprites is a basic task that provides you with copies of sprites on which to experiment. 
Duplicating a sprite makes an exact copy, as shown in the following figure. 

Duplicated sprites in the workspace 

 

 To duplicate the sample sprites 

1 Click the daisy. 

2 On the Edit menu, click Duplicate.  

You can also create duplicates by clicking CTRL+D, or clicking and holding CTRL and dragging the 
bounding box. Notice how the duplicate sprite is offset from the original and that the duplicate 
becomes the selected sprite. 

3 Make one more duplicate of the daisy sprite and make two duplicates of each of the other flower 
sprites. 

 

To make the sprites easier to work with, drag each of the duplicates to form a column of each type of 
flower on the composition space and the workspace. 

You now have several sprites to use in the logo. You can change the size of the sprites to create a 
more interesting composition. 

The next topic in this tutorial is Resizing Sprites. To take a break, save your composition now. 

 

Resizing Sprites 
 

The design of the logo will provide more visual interest if the flowers are different sizes. Image 
Composer offers a couple of ways to resize sprites. One way to change the size of a sprite is to enter 
values for height and width by using the Arrange tool palette. 

 To resize a sprite 

1 Click the topmost daisy. 

Look in the status bar at the numbers for width (W) and height (H). You see that the daisy is 148 
pixels wide by 134 pixels high. 

2 On the toolbox, click Arrange . 

3 In the Width box in the center of the tool palette, select the current value and type 123.  

If the Keep aspect ratio checkbox is selected, as it is by default, you see that the Height has 
automatically been changed to 111. 

If the Keep aspect ration checkbox is clear, in the Height box on the left side of the tool palette, 
select the current value and type 111. 

4 Click Apply. 
 



Tip   You can also resize a sprite by clicking and dragging the resize handle at the corner of the 
bounding box. The status bar tells you the size of the selected sprite as you drag the handle. 

The Arrange palette is partially blocking your view of the workspace. You can hide a tool palette so 
that it can be displayed for subsequent use. Throughout the tutorial, if you find that a tool palette 
blocks your view of the composition, hide it and then display it.  

 To hide and display a tool palette 

1 Click F2 to hide the palette. 

2 Click F2 to display the palette after it has been hidden. 
 

You now have two larger daisy sprites and one smaller daisy sprite. In addition to resizing a sprite by 
pixels, you can change the size of a sprite by a specific percentage. 

The next topic in this tutorial is Resizing Sprites by a Specific Percentage. To take a break, save your 
composition now. 

 

Resizing Sprites by a Specific Percentage 
 

Image Composer provides alternative ways to accomplish many tasks. For example, in addition to 
resizing a sprite by pixels, you also can use the Arrange tool palette to resize a sprite by a specific 
percentage. The following figure shows the daisy sprites after being resized. 

Daisy sprites after resizing 

 

 To resize sample sprites by a specific percentage 

1 Click one of the larger daisies. 

2 On the toolbox, click Arrange . 

3 In the Units box, click Percent. 

4 In the Width box, enter 57. 

The Keep aspect ratio box is checked by default so that you have to enter only width or height 
and the corresponding value is computed automatically. 

5 Click Apply.  

When you clicked Apply, the Units box returned to Pixels display, showing that the resized sprite 
is now 84 pixels wide and 76 pixels high.  

6 Resize one of the hibiscus sprites to 58% of its original size, and resize another hibiscus to 76% of 
original size. 

7 Resize one tulip to 84% of the original size, and resize another tulip to 67% of the original size. 
 

You might want to experiment with making sprites other sizes, larger and smaller. After each 
experiment, you can click Undo Resize on the Edit menu to return the sprite to its original size. 

Now you have three different sizes of sprites for each type of flower sprite. When you click a sprite, 
the status bar displays the sprite's width and height in pixels.The following figures show the hibiscus 
and tulips sprites after resizing. 

Hibiscus sprites after resizing 

 

Tulip sprites after resizing 

 

You now have one of each type of flower sprite in small, medium, and large sizes. Now you can 
modify the colors of the sample sprites to add variety to the composition. 



The next topic in is Adjusting Color Intensity. To take a break, save your composition now. 

 

Adjusting Color Intensity 
 

You can adjust the color of a sprite by using the Color Controls tools on the Color Tuning tool 
palette. You adjust color intensity by setting the saturation level, as shown in the following figure. 

 

 To adjust the intensity of the sample sprites 

1 Click the largest tulip. 

2 On the toolbox, click Color Tuning {ColorTuning_button.bmp}. 

3 On the Color Tuning tool palette, click Color Controls, if this tab is not  already displayed. 

4 In the Saturation box in the lower right of the pane, select the current value and type 30. 

Note   You also can adjust the saturation by adjusting the slider. 

5 Click Apply. 

Notice that the tulip sprite now is a more intense red and the bounding box handles now have 
color-striped boxes, indicating that you can now use Color Tuning tools. 

6 Adjust the color of the largest hibiscus sprite to a saturation of 100 and the largest daisy sprite to a 
saturation of 50. 

 

The following figures show the large hibiscus and daisy sprites after adjusting saturation. 

Large hibiscus sprite after Saturation adjustment 

 

Large daisy sprite after Saturation adjustment 

 

Now you can change the colors of the medium-size flower sprites by adjusting their hues. 

The next topic in this tutorial is Adjusting Hue. To take a break, save your composition now. 

 

Adjusting Hue 
 

In Image Composer, you can change the color of a sprite by adjusting its hue, as shown in the 
following figure. 

 

 To adjust the hue of the sample sprites 

1 Click the medium-size tulip sprite. 

2 On the toolbox, click Color Tuning {ColorTuning_button.bmp}. 

3 On the Color Tuning palette, click Color Controls, if this tab is not already displayed. 

4 In the Hue box, select the current value and type -100. 

5 Increase the intensity of the tulip sprite by setting the saturation to 30. 

6 Click Apply. 

Notice that you can make more than one color adjustment with a single apply action. The tulip 
sprite is now bluish-purple, as shown in the preceding figure. 

7 For the medium-size hibiscus sprite, set the hue to -100 and the saturation to 30, and click Apply. 

8 For the medium-size daisy sprite, set the hue to -60 and the saturation to 10, and click Apply. 



 

The following figures show the results of your modifications. 

Medium-size hibiscus sprite after hue and saturation adjustment 

 

Medium-size daisy sprite after hue and saturation adjustment 

 

Drag the tulips off the composition space into the workspace area. Don’t worry if the they seem to 
overlap one another. 

You can adjust the colors of the remaining flowers by setting and applying the current color on the 
Color Swatch. 

The next topic in this tutorial is Defining the Current Color. To take a break, save your composition 
now. 

 

Defining the Current Color 
 

The Color Swatch on the toolbox displays the current color, which is the color used for all new 
sprites and for many effects. 

 To define the current color 

1 On the bottom of the toolbox, click the Color Swatch . 

2 In the Color Picker dialog box, click the True Color tab, if not already displayed. 

3 In Color Space, select RGB if it is not already selected. 

4 In the edit boxes for Red, Green, and Blue, type the following values: Red = 232, Green = 10, and 
Blue = 158. 

Note   You can also move the pointer in the Color Matrix to a color that looks good to you. Notice 
that the circular pointer inside the matrix has moved to location of the color corresponding to the 
values you entered. 

5 Click OK. 
 

Notice that the Color Swatch below the toolbox now is the color you specified in the Color Picker. 
This indicates that light purple is the current color. Now you're ready to alter the colors of the flower 
sprites in a variety of ways using Image Composer. 

The next topic in this tutorial is Enhancing Colors.To take a break, save your composition now. 

 

Enhancing Colors 
 

You can change the colors of sprites by using the Color Enhancement tools on the Effects tool 
palette. These tools apply the current color to the selected sprite, shown in the following figure. 

 

 To colorize the sample sprites 

1 Click the smallest daisy sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Color Enhancement. 

4 In the Effects list box, click Dye. 

5 Click the Details tab. 

6 In the opacity box, select the current value and type 60. 



7 Click Apply. The figure above shows the result. 
 

Repeat this procedure to make the smallest hibiscus a rich red after setting the current color as 
follows: Red = 255, Green = 10, Blue = 14. 
 

The smallest hibiscus sprite after applying the Dye effect 

 

Before you enhance the smallest tulip sprite, set the current color to a bright yellow. This time, 
right-click the Color Swatch to display the Quick Color Picker. Click a yellow in the quick color 
palette. 

 To tint the sample sprites 

1 Click the smallest tulip sprite. 

2 On the toolbox, click Effects , if the Effects palette is not already displayed.  

3 In the Category list, click Color Enhancement, if not already displayed. 

4 In the Effects list, click Tint. 

5 Click the Details tab. 

6 In the opacity box, select the current value and type 50. 

7 Click Apply. The following figure shows the result. 
 

The smallest tulip sprite after applying the Tint effect 

 

Experiment with different colors and different opacities to see the wide variety of colors you can add 
to a sprite. 

Now you have a bunch of flowers of different sizes and colors, but they all still look like photographs. 
You can use the effects provided by Image Composer to change this look. Before continuing, 
however, move the sprites away from the center of the  composition space. Click F2 to hide the 
Effects palette. 

The next topic is Using Art Effects. To take a break, save your composition now. 

 

Using Artistic Effects 
 

The flower sprites that you have created and modified are all versions of the original photograph of 
each flower. Image Composer’s Effects can change all this with the click of a mouse button, as 
shown in the following figure. 

 

You might want to consider showing some of the flower sprites in a different, more creative and 
artistic way. This portion of the tutorial illustrates how to apply three different effects using the Effects 
tool palette. 

Note   If you are attempting to create a logo in the shortest possible time, you might want to skip this 
section of the tutorial and go on to the next topic, Creating a New Sprite. 
 

 To add Accents to the sample sprites 

1 Click the largest tulip sprite. 

2 On the toolbox, click Effects . 

3 On the Effects tool palette, in the Category list, click Paint. 

4 In the Effects list box, click Accents. 

5 Click Apply. 



Notice how the tulip sprite now looks like an artist’s rendering rather than a photograph. If the 
Effects palette is blocking the large tulip sprite, click F2 to hide the palette. 

6 Repeat this procedure for the large hibiscus sprite and the large daisy sprite. Click F2 to display 
the Effects palette if it was hidden. 

 

The large hibiscus sprite with Accents 

 

The large daisy sprite with Accents 

 

Now you can apply additional artistic effects to the other flower sprites. You can create a temporary 
set of selected sprites, called a selection set, and apply the same effect to each of the sprites in one 
action. Before moving to the next procedure, click on a blank area in the  composition space to clear 
the selection. 

 To apply Crosshatch to a set of sprites 

1 Press and hold SHIFT and click each of the medium-size flower sprites. This creates a selection set 
of sprites. 

2 On the Effects tool palette, in the Category list, click Sketch. 

3 In the Effects list, click Crosshatch. 

4 Click Apply. 

5 On the Edit menu, click Clear Selection to prepare to apply the next set of effects. 

– or – 

Click a blank area in the workspace. 
 

The following figures show the effects of Crosshatch on each of the medium-size flower sprites. 

 

 

 

 To apply Fine Marker effects to a set of sprites 

1 Press and hold SHIFT and click each of the small flowers. This creates a selection set of sprites. 

2 On the Effects tool palette, in the Category list, click Sketch. 

3 In the Effects box, click Fine Marker. 

4 Click Apply. 
 

The following figures show the sprites before and after applying the effects. 

 

 

 

Experiment by applying different artistic Effects to each of the sprites until you are satisfied with the 
results. You will find a remarkable variety of effects to apply. Remember that you can undo an effect 
by clicking Undo on the Edit menu. 

You now have created an interesting group of flower sprites. At this point, you need to create an 
organizing element for your logo. 

The next topic is Part 2:  Creating the Logo Background and Name. To take a break, save your 
composition now. 

 



Part 2: Creating the Logo Background and Name 
 

In this portion of the tutorial, you will create new sprites in Microsoft Image Composer. The topics in 
this part of the tutorial take you through the basics of creating a geometric shape, transferring a 
pattern to that shape, and then rotating and arranging that shape. 

The next topic is Creating a New Sprite. 

 

Creating a New Sprite 
 

Image Composer offers many ways to create sprites. For this topic, you need a solid shape as an 
organizing element. Later, you can texture it with a pattern from another sprite. 

To begin this phase of the tutorial, move all the flowers off the  composition space. 

 To create an oval 

1 On the toolbox, click Shapes . 

2 On the Shapes tool palette, click Oval. 

3 In the Opacity for new shape box, select the current value and type 100 if it is not the current 
value. 

4 In the  composition space, click and drag to create an oval of roughly 400 pixels wide by 250 
pixels high. Check the size of the oval as you create it by watching the numbers in the right side of 
the status bar. 

5 Click Create. 

The oval you created is yellow, which is the current color, as shown in the Color Swatch. 
 

The next step is to add a texture to provide depth and visual interest to the background. 

The next topic is Transferring Patterns from One Sprite to Another. To take a break, save your 
composition now. 

 

Transferring Patterns from One Sprite to Another 
 

One of Image Composer’s most powerful features is the ability to transfer patterns from one sprite to 
another. The Texture Transfer tools can be used to transfer pixel values from one sprite to another. 
Pattern operations require a dominant sprite as a source to supply the values and a destination sprite 
to accept the values. The following figure illustrates how your oval will look after transferring a pattern 
from a sprite supplied by Image Composer. 

 

Before continuing, make sure that all flower sprites are off the composition space. You will use a 
sprite of clouds to add texture the oval sprite, but first you must insert the image, CLOUDS.TIF. For 
information on inserting a sprite, see Inserting Images. 

When you insert the clouds, you see they are purple and small. Before moving to the next step, 
enlarge the cloud sprite. 

 To enlarge and position the clouds sprite 

1  Move the cloud sprite to the upper left corner of the  composition space. 

2 Drag the lower right corner of the cloud sprite's bounding box, extending it to cover the oval 
completely and extend to the edges of the composition space. 

3 On the Arrange menu, click Send to Back. 
 



Now you can texture the oval, which is the destination sprite, with pixels from the cloud sprite, which 
is the source sprite. In order to perform this operation, the two sprites must overlap one another. 
Check to be sure that no part of the oval sprite is visible at the edges of the cloud sprite. Move the 
cloud sprite if necessary.  

When you transfer textures, the source sprite must be selected before the destination sprite. If the 
source sprite obscures the destination sprite, cycle through the sprites by pressing TAB until you see 
the bounding box of the destination sprite. 

 To transfer texture from the cloud sprite to the oval sprite 

1 Click the cloud sprite. 

2 Press the CTRL key and click the oval.  

The cloud sprite's bounding box has solid black handles, indicating that it is the dominant, or 
source, sprite. 

3 On the tool box, click Texture Transfer {TextureTransfer_button.bmp}. 

4 In the Texture Transfer list, click Transfer Full. 

5 Click Apply.  

The oval sprite seems to disappear. This is because the texture and color of the cloud sprite has 
been transferred to the oval. Even though you cannot see the oval, it is there.  

6 On the Edit menu, click Clear Selection. 

7 Click the center of the  composition space and move the selected sprite, the oval, off the  
composition space.  

Now the oval is textured with purple clouds. Delete the cloud sprite by selecting it and pressing 
DELETE. Move the oval back to the  composition space. Move the flower sprites just below and to the 
sides of the oval to begin the next step. Adjust the position of the  composition space by using the 
vertical scroll bar. 

The next topic is Flipping Sprites. If you want to take a break, save your composition now. 

 

Flipping Sprites 
 

Flipping sprites can provide more creative control over the balance of a composition. For example, if 
you have scanned in a picture of a person facing left and you want the person to face right, you can 
flip the sprite to achieve this. 

You can flip sprites horizontally, vertically, or both directions at once. 

 To flip the medium-size hibiscus sprite 

1 Click the medium-size hibiscus. 

2 On the Arrange menu, click Flip Horizontal. 
 

The selected hibiscus in now facing the opposite direction, as shown in the following figure. 

 

Experiment with flipping the daisies and the tulips. 

The next topic is Rotating Sprites. If you want to take a break, save your composition now. 

 

Rotating Sprites 
 

Now, all the sprites are facing straight up and down. To accentuate the shape of the background 
sprite, you can rotate several of the sprites. 



Rotated tulip sprites 

 

 To rotate a tulip sprite interactively 

1 Click the largest tulip sprite. 

2 Move the pointer to the rotation handle in the upper right corner of the bounding box.  

The pointer changes from an arrow to an arrow with a circle. 

3 Drag the rotation handle until the status bar reads 29 Deg (29 Deg from the base angle), then 
release the mouse button. 

 

In addition to rotating sprites interactively, you can also rotate a sprite by a specified angle. 

 To rotate the medium-size tulip sprite by a specified angle 

1 Click the medium-size tulip sprite. 

2 On the toolbox, click Arrange . 

3 In the Rotation box, select the current value and type -30. 

4 Click Apply. 

5 Click the smallest tulip sprite and repeat the procedure, typing -55 in the Rotation box. 
 

The next topic is Arranging Sprites. To take a break, save your composition now. 

 

Arranging Sprites 
 

An important concept for arranging sprites is the stack. The stack is the order in which you created or 
added the sprites. The stack order is independent of the positions that sprites occupy. A sprite might 
be next to another sprite on the composition guide, but not next to that sprite on the stack. 

You can reorder the positions of sprites in the stack by using tools on the Arrange tool palette. You 
can arrange sprites independently or according to their relative positions in a composition. 

 To move the purple tulip in front of the oval sprite, relative to stack order 

1 Click the purple tulip sprite and move it to the top of the oval sprite, just to the left of center.  

Notice that the tulip sprite is behind the oval sprite. 

2 On the toolbox, click Arrange . 

3 On the Arrange tool palette, in the Order section, click the lower left white square to reorder the 
sprite ahead of the cloud sprite. 

The tulip sprite is now in front of the cloud sprite. 
 

You can follow a similar procedure to arrange the rest of the flower sprites. Move the oval sprite to the 
back of the stack by selecting it using the Send to Back command on the Arrange menu. 

The current state of the logo 

 

In order to arrange the flower sprites to resemble the finished logo design, you will need to alter the 
positions of several of the flower sprites. Arrange the flower sprites by moving them until the 
arrangement resembles the final version of the logo, or choose your own arrangement. When you 
have an arrangement that satisfies you, you can add the finishing touch to the logo: the business 
name. 

The next topic is Creating Text Sprites. If you want to take a break, save your composition now. 

 



Creating Text Sprites 
 

Text sprites are like any other sprites in most respects. You can move them, color them, texture them, 
and apply any effects, tools, and filters. After you have created a text sprite, you can edit the text by 
double-clicking it. 

The following figure shows flattened text sprites against the rest of the composition. 

 

 To select a font for the text sprite 

1 On the toolbox, click Text . 

2 On the Text tool palette, in the Font list, click Times New Roman. 

3 In the Style list, click Bold Italic. 

4 In the Size list, click 36.  

5 To make the logo text stand out against the brightly colored background, click the Color chip, and 
in the Color Picker, change the text color to off-white by setting the values for Red, Green, and 
Blue to 245. 

Now that you have selected a font and color, you can enter the text. 

 To create the logo text sprites 

1 Move the text cursor to an empty portion of the workspace, and click to display the text entry box. 

2 In the Text entry box, type La Fleur.  

You see that the text you want to create is longer than the text entry box can accommodate. You 
need to enlarge the text entry box. 

TIP  If you have trouble seeing the text against the white background of the text entry box, select 
the text. It will then stand out against the dark background of the selection. Be careful to deselect 
the selected text before you add or delete any characters or the entire selected text will be deleted. 

3 Click the right-side resize handle and drag it to increase the size of the entry box by enough to add 
one more letter. 

4 Type r. 

5 Click outside the text entry box anywhere in the workspace to create the sprite. 

The first text sprite is now finished. Notice that the bounding box of  the sprite is automatically 
sized to fit the sprite with no unncessary space. 

6 On the toolbox, click Text . 

7 In the Size box, change the font size to 48. 

8 Click in the workspace, and in the text entry box, type d’Internet, enlarging the text entry box to 
accommodate the letters. 

9 Click outside the entry box to create the new text sprite. 
 

The second text sprite is now the current sprite. Move it to the center of the oval shape that contains 
the flower sprites. Then select the first text sprite and move it above the second text sprite. Arrange 
them in a way that pleases you.  

You can group sprites to apply effects to more than one sprite at a time. In addition, grouping sprites 
makes their relative positions permanent. You can ungroup the sprites later if you choose as long as 
you have not applied effects. When you are satisfied with the grouping, you can flatten the group, so 
that it becomes a single sprite. When a group has been flattened, you can continue to modify the 
flattened sprite as if it were any other sprite, but you cannot reverse the Flatten command after you 
have applied effects to the flattened sprite. 

 To group the text sprites 

1 Click the first text sprite. 

2 Press and hold SHIFT and click the second text sprite. 



3 On the Arrange menu, click Group. 

Be sure you are satisfied with the grouping before proceeding. 

4 On the Arrange menu, click Flatten Selection. 
 

To add crispness to the text, you can add a light outline. 

The next topic is Adding Outlines to Sprites. If you want to take a break, save your composition now. 

 

Adding Outlines to Sprites 
 

An outline makes a sprite more distinct against a background. 

 To add an outline to the text sprite 

1 Click the text sprite. 

2 In the toolbox, click Effects . 

3 In the Category list, click Outlines. 

4 In the Effects list, click Edge. 

5 Click the Details tab. 

6 In Edge Effect, click the color chip. 

7 On the Color Picker, in the True Color tab, move the pointer to a deep bluish purple (Red = 29, 
Green = 1, and Blue = 87), and click OK. 

8 Adjust Opacity slider to 100 if is not already at that setting. 

9  Click Apply. 
 

To help the text stand out against the brightly colored background, add a drop shadow. 

The next topic is Adding Drop Shadows to Sprites. To take a break, save your composition now. 

 

Adding Drop Shadows to Sprites 
 

A shadow on a sprite adds depth to a composition. If not already selected, click the text sprite. 

The finished logo, including the drop shadows 

 

 To add a drop shadow to the text sprite 

1 In the toolbox, click Effects . 

2 In the Category list, click Outlines. 

3 In the Effects list box, click Drop Shadow. 

4 Click the Details tab. 

5 On the light source control, click Southeast. 

6 Click the Color chip. 

7 On the Color Picker, click the Eyedropper and move the eyedropper pointer to a purple flower 
and click, then click OK. 

This sets the color for the drop shadow, in this case a color from one of the flowers. 

8 Move the Softness slider all the way to the left. 

9 On the Effects tool palette, click Apply. 
 

The logo is now complete. 

Step back from your monitor and look at the logo with a critical eye. Now is the time to make any 



changes you feel are appropriate. Because this logo will be seen on Web sites, you might want to see 
how it will look when viewed in 8-bit color. 

The next topic is Part 3:  Preparing Your Logo for the Web. If you want to take a break, save your 
composition now. 

 

Part 3: Preparing Your Logo for the Web 
 

In this section of the tutorial, you will work with a custom color palette. Part 3 takes you through the 
basics of creating a custom color palette for your logo, viewing the logo in the custom color palette, 
and saving the logo in a web-ready file format.  

The next topic is Creating a Custom Color Palette. 

 

Creating a Custom Color Palette 
 

You composed your finished logo in True Color, but it can be displayed in any of a wide variety of 
color palettes. Image Composer allows you to view your logo as it will look when displayed on a Web 
page. For best results, the logo should be saved to an 8-bit GIF file. 

To view a composition in 8-bit color, you must create a custom palette. 

 To create a custom color palette for the logo 

1 On the toolbox, click the Color Swatch . 

2 Click the Custom Palette tab. 

3 Click New.  

The New Color Palette dialog box appears. 

4 In the Palette name box, type Fleur8bt as a name for your palette. 

5 In the Palette Size box, click 236. 

6 In the Dither by box, click Error Diffusion if not already selected, and click OK. 

7 Click Generate Colors. 

The Generate Colors dialog box appears. 

8 In the Number of colors box, click 236. 

9  In the Generate from box, click Balanced Ramp and click Add.  

A message box informs you that the Balanced Ramp might not always produce exactly the 
number of colors you expect. Click OK. 

10  In the Generate from drop-down box, click System Colors and click Add.  

This action added the system colors to include the 20 colors that Windows 95 works with. 

11  Click Close. 

12  On the Custom Palette tab, click OK. 
 

Now that you have created an 8-bit palette, you can view your composition in the colors it will display 
on the Web. Your 8-bit palette has 256 colors, including the 236 colors you generated from your 
composition plus the 20 system colors. 

The next topic is Viewing a Composition in a Custom Palette. To take a break, save your composition 
now. 

 

Viewing a Composition in a Custom Palette 
 



Now that you have created a custom palette, it is time to view the composition using that custom 
palette. 

 To view the logo in a custom palette 

1 On the Window menu, click New Window. 

2 In the Color Format drop-down box on the toolbar, click Fleur8bt. 

You now have two views of your logo, original True Color and 8-bit. 

3 On the Window menu, click Tile. 
 

Adjust the views by using the scroll bars. Move one of the flowers in the top window. Notice that when 
you move an sprite in one window, it also moves in the other window. Click the title bar in each 
workspace window to select a view. Notice that the Color Format box in the toolbar changes as you 
click each window. 

You can make any adjustments you need to ensure that your logo appears on the Web exactly as you 
want it to appear. 

When you are satisfied with the logo, save it. 

The next topic is Saving a Composition. To take a break, save your composition now. 

 

Saving a Composition 
 

Saving an Image Composer composition is the same as saving any file in Microsoft Windows 95 and 
Windows NT.  

When you save a composition, depending on the file type you save to, you might be saving the 
composition space as well as the sprites. For example, saving a file to the .mic file type, you save the 
composition space, saving a file to the .gif or .jpg file types, you do not save the composition space. In 
the first part of this section, you will save the composition space. For more information, see Saving 
Files in Different Formats. 

The logo itself is approximatley 420 pixels wide by 275 pixels high, depending on your arrangement. 
You can see that the composition space is not exactly the same size as the logo. To be sure that the 
final composition includes all the design elements, you can change the size of the composition guide. 
First, adjust the size of the composition space in the True Color window. Click the title bar on this 
window and make this window full size. 

 To change the size of the composition space 

1 On the View menu, click Composition Guides. 

2 Click the dashed line on the left of the composition space and drag it until it just beyond the left 
side of the logo's left sprites.  

3 Click the dashed line on the right of the composition space, and move it just beyond the right side 
of the logo's right sprites. 

4 Click the dashed line on the top of composition space and drag it until it is just above the top of the 
logo's top sprites.  

5 Click the dashed line on the bottom of the composition space and drag it just below the bottom of 
the logo's bottom sprites. 

 

You can now proceed to save the logo. First, save the True Color version of the logo. 

 To save the logo as an Image Composer composition 

1 On the Window menu, click Untitled:1. If you have previously saved your work on the tutorial, the 
title bar might display the file name under which you saved your work. 

2 On the File menu, click Save As. 

3 In the Save As dialog box, choose the drive and folder into which you want to save your work. 



4 In the Save as type drop-down box, click Image Composer Composer (*.mic), if not already 
selected. 

5 In the File name box, enter a unique name for the composition, such as fleurlog.mic. 

6 Click Save. 
 

You have saved the True Color version of your logo; now you can save the custom palette version.  

 To save the logo with the custom color palette 

1 On the File menu, click Save As. 

2 In the Save As dialog box, choose the drive and folder into which you want to save your work. 

3 In the Save as type box, click Compuserve GIF (*.gif). 

4 In the Color format box, click fleur8bt. 

5 In the File name box, enter a unique name for the composition, such as flurlog8.gif. 

6 Click Save.   

This format flattens the composition so that the sprites can no longer be manipulated as separate 
objects. Click OK in the hint box.  

 

Congratulations! You now have saved two versions of your logo. The first is an Image Composer 
composition in 24-bit color. You can use this version as a starting point for sending your composition 
to many different types of output. The second, 8-bit, version is suitable for posting to a Web site. 

 

Editing Adobe Photoshop files in Microsoft Image Composer 
 

You can open and edit your Adobe Photoshop files in Microsoft Image Composer. If you created your 
file using version 3.0 or later, each of the image objects becomes a sprite when you open the file in 
Image Composer. For files created in earlier versions, the image objects are combined into one sprite 
in your Image Composer composition. If you want to make separate sprites from the single sprite, you 
can extract portions. Also, if the paths in your Photoshop image do not appear in Image Composer; 
you can create sprites that have the same image as your paths by using the Curve tool. 

The size you set for the original composition in Photoshop determines the size of the composition 
space in Image Composer. If your Photoshop file has a background image, that image becomes a 
sprite in the Image Composer composition, covering the Image Composer composition space. The 
layers of the composition are blended much like the Normal layer function used in Photoshop. 

 To open an Adobe Photoshop file 

1 On the File menu, click Open. 

2 In the Files of type box, click Adobe Photoshop (*.psd). 

3 Locate the file you want to open and click Open. 

4 Edit the file using any Image Composer tools and effects. 
 

Notes 

• If your .psd file does not open, you need to save it as RGB in Photoshop before opening it in 
Image Composer. 

• Image Composer will not read Photoshop files with Adjustment Layers.  
 
 

Saving your composition in Adobe Photoshop file format 
 

You can save your Microsoft Image Composer composition as an Adobe Photoshop version 3.0 .psd 
file. Each sprite becomes an image object. 

 To save your composition as a .psd file 



1 On the File menu, click Save As. 

2 In the Save as type box, click Adobe Photoshop 3.0 (*.psd). Click Save. 

3 If you want to include the composition space as the background object in your file, select the Save 
the composition space as the background layer check box in the Photoshop (.PSD) File Save 
Options dialog box. 

Note   If you select this check box, and then open the file in Photoshop, the file has a background 
layer that is the size and color of the composition space. If you clear this check box, the file does 
not include the composition space as a background layer. 

 

4 If you want to include all of the sprites regardless of their position relative to the composition space, 
select the Save the sprites outside of the composition space check box. 

Note   If you select this check box, then open the file in Photoshop, the file has a background 
layer that is the size and color of the composition space. If you clear this check box, only the 
sprites and portions of sprites that are within the area of the composition space are saved in the 
file. 

 

5 Click OK. 
 
 

Impressionist plug-in overview 
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Impressionist is a plug-in program that lets you change the look of sprites by applying artistic filters 
and effects to them. The artistic styles available in Impressionist are similar to those found on the 
Effects palette, but with more options and control over the results. You can access Impressionist 
from the Plug-Ins menu in Microsoft Image Composer. 

Impressionist offers: 

• Seventeen artistic style groups, including Chalk, Charcoal, Crayon, Paint, Pencil, Pointillist, and 
Watercolor. Each style group contains several effect variations to choose from. 

• Control over the application of styles, by letting you determine factors such as brush size, paper 
texture, color choice, and orientation. 

• Extensive preview and demonstration capabilities, so you can see exactly how a particular effect 
will alter your selection. 

• A detailed Help file that describes each style and option in the Impressionist plug-in.  
 

Note   If the menu command for Impressionist (or any other plug-in) is unavailable, make sure that 
a sprite is selected. If you still can’t access the command, Impressionist may not be installed. To 
install Impressionist, run the Image Composer Setup program, click Add/Remove, and select the 
Impressionist Plug-Ins check box. 

 

Installing additional plug-ins 
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Microsoft Image Composer supports the Photoshop plug-in filter interface. This means that you can 
install and use many 32-bit plug-in filters from popular third-party programs and vendors. 

 To install additional plug-ins 



1 On the Tools menu, click Options, and then click the Plug-Ins tab. 

2 In the Additional Plug-In Directory box, type the path to the folder where you keep your plug-in 
software, or click Browse to find the folder. 

3 Click OK. 

The Plug-Ins menu now contains commands for the plug-ins you added. 

– or – 

You can manually add plug-in program files to the \Microsoft Image Composer\PlugIns folder. If 
Image Composer is open, you must restart it before you can use the plug-in. 

 

Notes 

• The plug-in menu command is available only when you have a sprite selected. 

• Although Image Composer supports Photoshop-compatible filter plug-ins, it does not support 
import or export plug-ins. For more information about filter plug-ins, see the Image Composer 
readme file. 

 
 

Printing compositions 
 

In addition to the printer controls found in most Print dialog boxes, the Print dialog box in Microsoft 
Image Composer contains the following composition-specific controls: 

• Composition   Click to print the portion of your composition that is contained within the 
composition space. 

• Current View   Click to print only the portion of your composition that is contained within the 
active workspace view window. 

• Best Fit   Click to retain the current aspect ratio of the composition at the largest size possible on 
the printed page. 

• Stretch to Page   Click to change the aspect ratio of the composition so that the printed image 
fills the entire printed page. 

• Scale   Click to choose a percentage by which to scale the composition. The X% and Y% controls 
are independent, so by entering different values in each, you can change the aspect ratio of a 
composition. 

 

When you print a composition, the resolution of the printed image is based on the common monitor 
resolution of 96 dpi (dots per inch). This means that when you print a composition scaled at 100%, 
the printed image looks the same size as the image on the monitor regardless of the dpi setting of the 
printer. 

 To print a composition 

1 On the File menu, click Print. 

2 In the Print dialog box, click a printer in the Name box. 

3 In the Print Selection group, click Composition or Current View. 

4 In the Print Options group, click Best Fit, Stretch to Page, or Scale.  

If you click Scale, enter a percentage for both X% and Y%.  Percentages must be values between 
1 and 99999. For large values, the image is cropped to the area that can be printed on a page. You 
can enter different values for X% and Y% to produce a printed image that is stretched or 
squeezed.  

5 In the Copies box, click the number of copies you want. 

6 Click OK. 
 
 

What’s New in Image Composer 1.5 
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Image Composer 1.5 incorporates a wealth of new features and functions to make creating exciting 
art for Web sites even easier than in previous versions.  

For creating images: 

• Button Wizard and Editor. The Button Wizard makes it easy to create from 1 to 20 buttons in one 
wizard session. This wizard is available on the Insert menu. The Button Editor is found on the Edit 
menu and is for making changes to buttons created by the Button Wizard. For more information, 
see help for the Button Wizard. 

• Editable text sprites. You can make changes to the text or formatting of text sprites after you have 
created them by double-clicking them in the workspace. The new text tools allow for easier 
formatting of lists and justified text. For more information, see Text Sprite Overview. 

• Cutout tools. The new tools on the Cutout palette make creating cutouts for making masks and for 
creating new sprites from portions of existing sprites easier than ever before. For more information, 
see Cutout Overview. 

 

For modifying images: 

• Object smoothing. You can now decide whether or not to use anti-aliasing to eliminate jaggies in 
sprites by using the Object Smoothing command on the Edit menu. For more information on 
smoothing text sprites, see Text sprite overview. 

• Select button. A new select button on the toolbox lets you select one or more sprites when you are 
working on any tool palette or dialog box. 

• Continuous crop. The crop tool on the Arrange palette is now continuously active so that you can 
make step-by-step cropping changes to a sprite. 

• Variable drop shadows. Create shadows with a soft, diffused edge, or a hard, well-defined edge by 
using the Details tab for the Drop Shadow effect, found on the Effects palette. For more 
information, see Drop Shadow. 

 

For saving images: 

• Save for the Web Wizard. This wizard makes it easy to save compositions or sprites for use on 
Web sites. It helps you choose file types and gives guidance on issues of transparency. This 
wizard is found on the File menu. 

• More supported file formats. You now can save or open files in .png, .mix, and .fpx formats. For 
more information, see Saving files in different formats. 

 

Changes to the Image Composer interface: 

• New workspace and composition space design. The composition space, known as the composition 
guide in earlier versions, is now easily resizable. Just drag the dashed lines (called composition 
guides). For more information, see The composition space. 

• Redesigned tool palettes. All effects are now on one palette, Effects. Textures are on the Texture 
Transfer palette. The Arrange palette has been redesigned for ease of use. The new Cutout 
palette places all cutout tools in one place. The Patterns and Fills, Warps and Filters, and Art 
Effects palettes are combined on the Effects palette. 

• Gif animator is now available on the Tools menu. For more information, see Gif Animator Overview 

• Introduction to Image Composer. If you are new to Image Composer, this introduction provides an 
overview of the product and what it can do for you. To begin the introduction, see Introduction to 
Microsoft Image Composer. 



• A Color Fill tool now appears on the toolbar.  

• New names for effects and commands. For more information, see Changed Names. 

 

 

Changed Names 
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The names of several commands, effects, and textures have changed from Version 1.0a to Version 
1.5.  

The following table shows the old and new names of the effects that were on the Art Effects palette in 
Version 1.0a and are now on the Effects tool palette. Other effects on the Art Effects palette retain 
their names for Version 1.5 and are located on the Effects palette. 

 

Old Name New Name New Group 

Note Paper Flocking Arts and Crafts 

Patchwork Mosaic Arts and Crafts 

Poster edges Poster Arts and Crafts 

Reticulation Sandpaper Arts and Crafts 

Photocopy Stone Print  Arts and Crafts 

Square Gradient Gradient (Square) Gradient 

Accented Edges Accents Paint 

Water Paper Wet Paper Paint 

Make Transparent Transparent Photographic 

Ink Outlines Fine Marker Sketch 

Graphic Pen Technical Pen Sketch 

Glowing Edges Glowing Accents Surface 

Mosaic Broken Surface 

Texturizer Rough Texture Surface 

Craquelure Cracked Varnish  Surface 

 

The following table contains the old and new names of effects that were found on the Warps and 
Filters palette in Version 1.0a and are now on the Effects palettes. Other effects on the warps and 
Filters palette in Version 1.0a have retained their names for Version 1.5 and also are located on the 
Effects palette. 

Old Name New Name New Group 

Color Over Color Bounding 
Box 

Color 
Enhancement 

Colorize Dye Color 
Enhancement 

Luminance Grayscale Color 
Enhancement 



Wash Transparent Color 
Enhancement 

Escher Fisheye Distort 

Vortex Vortex Distort 

Shadow Drop Shadow Outlines 

Complement Color Negative Photographic 

 

The following table shows the old and new names of commands that were on the Patterns and Fills 
palette in Version 1.0a and are on the Effects palette in Version 1.5. Other effects found on the 
Patterns and Fills palette in Version 1.0a have retained their names and are found on the Effects 
palette in version 1.5. 

   Old Name New Name New Group 

   All Gradients Square Gradient 

 

Textures, Effects, and commands no longer in product. 

 

   Name Palette in 1.0a Group in 1.0a 

   Color Atop Warps and Filters Color Enhancement 

   Emboss Art Effects Utility 

   Interactive Warp - Barrel Warps and Filters Warp Transforms 

   Interactive Warp - Bow Warps and Filters Warp Transforms 

   Interactive Warp - Schmudge Warps and Filters Warp Transforms 

   Interactive Warp - Stardisk Warps and Filters Warp Transforms 

 

The following warps have been moved to the Arrange palette. In Version 1.0a these were on the 
Warps and Filters palette. 

• Skew 

• Perspective 

• Bilinear 

 

 

Arranging sprites overview 
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Arrange palette 

 

 

You can use the tools on the Arrange palette to perform a variety of actions on a selected sprite, a 
set of selected sprites, or a group of sprites. 

Action you can perform One 
sprite 

Many 
sprites 

A 
group 

 

Align sprites with each other. No Yes No 

Align sprites with the composition space. Yes Yes Yes 



Crop a sprite. Yes No No 

Extend the bounding box that surrounds a 
sprite. This action is particularly useful when 
you need to select two sprites for a texture 
transfer, and their bounding boxes are the 
exact same size. 

Yes No No 

Flatten sprites. No Yes Yes 

Flip a sprite. Yes Yes No 

Group a set of sprites. No Yes No 

Reorder a sprite’s position in the stack. Yes Yes Yes 

Resize a sprite. Yes No No 

Rotate a sprite. Yes No No 

Set or lock the position of the sprite in the 
composition. 

Yes Yes Yes 

Warp a sprite to change its perspective, its 
slant, or both. 

Yes No No 

Ungroup or explode a group of sprites. No No Yes 
 

For information about selecting a single sprite or many sprites, see Selecting sprites, tools, and 
colors. 

 

Flipping a sprite 
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Flip tools 

 

 

Flip a sprite when you want to change its orientation. For example, you can flip a sprite of a face so 
that it faces left instead of right.  

Click the picture above to see an example of flipping a sprite. 

 To flip a sprite 

1 Select the sprite you want to flip. 

2 On the toolbox, click Arrange . 

3 On the Arrange palette, click one of the flip buttons: 

• To flip the sprite horizontally, click Flip Horizontal . 

• To flip the sprite vertically, click Flip Vertical . 

• To flip the sprite in both directions, click Flip Both . 
 
 

Rotating a sprite 
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Rotate tools Preset Rotation tools 

  

 

Rotate a sprite when you want to turn it about on its center. You can rotate a sprite 90 degrees to the 
left or to the right, or rotate it 180 degrees, which is the same as flipping it horizontally and vertically. 
You can also rotate a sprite freely by specifying the degrees by which you want to turn it. 

Click the pictures above to see examples of rotating a sprite. 

 To rotate a sprite 

1 Select the sprite you want to rotate. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click one of the rotate buttons: 

• To rotate the sprite 90 degrees to the left, click Rotate Left 90 . 

• To rotate the sprite 90 degrees to the right, click Rotate Right 90 . 

• To rotate the sprite 180 degrees, click Rotate 180 . 

– or – 

In the Rotation box, type the number of degrees that you want to rotate the sprite by. This number 
must be between -360 and 360. For example, if you want to rotate the current sprite halfway 
between its current position and a Rotate Right 90 position, type 45. Then click Apply. 

 
 

Resizing a sprite 
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Resizing Tools 

 

 

Resize a sprite when you want to shrink or enlarge it. You can resize a sprite by dragging it to a new 
size, or by specifying new measurements for its width and height. 

When you resize a sprite, you can change it height and width independently, or you can maintain its 
aspect ratio so that resizing it in any direction preserves it proportions. 

Click the picture above to see an example of resizing a sprite. 

 To resize a sprite by hand 

1 Select the sprite you want to resize. 

2 Position the pointer over a resizing handle, and drag that handle to a new location. 
 

Tip   When you drag the resize handle, use SHIFT to maintain the sprite’s proportions, or use CTRL 
to resize the sprite around its center. 

 

 To resize a sprite numerically 

1 Select the sprite you want to resize. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, select the Keep aspect ratio check box if you want to maintain the sprite’s 
width with respect to its height as you resize it. 



4 In the Units box, click Percent if you want to resize the sprite by a specified percentage, or click 
Pixels if you want to specify the sprite’s width and height in pixels. 

5 In the Width and Height boxes, type the new size of the sprite: 

• If you chose Percent in the Units box, type the percentage that you want to increase or 
decrease the sprite by. This value must be between 0 and 999. For example, to double its size, 
type 200 in both boxes. 

• If you chose Pixels in the Units box, type the number of pixels for its width and height. This 
value must be between 1 and 4096. 

 

1 Click Apply. 
 
 

Cropping a sprite 
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Crop/Extend tool 

 

 

Crop a sprite when you want to keep a rectangular portion of the sprite and trim away the rest of it. 
Cropping is particularly useful when you import a picture, and you want to trim its background.  

You can crop a sprite as an alternative to creating a rectangular cutout. For more information, see 
Creating rectangular and oval cutouts from a sprite. 

Click the picture above to see an example of cropping a sprite. 

 To crop a sprite 

1 Select the sprite you want to crop. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Crop/Extend . 

4 Position the pointer over a cropping handle, and drag that handle to a new location. You can click 
and drag each cropping handle many times until the image is cropped the way you want. 

5 Click away from the sprite. 
 
 

Extending the bounding box of a sprite 
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Crop/Extend tool 

 

 

Extend the bounding box of a sprite when you want to increase the margin of transparent pixels 
around the sprite. 

Extending a sprite’s bounding box is particularly useful when you want to apply a texture transfer 
between two sprites that are the same size. It’s easier to position the two sprites after you extend the 
bounding box of one sprite. You can then easily return the extended bounding box to its original size 



by using the Fit Bounding Box tool. 

Click the picture above to see an example of extending a sprite’s bounding box. 

 To extend the bounding box of a sprite 

1 Select the sprite whose bounding box you want to extend. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Crop/Extend . 

4 Position the pointer over a cropping handle, and drag that handle away from the sprite. You can 
click and drag each cropping handle many times until the bounding box is extended to the size you 
want. 

5 Click away from the sprite. 
 
 

Aligning sprites with each other 
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Align tools 

 

 

The Align buttons on the Arrange palette provide 12 ways to align sprites. You can align their tops, 
bottoms, left or right sides, or each of their four corners, centers, or edges. Use one of these methods 
when you want two or more sprites to line up evenly. 

Click the picture above to see an example of aligning sprites. 

 To align sprites with each other 

1 Select the sprites you want to align. The sprite whose bounding box has solid black handles is the 
sprite that the other selected sprites will align with. 

You can choose a different source sprite in the current selection by pressing TAB. For information 
about selecting sprites, see Selecting sprites, tools, and colors. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click one of the Align buttons. 
 

Click To 
 

 Align the selected sprites on top of the source sprite at their upper 
left corners. 

 Align the top edges of the selected sprites with the top edge of the 
source sprite. 

 Align the selected sprites on top of the source sprite at their upper 
right corners. 

 Align the left edges of the selected sprites with the left edge of the 
source sprite. 

 Align the selected sprites on top of the source sprite at their 
centers. 

 Align the right edges of the selected sprites with the right edge of 
the source sprite. 

 Align the selected sprites on top of the source sprite at their 
lower-left corners. 



 Align the bottom edges of the selected sprites with the bottom edge 
of the source sprite. 

 Align the selected sprites on top of the source sprite at their 
lower-right corners. 

 Arrange the sprites in a column so that the centers of the selected 
sprites align with the center of the source sprite. 

 Arrange the sprites in a row so that the centers of the selected 
sprites align with the center of the source sprite. 

 Move the selected sprites toward each other so that their edges 
touch. 

 

If you want to line up or center sprites with respect to the composition space, see Aligning sprites with 
the composition space. 

 

Aligning sprites with the composition space 
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When you align sprites with each other, the order that you select the sprites in is important because 
the sprite whose bounding box has solid black handles, which is usually the first sprite you selected, 
remains anchored at its current position. The other sprites in your selection are aligned with that 
sprite. However, when you align sprites with the composition space, the order that you select the 
sprites in doesn’t affect the alignment. The composition space remains fixed, and the selected sprites 
line up with it.  

Align sprites with the composition space when you want to make sure that the sprites stay inside the 
composition space. Keeping sprites in the composition space is important if you plan to save your 
composition as a flat file. 

Note   When you use Touch Edges, the selected sprites are moved outside the composition space. 
 

 To align sprites with the composition space 

1 Select the sprites you want to align. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click one of the Align buttons. 
 

Click To 
 

 Stack the selected sprites in the upper-left corner of the 
composition space. 

 Align the top edges of the selected sprites with the top edge of the 
composition space. 

 Stack the selected sprites in the upper-right corner of the 
composition space. 

 Align the left edges of the selected sprites with the left edge of the 
composition space. 

 Center the selected sprites inside the composition space. 

 Align the right edges of the selected sprites with the right edge of 
the composition space. 

 Stack the selected sprites in the lower-left corner of the composition 



space. 

 Align the bottom edges of the selected sprites with the bottom edge 
of the composition space. 

 Stack the selected sprites in the lower-right corner of the 
composition space. 

 Arrange the sprites in a column so that the centers of the selected 
sprites align with the center of the composition space. 

 Arrange the sprites in a row so that the centers of the selected 
sprites align with the center of the composition space. 

 Move the selected sprites outside the composition space so that 
their edges touch the nearest edge of the composition space. 

 

If you want to line up or center sprites with respect to other selected sprites, see Aligning sprites with 
each other. 

 

Grouping sprites 
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Combine a set of sprites into a group when you want to treat those sprites as a single sprite when you 
position or arrange them in a composition, or when you want to order them in the stack. A group of 
sprites is similar to a selection set of sprites with one important distinction: selection sets are 
maintained until you click outside the selection, whereas grouped sprites are maintained until you 
separate them with Ungroup. 

Sprites that are already grouped can be nested in a larger group. Image Composer remembers the 
original grouping of sprites that you place in a larger group. 

Note   Certain actions, such as rotating, resizing, cutting out, and applying effects and texture 
transfers, cannot be performed on a group. You must first ungroup the sprites or flatten the selection. 
For details, see Ungrouping sprites and Flattening a selection. 
 

 To group sprites 

1 Select the sprites you want to group. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Group . 
 
 

Ungrouping sprites 
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Ungrouping separates grouped sprites and places them in a selection set. If the group consists of 
smaller groups, those smaller groups remain grouped. 

Ungrouping is similar to exploding in that both actions break up a grouped sprite. However, when you 
explode a group, the result is always a set of individual sprites regardless of whether some of those 



sprites were previously grouped together. 

 To ungroup sprites 

1 Select the group of sprites you want to ungroup. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Ungroup . 
 
 

Exploding a group 
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Explode a group when you want to convert it to a selection set of individual sprites. Exploding is 
similar to ungrouping in that both actions break up a grouped sprite. If you nested a grouped sprite by 
adding it to a larger group, then the original group is maintained when you ungroup the nested group. 
But when you explode a group, the result is always a set of individual sprites, regardless of whether 
some of those sprites were previously grouped together.  

 To explode a group 

1 Select the sprites you want to group. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Explode . 
 
 

Flattening a selection 
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Flatten a selection when you want to convert the selection to a single sprite. Flattening is similar to 
grouping in that both actions combine a selection set of sprites. However, flattening is a permanent 
action, whereas a group of sprites can be ungrouped. 

You will need to flatten a selection if you want to perform certain actions on a set of sprites that 
cannot be performed on groups, such as rotating, resizing, cutting out, and applying effects or texture 
transfers. 

 To flatten a selection 

1 Select the sprites you want to permanently combine. 

Tip   If you want to preserve your original sprites, duplicate the selection first, and then flatten the 
selection. In this way, you can still work with your original sprites individually. 

 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Flatten . 
 

Note   You can reverse this action only by clicking Undo immediately after completing it. 
 
 

Changing the order of sprites 
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Order tools 

 

 

Change the order of sprites in your composition when you want to control their position in the stack. 
For example, if you create a sprite that is a shadow of another sprite, you should change the order of 
those two sprites to make sure that the shadow is behind the other sprite. 

You can change the order of a sprite in respect to all the other sprites in your composition. You can 
also select two sprites and swap their order. In this case, the position of the source sprite is anchored, 
and Before or Behind moves the other sprite. 

Click the picture above to see an example of reordering sprites. 

 To change the order of sprites 

1 Select the sprites whose order you want to change. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click one of the Order tools. 
 

Click To move the selected sprite 
 

 To the top of the stack. 

 One position in front of the source sprite, in a multiple selection. 
The source sprite is surrounded by solid black handles. 

 One position in back of the source sprite, in a multiple selection. 
The source sprite is surrounded by solid black handles. 

 To the bottom of the stack. 

 One position lower (toward the bottom) in the stack. 

 One position higher (toward the top) in the stack. 
 
 

Setting a home position 
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When you place or arrange sprites on a composition, you can set a home position for each sprite or 
group of sprites. The home position is the sprite’s location in the composition relative to the 
composition space. The status bar indicates the current position of the selected sprite by showing the 
x-axis and y-axis coordinates of the sprite’s upper-left corner. 

Setting a home position stores the current position of the selected sprite. This is useful when you 
want to experiment with the placement of a sprite in your composition, but you want to be able to 
return the sprite to its original location. To do this, you simply restore the sprite to its home position. If 
you restore a sprite to its home position without first setting its home position, the sprite is placed in 
the upper-left corner of the composition space so that its x-axis and y-axis settings are both 0. 

 To set a home position 

1 Select a sprite and move it to the location that you want to set as its home position. 

2 On the toolbox, click Arrange . 



3 In the Arrange palette, click Set Home Position . 
 

To return a sprite to its home position after you move it, click Return to Home Position . If you did 
not set a home position for this sprite, it will move to the upper-left corner of the composition space. 

Tip   If you subsequently make a sprite part of a group, the position of the group is used instead of 
that of the sprite. When you ungroup the sprites, their individual positions are restored. 
 
 

Locking a sprite’s position 
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When you place or arrange sprites in a composition, you can lock the position of each sprite or group 
of sprites so that you cannot move it. When you position the pointer over a sprite whose position has 
been locked, the pointer changes to  to indicate that you need to unlock it before you can move it. 

Locking a sprite is useful when you want to arrange or align a large set of sprites, but you want to 
make sure that specific sprites are not moved. For example, suppose you center a sprite in the 
composition space and want to arrange all the other sprites in the composition around that sprite. If 
you lock the center sprite, moving or aligning the other sprites will not change its position. 

 To lock a sprite’s position 

1 Select a sprite and move it to the position that you want to lock. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click Lock/Unlock Position . 
 

If the sprite’s position was previously locked, clicking Lock/Unlock Position will unlock its position so 
that you can move it. 

 
 

Adjusting the bounding box to fit sprites 
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Fit Bounding Box tool 

 

 

You can adjust the size of a bounding box so that it fits the perimeter of the selected sprite. You may 
want to adjust a sprite’s bounding box after you use the Crop/Extend tool to extend the bounding 
box. For example, suppose you extended the bounding box of a sprite so that you could select two 
sprites of identical size for a texture transfer. When the texture transfer is complete, you can return 
the bounding box that you extended to its former size. 

Click the picture above to see an example of cropping a sprite. 

 To adjust the bounding box to fit a sprite 

1 Select the sprite whose bounding box you want to tighten. 

2 On the toolbox, click Arrange . 



3 In the Arrange palette, click Fit Bounding Box . 
 
 

Warping a sprite 
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Warp tools 

 

 

Warp a sprite when you want to distort its proportions. Warping a sprite is useful when you want to 
create the illusion of depth perspective, for example. 

If you use one of the Warp tools, the pointer changes when it’s positioned in the workspace. You can 
then drag the edges of the sprite’s bounding box to see the outline of the warp: 

Warp Pointer Description 
 

  Applies two-point perspective to the selected sprite. 

  Tilts a sprite by shearing its opposing sides in opposite 
directions around its center. 

  Refits the sprite to its bounding box after you adjust the 
position of one or more corners of the box. 

 

Click the picture above to see an example of warping a sprite. 

 To warp a sprite 

1 Select the sprite you want to warp. 

2 On the toolbox, click Arrange . 

3 In the Arrange palette, click one of the Warp buttons. 

4 Position the pointer over the sprite and drag the sprite’s bounding box to the desired shape. You 
can click and drag the bounding box many times until it is shaped the way you want. 

5 Click Apply. 
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Before Resizing After Resizing 

  

 
 

 

Before Crop After Crop 
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Before Align Centered Vertically Bottoms Aligned 
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applied 
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applied 
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applied 
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applied 

After Bilinear is 
applied 

    
 
 

Working with channels overview 
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You can use the channel edit commands, Copy Channel, Paste Channel, and Broadcast Channel, 
to perform actions such as the following: 

• Create new sprites based on a single channel of an existing sprite. 

• Replace a channel of one sprite with a channel from another sprite. 

• Replace all channels of a sprite with a channel from that same sprite. 
 

The Copy Channel and Paste Channel commands work with the Clipboard, much the same as any 
copy and paste operations. They are useful for placing a single channel from a source sprite into the 
same, or another, channel in a destination sprite. This action produces an effect in which a single 
channel from the source sprite appears superimposed on the destination sprite. You can also use the 
Copy Channel and Paste Channel commands on a single sprite. 

Clipboard paste creates a new sprite, while the channel paste commands alter an existing sprite. Use 
the Paste command on the Edit menu to paste the copied channel into the composition as a new 
sprite. 

The Broadcast Channel command operates on a single sprite to create a grayscale version of the 
sprite. This command is useful when examining a single channel. For example, when you broadcast 
the alpha channel, you replace all color channels with the alpha channel, producing an image 
resembling a cutout of the sprite. 

Note   If your color is set to white, a sprite might seem to disappear when you use the edit channel 
commands. This is because the sprite is filled with white in those areas in which the channel has 
content, and it is transparent in those areas in which there is no content. To see the sprite, change 
the composition space color or move the sprite off the composition space. 
 
 

Copying a channel 
 

1 Select the sprite from which you want to copy a channel. 

2 On the Edit menu, click Copy Channel. 

3 On the Copy Channel submenu, click one of the following: Red, Green, Blue, or Alpha. 
 

The channel is now on the clipboard and is ready to be pasted into a destination sprite by using the 
Paste Channel command. You can also paste the copied channel into the composition as a new 
sprite by using the Paste command. 
 
 

Pasting a channel 
 

1 Copy a channel from a sprite you have selected. 

2 Select a sprite into which you will paste the copied channel. This can be the same sprite or a 
different one. 



3 On the Edit menu, click Paste Channel. 

4 On the Paste Channel submenu, click the channel into which you want to paste the copied 
channel. 

You can also paste the copied channel into the composition as a new sprite by using the Paste 
command. 

 

Broadcasting a channel 
 

1 Select the sprite you want to affect. 

2 On the Edit menu, click Broadcast Channel. 

3 On the Broadcast Channel submenu, click the channel that you want to fill the other channels. 
 
 

Creating a shadow cast by a sprite 
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Shadows can enhance compositions by adding depth and texture. Using cast shadows creates the 
illusion of a light source hitting a sprite and casting a distinct shadow in the shape of the sprite. You 
can add textures or effects to cast shadows for maximum dramatic results.  

The following figures show a metronome casting a shadow. The shadow was created by using the 
Duplicate command to make a new sprite with the shape of a metronome. The shadow was then 
placed behind the metronome. 

  

Original sprite New sprite for 
shadow shape 

  

 Shadow in place Finished composition 

 
 

 To create a shadow cast by a sprite 

1 Click the sprite that is to cast a shadow. 

2 Click the Color Swatch  and select a color for the shadow. 

3 On the Edit menu, click Duplicate, or click CTRL and drag the bounding box to create a duplicate 
sprite.  

The new sprite is selected when you create it. 

4 Drag the new sprite away from the original so it is easier to work with. 

5 On the toolbar, click Color Fill . 

6 Apply effects, transfer textures, or both until the desired effect has been created.  

For example, you can rotate the shadow sprite by dragging the rotate handle on the bounding box, 
or change the shadow's shape by using the Warp effects on the Arrange palette,  

7 Drag the shadow sprite into the desired position relative to the original sprite. 

8 From the Arrange menu, click Send to Back. 

 

 

Creating a mask 
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Create a mask when you want to protect sections of a sprite while you apply changes to the 
nonmasked areas 

  

Original sprite Mask made from original sprite 

  

Mask and background after 
applying effects 

Composition with all sprites in 
place 

 

To create masks, you create a new sprite containing a specific area of a source sprite. This new 
sprite, the mask, is an area you want to protect from changes, to apply specific changes to, or to use 
as the basis of a shadow. Then, after you make changes to the source sprite, the mask, or both, you 
can move the mask into its original position, or you can offset it from the source sprite to create a 
shadow. 

For example, in the preceding figures, you see a composition of a skyline against a neutral-colored 
sky in the first frame. The goal is to show the scene at dusk. To accomplish this task, you create a 
mask of only the skyline and move it away from the composition. Next you can apply a gradient, such 
as Night Sky, to the composition. Finally, you can apply a colorize filter to give the skyline an evening 
feel and move the skyline back into its original location. 

 To create a mask 

1 Click the sprite you want to mask. 

2 On the toolbox, click Cutout . 

3 Click Curve . 

4 Adjust the Opacity slider to the desired setting, or type a value between 0 and 100 in the Opacity 
box.  

Lower values create a more transparent mask; higher values create a more opaque mask. 

5 Click around the portion of the sprite you want to mask. 

6 In the Edit Curve or Polygon section of the palette, click Move Points ,  Add Points  or Delete 
Points  to adjust the curve. 

7 Click Cut out. 
 

You have created an exact copy of the area of the sprite included in the curve. 
 
 

Creating a new sprite from a single channel 
 

 To create a new sprite from a single channel 

1 Select a sprite. 

2 On the Edit menu, click Copy Channel. 

3 On the Copy Channel submenu, click the Red, Green, Blue, or Alpha channel. 

4 On the Edit menu, click Paste. 
 

A new sprite appears that contains a single color channel.  
 
 

Color Tuning overview 
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   Click the topic you want to learn more about. 

Color Controls Highlight Shadows Dynamic Range 

 

Use the Color Tuning tool palette to alter multiple color aspects of a sprite in a single generation of 
change. This single generation of change reduces the overall image loss that often results from 
multiple generations of change.  

A single generation of change means that all color tuning changes you make to the sprite since 
selecting the Color Tuning palette are cumulative. If you click Reset or Undo before selecting a 
different sprite, all the changes you have made since selecting the Color Tuning palette will be lost. 

The Color Tuning tool palette contains tools for altering the following color aspects of a sprite: 

• Brightness 

• Saturation 

• Hue 

• Contrast 

• Shadow intensity 

• Midtone intensity 

• Highlight intensity 

• Pixel intensity distribution 
 
 

Color Controls overview 
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Color Tuning Tool Palette with the Color Controls Group 

 

The Color Controls tools alter the saturation and contrast for all color channels at once or for 
individual color channels, and alter the hue, and brightness color aspects of the pixels in a sprite. 

   Click on the picture you want to learn more about. 

• Brightness alters the absolute lightness or darkness of the color for all three color channels 
simultaneously, or for the red, blue, and green channels individually. 

 

• Contrast alters the degree of difference between the lightest and darkest parts of the color by 
adjusting either all three color channels simultaneously or by adjusting the red, blue, and green 
channels individually. 

 

• Hue moves the color of each pixel around a virtual color circle in increments of plus or minus one 
degree from -180 degrees to +180 degrees. Values for -180 degrees and +180 degrees are the 
same because they are at the same point on the virtual color circle.  

 

• Saturation alters a color by increasing or decreasing the amount of gray in proportion to hue for all 



three color channels simultaneously. 

 
 
 

Brightness 
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Original sprite Brightness at +50 Brightness at -50 

 

Brightness alters the lightness or darkness of color in increments of +/-1, from -100 to +100. A value 
of -100 represents fully darkened; +100 represents fully brightened. 

By default, All Channels is selected when you work with Brightness. For more information about 
how Brightness affects the red, green, and blue color channels independently, see Brightness for 
RGB Channels. 

Where to find this item 

Brightness is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click one of the preceding pictures to find out how to apply Brightness to all channels. 

How to adjust the result 

To increase the brightness of the color, move the Brightness slider to the right or type a larger 
number in the Brightness box. To decrease the brightness of the color, move the Brightness slider 
to the left or type a smaller number in the Brightness box. Any numbers you type in the box must be 
between -100 and 100. 

 

Brightness for RGB channels 
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Original sprite Brightness at +50 
for the Red Channel 

only 
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for the Green 
Channel only 
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Brightness alters the lightness or darkness of color in increments of +/-1, from -100 to +100. A value 
of -100 represents fully black; +100 represents fully bright. 

By default, All Channels is selected when you work with Brightness. 

Where to find this item 

Brightness is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click a picture above to find out how to apply Brightness to RGB channels. 

How to adjust the result 

To increase the brightness of the color, move the Brightness slider to the right or type a larger 
number in the Brightness box. To decrease the brightness of the color, move the Brightness slider 
to the left or type a smaller number in the Brightness box. Any numbers you type in the box must be 
between -100 and 100. 

 

Contrast 
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Original sprite Contrast at +50 Contrast at -50 

 

Contrast alters the degree of difference between the lightest and darkest parts of the sprite in 
increments of -/+1, from -100 to +100. 

By default, All Channels is selected when you work with Contrast. For more information about how 
Contrast affects the red, green, and blue color channels independently, see Contrast for RGB 
Channels. 

Where to find this item 

Contrast is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click a picture to find out how to apply Contrast to all channels. 

How to adjust the result 

Any numbers you type in the edit box must be between -100 and 100. 

To increase the degree of difference between the lightest and darkest parts of the sprite, move the 
Contrast slider to the right or type a larger number in the Contrast box. To decrease the degree of 
difference between the lightest and darkest parts of the sprite, move the Contrast slider to the left or 
type a smaller number in the Contrast box. Any numbers you type in the box must be between -100 
and 100. 

 



Contrast for RGB channels 
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Original sprite Red Channel only; 
Contrast at +50  
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Contrast at +50 
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Contrast at +50 

 

Contrast alters the degree of difference between the lightest and darkest parts of the sprite in 
increments of -/+ 1, from -100 to +100. 

By default, All Channels is selected when you work with Contrast. 

Where to find this item 

Contrast is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click a picture above to find out how to apply Contrast to RGB channels. 

How to adjust the result 

To increase the degree of difference between the lightest and darkest parts of the sprite, move the 
Contrast slider to the right or type a larger number in the Contrast box. To decrease the degree of 
difference between the lightest and darkest parts of the sprite, move the Contrast slider to the left or 
type a smaller number in the Contrast box. Any numbers you type in the box must be between -100 
and 100. 
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Original sprite Hue at +100 Hue at -100 

   

Hue at 50 Hue at -50  

 

Hue moves the color of each pixel around a virtual color circle in increments of -/+ 1, from -180 to 
+180 degrees. Red, green, and blue are 120 degrees apart on the color circle. If you rotate red pixels, 
for example, 120 degrees, the pixels become green. 

By default, All Channels is selected when you work with Hue. 



Where to find this item 

Hue is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click a picture to find out how to apply Hue. 

How to adjust the result 

To increase the green tinting in the sprite color, move the Hue slider to the right or type a larger 
number in the Hue box. To increase the blue tinting in the sprite color, move the Hue slider to the left 
or type a smaller number in the Hue box. Any numbers you type in the box must be between -180 
and 180. 

 

Saturation 
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Original sprite Saturation at +50 Saturation at -50 

  

Saturation alters a color by increasing or decreasing the amount of gray present in increments of -/+ 
1, from -100 to +100. 

By default, All Channels is selected when you work with Saturation. You cannot alter the saturation 
of each channel individually. 

Where to find this item 

Saturation is available on the Color Tuning tool palette, in the Color Controls group. 

How to apply this item 

Click a picture above to find out how to apply Saturation. 

How to adjust the result 

To decrease the amount of gray in the color, move the Saturation slider to the right or type a larger 
number in the Saturation box. To increase the amount of gray in the color, move the Saturation 
slider to the left or type a smaller number in the Saturation box. Any numbers you type in the box 
must be between -100 and 100. 

 

Highlight/Shadow overview 
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Color Tuning Tool Palette with Highlight/Shadows Options 

 

Controls on the Highlight/Shadows tab alter the relative intensities of the shadows, midtones, and 
highlights of a sprite’s color. 

For more information about how shadows, midtones, and highlights are controlled independently in 
the red, green, and blue color channels, see Highlight/Shadow for RGB Channels. 

   Click on the picture of the setting you want to learn more about. 

  

Original sprite Highlight/Shadow at 
positive setting 

  

Highlight/Shadow at 
negative setting 

Highlight/Shadow at 
combined setting 

 

• The Shadow handle, located on the bottom of the compensation curve, adjusts the intensity of the 
dark color elements. 

• The Midtone handle, located in the middle of the compensation curve, adjusts the intensity of the 
middle range color elements. 

• The Highlight handle, located at the top of the compensation curve, adjusts the intensity of the 
lightest color elements. 

 

How to adjust the result 

To increase the intensity of the selected handle area, move any of the three handles up. To decrease 
the intensity of the selected handle area, move any of the three handles down. 

Tip   Strong differences in intensity between the color elements creates greater contrast. 
 
 

 

Curves window at a brighter (positive) setting. 

 

 

Curves window at a darker (negative) setting. 

 

 

Curves window at a combined setting. 

 

Highlight/Shadow for RGB channels 
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Highlight/Shadow alters the relative intensities of the shadows, midtones, and highlights of a sprite’s 
color in each channel independently. 

Where to find this item 

Highlight/Shadow is located on the Color Tuning tool palette. 

How to apply this item 

Click a pictures to find out how to apply Highlight/Shadow for RGB channels. 

How to adjust the result 

To decrease the intensity of the selected handle area, move any of the three handles up. To increase 
the intensity of the selected handle area, move any of the three handles down. 

 

 

Curves window with all channels at varied settings. 

 

 

Curves window with red channel setting. 

 

 

Curves window with green channel setting. 

 

 

Curves window with blue channel setting. 

 

Dynamic Range 
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Color Tuning Tool Palette with Dynamic Range Options 

 

Dynamic Range designates how intensity is distributed in a sprite by defining the low and high 



intensity ranges. 

The histogram window displays the intensity distribution within the sprite. The horizontal axis displays 
the intensity levels, with left representing low intensity and right representing high intensity. The 
vertical axis displays the number of pixels that fall within a given intensity level. The two vertical bars 
located on the sides of the histogram window represent the low and high intensity output ranges. 

  

Original sprite Left bar moved to 
left 

  

Right bar moved to 
right 

Right and left bars 
moved to center 

 

Where to find this item 

Dynamic Range is located on the Color Tuning tool palette. 

How to apply this item 

Click a picture to find out how to apply Dynamic Range. 

 

 

Histogram of the original sprite. 

 

 

Histogram showing the left bar moved left. 

 

 

Histogram showing the right bar moved right. 

 

 

Histogram showing the right and left bars moved to center. 

 

Adjusting shadow, midtone, and highlight intensity 
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Use the Highlight/Shadow group to increase or decrease the relative intensities within a sprite in the 
low, medium, and high tones independently. 

1 Select a sprite. 

2 On the toolbox, click Color Tuning. 



3 On the Color Tuning tool palette, click Highlight/Shadows. 

4 In the Compensation Curves window, select the Shadow, Midtone, or Highlight handle and 
drag to the desired position. 

Tip   Dragging a handle up or left increases the brightness of that color area. Dragging a handle 
down or to the right increases the darkness of that color area. 

 

5 Click Apply. 

Note   Microsoft Image Composer applies all of the changes made on the Color Tuning tool 
palette, whether in the Color Controls, Highlight/Shadow, or Dynamic Range groups, when you 
click Apply. 

 

For more information about adjusting for individual channels, see To Adjust Shadow, Midtones and 
Brightness for RGB. 

 

Adjusting shadow, midtone, and highlight intensity for RGB channels 
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Use the Highlight/Shadow group to increase or decrease the relative intensities within a sprite in the 
low, medium, and high tones independently. 

1 Select a sprite. 

2 On the toolbox, click Color Tuning. 

3 On the Color Tuning palette, click Highlight/Shadow. 

4 Select either the red, green, or blue channel to adjust. 

5 In the Compensation Curves window, select the Shadow, Midtone or Highlight handle and drag 
to the desired position. 

Tip   Dragging a handle up or left increases the brightness of that color area. Dragging a handle 
down or right increases the darkness of that color area. 

 

6 Click Apply. 

Note   Microsoft Image Composer applies all the changes made on the Color Tuning tool palette, 
whether in the Color Controls, Highlight/Shadow, or Dynamic Range groups, when you click 
Apply. 

 
 

Specifying color intensity distribution 
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Use Dynamic Range to expand or reduce a sprite’s use of color intensity distribution. 

1 Select a sprite. 

2 On the toolbox, click Color Tuning. 

3 On the Color Tuning palette, click Dynamic Range. 

4 In the Low Output Range box, select the lowest intensity value for pixels in the sprite. Type a 
value between 0 and 255 indicating the intensity you want. 



5 In the High Output Range box, select the highest intensity value for pixels in the sprite. Type a 
value between 0 and 255 indicating the intensity you want.  

- or - 

Adjust the left and right bars of the histogram window to set the low and high intensity values for 
the sprite. 

Tip   If a sprite is too bright, reduce the distance between the left and right bars in the histogram 
window. If a sprite is too dark, increase the distance between the left and right bars in the 
histogram window. 

 

6 Click Apply. 

Note   Microsoft Image Composer applies all the changes made on the Color Tuning tool palette, 
whether in the Color Controls, Highlight/Shadow, or Dynamic Range groups, when you click 
Apply. 

 
 

Altering the color of a sprite 
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1 Select a sprite. 

2 On the toolbox, click Color Tuning. 

3 Adjust the Brightness, Contrast, Hue and Saturation slider bars to achieve the desired result. 

4 Click Apply. 

 

Altering the RGB colors of a sprite independently 

{button 
,AL("tuning")} 
Related Topics 

{button 
,AL("color 
tuning 
palette ovr 
")} Overview 

 

 

1 Select a sprite. 

2 On the toolbox, click Color Tuning. 

3 Click the Red, Green, or Blue color channel. 

4 Adjust the Brightness or Contrast sliders to achieve the desired result for the channel. 

5 Click Apply 

Note   If All is not selected, Microsoft Image Composer applies the changes you have specified 
for each color channel when you click Apply, even though you can not view all the channel 
settings. 

 
 

Brightness Hint 

Move the slider to the right to increase the brightness of the color. 

Move the slider to the left to increase the darkness of the color. 

You can also indicate the amount of brightness you want by typing a value between -100 and 100 in 
the Brightness box. Larger values increase brightness; smaller values increase darkness. 

 



Contrast Hint 

Move the slider to the right to increase the degree of difference between the lightest and darkest parts 
of the color. 

Move the slider to the left to decrease the degree of difference. 

You can also indicate the amount of contrast you want by typing a value between -100 and 100 in the 
Contrast box. Larger values increase the difference between the lightest and darkest parts of the 
color; smaller values decrease the difference. 

 

Hue Hint 

Move the slider to the right to increase the green tinting in the sprite color. 

Move the slider to the left to increase the blue tinting in the sprite color. 

You can also indicate the hue you want the color to have by typing a value between -180 and 180 in 
the Hue box. Larger values increase green tinting; smaller values increase blue tinting. 

 

Saturation Hint 

Move the slider to the right to decrease the amount of gray in the color. 

Move the slider to the left to increase the amount of gray in the color. 

You can also indicate the amount of saturation you want by typing a value between -100 and 100 in 
the Saturation box. Larger values decrease the amount of gray in the color (increase saturation); 
smaller values increase the amount of gray (decrease saturation). 

 

Working with color 
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Microsoft Image Composer offers you a wide range of colors and a variety of ways to use them in 
your compositions. Available colors are stored on a color palette that is saved with your composition. 
You can choose the color palette for your composition based on your display system and the colors 
that your composition needs. 

In Image Composer, you can control color in several ways. You can: 

• Use the True Color palette, which is available by default in Image Composer, to display true color 
on display systems that use a 24-bit graphics adapter video card. 

• Use one of the three custom color palettes that Image Composer provides: 

• Gray Ramp has 236 shades of gray ranging from pure black to pure white. 

• Web (Dithered) has 216 colors and uses the Error Diffusion dithering option. Use this palette 
for photographs or other types of images that you want to publish to the Web. If this palette 
doesn’t include a color needed by an image that you insert in your composition, Image 
Composer uses the nearest matching color from this palette. 

• Web (Solid) has 216 colors and uses the Solid dithering option. Use this palette for line art or 
solid-colored art that you want to publish to the Web. To avoid dithering, the Web (Solid) palette 
includes the minimum set of colors that should always be available to all images, regardless of 



the operating system or the browser used to display the image. 

For more information about dithering options, see Controlling color with dithering. 

• Create a custom color palette so that you can design compositions that look great on less capable 
systems or for Web browsers that may not have true color capability. You can also change one or 
more of the color entries in an existing custom palette. 

• Control how colors in a custom palette appear on various display systems by selecting the 
dithering option that produces the best results. 

• Change the current color that you fill a sprite with by using the Color Fill button  on the toolbar, 
and that you use to apply various effects in the current composition. 

• Fine-tune the color of a sprite by using the Color Tuning palette to adjust the brightness, contrast, 
highlights, or shadows. 

 
 

Using true color 
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The True Color palette mixes the reds, greens, and blues available on display systems that support 
24-bit color to produce 16.7 million colors. This is one of the highest fidelity color formats. If your 
display system supports 24-bit color, you can create compositions in true color. 

 

It is important to choose a palette that is supported by the display systems that you plan to show your 
composition on. If you show a composition that was created with the True Color palette on a display 
system that doesn’t support true color, the colors will dither and may appear grainy or splotchy. In this 
case, consider using one of the custom color palettes that Microsoft Image Composer provides or 
create your own custom color palette containing up to 256 colors. For more information, see Using 
custom color palettes. 

 

Using custom color palettes 
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The colors that appear in your composition are picked from a palette of hues that are stored with the 
composition. If the display systems that you use to create a composition supports more colors than 
the typical display system that you plan to show your composition on, you can: 

• Use one of the three palettes that Microsoft Image Composer provides in addition to the True 
Color palette. 

• Use the Gray Ramp palette for compositions that use black, white, and shades of gray. 

 

• Use the Web (Dithered) palette for full-color compositions that use up to 256 colors: 

 

If this palette doesn’t include a color needed by an image that you insert in your composition, 
Image Composer uses the nearest matching color from this palette. 



• Use the Web (Solid) palette for line art or solid-colored art that you want to publish to the Web. 
This palette includes the same colors as the Web (Dithered) palette, but does not allow the 
colors in your composition to dither. 

– or – 

• Create your own custom palette that contains only the colors that your composition needs.  
 

For example, if you want to publish a 16-color composition on the Web, you can accommodate a 
variety of display systems and Web browsers by creating a custom color palette that contains only 
those 16 colors. 

Each custom color palette is saved with the composition that you create it for. You can also export a 
custom color palette as a palette (.pal) file so that you can use it with other compositions and 
applications. 

 

Creating a custom palette 
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Microsoft Image Composer provides three custom color palettes in addition to the True Color palette: 

• Gray Ramp has 236 shades of gray ranging from pure black to pure white. 

• Web (Dithered) has 216 colors. If this palette doesn’t include a color needed by an image that you 
insert in your composition, Image Composer uses the nearest matching color. 

• Web (Solid) includes  the same 216 colors as Web (Dithered) but does not allow dithering. 
 

If these custom color palettes don’t meet the needs of your composition, or if your display system 
doesn’t support true color, you can create your own custom color palette. 

 To create a custom palette 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the Custom Palette tab. 

3 Under Create and edit custom palettes, click New. 

4 In the New Color Palette dialog box, type a name in the Palette name box. 

5 In the Palette size box, select the number of colors you want to add to your new palette. 
 

Note   Once you specify a number of colors, you can’t change it. If you think you will want to add 
colors to the palette after you create the initial set of color entries, select the next largest palette 
size. 

 

6 In the Dither by box, select a method for approximating colors that are not in the current color 
palette. 

 

To Click Result 
 

Not dither Solid No color blending, which creates 
a poster-like effect with 
splotches of color 

Use a standard 16 x 16 
ordered dither 

Pattern Little color blending, which 
produces a blocky appearance 

Use a 256 x 256 ordered 
dither 

Random Medium color blending 

Distribute the color difference 
between the true color and 

Error Diffusion High color blending, which is 
useful with photographs 



the nearest palette color to 
the neighboring colors 

 

7 Click OK. 

Now you can add colors to your custom palette. For details, see Adding colors from a sprite or 
composition and Adding colors from a color ramp. 

 

Adding colors from a sprite or composition 
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After you create a custom color palette, you can add colors to it from selected sprites or from an 
entire composition. For example, you can create a new palette with 256 color entries, add 100 colors 
from one group of sprites, and then continue to add an additional 156 colors as you need them. 

 To add colors from a sprite or composition 

1 In the composition, select the sprites that have the colors you want to add to a palette. 

2 Click the Color Swatch. 

3 In the Color Picker dialog box, click the Custom Palette tab. 

4 In the Color Palette box, click the name of the palette that you want to add colors to. 
 

Tip   If the palette name does not appear in the Color Palette list, click Import to locate the 
palette and add it to the list. 

 

5 Under Create and edit custom palettes, click Generate Colors. 

6 In the Generate Colors dialog box, type the number of colors you want to generate from the sprite.  
 

Note   This number cannot exceed the number of empty color entries in the palette. If the number 
of colors in your selection or composition exceeds the number of empty color entries, you can 
either add as many colors to the palette as it will fit, or create a new palette. For details, see 
Creating a custom palette. 

7 In the Generate from box, click Selection to generate colors from the selected sprites, or click 
Composition to generate colors from the entire composition. 

8 Click Add. 

9 If your palette still has empty entries and you want to add more colors, repeat steps 7 and 8. 

– or – 

Click Close. 
 
 

Adding colors from a color ramp 
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You can add colors to a custom palette from several color ramps. Each color ramp contains several 
hues of the same color, from pure black to the pure primary color (red, green, or blue) or secondary 
color (cyan, magenta, or yellow). For example, Blue Ramp contains hues of blue from pure black to 
pure blue. 

1 Click the Color Swatch. 

2 In the Color Picker dialog box, select the Custom Palette tab. 



3 In the Color Palette box, click the name of the palette that you want to add colors to. 
 

Tip   If the palette name does not appear in the Color Palette list, click Import to locate the 
palette and add it to the list. 

 

4 Under Create and edit custom palettes, click Generate Colors. 

5 In the Generate Colors dialog box, type the number of colors you want to add to the palette. 
 

Note This number cannot exceed the number of empty color entries in the palette. 
 

6 In the Generate from box, click the ramp that you want to add. 

To add Click 
 

Up to 216 entries with an equal number of red, green, 
and blue entries. 

Balanced Ramp 

Up to 256 red, green, and blue entries. Full Ramp 

Up to 256 entries from pure white to pure black. Gray Ramp 

Up to 256 entries from pure red to pure black. Red Ramp 

Up to 256 entries from pure green to pure black. Green Ramp 

Up to 256 entries from pure blue to pure black. Blue Ramp 

Up to 256 entries from pure cyan to pure black. Cyan Ramp 

Up to 256 entries from pure magenta to pure black. Magenta Ramp 

Up to 256 entries from pure yellow to pure black. Yellow Ramp 

Up to 256 entries with a gradual blend from one pure 
color to the next pure color (red, yellow, green, cyan, 
blue, magenta, red). 

Hue Ramp 

The 20 standard system colors. System Colors 
 

7 Click Add. 
 

Note   If Add is not available, either the number of colors you specified is too low for the ramp you 
selected, or the palette does not have enough empty entries to add the colors. 

 

8 If your palette still has empty entries and you want to add more colors, repeat steps 5 through 7. 

– or – 

Click Close. 
 
 

pure white 

In the RGB color model: Red = 255, Green = 255, Blue = 255. 

 

pure black 

In the RGB color model: Red = 0, Green = 0, Blue = 0. 

 

pure red 

In the RGB color model: Red = 255, Green = 0, Blue = 0. 

 

pure green 

In the RGB color model: Red = 0, Green = 255, Blue = 0. 

 



pure blue 

In the RGB color model: Red = 0, Green = 0, Blue = 255. 

 

pure cyan 

In the RGB color model: Red = 0, Green = 255, Blue = 255. 

 

pure magenta 

In the RGB color model: Red = 255, Green = 0, Blue = 255. 

 

pure yellow 

In the RGB color model: Red = 255, Green = 255, Blue = 0. 

 

Changing the colors in a custom palette 

{button ,AL("color 
palettes how;custom 
palette topics")} 
Related Topics 

{button 
,AL("color ovr 
")} Overview 

 

 

After you create a custom palette and add colors, you can change the colors in the palette one at a 
time. You cannot change colors in the three custom palettes provided with Microsoft Image Composer 
(Gray Ramp, Web (Dithered) and Web (Solid)). 

 To change the colors in a custom palette 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the Custom Palette tab. 

3 Double-click the color entry you want to change. 

4 In the Choose Color dialog box, select a color using any of the methods below. 

To  Follow these steps 
 

Click a color • Click inside the color matrix.  

To change the amount of black in the color, 
move the handle on the left of the color matrix; 
to change the amount of white, move the 
handle on the right of the color matrix. 

Type numbers for the 
selected color model 

• If the RGB color model is selected, enter values 
in the Red, Green, and Blue boxes. The 
number in each box must be between 0 and 
255. 

• If the HSV color model is selected, enter values 
in the Hue, Saturation, and Value boxes. The 
number in the Hue box must be between 0 and 
359; the numbers in the Saturation and Value 
boxes must be between 0 and 100. 

Pick a color from the 
desktop 

1. Click the Eyedropper button . 

2. To select a single color, click the color you want 
to copy. 



– or – 

To select the average color from a range of 
colors, drag a bounding box around the pixels 
whose colors you want to average. 

 

5 Click Apply. 
 
 

Selecting a palette for your composition 
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When you create a new composition, the name of the current color palette appears in the Color 
Format box on the toolbar. You can select a different palette for your composition depending on the 
number of colors in your composition and the number of colors that your display system supports. 

 To select a palette for your composition 

• Click a palette name from the Color Format list. 
 

Notes 

• If your composition contains a sprite that you inserted from a file, the original color information for 
that sprite is retained when you change palettes. Changing palettes may change the appearance 
of an inserted sprite. To view the original appearance and color information of the sprite, right-click 
it and then click Properties. 

• When you apply a color effect such as a gradient to a sprite, the result appears in the colors on the 
current palette. For example, if you apply a color gradient to a sprite in a composition that uses the 
Gray Ramp palette, the result appears in shades of gray. You can view the effect in color by 
selecting a color palette, such as True Color or Web (Dithered), for the entire composition. 

• By default, Microsoft Image Composer saves compositions with the True Color palette. If you want 
to save your composition with a different palette, specify a different color format when you save the 
composition. For more information, see Saving files in different formats. 

 

Setting the current color 
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The Color Swatch displays the current color, which is used when you create new sprites, apply 
various effects, paint on a sprite, and more. To use a different color for any of these actions, you must 
change the current color before creating or altering a sprite. For information about changing the color 
of a sprite, see Applying a Color Enhancement Effect. 

 

The available colors you can choose from depend on the color palette that your composition currently 
uses. The name of the current palette appears in the Color Format box on the toolbar. To choose a 
color that isn’t on the current palette, you must first attach a different palette to your composition. For 
details, see Selecting a palette for your composition. 

 To set the current color 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the True Color tab if your composition uses the True Color 
palette, or click the Custom Palette tab if your composition uses any other palette. 



3 Select the color you want to use: 

• To select a true color, click inside the color matrix on the True Color tab. For details, see 
Selecting a true color. 

• To select a color from another palette, select the name of the palette that has the color you want 
to use from the Color Palette box on the Custom Palette tab. Then click a color entry in the 
palette. 

4 Click OK. 
 

Any new sprite, pattern, or fill that you add will use the new color. 

 

Selecting a true color 
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When you select a true color for the Color Swatch, you can click inside the color matrix in the Color 
Picker dialog box to select that color. 

 

You can also define your selection more precisely by adjusting the handles, sliders, and boxes to 
specify the values in the selected color model. 

 To select a true color 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the True Color tab. 

3 Click inside the color matrix to change the color in the New color to use box. You can also type 
the values for the color in the selected color model: 

• If the RGB color model is selected, enter values in the Red, Green, and Blue boxes. The 
number in each box must be between 0 and 255, inclusive. 

• If the HSV color model is selected, enter values in the Hue, Saturation, and Value boxes. The 
number in the Hue box must be between 0 and 359, inclusive; the numbers in the Saturation 
and Value boxes must be between 0 and 100, inclusive. 

4 To adjust the color you selected, follow these steps: 
 

To Do This 
 

Change the amount of black 
in the color 

Move the handle on the left of the color 
matrix. 

Change the amount of white 
in the color 

Move the handle on the right of the color 
matrix. 

Change the hue Move the handle at the top of the color 
matrix. If the new color remains white 
regardless of what you select, move the 
handle on the right of the color matrix 
toward the top. 

– or – 

Select the HSV color model and  type a 
number between 0 and 359 in the Hue 
setting.  

Change the amount of gray in 
the color 

Select the HSV color model and  type a 
number between 0 and 100 in the 
Saturation setting.  



Lighten or darken the color Select the HSV color model and type a 
number between 0 and 100 in the Value 
setting.  

Select a pure primary color Select the RGB color model and change 
one of the settings to 255. Then change 
the other two settings to 0. 

Select a pure secondary color Select the RGB color model and change 
one of the settings to 0. Then change the 
other two settings to255. 

Select a shade of gray Select the RGB color model and change 
all three settings to the same number. 

 
 

Using a color from the desktop as the current color 
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You can set the current color to any color that is visible on your desktop, even if that color is outside 
Microsoft Image Composer. This feature makes selecting colors easy, especially when you need to 
match a precise color in another program. For example, you can set the current color to a color in 
your desktop wallpaper or to a color used by an image visible in your Web browser.  

You can also select a range of pixels, and set the current color to the average color within that range. 

 To use a color from the desktop as the current color 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click Eyedropper  on the True Color tab. 

3 To select a single color, click the color you want to copy. 

– or – 

To select the average color from a range of colors, drag a bounding box around the pixels whose 
colors you want to average. 

4 Click OK. 
 
 

Using the Quick Color Picker to select a color 
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The Quick Color Picker provides a shortcut for changing the current color. The Quick Color Picker 
combines the Hue/Blackness matrix and Hue/Whiteness matrix that appear on the True Color tab of 
the Color Picker dialog box. 

 

 To use the Quick Color Picker to select a color 

1 Right-click the Color Swatch. 

2 In the Quick Color Picker, click the color you want to select. 
 

To change the palette that appears in the Quick Color Picker, see Selecting a palette for the Quick 
Color Picker. 

 



Selecting a palette for the Quick Color Picker 

{button ,AL("color 
picker how;color 
palettes topics")} 
Related Topics 

{button 
,AL("color ovr 
")} Overview 

 

 

When you open the Quick Color Picker, the True Color palette appears by default. You can select a 
different palette for the Quick Color Picker if you want quick access to the last palette you selected 
from the Color Picker dialog box. 

 

 To select a palette for the Quick Color Picker 

1 Click the Color Swatch. 

2 Select the palette that you want the Quick Color Picker to use: 

• To use the True Color palette, click the True Color tab. 

• To use a custom color palette, click the Custom Palette tab. Then select a custom palette from 
the Color Palette list. 

 

1 Click OK. 
 

When you right-click the Color Swatch, the palette you selected appears in the Quick Color Picker. 

 

Previewing your composition with a color palette 
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You can preview your composition using the colors from any color palette that is currently loaded. 
Previewing your composition with another palette allows you to make sure that your composition 
appears properly on a variety of display systems.. For example, you can use the Web (Dithered) 
palette to preview compositions that may be viewed with Web browsers that do not support true color. 

 To preview your composition with a color palette 

• On the toolbar, select the name of the palette you want to preview your composition with from the 
Color Format list. 

 

Tip   If the palette name does not appear in the Color Format list, use the Custom Palette tab in 
the Color Picker dialog box to load the palette. 
 
 

Controlling color with dithering 
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The appearance of colors on custom color palettes can vary depending on the capabilities of the 
display system you are using. For example, some display systems support 24-bit color, while others 
support only 8-bit color. Also, some Web browsers use their own color palettes that do not contain all 
the colors that your composition needs. 



To allow for differences between the colors in the custom palette that you use to create a composition 
and the colors that the display system can produce, Microsoft Image Composer uses dithering. 
Dithering mixes the colors available on the display system to approximate the color that is not 
available. You can choose from four types of dithering to control how dithering is applied for your 
custom color palette. Each type of dithering specifies how gray pixels are used to correct a color. 

 To control color with dithering 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the Custom Palette tab. 

3 In the Color Palette box, click the name of the palette that you want to specify a dithering option 
for. 

 

Tip   If the palette name does not appear in the Color Palette list, click Import to locate the 
palette and add it to the list. 

 

4 Under Create and edit custom palettes, click Edit. 

5 In the Edit Color Palette dialog box, click one of these options in the Dither by list. 

To Click Result 
 

Not dither Solid No color blending, which 
creates a poster-like 
effect with splotches of 
color 

Use a standard 16 x 16 
ordered dither 

Pattern Little color blending, 
which produces a blocky 
appearance 

Use a 256 x 256 ordered 
dither 

Random Medium color blending 

Distribute the color difference 
between the true color and 
the nearest palette color to 
the neighboring colors 

Error Diffusion Sharp color blending, 
which is useful with 
photographs 

 

6 Click OK. 

 

True Color tab (Color Picker dialog box) 
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On the True Color tab, you can change the current color. The color you choose is applied whenever 
you create a new shape, add a text sprite, or apply a fill or pattern to a sprite in your composition. 

You can choose a color in a variety of ways depending on the color model you want to use: 

• If you want to choose the current color from a range of colors, you can click inside the color matrix. 

• If you want to add black or white to the hue in the current color, you can click inside the column to 
the right of the color matrix. 

• If you are familiar with choosing a color based on amounts of red, green, and blue (RGB) or hue, 
saturation, and value (HSV), you can use sliders or boxes to define exact values for the color 
model you use. For more information about true color or color models, see Working with color. 

 

The True Color tab provides the following elements to help you choose a new color. 

Original color used/New color to use   Displays the current color and the new color, if one is 
selected. 



 

Revert    Sets the New color to use box back to the same color in the Original color used box. 

Color matrix   Displays the true colors you can choose from. You can click a color inside the matrix 
or use the handles on the left and top sides to select a color. To adjust the amount of white or 
black in the selected color, click inside the column beside the color matrix or use the vertical 
handle to select the color. The color you select appears in the New color to use box. 

 

Note   If you move the vertical handle of the right column to the bottom, the color becomes pure 
white regardless of your selection in the color matrix. 

 

Color model   Specifies the color model used for the current composition. 

Sliders and boxes   The sliders increase or decrease the amount of red, green, and blue (for the 
RGB color model) or hue, saturation, and value (for the HSV color model) in the New color to use 
box. The boxes specify the numerical value of each amount in the selected color. Amounts of red, 
green, and blue range from 0 to 255; amounts of hue range from 0 to 359; and amounts of 
saturation and value range from 0 to 100. 

Eyedropper   Lets you view RGB or HSV values for the color that you point to. To display these 
values, click Eyedropper  and then position the pointer over the pixel. Click a pixel to fill the New 
color to use box with the color of the pixel you clicked on. The box to the right of the Eyedropper 
button displays the horizontal (x-axis) and vertical (y-axis) coordinates of that pixel. 

 

To choose an averaged color from an area on the screen, click Eyedropper  and then drag a 
rectangle around the area on the desktop that you want to average. 

OK   Closes the Color Picker dialog box and displays the selected color in the Color Swatch. 

Cancel   Closes the Color Picker dialog box without changing the color in the Color Swatch. 

 

Choose Color dialog box 
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In the Choose Color dialog box, you can change the color of an entry in a custom palette. That 
palette appears on the Custom Palette tab in the Color Picker dialog box. The color you choose in 
the Choose Color dialog box replaces the color of the custom palette entry. 

You can choose a color in a variety of ways depending on the color model you want to use: 

• If you want to choose the current color from a range of colors, you can click inside the color matrix. 

• If you want to add black or white to the hue in the current color, you can click inside the column to 
the right of the color matrix. 

• If you are familiar with choosing a color based on amounts of red, green, and blue (RGB) or hue, 
saturation, and value (HSV), you can use sliders or boxes to define the exact values for the color 
model you use. For more information about true color or color models, see Working with color. 

 

The Choose Color dialog box provides the following elements to help you choose a new color. 

Original color used/New color to use   Displays the color of the custom palette entry and the new 
color, if one is selected: 

 

Revert    Sets the New color to use box back to the same color in the Original color used box. 

Color matrix   Displays the true colors you can choose from. You can click a color inside the matrix 



or use the handles on the left and top sides to select a color. To adjust the amount of white or 
black in the selected hue, click inside the column beside the color matrix or use the vertical handle 
to select the color. The color you select appears in the New color to use box. 

 

Note   If you move the vertical handle of the right column to the bottom, the color becomes pure 
white regardless of your selection in the color matrix. 

 

Color model   Specifies the color model used by the custom palette. 

Sliders and boxes   The sliders increase or decrease the amount of red, green, and blue (for the 
RGB color model) or hue, saturation, and value (for the HSV color model) in the New color to use 
box. The boxes specify the numerical value of each amount in the selected color. Amounts of red, 
green, and blue range from 0 to 255; amounts of hue range from 0 to 359; and amounts of 
saturation and value range from 0 to 100. 

Eyedropper   Lets you view RGB or HSV values for the color that you point to. To display these 
values, click Eyedropper  and then position the pointer over the pixel. Click a pixel to fill the New 
color to use box with the color of the pixel you clicked on. The box to the right of the Eyedropper 
button displays the horizontal (x-axis) and vertical (y-axis) coordinates of that pixel. 

 

To choose an averaged color from an area on the screen, click Eyedropper  and then drag a 
rectangle around the area on the desktop that you want to average. 

Apply   Closes the Choose Color dialog box and displays the selected color in the selected custom 
palette entry. 

Close   Closes the Choose Color dialog box without changing the color of the selected custom 
palette entry. 

 

Custom Palette tab (Color Picker dialog box) 

{button ,AL("color ovr;tc 
tab;")} Related Topics 

  

 

On the Custom Palette tab, you can replace the current color with a color from the one of the custom 
color palettes that come with Microsoft Image Composer. You can also choose a color from a custom 
palette that you create and edit on the Custom Palette tab. The color you choose is applied 
whenever you create a new shape, add a text sprite, or apply a fill or pattern to a sprite in your 
composition. 

Color Palette   Displays the name of the palette shown on the tab and allows you to select from a 
list of palettes that are loaded and available. This list includes the custom palettes provided with 
Image Composer, as well as palettes that were imported when you inserted sprites in the 
composition. This list of palettes is the same as the Color Format list on the Image Composer 
toolbar. 

Import   Displays the Import Custom Palette dialog box where you can select a custom palette 
(.pal) file to use in Image Composer. After you import a palette, you can select one of its entries as 
the current color, or you can select that palette from the Color Format list on the toolbar. 

Export   Displays the Export Custom Palette dialog box so you can save the current palette as a 
.pal file for use in other applications. 

Custom palette entries   Displays the colors in the palette. You can click an entry to use it for the 
current color or double-click an entry to change its color in the Choose Color dialog box. 

 

Sort palette by   Specifies the order of the colors in the palette so you can easily find or compare 
colors. For example, to order the colors by saturation, select Saturation; to order the colors by 



intensity, select Value. 

Create and edit custom palettes   Contains the buttons used to create a custom palette or alter an 
existing palette. The custom palettes provided with Image Composer can’t be altered. If you want 
to vary one of these palettes, you must create a new palette, generate colors from the palette you 
want to alter, and then change the entries on the new palette. 

• New   Displays the New Color Palette dialog box where you specify the number of colors in 
the palette and the type of dithering the palette uses. If you want to change the number of color 
entries in a custom palette, you must recreate the palette. 

• Edit   Displays the Edit Color Palette dialog box where you can change the palette name and 
the type of dithering the palette uses. You cannot change these settings for the custom color 
palettes provided with Image Composer. 

• Remove   Deletes the custom palette from the Color palette list. You cannot delete the 
custom palettes provided with Image Composer. 

• Generate Colors   Displays the Generate Colors dialog box where you specify the number of 
colors you want to copy from an existing palette to blank entries in your custom palette. 

 

Note   To add colors to a palette that is already full of colors, double-click the color entry you want 
to change or right-click the entry and click Quick Color Picker from the shortcut menu. Then 
select a new color. 

 

OK   Closes the Color Picker dialog box and displays the selected color in the Color Swatch. 

Cancel   Closes the Color Picker dialog box without changing the color in the Color Swatch. 

Note   Changes to custom palettes are saved immediately and are not canceled when you click 
Cancel. 

 
 

Group 

Combines the selected sprites into a group. Grouped sprites are treated as a single sprite when you 
use the Arrange tools. 

 

Ungroup 

Separates grouped sprites and places them in a selection set. If the selected group consists of 
smaller groups, those smaller groups are maintained. 

 

Explode 

Separates grouped sprites and places them in a selection set, similar to Ungroup. However, if the 
selected group consists of smaller groups, those smaller groups are not maintained. Exploding a 
group creates a selection set of individual sprites. 

 

Flatten Selection 

Permanently combines the sprites in the current selection or group into a single sprite. While you can 
ungroup a group of sprites, you cannot click Ungroup to separate a set of sprites after they have 
been flattened. However, you can undo this action immediately after clicking Flatten Selection. 

 

Set Home Position 

Stores the position of the current sprite or group in the composition. After you move the sprite or 
group, you can restore it to its stored position by clicking Return to Home Position. 



 

Return to Home Position 

Moves the selected sprite or group to the position it was in when you clicked Set Home Position. If 
you did not set a home position for the sprite, it is moved to the upper-left corner of the composition 
space. 

 

Lock/Unlock Position 

Locks or unlocks the position of the selected sprite. You cannot move a locked sprite until you unlock 
it by clicking Lock/Unlock Position. 

 

Upper-Left Corners 

Aligns the upper-left corners of the selected sprites. If Relative to composition space is selected, 
aligns the upper-left corners of the selected sprites with the upper-left corner of the composition 
space. 

 

Tops 

Aligns the top edges of the selected sprites. If Relative to composition space is selected, aligns the 
top edges of the selected sprites with the top edge of the composition space. 

 

Upper-Right Corners 

Aligns the upper-right corners of the selected sprites. If Relative to composition space is selected, 
aligns the upper-right corners of the selected sprites with the upper-right corner of the composition 
space. 

 

Centers Vertically 

Arranges the sprites in a column so that the centers of the selected sprites are lined up. If Relative to 
composition space is selected, vertically aligns the center of each of the selected sprites with the 
center of the composition space. 

 

Left Sides 

Aligns the left edges of the selected sprites. If Relative to composition space is selected, aligns the 
left edges of the selected sprites with the left edge of the composition space. 

 

Centers 

Aligns the centers of the selected sprites. If Relative to composition space is selected, centers each 
of the selected sprites in the composition space. 

 

Right Sides 



Aligns the right edges of the selected sprites. If Relative to composition space is selected, aligns 
the right edges of the selected sprites with the right edge of the composition space. 

 

Centers Horizontally 

Arranges the sprites in a row so that the centers of the selected sprites are lined up. If Relative to 
composition space is selected, horizontally aligns the center of each of the selected sprites with the 
center of the composition space. 

 

Lower-Left Corners 

Aligns the lower-left corners of the selected sprites. If Relative to composition space is selected, 
aligns the lower-left corners of the selected sprites with the lower-left corner of the composition space. 

 

Bottoms 

Aligns the bottom edges of the selected sprites. If Relative to composition space is selected, aligns 
the bottom edges of the selected sprites with the bottom edge of the composition space. 

 

Lower-Right Corners 

Aligns the lower-right corners of the selected sprites. If Relative to composition space is selected, 
aligns the lower-right corners of the selected sprites with the lower-right corner of the composition 
space 

 

Touch Edges 

Positions the selected sprites so that at least one edge of each sprite touches an edge of the source 
sprite in the selection. If Relative to composition space is selected, positions the selected sprites so 
that one edge of the source sprite touches the nearest edge of the composition space. 

 

Order 

Orders the selected sprite in the stack: 

To Front  Moves the current sprite to the top of the stack. 

Before  Moves the selected sprite one position in front of 
the source sprite, which is surrounded by solid 
black handles. 

Behind  Moves the selected sprite one position in back of 
the source sprite, which is surrounded by solid 
black handles. 

To Back  Moves the current sprite to the bottom of the 
stack. 

Send Backward  Moves the current sprite one level back in the 
stack. 

Bring Forward  Moves the current sprite one level forward in the 
stack. 

 
 



Bring To Front 

Moves the current sprite to the top of the stack. 

 

Send To Back 

Moves the current sprite to the bottom of the stack. 

 

Bring Forward 

Moves the current sprite one level forward in the stack. 

 

Send Backward 

Moves the current sprite one level back in the stack. 

 

Relative to composition space 

Aligns the selected sprites with the composition space when you use one of the Align tools. 

 

Flip 

Flips the selected sprite horizontally, vertically, or both: 

 Flips the selected sprite on a horizontal axis. 

 Flips the selected sprite on a vertical axis. 

 Flips the selected sprite on horizontal and vertical axes. 
 
 

Flip Horizontal 

Flips the selected sprite on a horizontal axis. 

 

Flip Vertical 

Flips the selected sprite on a vertical axis. 

 

Flip Both 

Flips the selected sprite on horizontal and vertical axes. 

 

Rotate 90° 

Rotates the selected sprite in increments of 90 degrees: 

 Rotates the selected sprite 90 degrees to the left. 

 Rotates the selected sprite 90 degrees to the right. 

 Rotates the selected sprite 180 degrees, which produces the same 
result as Flip Both. 



 
 

Rotate Left 90 

Rotates the selected sprite 90 degrees to the left. 

 

Rotate Right 90 

Rotates the selected sprite 90 degrees to the right. 

 

Rotate 180 

Rotates the selected sprite 180 degrees, which produces the same result as Flip Both. 

 

Rotation 

Specifies the number of degrees that the selected sprite is rotated when you click Apply. To change 
the value, enter a number between -360 and 360. 

 

Width 

Displays the width of the selected sprite’s bounding box. The unit of measurement appears in the 
Units box. If the unit of measurement is pixels, this value must be between 1 and 4096. 

 

Height 

Displays the height of the selected sprite’s bounding box. The unit of measurement appears in the 
Units box. If the unit of measurement is pixels, this value must be between 1 and 4096. If Keep 
aspect ratio is selected, this value will match your Width entry. 

 

Units 

Specifies the unit of measurement for the values in the Width and Height boxes. The default value is 
Pixels, which measures the size of a sprite’s bounding box in pixels. To change the unit of 
measurement, click Percent, which measures the percentage of change in the size of a sprite’s 
bounding box. 

 

Keep aspect ratio 

When selected, maintains the ratio of height to width of the selected sprite when you change its 
Width or Height values. 

 

Fit Bounding Box 

Automatically sizes the bounding box around the perimeter of the selected sprite. In some 
circumstances, such as when you want to apply a texture transfer between two sprites that are the 
same size, you will use the Crop/Extend tool to enlarge the bounding box of a sprite, leaving a 
margin of transparent pixels. Use Fit Bounding Box to return the bounding box to its original size. 



 

Crop/Extend 

Cropping decreases the selected sprite by trimming its edges. Extending increases the size of the 
bounding box of the selected sprite by adding a margin of transparent pixels around the sprite. 

 

Perspective 

Applies two-point perspective to the selected sprite. 

 

Skew 

Tilts the selected sprite by shearing its opposing sides in opposite directions around its center. 

 

Bilinear 

Refits the selected sprite to its bounding box after you adjust the position of one or more corners of 
the box. 

 

Apply 

Applies the changes you have made without closing the palette. 

 

Color Tuning 

Displays controls for adjusting hue, saturation, brightness, and contrast. 

 

Highlight/Shadow 

Displays controls to alter the highlights, midtones, and shadows of the current sprite. 

 

Dynamic Range 

Displays controls to adjust the dynamic range of the current sprite’s pixels. 

 

All channels 

Specifies that all channels (red, green, and blue) are modified when altering the brightness or contrast 
properties of the current sprite. 

 

Red channel 

Specifies that the red channel is modified when altering the brightness or contrast properties of the 
current sprite. 

 



Green channel 

Specifies that the green channel is modified when altering the brightness or contrast properties of the 
current sprite. 

 

Blue channel 

Specifies that the blue channel is modified when altering the brightness or contrast properties of the 
current sprite. 

 

Brightness 

Specifies the degree of increase or decrease of brightness that can be applied to the current sprite. 
Values range from -100, which is very dark, to 100, which is very bright. 

 

Contrast 

Adjusts the amount of contrast that can be applied to the current sprite. Values range from -100 to 
100. Higher values increase contrast leading to a more sculptured look, lower values decrease 
contrast leading to a flatter look. 

 

Hue 

Adjusts the hue of the current sprite relative to its hue when this palette was displayed, not to other 
changes in hue applied with this control. Values range from -180 to 180. Hues are applied as if from a 
virtual circular color wheel, so values of -180 and 180 produce the same result.  

 

Saturation 

Adjusts the color saturation that can be applied to the current sprite. Values range from -100 to 100. 
Lower values remove color from the sprite, higher values intensify colors. 

 

All channels 

Specifies that all channels (red, green, and blue) are modified when altering the shadows, midtones, 
and highlights of the current sprite. 

 

Red channel 

Specifies that the red channel is modified when altering the shadows, midtones, and highlights of the 
current sprite. A red line appears in the Highlight/Shadows window indicating that you are editing only 
this channel. 

 

Green channel 

Specifies that the green channel is modified when altering the shadows, midtones, and highlights of 
the current sprite. A green line appears in the Highlight/Shadows window indicating that you are 
editing only this channel. 



 

Blue channel 

Specifies that the blue channel is modified when altering the shadows, midtones, and highlights of the 
current sprite. A blue line appears in the Highlight/Shadows window indicating that you are editing 
only this channel. 

 

Compensation Curves window 

Displays a diagonal line or lines with handles for shadow intensity (bottom), midtone intensity 
(middle), and highlight intensity (top). Each handle can be dragged upward and to the right to 
increase intensity, or downward and to the left to decrease intensity. When you click an individual 
color channel in the Channels buttons, the curve for each channel can be manipulated separately. 

 

High Output Range box 

Displays the highest pixel intensity setting for the current sprite. Values range from 0 to 255. 
Decreasing the value from the default of 255 creates a brighter, less detailed result.  

 

Low Output Range box 

Displays the lowest pixel intensity setting for the current sprite. Values range from 0 to 255. 
Increasing the value from the default of 0 produces a darker, more dense result. 

 

Histogram window 

Graphically displays the dynamic range settings of the current sprite. The horizontal axis represents 
the range of intensity from the lowest setting on the left side of the window, to the highest setting on 
the right side of the window. The vertical axis represents the number of pixels and their given intensity 
levels. Moving the left bar to the right increases the low range, darkening the selected sprite. Moving 
the right bar to the left decreases the upper range, lightening the sprite. 

 

Zoom In 

Increases the vertical scale of the histogram. 

 

Zoom Out 

Reduces the vertical scale of the histogram. 

 

Auto Maximize 

Moves the vertical bars in the Histogram window to the borders of the histogram to take advantage 
of the dynamic range of the current sprite. 

 

Apply 



Applies all of the changes made on the Color Tuning tool palette, from the Color Controls, 
Highlight/Shadows, and Dynamic Range groups, simultaneously to the selected sprite. 

 

Reset 

Resets all of the Color Controls, Highlight/Shadows, or Dynamic Range setting to their original 
values and reverts the selected sprite to its original state, discarding all color tuning changes you 
have made.  

 

Quick Color Picker 

Allows you to change the current color. The Quick Color Picker displays the last palette you selected 
in the Color Picker dialog box. To change the palette that displays in the Quick Color Picker, click 
the Color Swatch and select a different palette in the Color Picker dialog box. 

 

Palette name 

Specifies the name of the custom palette. To create a new palette, type a name in this box in the New 
Color Palette dialog box. To change the name of an existing palette, type the new name in this box in 
the Edit Color Palette dialog box. 

 

Palette size 

Specifies the number of color entries on the current palette. If you are creating a new palette, type a 
number from 2 to 256 or select a predefined palette size from this list. You cannot change the palette 
size of an existing palette. 

 

Dither by 

Specifies the type of dithering used to adjust colors if the display system is unable to exactly 
reproduce the specified color. Select one of the three dithering methods, or select Solid for no 
dithering. 

 

Number of colors 

Specifies the number of colors that will be added to the custom palette from the color ramp or palette 
shown in the Generate from list.  

 

Number of colors range 

Displays the minimum and maximum numbers of colors you can add to your custom palette. The 
minimum number is the number of color entries needed by the ramp or palette shown in the Generate 
from list. The maximum number is the number of empty color entries on your custom palette. 

 

Generate from list 

Specifies the name of the ramp or palette to select colors from. You can generate colors from the 
standard palettes and ramps provided with Microsoft Image Composer, or you can generate colors 



from the current composition or selected sprites. 

 

Add 

Adds the specified number of colors from the selected ramp or palette to the custom palette. 

 

Close 

Closes this dialog box and returns to the Custom Palette tab. 

 

Color matrix (hue/blackness) 

Displays the true colors you can select for a color entry in your custom palette. To select a hue, click 
a color in the matrix or use the handles along the top of the matrix. To adjust the amount of black in 
the color, move the handle along the left side of the matrix. The color you select appears in the New 
color to use box. 

 

Color matrix (hue/whiteness) 

Displays the selected color with increasing amounts of white added to it. To adjust the the amount of 
white in the color, click a color in the matrix or use the handle along the right side. If you move the 
handle to the bottom, the color becomes pure white. The color you select appears in the New color 
to use box. 

 

Original color used 

Displays the selected color entry on your custom palette. 

 

New color to use 

Displays the color you selected in the color matrix. This color will replace the selected color entry on 
your custom palette. 

 

Revert 

Resets the color in the New color to use box to the color in the Original color used box. 

 

RGB 

Displays the Red, Green, and Blue values used in the RGB color model. You can adjust these values 
to define the color for the selected color entry in your custom palette. 

 

HSV 

Displays the Hue, Saturation, and Value values used in the HSV color model. You can adjust these 
values to define the color for the selected color entry in your custom palette. 



 

Red/Hue 

If you selected the RGB option, this box specifies the value (0 to 255) for the amount of red in the 
color shown in the New color to use box. If you selected the HSV option, this box specifies the value 
(0 to 359) for the hue in the color shown in the New color to use box. 

 

Green/Saturation 

If you selected the RGB option, this box specifies the value (0 to 255) for the amount of green in the 
color shown in the New color to use box. If you selected the HSV option, this box specifies the value 
(0 to 100) for the saturation in the color shown in the New color to use box. 

 

Blue/Value 

If you selected the RGB option, this box specifies the value (0 to 255) for the amount of blue in the 
color shown in the New color to use box. If you selected the HSV option, this box specifies the value 
(0 to 100) for the intensity in the color shown in the New color to use box. 

 

Eyedropper 

Lets you pick any color on your desktop or view the RGB or HSV values of the color that you point to. 
To pick a color, click Eyedropper and then click a color on your desktop. To choose an averaged 
color from an area on the screen, click this button and then drag a rectangle around the area on the 
desktop that you want to average. 

 

Pixel coordinates 

Displays the horizontal (x-axis) and vertical (y-axis) screen coordinates of the pixel you are pointing to 
with the Eyedropper. 

 

Apply 

Closes the Choose Color dialog box and displays the selected color entry on your custom palette. 

 

Cancel 

Closes the Choose Color dialog box without changing the selected color entry on your custom 
palette. 

 

Effects 

Displays the effects available for the last category you selected. To change the settings for an effect, 
click that effect and then click the Details tab. 

 

Effects 



Displays the effects available for the selected category. To apply an effect, click the effect in this list, 
and then click Apply. To change the settings for an effect, click the effect in this list, and then click the 
Details tab. 

 

Category 

Displays a list of effects categories. Select a category to change the effects shown at left. 

 

Apply 

Applies the selected effect without closing the palette. 

 

Details 

Displays the settings that you can change for the effect you selected on the Effects tab. 

 

Edge width slider 

Adjusts the width of the edges in the selected sprite when the Accents effect is applied. To increase 
the edge width, move the slider to the right and then click Apply. 

 

Edge width box 

Specifies the width of the edges in the selected sprite when the Accents effect is applied. The default 
value is 2. Higher values create broader edges. To change the value, enter a number between 1 and 
14, and then click Apply. 

 

Edge brightness slider 

Adjusts the brightness of the edges in the selected sprite when the Accents effect is applied. To 
increase the edge brightness, move the slider to the right and then click Apply. 

 

Edge brightness box 

Specifies the brightness of the edges in the selected sprite when the Accents effect is applied. The 
default value is 38. Higher values create brighter edges. To change the value, enter a number 
between 0 and 50, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Accents effect. To make the effect appear smoother and less 
detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Accents effect. The default value is 5. Higher values create 
smoother effects. To change the value, enter a number between 1 and 15, and then click Apply. 



 

Opacity slider 

Adjusts the amount of opacity for the selected effect. Low opacity values create a more transparent 
effect, retaining more of the sprite's original look. High opacity values create more detailed, defined 
effects. To decrease the amount of opacity, move the slider to the left; to increase the amount of 
opacity, move the slider to the right. Then click Apply 

 

Opacity box 

Specifies the opacity value of the effect you want. Low opacity values create a more transparent 
effect, retaining more of the sprite's original look. High opacity values create more detailed, defined 
effects. To change the value, enter a number between 1 and 100, and then click Apply. 

 

Use Default 

Resets the controls for the selected effect to their default values. 

 

Direction balance slider 

Adjusts the percentage of right diagonal strokes for the Angled Strokes effect. Move the slider to the 
left to increase the percentage of left diagonal strokes or to the right to increase the percentage of 
right diagonal strokes, and then click Apply. 

 

Direction balance box 

Specifies the percentage of right diagonal strokes for the Angled Strokes effect. The default value is 
50. Higher values add more right diagonal strokes; lower values add more left diagonal strokes. To 
change the value, enter a number between 0 and 100, and then click Apply. 

 

Stroke length slider 

Adjusts the stroke length of the Angled Strokes effect. To create longer strokes, move the slider to 
the right and then click Apply. 

 

Stroke length box 

Specifies the stroke length of the Angled Strokes effect. The default value is 15. Higher values 
create longer strokes. To change the value, enter a number between 3 and 50, and then click Apply. 

 

Sharpness slider 

Adjusts the sharpness and detail of the Angled Strokes effect. To make the effect appear sharper 
and more detailed, move the slider to the right and then click Apply. 

 

Sharpness box 



Specifies the sharpness of the Angled Strokes effect. The default value is 3. Higher values create 
sharper, more detailed effects; low values create a soft effect. To change the value, enter a number 
between 0 and 10, and then click Apply. 

 

Detail slider 

Adjusts the amount of detail in the surface modulations of the Bas Relief effect. To increase the 
amount of detail, move the slider to the right and then click Apply. 

 

Detail box 

Specifies the degree of detail of surface modulations applied with the Bas Relief effect. The default 
value is 13. Higher values create sharper, more detailed effects; lower values create a soft effect. To 
change the value, enter a number between 1 and 15, and then click Apply. 

 

Light position 

Displays the position of the light source that determines where highlights and shadows appear on the 
selected sprite when the Bas Relief effect is applied. To change the position, click a different item in 
this list, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the surface of the Bas Relief effect. To make the effect appear 
smoother and less detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the surface smoothness of the Bas Relief effect. The default value is 3. Higher values 
create a smoother, less detailed effect; lower values create a more textured, detailed effect. To 
change the value, enter a number between 1 and 15, and then click Apply. 

 

Horizontal 

Specifies the number of pixels by which the sprite expands to the left and to the right when you blur it 
with the Blur effect. The default value is 5. Higher values create a blurrier effect; lower values retain 
more of the sprite’s original appearance. To change the value, enter a number between 0 and 100, 
and then click Apply. 

 

Vertical 

Specifies the number of pixels by which the sprite expands to the top and to the bottom when you blur 
it with the Blur effect. The default value is 5. Higher values create a blurrier effect; lower values retain 
more of the sprite’s original appearance. To change the value, enter a number between 0 and 100, 
and then click Apply. 

 

Tile size slider 



Adjusts the size of the tiles applied to the selected sprite with the Broken Tile effect. To increase the 
tile size, move the slider to the right and then click Apply. 

 

Tile size box 

Specifies the tile size of the Broken Tile effect. The default value is 12. Higher values create larger 
tiles. To change the value, enter a number between 2 and 100, and then click Apply. 

 

Grout width slider 

Adjusts the amount of space between the tiles when the Broken Tile effect is applied to the selected 
sprite. To increase the amount of space between tiles, move the slider to the right and then click 
Apply. 

 

Grout width box 

Specifies the grout width of the Broken Tiles effect. The default value is 3. Higher values create 
wider grout lines between tiles. To change the value, enter a number between 1 and 15, and then 
click Apply. 

 

Lighten grout slider 

Adjusts the color of the grout between tiles when the Broken Tiles effect is applied to the selected 
sprite. To lighten the grout color, move the slider to the right and then click Apply. 

 

Lighten grout box 

Specifies the lightness of the grout of the Broken Tiles effect. The default value is 9. Higher values 
lighten the color of the grout lines. To change the value, enter a number between 0 and 10, and then 
click Apply. 

 

Warp direction 

On the Effects palette, specifies the direction of the Bulge and Mesa effects. To swell the middle 
area of the selected sprite, click Out. To cave in the middle area of the sprite, click In. 

On the Paint palette, the Mesa effect is applied only to the area that is painted, not to the entire 
sprite. The Bulge effect is not available on the Paint palette. 

 

Charcoal area slider 

Adjusts the area of the selected sprite drawn with charcoal strokes for the Chalk and Charcoal 
effect. To increase this area, move the slider to the right and then click Apply. 

 

Charcoal area box 

Specifies the area of the selected sprite drawn with charcoal strokes for the Chalk and Charcoal 
effect. The default value is 6. Higher values create more sketch strokes in the current color. To 



change the value, enter a number between 0 and 20, and then click Apply. 

 

Chalk area slider 

Adjusts the area of the selected sprite drawn with chalk in the current color strokes for the Chalk and 
Charcoal effect. To increase this area, move the slider to the right and then click Apply. 

 

Chalk area box 

Specifies the area of the selected sprite drawn with chalk strokes in the current color for the Chalk 
and Charcoal effect. The default value is 6. Higher values create more sketch strokes in white. To 
change the value, enter a number between 0 and 20, and then click Apply. 

 

Stroke pressure slider 

Adjusts the stroke pressure of the Chalk And Charcoal effect. Move the slider to alter the darkness 
and definition of the stroke, and then click Apply 

 

Stroke pressure box 

Specifies the amount of stroke pressure of the Chalk And Charcoal effect. The default value is 1. 
Higher values create strokes that appear to be applied with greater pressure. To change the value, 
enter a number between 0 and 5, and then click Apply. 

 

Charcoal thickness slider 

Specifies the thickness of the charcoal applied with the Charcoal effect. To increase the thickness, 
move the slider to the right and then click Apply. 

 

Charcoal thickness box 

Specifies the thickness of the charcoal applied with the Charcoal effect. The default value is 1. 
Higher values create denser sketch strokes in the current color. To change the value, enter a number 
between 1 and 7, and then click Apply. 

 

Detail slider 

Adjusts the amount of detail retained in the selected sprite when the Charcoal effect is applied. To 
increase the amount of detail, move the slider to the right and then click Apply. 

 

Detail box 

Specifies the degree of detail retained in the selected sprite when the Charcoal effect is applied. The 
default value is 5. Higher values retain more of the details. To change the value, enter a number 
between 0 and 5, and then click Apply. 

 



Light/Dark Balance slider 

Adjusts the percentage of dark areas in the sprite when the Charcoal effect is applied. Move the 
slider to the left to lighten the effect or to the right to darken the effect, and then click Apply. 

 

Light/Dark balance box 

Specifies the percentage of dark areas in the sprite when the Charcoal effect is applied. The default 
value is 50. Values above 50 darken the effect; values below 50 lighten the effect. To change the 
value, enter a number between 0 and 100, and then click Apply. 

 

Width 

Specifies the width of each square for the Checkerboard effect or each stripe for the Stripes effect. 
The default value is 10. Higher values increase the width. To change the value, enter a number 
between 1 and 120, and then click Apply. 

 

Height 

Specifies the height of each square for the Checkerboard effect. The default value is 10. Higher 
values increase the height. To change the value, enter a number between 1 and 120, and then click 
Apply. 

 

Match width and height 

When selected for the Checkerboard effect, maintains the ratio of height to width of each checker. 

Match width and spacing 

When selected for the Stripes effect, makes the spacing between stripes equal to the width of each 
stripe. 

 

Detail slider 

Adjusts the amount of detail retained in the selected sprite when the Chrome effect is applied. To 
increase the amount of detail, move the slider to the right and then click Apply. 

 

Detail box 

Specifies the degree of detail retained in the selected sprite when the Chrome effect is applied. The 
default value is 4. Higher values create a more intricate, shimmering effect. To change the value, 
enter a number between 0 and 10, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Chrome effect. To make the effect appear smoother and less 
detailed, move the slider to the right and then click Apply. 

 



Smoothness box 

Specifies the overall smoothness of the Chrome effect. The default value is 7. Higher values create 
smooth, rounded contours; lower values create a more detailed effect. To change the value, enter a 
number between 0 and 10, and then click Apply. 

 

Number of levels slider 

Adjusts the level of detail and color retained in the selected sprite when the Cutout effect is applied. 
To retain more of the sprite’s original appearance, move the slider to the right and then click Apply. 

 

Number of levels box 

Specifies the number of levels of detail and color retained in the selected sprite when the Cutout 
effect is applied. The default value is 4. Higher values retain more of the sprite’s original appearance. 
To change the value, enter a number between 2 and 8, and then click Apply. 

 

Edge simplicity slider 

Adjusts the level of edge detail retained in the selected sprite when the Cutout effect is applied. To 
retain more of the edge detail, move the slider to the left, and then click Apply. 

 

Edge simplicity box 

Specifies the level of edge detail retained in the selected sprite when the Cutout effect is applied. The 
default value is 4. Higher values simplify the edges and create a less detailed appearance. To change 
the value, enter a number between 0 and 10, and then click Apply. 

 

Edge fidelity slider 

Adjusts the level of fidelity to the selected sprite’s contours when the Cutout effect is applied. To 
follow the original contours of the selected sprite more closely, move the slider to the right and then 
click Apply. 

 

Edge fidelity box 

Specifies the level of fidelity to the selected sprite’s contours when the Cutout effect is applied. The 
default value is 2. Higher values create edge contours that closely resemble those of the original 
sprite. To change the value, enter a number between 1 and 3, and then click Apply. 

 

Pencil width slider 

Adjusts the width of each pencil stroke for the Colored Pencil effect. To increase the pencil width, 
move the slider to the right and then click Apply. 

 

Pencil width box 

Specifies the width of each pencil stroke for the Colored Pencil effect. The default value is 4. Higher 



values create broader strokes. To change the value, enter a number between 1 and 24, and then click 
Apply. 

 

Stroke pressure slider 

Adjusts the pressure of each pencil stroke for the Colored Pencil effect. To increase the appearance 
of greater pressure, move the slider to the right and then click Apply. 

 

Stroke pressure box 

Specifies the pressure of each pencil stroke for the Colored Pencil effect. The default value is 8. 
Higher values create strokes that appear to be applied with greater pressure. To change the value, 
enter a number between 0 and 15, and then click Apply. 

 

Paper brightness slider 

Adjusts the shade of gray background paper for the Colored Pencil effect. To brighten the color of 
the background paper, move the slider to the left and then click Apply. 

 

Paper brightness box 

Specifies the degree of brightness of the gray background paper for the Colored Pencil effect. The 
default value is 25. Higher values create darker shades of gray. To change the value, enter a number 
between 0 and 50, and then click Apply. 

 

Foreground level slider 

Adjusts the area of the selected sprite drawn with crayon strokes in the current color for the Conté 
Crayon effect. To increase this area, move the slider to the right and then click Apply. 

 

Foreground level box 

Specifies the area of the selected sprite drawn with crayon strokes in the current color for the Conté 
Crayon effect. The default value is 11. Higher values create heavier color coverage. To change the 
value, enter a number between 1 and 15, and then click Apply. 

 

Background level slider 

Adjusts the area of the selected sprite blended with the background color for the Conté Crayon 
effect. To increase this area, move the slider to the right and then click Apply. 

 

Background level box 

Specifies the area of the selected sprite blended with the background color for the Conté Crayon 
effect. The default value is 7. Higher values increase the amount of background area that uses the 
color of the composition space. To change the value, enter a number between 1 and 15, and then 
click Apply. 



 

Texture Controls 

Displays the Texture Controls dialog box, where you can specify the type of texture to use for this 
effect and set its related options. 

 

Stroke length slider 

Adjusts the stroke length of the Crosshatch effect. To create longer strokes, move the slider to the 
right and then click Apply. 

 

Stroke length box 

Specifies the stroke length of the Crosshatch effect. The default value is 9. Higher values create 
longer strokes. To change the value, enter a number between 3 and 50, and then click Apply. 

 

Sharpness slider 

Adjusts the sharpness and detail of the Crosshatch effect. To make the effect appear sharper and 
more detailed, move the slider to the right and then click Apply. 

 

Sharpness box 

Specifies the sharpness of the Crosshatch effect. The default value is 6. Higher values create 
sharper, more detailed effects; lower values create a soft effect. To change the value, enter a number 
between 0 and 20, and then click Apply. 

 

Strength slider 

Adjusts the number of times the Crosshatch effect is applied in succession. To increase this number, 
move the slider to the right and then click Apply. 

 

Strength box 

Specifies the number of times the Crosshatch effect is applied in succession. The default value is 1. 
A higher value increases the degree of crosshatching on the selected sprite. To change the value, 
enter a number between 1 and 3, and then click Apply. 

 

Balance slider 

Adjusts the proportion of dark strokes to light strokes in the selected sprite when the Dark Strokes 
effect is applied. To increase the area painted with dark strokes, move the slider to the right; to 
increase the area painted with light strokes, move the slider to the left. Then click Apply. 

 

Balance box 

Specifies the proportion of dark strokes to light strokes in the selected sprite when the Dark Strokes 



effect is applied. The default value is 5. Higher values increase the area painted with dark strokes; 
lower values increase the area painted with light strokes. To change the value, enter a number 
between 0 and 10, and then click Apply. 

 

Black intensity slider 

Adjusts the amount of black in the dark strokes when the Dark Strokes effect is applied to the 
selected sprite. To increase the black intensity, move the slider to the right and then click Apply. 

 

Black intensity box 

Specifies the amount of black in the dark strokes when the Dark Strokes effect is applied to the 
selected sprite. The default value is 6. Higher values increase the degree of black intensity. To 
change the value, enter a number between 0 and 10, and then click Apply. 

 

White intensity slider 

Adjusts the amount of white in the light strokes when the Dark Strokes effect is applied to the 
selected sprite. To increase the white intensity, move the slider to the right and then click Apply. 

 

White intensity box 

Specifies the amount of white in the light strokes when the Dark Strokes effect is applied to the 
selected sprite. The default value is 2. Higher values increase the degree of white intensity. To 
change the value, enter a number between 0 and 10, and then click Apply. 

 

Graininess slider 

Adjusts the degree of graininess for the Diffuse Glow effect. To increase the graininess, move the 
slider to the right and then click Apply. 

 

Graininess box 

Specifies the degree of graininess for the Diffuse Glow effect. The default value is 6. Higher values 
increase the graininess; lower values retain more of the sprite’s original appearance. To change the 
value, enter a number between 0 and 10, and then click Apply. 

 

Glow amount slider 

Adjusts the area of the selected sprite that is affected by the Diffuse Glow effect. To increase the 
area, move the slider to the right and then click Apply. 

 

Glow amount box 

Specifies the area of the selected sprite that is affected by the Diffuse Glow effect. The default value 
is 10. Higher values increase the amount of glow added to the sprite. To change the value, enter a 
number between 0 and 20, and then click Apply. 



 

Clear amount slider 

Adjusts the diffusion of the highlights applied with the Diffuse Glow effect. To increase the diffusion, 
move the slider to the left and then click Apply. 

 

Clear amount box 

Specifies the degree of diffusion of the highlights applied with the Diffuse Glow effect. The default 
value is 15. Higher values result in less diffused highlights, while a setting of 0 replaces all color pixels 
with white. To change the value, enter a number between 0 and 20, and then click Apply. 

 

Directions 

Specify the direction of the light source on the selected sprite for the Drop Shadow effect. To change 
the placement of the drop shadow, click the North, Northeast, East, Southeast, South, Southwest, 
West, or Northwest button. 

 

Distance slider 

Adjusts the depth of the selected sprite’s shadow for the Drop Shadow effect. To increase the depth, 
move the slider to the right and then click Apply. 

 

Distance box 

Specifies the depth of the selected sprite’s shadow for the Drop Shadow effect. The default value is 
10 pixels. Higher values increase the offset of the drop shadow. To change the value, enter a number 
between 0 and 100, and then click Apply. 

 

Angle 

Specifies the direction of the selected sprite’s shadow for the Drop Shadow effect. The default value 
is 315 degrees, which creates a drop shadow in a southeast direction. To change the value, enter a 
number between 0 and 359, and then click Apply. 

 

Color 

Displays the color of the selected sprite’s edge for the Edge and Edge Only effects. To change the 
color, click the color chip to open the Color Picker dialog box, or right-click to open the Quick Color 
Picker. 

 

Color 

Displays the color of the selected sprite’s shadow for the Drop Shadow effect. To change the color, 
click the color chip to open the Color Picker dialog box, or right-click to open the Quick Color 
Picker. 

 



Softness 

Adjusts the softness of the Drop Shadow effect. To blend the drop shadow with the background, 
move the slider toward Soft and then click Apply. 

 

Brush size slider 

Adjusts the size of the brush used to apply the Dry Brush effect. To increase the brush size, move 
the slider to the right and then click Apply. 

 

Brush size box 

Specifies the size of the brush used to apply the Dry Brush effect. The default value is 2. Higher 
values create larger, less detailed brush strokes. To change the value, enter a number between 0 and 
10, and then click Apply. 

 

Brush detail slider 

Adjusts the amount of detail in the paint strokes for the Dry Brush effect. To increase the amount of 
detail, move the slider to the right and then click Apply. 

 

Brush detail box 

Specifies the amount of detail in the paint strokes for the Dry Brush effect. The default value is 8. 
Higher values create greater brush stroke detail. To change the value, enter a number between 0 and 
10, and then click Apply. 

 

Texture slider 

Adjusts the amount of roughness in the texture of the Dry Brush effect. To increase the roughness, 
move the slider to the right and then click Apply. 

 

Texture box 

Specifies the amount of roughness in the texture of the Dry Brush effect. The default value is 1. 
Higher values create rougher textures. To change the value, enter a number between 1 and 3, and 
then click Apply. 

 

Thickness slider 

Adjusts the thickness of the outline for the Edge and Edge Only effects. To increase the thickness, 
move the slider to the right and then click Apply. 

 

Thickness box 

Specifies the thickness of the outline for the Edge and Edge Only effects. The default value is 1. 
Higher values create thicker outlines. To change the value, enter a number between 1 and 100, and 
then click Apply. 



 

Relief slider 

Adjusts the degree of relief (contrast due to texture) applied to the selected sprite with the Emboss 
effect. To increase the degree of relief, move the slider to the right and then click Apply. 

 

Relief box 

Specifies the degree of relief (contrast due to texture) applied to the selected sprite with the Emboss 
effect. The default value is 11. Higher values create more contrast between the surface elements of 
the sprite and increase its three-dimensional appearance. To change the value, enter a number 
between 0 and 25, and then click Apply. 

 

Light position 

Displays the position of the light source used by Emboss effect to determine where highlights and 
shadows appear on the selected sprite. To change the position, click a different item in the list, and 
then click Apply. 

 

Grain slider 

Adjusts the degree of graininess applied with the Film Grain effect. To increase the graininess, move 
the slider to the right and then click Apply. 

 

Grain box 

Specifies the degree of graininess applied with the Film Grain effect. The default value is 4. Higher 
values increase the graininess; lower values retain more of the sprite’s original appearance. To 
change the value, enter a number between 0 and 20, and then click Apply. 

 

Highlight area slider 

Adjusts the area of the selected sprite that is highlighted when the Film Grain effect is applied. To 
increase the highlighted area, move the slider to the right and then click Apply. 

 

Highlight area box 

Specifies the area of the selected sprite that is highlighted when the Film Grain effect is applied. The 
default value is 0. Higher values add more highlights to the sprite. To change the value, enter a 
number between 0 and 20, and then click Apply. 

 

Highlight intensity slider 

Adjusts the brightness of the highlights added by the Film Grain effect. To increase the brightness, 
move the slider to the right and then click Apply. 

 

Highlight intensity box 



Specifies the brightness of the highlights added by the Film Grain effect. The default value is 10. 
Higher values create brighter highlights. To change the value, enter a number between 0 and 10, and 
then click Apply. 

 

Stroke length slider 

Adjusts the stroke length of the Fine Marker effect. To create longer strokes, move the slider to the 
right and then click Apply. 

 

Stroke length box 

Specifies the stroke length of the Fine Marker effect. The default value is 4. Higher values create 
longer strokes. To change the value, enter a number between 1 and 50, and then click Apply. 

 

Dark intensity slider 

Adjusts the darkness of the darker tones for the Fine Marker effect. To increase the intensity of the 
darker tones, move the slider to the right and then click Apply. 

 

Dark intensity box 

Specifies the value of the dark tones for the Fine Marker effect. The default value is 20. Higher 
values increase the intensity of the dark tones. To change the value, enter a number between 0 and 
50, and then click Apply. 

 

Light intensity slider 

Adjusts the lightness of the lighter tones for the Fine Marker effect. To increase the intensity of the 
light tones, move the slider to the right and then click Apply. 

 

Light intensity box 

Specifies the value of the light tones for the Fine Marker effect. The default value is 10. Higher values 
increase the intensity of the light tones. To change the value, enter a number between 0 and 50, and 
then click Apply. 

 

Spread amount 

Specifies the amount of spread for the Fisheye effect. The default value is 150. Higher values cause 
the center of the selected sprite to spread, pushing the edges of the sprite toward the sides of the 
bounding box. Lower settings cause the center of the selected sprite to shrink and the lower-left and 
upper-right corners of the sprite to elongate. To change the value, enter a number from 0 to 1000, 
and then click Apply. 

 

Image balance slider 

Adjusts the proportion of current color to composition space color for the Flocking effect. To use 
more of the current color, move the slider to the right; to use more of the composition space color, 



move the slider to the left. Then click Apply. 

 

Image balance box 

Specifies the proportion of current color to composition space color for the Flocking effect. The 
default value is 25. Values above 25 use more of the current color; values below 25 use more of the 
composition space color. To change the value, enter a number between 0 and 50, and then click 
Apply. 

 

Graininess slider 

Adjusts the degree of graininess for the Flocking effect. To increase the graininess, move the slider 
to the right and then click Apply. 

 

Graininess box 

Specifies the degree of graininess for the Flocking effect. The default value is 10. Higher values 
increase the graininess; lower values retain more of the sprite’s original appearance. To change the 
value, enter a number between 0 and 20, and then click Apply. 

 

Relief slider 

Adjusts the degree of relief (contrast due to texture) applied to the selected sprite with the Flocking 
effect. To increase the degree of relief, move the slider to the right and then click Apply. 

 

Relief box 

Specifies the degree of relief (contrast due to texture) applied to the selected sprite with the Flocking 
effect. The default value is 11. Higher values create more contrast between the surface elements of 
the sprite and increase its three-dimensional appearance. To change the value, enter a number 
between 0 and 25, and then click Apply. 

 

Brush size slider 

Adjusts the size of the brush used to apply the Fresco effect. To increase the brush size, move the 
slider to the right and then click Apply. 

 

Brush size box 

Specifies the size of the brush used to apply the Fresco effect. The default value is 2. Higher values 
create larger, coarser brush strokes. To change the value, enter a number between 0 and 10, and 
then click Apply. 

 

Brush detail slider 

Adjusts the amount of detail in the paint strokes for the Fresco effect. To increase the amount of 
detail, move the slider to the right and then click Apply. 



 

Brush detail box 

Specifies the amount of detail in the paint strokes for the Fresco effect. The default value is 8. Higher 
values create greater brush stroke detail. To change the value, enter a number between 0 and 10, 
and then click Apply. 

 

Texture slider 

Adjusts the amount of roughness in the texture of the Fresco effect. To increase the roughness, 
move the slider to the right and then click Apply. 

 

Texture box 

Specifies the amount of roughness in the texture of the Fresco effect. The default value is 1. Higher 
values create rougher textures. To change the value, enter a number between 1 and 3, and then click 
Apply. 

 

Image balance slider 

Adjusts the proportion of current color to composition space color for the Torn Edges effect. To use 
more of the current color, move the slider to the right; to use more of the composition space color, 
move the slider to the left. Then click Apply. 

 

Image balance box 

Specifies the proportion of current color to composition space color for the Torn Edges effect. The 
default value is 25. Values above 25 use more of the current color; values below 25 use more of the 
composition space color. To change the value, enter a number between 0 and 50, and then click 
Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Torn Edges effect. To make the effect appear smoother and 
less detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Torn Edges effect. The default value is 11. Higher values 
create smoother effects. To change the value, enter a number between 1 and 15, and then click 
Apply. 

 

Contrast slider 

Adjusts the amount of contrast between light and dark tones for the Torn Edges effect. To increase 
the contrast, move the slider to the right and then click Apply. 

 



Contrast box 

Specifies the contrast value between light and dark tones for the Torn Edges effect. The default 
value is 17. Higher values create brighter tones. To change the value, enter a number between 1 and 
25, and then click Apply. 

 

Distortion slider 

Adjusts the degree of distortion applied to the selected sprite with the Glass effect. To increase the 
amount of distortion, move the slider to the right and then click Apply. 

 

Distortion box 

Specifies the degree of distortion applied to the selected sprite with the Glass effect. The default 
value is 5. Higher values create greater levels of distortion. To change the value, enter a number 
between 0 and 20, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the selected glass surface of the Glass effect. To make the effect 
appear smoother and less detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Glass effect. The default value is 3. Higher values create 
smoother, less detailed effects. To change the value, enter a number between 1 and 15, and then 
click Apply. 

 

Surface Controls 

Displays the Glass Surface Controls dialog box, where you can specify the type of glass to use for 
this effect and set its related options. 

 

Edge width slider 

Adjusts the width of the edges in the selected sprite when the Glowing Accents effect is applied. To 
increase the edge width, move the slider to the right and then click Apply. 

 

Edge width box 

Specifies the width of the edges in the selected sprite when the Glowing Accents effect is applied. 
The default value is 2. Higher values create broader edges. To change the value, enter a number 
between 1 and 14, and then click Apply. 

 

Edge brightness slider 

Adjusts the brightness of the edges of the selected sprite when the Glowing Accents effect is 
applied. Move the slider to adjust the edge brightness, and then click Apply. 



 

Edge brightness box 

Specifies the brightness of the edges in the selected sprite when the Glowing Accents effect is 
applied. The default value is 6. Higher values create brighter edges. To change the value, enter a 
number between 0 and 20, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Glowing Accents effect. To make the effect appear smoother 
and less detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Glowing Accents effect. The default value is 5. Higher 
values create smoother, more rounded contours. To change the value, enter a number between 1 
and 15, and then click Apply. 

 

Graininess slider 

Adjusts the graininess for the Grain effect. To increase the graininess, move the slider to the right 
and then click Apply. 

 

Graininess box 

Specifies the degree of graininess for the Grain effect. The default value is 40. Higher values 
increase the graininess; lower values retain more of the sprite’s original appearance. To change the 
value, enter a number between 0 and 100, and then click Apply. 

 

Grain type 

Displays a list of grain types for the Grain effect. To change the grain type, select a different item 
from the list and then click Apply. 

 

Contrast slider 

Adjusts the amount of contrast for the Grain effect. To increase the contrast, move the slider to the 
right and then click Apply. 

 

Contrast box 

Specifies the contrast value for the Grain effect. The default value is 50. Higher values create brighter 
highlights and dark tones. To change the value, enter a number between 0 and 100, and then click 
Apply. 

 

Size slider 



Adjusts the size of the screen for the Halftone Screen effect. To increase the screen size, move the 
slider to the right and then click Apply. 

 

Size box 

Specifies the size of the screen for the Halftone Screen effect. The default value is 1. Higher values 
create larger halftone dots, circles, or lines. To change the value, enter a number between 1 and 12, 
and then click Apply. 

 

Screen type 

Displays a list of screen types for the Halftone Screen effect. To change the screen type, click 
Circle, Dot, or Line, and then click Apply. 

 

Contrast slider 

Adjusts the contrast between light and dark halftones for the Halftone Screen effect. To increase the 
contrast, move the slider to the right and then click Apply. 

 

Contrast box 

Specifies the contrast between light and dark halftones for the Halftone Screen effect. The default 
value is 5. Higher contrast values create brighter highlights and darker dark tones. To change the 
value, enter a number between 0 and 50, and then click Apply. 

 

Stroke width slider 

Adjusts the width of each brush stroke for the Sumi-e (pronounced sue-me-ay) effect. To increase the 
width of the brush stroke, move the slider to the right and then click Apply. 

 

Stroke width box 

Specifies the width of each brush stroke for the Sumi-e (pronounced sue-me-ay) effect. The default 
value is 10. Higher values create broader brush strokes. To change the value, enter a number 
between 3 and 15, and then click Apply. 

 

Stroke pressure slider 

Adjusts the pressure of the brush strokes for the Sumi-e (pronounced sue-me-ay) effect. To make the 
brush strokes appear coarser, move the slider to the right and then click Apply. 

 

Stroke pressure box 

Specifies the pressure of the brush strokes for the Sumi-e (pronounced sue-me-ay) effect. The 
default value is 2. Higher values create strokes that appear to have been applied with greater 
pressure. To change the value, enter a number between 0 and 15, and then click Apply. 

 



Contrast slider 

Adjusts the contrast of the Sumi-e (pronounced sue-me-ay) effect. To increase the contrast, move 
the slider to the right and then click Apply. 

 

Contrast box 

Specifies the contrast of the Sumi-e (pronounced sue-me-ay) effect. The default value is 16. Higher 
values create greater contrast. To change the value, enter a number between 0 and 40, and then 
click Apply. 

 

Radius factor % 

On the Effects palette, specifies the size of the radius of the truncated cone created by the Mesa 
effect. The default value is 70. With Warp Direction set to Out, higher values cause the edges of the 
selected sprite to become more circular and the center to bulge out. With Warp Direction set to In, 
higher values cause the center of the selected sprite to shrink and the edges to elongate. To change 
the value, enter a number from 0 to 100, and then click Apply. 

On the Paint palette, the Mesa effect is applied only to the area that is painted, not to the entire 
sprite. 

 

Square size slider 

Adjusts the size of each square tile for the Mosaic effect. To increase the size of each square, move 
the slider to the right and then click Apply. 

 

Square size box 

Specifies the size of each square tile for the Mosaic effect. Higher values create larger tiles. The 
default value is 4 pixels. To change the value, enter a number between 0 and 10, and then click 
Apply. 

 

Relief slider 

Adjusts the degree of relief (contrast due to the projection of the mosaic tiles) for the Mosaic effect To 
increase the degree of relief, move the slider to the right and then click Apply. 

 

Relief box 

Specifies the degree of relief (contrast due to the projection of the mosaic tiles) for the Mosaic effect. 
The default value is 8. Higher values create more contrast between the surface elements of the sprite 
and increase its three-dimensional appearance. To change the value, enter a number between 0 and 
25, and then click Apply. 

 

Glow size slider 

Adjusts the type and degree of glow applied with Neon Glow effect. To add glow to the outside of 
dark objects and the inside of light objects, move the slider to the right. To add glow to the inside of 
dark objects and the outside of light objects, move the slider to the left. Then click Apply. 



 

Glow size box 

Specifies the type and degree of glow applied with Neon Glow effect. Positive values add glow to the 
outside of dark objects and the inside of light objects, while negative values add glow to the inside of 
dark objects and the outside of light objects. The greater the setting (positive or negative), the larger 
the glow effect. The default value is 5. To change the value, enter a number between -24 and 24, and 
then click Apply. 

 

Glow brightness slider 

Adjusts the intensity of the glow that is applied with the Neon Glow effect. To increase the intensity of 
the glow, move the slider to the right and then click Apply. 

 

Glow brightness box 

Specifies the value of the brightness or intensity of the glow applied with the Neon Glow effect. The 
default value is 15. Higher values increase the appearance that the selected sprite is radiating light 
and heat. To change the value, enter a number between 0 and 50, and then click Apply. 

 

Glow color 

Displays the color of the glow applied with the Neon Glow effect. To change the color, click the 
button to open the Color Picker dialog box. 

 

Brush size slider 

Adjusts the size of the brush used to apply the Paint Daubs effect. To increase the brush size, move 
the slider to the right and then click Apply. 

 

Brush size box 

Specifies the size of the brush used to apply the Paint Daubs effect. The default value is 8. Higher 
values create larger brush strokes. To change the value, enter a number between 1 and 50, and then 
click Apply. 

 

Brush type 

Displays the types of brush used for the Paint Daubs effect. To change the brush type, select a 
different item from this list and then click Apply. 

 

Sharpness slider 

Adjusts the sharpness and detail for the Paint Daubs effect. To make the effect appear sharper and 
more detailed, move the slider to the right and then click Apply. 

 

Sharpness box 



Specifies the sharpness of the Paint Daubs effect. The default value is 7. Higher values create 
sharper, more detailed effects; lower values create a soft effect. To change the value, enter a number 
between 0 and 40, and then click Apply. 

 

Stroke size slider 

Adjusts the width of each stroke applied with the Palette Knife effect. To increase the stroke width, 
move the slider to the right and then click Apply. 

 

Stroke size box 

Specifies the width of each stroke applied with the Palette Knife effect. The default value is 25. 
Higher values create broader strokes. To change the value, enter a number between 1 and 50, and 
then click Apply. 

 

Stroke detail slider 

Adjusts the degree of detail for the Palette Knife effect. To increase the amount of detail, move the 
slider to the right and then click Apply. 

 

Stroke detail box 

Specifies the degree of detail for the Palette Knife effect. The default value is 3. Higher values create 
sharper, more detailed strokes. To change the value, enter a number between 1 and 3, and then click 
Apply. 

 

Softness slider 

Adjusts the softness of the strokes applied with the Palette Knife effect. To soften the edges of each 
stroke, move the slider to the right and then click Apply. 

 

Softness box 

Specifies the softness of the strokes applied with the Palette Knife effect. The default value is 0. 
Higher values create the appearance of softer, less detailed palette knife strokes. To change the 
value, enter a number between 0 and 10, and then click Apply. 

 

Image balance slider 

Adjusts the proportion of low areas to high areas in the selected sprite when the three-dimensional 
Plaster effect is applied. To add more low areas, move the slider to the right; to add more high areas, 
move the slider to the left. Then click Apply. 

 

Image balance box 

Specifies the proportion of low areas to high areas in the selected sprite when the three-dimensional 
Plaster effect is applied. The default value is 20. Higher values increase the proportion of low areas 
to high areas; lower values increase the proportion of high areas to low areas. To change the value, 



enter a number between 0 and 50, and then click Apply. 

 

Light position 

Displays the position of the light source that determines where highlights and shadows appear on the 
selected sprite when the the Plaster effect is applied. To change the position, click a different item in 
the list, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Plaster effect. To make the effect appear smoother and less 
detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the smoothness of the Plaster effect. The default value is 2. Higher values create a 
smoother, less detailed effect; lower values create a more textured, detailed effect. To change the 
value, enter a number between 1 and 15, and then click Apply. 

 

Highlight strength slider 

Adjusts the intensity of reflected light on the selected sprite when the Plastic Wrap effect is applied. 
To increase the intensity of reflected highlights, move the slider to the right and then click Apply. 

 

Highlight strength box 

Specifies the intensity of reflected light on the selected sprite when the Plastic Wrap effect is applied. 
The default value is 15. Higher values create brighter highlights. To change the value, enter a number 
between 0 and 20, and then click Apply. 

 

Detail slider 

Adjusts the amount of detail in the surface modulations of the Plastic Wrap effect. To increase the 
amount of detail, move the slider to the right and then click Apply. 

 

Detail box 

Specifies the degree of detail of surface modulations applied with the Plastic Wrap effect. The default 
value is 9. Higher values create sharper, more detailed effects; lower values create a softer effect. To 
change the value, enter a number between 1 and 15, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Plastic Wrap effect. To make the effect appear smoother and 
less detailed, move the slider to the right and then click Apply. 

 



Smoothness box 

Specifies the surface smoothness of the Plastic Wrap effect. The default value is 7. Higher values 
create a smoother, less detailed effect; lower values create a more textured, detailed effect. To 
change the value, enter a number between 1 and 15, and then click Apply. 

 

Edge thickness slider 

Adjusts the thickness of the edges for the Poster effect, which reduces the number of color shades in 
the sprite and adds dark lines along the edges. To increase the edge thickness, move the slider to the 
right and then click Apply. 

 

Edge thickness box 

Specifies the thickness of the edges for the Poster effect, which reduces the number of color shades 
in the sprite and adds dark lines along the edges. The default value is 2. Higher values create thicker 
edges. To change the value, enter a number between 0 and 10, and then click Apply. 

 

Edge intensity slider 

Adjusts the intensity of the dark lines added to the edges of the selected sprite with the Poster effect. 
To increase the intensity of the edges, move the slider to the right and then click Apply. 

 

Edge intensity box 

Specifies the intensity of the dark lines added to the edges of the selected sprite with the Poster 
effect. The default value is 1. Higher values intensify the dark lines. To change the value, enter a 
number between 0 and 10, and then click Apply. 

 

Posterization slider 

Adjusts the number of colors or halftones applied to the selected sprite with the Poster effect. To 
increase the colors and halftones, move the slider to the right and then click Apply. 

 

Posterization box 

Specifies the number of colors or halftones applied to the selected sprite with the Poster effect. The 
default value is 2. Higher values apply more color and halftones to the selected sprite. To change the 
value, enter a number between 0 and 6, and then click Apply. 

 

Angle 

On the Effects palette, specifies the angle at which the Radial Sweep or Vortex effect is applied to 
the selected sprite. The default value is 0 degrees for the Radial Sweep effect and 45 degrees for the 
Vortex effect. To change the value, enter a number from -180 to 180, and then click Apply. 

On the Paint palette, the Vortex effect is applied only to the area being painted, not to the entire 
sprite.  

 



Linear knee % 

Specifies the linear knee percentage for the Rectangular effect, which makes the selected sprite 
appear as if it is bent at a specific point, called the knee. The default value is 70 percent. Higher 
values push the center of the selected sprite in the direction specified by the Axis option: to the right 
for X Only, down for Y Only, and down and to the right for Both X and Y. 

For example, a value of 90 percent increases the effect closer to the right edge of the sprite than does 
a value of 60 percent; a value of 90 percent for Y Only increases the effect closer to the bottom of the 
sprite than does a value of 60 percent. To change the value, enter a number from 0 to 100, and then 
click Apply. 

 

Function 

Displays a list of the mathematical functions used by the Rectangular effect to rearrange the pixels 
on each of the horizontal and vertical scanlines. The default value is Linear Knee. To change the 
value, click a different item in the list, and then click Apply. 

 

X only 

When selected, specifies that the Rectangular effect is applied only to the x-axis (horizontal axis) of 
the selected sprite. 

 

Y only 

When selected, specifies that the Rectangular effect is applied only to the y-axis (vertical axis) of the 
selected sprite. 

 

Both X and Y 

When selected, specifies that the Rectangular effect is applied equally to both the x-axis (horizontal 
axis) and y-axis (vertical axis) of the selected sprite. 

 

Symmetrical 

When selected, specifies that the Rectangular effect is applied symmetrically to opposite edges of 
the selected sprite rather than to a single edge. 

 

Ripple size slider 

Adjusts the size of the ripples when the Ripple effect is applied to the selected sprite. To increase the 
size of the ripples, move the slider to the right and then click Apply. 

 

Ripple size box 

Specifies the size of the ripples when the Ripple effect is applied to the selected sprite. The default 
value is 9. Higher values create the appearance of larger ripples. To change the value, enter a 
number between 1 and 15, and then click Apply. 

 



Ripple magnitude slider 

Adjusts the degree of distortion to the selected sprite when the Ripple effect is applied. To increase 
the degree of distortion, move the slider to the right and then click Apply. 

 

Ripple magnitude box 

Specifies the degree of distortion to the selected sprite when the Ripple effect is applied. The default 
value is 9. Higher values create more ripples, which further distorts the appearance of the sprite. To 
change the value, enter a number between 0 and 20, and then click Apply. 

 

Stroke length slider 

Adjusts the length of each stroke for the Rough Pastels effect. To create longer strokes, move the 
slider to the right and then click Apply. 

 

Stroke length box 

Specifies the length of each stroke for the Rough Pastels effect. The default value is 6. Higher 
values create longer pastel strokes. To change the value, enter a number between 0 and 40, and 
then click Apply. 

 

Stroke detail slider 

Adjusts the degree of detail in the strokes for the Rough Pastels effect. To increase the detail in each 
stroke, move the slider to the right and then click Apply. 

 

Stroke detail box 

Specifies the degree of detail in the strokes for the Rough Pastels effect. The default value is 4. 
Higher values create more detailed strokes. To change the value, enter a number between 1 and 20, 
and then click Apply. 

 

Density slider 

Adjusts the density of the stippling for the Sandpaper effect. To increase the density of the stippling, 
move the slider to the right and then click Apply. 

 

Density box 

Specifies the density of the stippling for the Sandpaper effect. The default value is 12. Higher values 
create denser stippling on the selected sprite. To change the value, enter a number between 0 and 
50, and then click Apply. 

 

Black level slider 

Adjusts the amount of dark areas in the selected sprite that are covered with the appearance of dense 
clumps of emulsion when the Sandpaper effect is applied. To increase the amount of dark areas, 



move the slider to the right and then click Apply. 

 

Black level box 

Specifies the amount of dark areas in the selected sprite that are covered with the appearance of 
dense clumps of emulsion when the Sandpaper effect is applied. The default value is 40. Higher 
values increase the size of the dark areas. To change the value, enter a number between 0 and 50, 
and then click Apply. 

 

White level slider 

Adjusts the amount of light areas in the selected sprite that are covered with stippling when the 
Sandpaper effect is applied. To increase the amount of light areas, move the slider to the right and 
then click Apply. 

 

White level box 

Specifies amount of light areas in the selected sprite that are covered with stippling when the 
Sandpaper effect is applied. The default value is 5. Higher values create more light areas with the 
appearance of stippling. To change the value, enter a number between 0 and 50, and then click 
Apply. 

 

Stroke length slider 

Adjusts the stroke length of the Smudge Stick effect. To increase the stroke length, move the slider 
to the right and then click Apply. 

 

Stroke length box 

Specifies the stroke length of the Smudge Stick effect. The default value is 2. Higher values create 
longer strokes. To change the value, enter a number between 0 and 10, and then click Apply. 

 

Highlight area slider 

Adjusts the area of the selected sprite that is highlighted when the Smudge Stick effect is applied. To 
increase the highlighted area, move the slider to the right and then click Apply. 

 

Highlight area box 

Specifies the area of the selected sprite that is highlighted when the Smudge Stick effect is applied. 
The default value is 0. Higher values add more highlights to the sprite. To change the value, enter a 
number between 0 and 20, and then click Apply. 

 

Highlight intensity slider 

Adjusts the brightness of the highlights added by the Smudge Stick effect. To increase the 
brightness, move the slider to the right and then click Apply. 



 

Highlight intensity box 

Specifies the brightness of the highlights added by the Smudge Stick effect. The default value is 10. 
Higher values create brighter highlights. To change the value, enter a number between 0 and 10, and 
then click Apply. 

 

Spray radius slider 

Adjusts the radius of the paint spatters for the Spatter effect. To increase the spatter size, move the 
slider to the right and then click Apply. 

 

Spray radius box 

Specifies the radius of the paint spatters for the Spatter effect. The default value is 10. Higher values 
create larger paint spatters. To change the value, enter a number between 0 and 25, and then click 
Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Spatter effect. To make the effect appear smoother and less 
detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Spatter effect. The default value is 5. Higher values create 
smoother effects. To change the value, enter a number between 1 and 15, and then click Apply. 

 

Value 

On the Effects palette, specifies the percentage of the sprite that is sampled for the Spoke Inversion 
effect. The default value is 100, which samples the entire image. A value of 25 samples the top-left 
quarter of the sprite; a value of 50 samples the top half of the sprite. To change the value, enter a 
number from 1 to 100, and then click Apply. 

On the Paint palette, the Spoke Inversion effect is applied only to the area being painted, not to the 
entire sprite. 

 

Brush size slider 

Adjusts the size of the brush, or sponge, used to apply the Sponge effect. To increase the brush size, 
move the slider to the right and then click Apply. 

 

Brush size box 

Specifies the size of the brush, or sponge, used to apply the Sponge effect. The default value is 2. 
Higher values create larger, less detailed strokes. To change the value, enter a number between 0 
and 10, and then click Apply. 



 

Definition slider 

Adjusts the amount of detail retained in the selected sprite when the Sponge effect is applied. To 
increase the definition, move the slider to the right and then click Apply. 

 

Definition box 

Specifies the degree of detail retained in the selected sprite when the Sponge effect is applied. The 
default value is 12. Higher values retain more of the details. To change the value, enter a number 
between 0 and 25, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Sponge effect. To make the effect appear smoother and less 
detailed, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Sponge effect. The default value is 5. Higher values create 
smoother effects. To change the value, enter a number between 1 and 15, and then click Apply. 

 

Stroke length slider 

Adjusts the stroke length of the Sprayed Strokes effect. To create longer strokes, move the slider to 
the right and then click Apply. 

 

Stroke length box 

Specifies the stroke length of the Sprayed Strokes effect. The default value is 12. Higher values 
create longer strokes. To change the value, enter a number between 0 and 20, and then click Apply. 

 

Stroke direction 

Displays the direction of the strokes applied with the Sprayed Strokes effect. To change the 
direction, click a different item in the list, and then click Apply. 

 

Spray radius slider 

Adjusts the radius of the paint strokes for the Sprayed Strokes effect. To create more disjointed 
strokes, move the slider to the right and then click Apply. 

 

Spray radius box 

Specifies the radius of the paint strokes for the Sprayed Strokes effect. The default value is 7. Higher 
values create longer, more disjointed strokes. To change the value, enter a number between 0 and 
25, and then click Apply. 



 

Color chip 

Displays one of the four colors of the selected Gradient effect. To change the color, click the color 
chip to open the Color Picker dialog box, or right-click to open the Quick Color Picker. You can also 
drag the color from one color chip to another. 

 

Gradient 

Displays the color gradient that blends the four colors displayed in the color chips at each corner of 
this box. 

 

Gradient name 

Displays a list of color gradients that are provided with Microsoft Image Composer, as well as the 
color gradients that you created and saved. To change the selected gradient, click a different item in 
the list, and then click Apply. 

 

Save 

Stores a custom gradient in the Gradient Name list. To save a custom gradient, select or type the 
name you want to save it as in the Gradient Name list, and then click this button. 

 

Delete 

Deletes a gradient from the Gradient Name list. To delete a gradient, select it from the Gradient 
Name list, and then click this button. 

Note   Deleting a gradient cannot be undone without reinstalling Microsoft Image Composer. 
 
 

Cell size slider 

Adjusts the size of each piece, or cell, in the Stained Glass effect. To increase the size of each cell, 
move the slider to the right and then click Apply. 

 

Cell size box 

Specifies the size of each piece, or cell, in the Stained Glass effect. The default value is 10. Higher 
values create larger cells. To change the value, enter a number between 1 and 50, and then click 
Apply. 

 

Border thickness slider 

Adjusts the thickness of the border around each cell in the Stained Glass effect. To increase the 
thickness of the border, move the slider to the right and then click Apply. 

 

Border thickness box 

Specifies the thickness of the border around each cell in the Stained Glass effect. The default value 



is 4. Higher values create thicker borders between cells. To change the value, enter a number 
between 1 and 20, and then click Apply. 

 

Light intensity slider 

Adjusts the intensity of the back light that shines through the glass in the Stained Glass effect. To 
increase the intensity, move the slider to the right and then click Apply. 

 

Light intensity box 

Specifies the intensity of the back light that shines through the glass in the Stained Glass effect. The 
default value is 3. Higher values increase the brightness of the light. To change the value, enter a 
number between 0 and 10, and then click Apply. 

 

Light/Dark balance slider 

Adjusts the proportion of current color to composition space color for the Stamp effect. To use more 
of the current color in the stamp, move the slider to the right; to use more of the composition space 
color in the background, move the slider to the left. Then click Apply. 

 

Light/Dark balance box 

Specifies the proportion of current color to composition space color for the Stamp effect. The default 
value is 25. Values above 25 fill more of the selected sprite with a stamp in the current color; values 
below 25 show more of the background in the composition space color. To change the value, enter a 
number between 0 and 50, and then click Apply. 

 

Smoothness slider 

Adjusts the overall smoothness of the Stamp effect. To make the effect appear smoother with less 
defined contours, move the slider to the right and then click Apply. 

 

Smoothness box 

Specifies the overall smoothness of the Stamp effect. The default value is 5. Higher values create 
smoother, rounder contours. To change the value, enter a number between 1 and 50, and then click 
Apply. 

 

Detail slider 

Adjusts the amount of detail and halftone definition for the Stone Print effect. To increase the detail 
and halftones, move the slider to the right and then click Apply. 

 

Detail box 

Specifies the amount of detail and halftone definition for the Stone Print effect. The default value is 7. 
Higher values create more detail and a broader range of halftones. To change the value, enter a 
number between 1 and 25, and then click Apply. 



 

Darkness slider 

Adjusts the proportion of dark halftones to light halftones for the Stone Print effect. To create darker, 
denser-looking halftones, move the slider to the right and then click Apply. 

 

Darkness box 

Specifies the proportion of dark halftones to light halftones for the Stone Print effect. The default 
value is 8. Higher values create darker, denser-looking halftones. To change the value, enter a 
number between 1 and 50, and then click Apply. 

 

Spacing 

Specifies the number of pixels between stripes for the Stripes effect. The default value is 10. Higher 
values increase the space between color stripes. To change the value, enter a number between 1 
and 120, and then click Apply. 

 

Crack spacing slider 

Adjusts the spacing between the cracks that appear in the selected sprite when the Cracked Varnish 
effect is applied. To increase the size of the spaces between the cracks, move the slider to the right 
and then click Apply. 

 

Crack spacing box 

Specifies the amount of space between the cracks that appear in the selected sprite when the 
Cracked Varnish effect is applied. The default value is 15. Higher values create a smoother finish 
with fewer cracks; lower values create the appearance of air bubbles in the varnish. To change the 
value, enter a number between 2 and 100, and then click Apply. 

 

Crack depth slider 

Adjusts the depth of the cracks that appear in the selected sprite when the Cracked Varnish effect is 
applied. To increase the three-dimensional appearance of the cracks, move the slider to the right and 
then click Apply. 

 

Crack depth box 

Specifies the depth of the cracks that appear in the selected sprite when the Cracked Varnish effect 
is applied. The default value is 6. Higher values increase the three-dimensional appearance of this 
effect. To change the value, enter a number between 0 and 10, and then click Apply. 

 

Crack brightness slider 

Adjusts the brightness of the cracks that appear in the selected sprite when the Cracked Varnish 
effect is applied. To darken the cracks, move the slider to the left and then click Apply. 

 



Crack brightness box 

Specifies the brightness of the cracks that appear in the selected sprite when the Cracked Varnish 
effect is applied. The default value is 9. Lower values darken the cracks. To change the value, enter a 
number between 0 and 10, and then click Apply. 

 

Stroke length slider 

Adjusts the length of the pen stroke for the Technical Pen effect. To create longer strokes, move the 
slider to the right and then click Apply. 

 

Stroke length box 

Specifies the length of the pen stroke of the Technical Pen effect. The default value is 15. Lower 
values create shorter strokes. To change the value, enter a number between 1 and 15, and then click 
Apply. 

 

Stroke direction 

Displays the direction of the pen strokes for the Technical Pen effect. To change the direction, select 
a different item from the list and then click Apply. 

 

Light/Dark balance slider 

Adjusts the percentage of dark areas in the sprite when the Technical Pen effect is applied. Move the 
slider to the left to lighten the effect or to the right to darken the effect, and then click Apply. 

 

Light/Dark balance box 

Specifies the percentage of dark areas in the sprite when the Technical Pen effect is applied. The 
default value is 50. Values above 50 darken the effect; values below 50 lighten the effect. To change 
the value, enter a number between 0 and 100, and then click Apply. 

 

Brush size slider 

Adjusts the size of the brush used to apply the Underpainting effect. To increase the brush size, 
move the slider to the right and then click Apply. 

 

Brush size box 

Specifies the size of the brush used to apply the Underpainting effect. The default value is 6. Higher 
values create larger, less detailed brush strokes. To change the value, enter a number between 0 and 
40, and then click Apply. 

 

Texture coverage slider 

Adjusts the area of the selected sprite that is covered with texture when the Underpainting effect is 
applied. To increase the amount of coverage, move the slider to the right and then click Apply. 



 

Texture coverage box 

Specifies the area of the selected sprite that is covered with texture when the Underpainting effect is 
applied. The default setting is 16. Higher values create a more richly textured surface. To change the 
value, enter a number between 0 and 40, and then click Apply. 

 

Brush detail slider 

Adjusts the amount of detail in the paint strokes for the Watercolor effect. To increase the amount of 
detail, move the slider to the right and then click Apply. 

 

Brush detail box 

Specifies the amount of detail in the paint strokes for the Watercolor effect. The default value is 9. 
Higher values create greater brush stroke detail. To change the value, enter a number between 1 and 
14, and then click Apply. 

 

Shadow intensity slider 

Adjusts the brightness of the shadows created in the selected sprite when the Watercolor effect is 
applied. To increase the brightness, move the slider to the right and then click Apply. 

 

Shadow intensity box 

Specifies the brightness of the shadows created in the selected sprite when the Watercolor effect is 
applied. The default value is 1. Higher values create brighter shadows. To change the value, enter a 
number between 0 and 10, and then click Apply. 

 

Texture slider 

Adjusts the smoothness of the texture in the selected sprite when the Watercolor effect is applied. To 
create a rougher texture, move the slider to the right and then click Apply. 

 

Texture box 

Specifies the amount of smoothness of the texture in the selected sprite when the Watercolor effect 
is applied. The default value is 1. Higher values create rougher textures. To change the value, enter a 
number between 1 and 3, and then click Apply. 

 

Frequency % 

Specifies the number of waves created in the selected sprite when the Wave effect is applied. The 
default value is 100 percent, which equals one wave. Higher values increase the number of waves 
applied to the selected sprite, so that a value of 200 percent applies two waves, a value of 300 
percent applies 3 waves, and so on. Lower values decrease the number of waves applied, so that a 
value of 50 percent applies a half-wave to the selected sprite. To change the value, enter a number 
between 1 and 1000, and then click Apply. 



 

Amplitude % 

Specifies the amplitude, or height, of the wave created in the selected sprite when the Wave effect is 
applied. The default value is 25 percent. Higher values raise the height of the wave so that the top 
and bottom of the wave might be cut off by the bounding box of the selected sprite. If this occurs, use 
the Arrange tool palette to increase the size of the bounding box. To change the value, enter a 
number between 1 and 50, and then click Apply. 

 

Symmetrical 

When selected, specifies that the Wave effect is applied from the center of the sprite. 

 

X only 

When selected, specifies that the Wave effect is applied only to the x-axis (horizontal axis), of the 
selected sprite. The resulting effect looks like an S-shape. 

 

Y only 

When selected, specifies that the Wave effect is applied only to the y-axis (vertical axis) of the 
selected sprite. 

 

Both X and Y 

When selected, specifies that the Wave effect is applied equally to both the x-axis (horizontal axis) 
and y-axis (vertical axis). The resulting effect looks as if two waves, one vertical and one horizontal, 
have been applied to the sprite. 

 

Fiber length slider 

Adjusts the length of the paper fibers for the Wet Paper effect. To create the appearance of longer 
fibers, move the slider to the right and then click Apply. 

 

Fiber length box 

Specifies the length of the paper fibers for the Wet Paper effect. The default value is 15. Higher 
values create the appearance of longer fibers. To change the value, enter a number between 3 and 
50, and then click Apply. 

 

Brightness slider 

Adjusts the brightness of the Wet Paper effect. To create a brighter result, move the slider to the right 
and then click Apply. 

 

Brightness box 



Specifies the brightness of the Wet Paper effect. The default value is 60. Higher values create 
brighter results. To change the value, enter a number between 0 and 100, and then click Apply. 

 

Contrast slider 

Adjusts the contrast of the Wet Paper effect. To create greater contrast, move the slider to the right 
and then click Apply. 

 

Contrast box 

Specifies the contrast of the Wet Paper effect. The default value is 80. Higher values create greater 
contrast. To change the value, enter a number between 0 and 100, and then click Apply. 

 

Type 

Displays the texture that will be applied to the selected effect: Brick, Burlap, Canvas, Sandstone, 
and TIFF File. To use a different texture, select a different item from the list and click OK. 

 

Light position 

Displays the position of the light source which determines where highlights and shadows appear on 
the selected sprite when the current effect is applied. To change the position, click a different item in 
the list, and then click OK. 

 

Scaling % slider 

Adjusts the scale, or size, of the texture in the Type list. To increase the size of the texture, move the 
slider to the right and click OK. 

 

Scaling % box 

Specifies the percentage of scaling of the texture in the Type list. The default value is 100. Higher 
scaling values create a looser pattern in the texture. To change the value, enter a number between 50 
and 200, and then click OK. 

 

Relief slider 

Adjusts the degree of relief (contrast due to texture) applied to the selected sprite when the current 
effect is applied. To increase the degree of relief, move the slider to the right and click OK. 

 

Relief box 

Specifies the degree of relief (contrast due to texture) applied to the selected sprite when the current 
effect is applied. To change the value, enter a number between 0 and 50, and then click OK. 

 

Invert texture 



When selected, the appearance of the texture selected from the Type list is turned inside out or 
upside down. For example, when the Brick texture is inverted, the bricks appear recessed instead of 
in relief. 

 

Type 

Displays the pattern in the glass surface that will be applied to the selected effect: Blocks, Canvas, 
Frosted, Tiny Lens, or TIFF File. To use a different surface pattern, click a different item in the list, 
and then click OK. 

 

Scaling % slider 

Adjusts the scale, or size, of the surface pattern in the Type list. To increase the size of the texture, 
move the slider to the right and click OK. 

 

Scaling % box 

Specifies the percentage of scaling of the surface pattern in the Type list. The default value is 100. 
Higher scaling values create a looser pattern in the glass. To change the value, enter a number 
between 50 and 200, and then click OK. 

 

Invert surface 

When selected, the appearance of the surface pattern selected from the Type list is turned inside out 
or upside down. For example, when the Brick texture is inverted, the bricks appear recessed instead 
of in relief. 

 

Texture Controls 

Displays the Texture Controls dialog box, where you can specify the type of texture to use for this 
effect and set its related options. 

 

OK 

Accepts any changes you have made and closes this dialog box. 

 

Cancel 

Ignores any changes you have made and closes this dialog box. 

 

Pattern preview 

Displays an example of the current pattern. 

 

Paste 

Inserts the contents of the Clipboard in the upper-left corner of the active composition. 



 

Paste Special 

Pastes the contents of the Clipboard into the upper-left corner of the active composition in the format 
you specify. 

 

Cut 

Removes the selected sprite or sprites and places them on the Clipboard. 

 

Copy 

Copies the selected sprite or sprites onto the Clipboard. 

 

Duplicate 

Creates a copy of the current sprite or sprites and places them in front of the original sprite or sprites 
at a slight offset. 

 

Delete 

Removes the selected sprite or sprites from the composition. 

 

Undo 

Cancels the last command or effect. The command changes to Can’t Undo if you can’t undo the 
previous command or effect. 

 

Select All 

Selects all the sprites in the composition. 

 

Clear Selection 

Removes the selected status of all sprites in a composition so that there is no selected sprite. 

 

Current Color Fill 

Fills the selection with the current color shown in the Color Swatch. 

 

Copy Channel Red 

Copies the red channel of the selected sprite to the Clipboard. 

 

Copy Channel Green 



Copies the green channel of the selected sprite to the Clipboard. 

 

Copy Channel Blue 

Copies the blue channel of the selected sprite to the Clipboard. 

 

Copy Channel Alpha 

Copies the alpha channel of the selected sprite to the Clipboard. 

 

Paste Channel Red 

Pastes the channel of the sprite that is on the Clipboard into the red channel of the currently selected 
sprite. 

 

Paste Channel Green 

Pastes the channel of the sprite that is on the Clipboard into the green channel of the currently 
selected sprite. 

 

Paste Channel Blue 

Pastes the channel of the sprite that is on the Clipboard into the blue channel of the currently selected 
sprite. 

 

Paste Channel Alpha 

Pastes the channel of the sprite that is on the Clipboard into the alpha channel of the currently 
selected sprite. 

 

Broadcast Channel Red 

Replaces all color channels of the current sprite with the red channel of that sprite. 

 

Broadcast Channel Green 

Replaces all color channels of the current sprite with the green channel of that sprite. 

 

Broadcast Channel Blue 

Replaces all color channels of the current sprite with the blue channel of that sprite. 

 

Broadcast Channel Alpha 

Replaces all color channels of the current sprite with the alpha channel of that sprite. 



 

Properties 

Displays the Sprite Properties dialog box for the selected sprite or sprites. For single sprites, 
displays information about the selected sprite. For multiple selections, displays information about the 
temporary selection set. If no sprites are selected, displays the Composition Properties dialog box, 
which contains information about the composition. 

 

Button 

Displays the Button Editor dialog box, which lets you change the attributes of a button created with 
the Button wizard, including its style, font, fill, shape, and size. This command is only available if a 
button is selected. 

 

Object Smoothing 

Switches smoothing on or off for text sprites, OLE objects, and pasted metafiles, but not for bitmap 
OLE objects. This command is only available if an object is selected. 

 

Dock Tool Palette 

Returns the tool palette to its default position on the lower-left part of the Microsoft Image Composer 
workspace. 

 

 

New 

Creates a new composition in the Microsoft Image Composer window. If a composition is currently 
open, displays a prompt asking if you want to save it. The composition space defaults are applied to 
the new composition. 

 

Open 

Opens an existing file. The file can be a Microsoft Image Composer composition (.mic) file or any 
other supported file format. If a composition is currently open, displays a prompt asking if you want to 
save it. 

 

Close  

Closes the active composition and displays a prompt asking if you want to save it. 

 

Save 

Saves the active composition with its current file name, location, and file format. 

 

Save As 



Saves the active composition with the file name, location, and file format you specify. 

 

Save Selection As 

Saves the active selection with the file name, location, and file format you specify. 

 

Save Copy As 

Saves a copy of the active composition with the file name, location, and file format you specify.  

 

Save for the Web 

Opens the Save for the Web wizard, which helps you set options related to saving a composition for 
a Web page. 

 

Composition Properties 

Displays the Composition Properties dialog box, which shows size and color information for the 
active composition. To view properties for a specific sprite, double click its name in the Sprite list. 

 

Composition Setup 

Displays the Composition Setup dialog box, where you can change the size and color of the 
composition space for the active composition only or for all new compositions. 

 

Select Scan Source 

Selects the default TWAIN source for the scanner you have selected. 

 

Acquire Scan 

Acquires an image from the selected TWAIN source. 

 

Print Setup 

Displays the Print Setup dialog box, where you can select a printer and change its settings and 
properties. 

 

Print 

Displays the Print dialog box, where you can change the printer settings for the active composition, 
and then print the composition or the current view. 

 

Send 

Sends a composition in an e-mail message. Saves the composition in a temporary file using the 



options you set when the composition was last saved, including file format and other settings. 

 

Most Recently Used File 

Lists the compositions that were most recently saved in reverse chronological order. The last 
composition saved appears first in the list. 

 

Exit 

Prompts you to save the active composition if it contains unsaved changes, and exits Microsoft Image 
Composer. 

 

Save 

For help on this dialog box, click the Microsoft Image Composer-specific control you want help on and 
press F1. 

 

Open 

For help on this dialog box, click the Microsoft Image Composer specific control you want help on and 
press F1. 

 

Hint 

Click OK and perform the action specified in this Hint dialog box. 

 

Microsoft Image Composer Help Topics  

Displays the Microsoft Image Composer help dialog box, including tabs for Contents, Index, and 
Find. 

 

Introduction to Microsoft Image Composer 

Displays introductory topics for users who are new to Microsoft Image Composer. 

 

Tutorial 

Displays the tutorial for Microsoft Image Composer. 

 

What’s New in This Version 

Describes new and changed features in Microsoft Image Composer 1.5. 

 

Aligning 

Displays the Help topic for aligning sprites in a composition. 



 

Changing Colors 

Displays the Help topic for applying different colors to a sprite. 

 

Changing Order 

Displays the Help topic for reordering sprites 

 

Creating Drop Shadows 

Displays the Help topic for creating a drop shadow effect. 

 

Cropping 

Displays the Help topic for cropping sprites. 

 

Cutting Out 

Displays the Help topic for creating cutouts. 

 

Resizing 

Displays the Help topic for shrinking or enlarging sprites. 

 

Saving Files 

ays the Help topic for saving compositions as different file types. 

 

Selecting 

Displays the Help topic for making selections in Microsoft Image Composer. 

 

Setting Transparent Backgrounds 

Displays the Help topic for setting background transparency for Web images. 

 

Keyboard Shortcuts 

Displays keyboard equivalents of mouse commands. 

 

Microsoft Image Composer Home Page 

Connects to the Image Composer home page on the World Wide Web: 
http://www.microsoft.com/imagecomposer/. 



 

Web Directory 

Connects your web browser to the Microsoft Web directory: 
http://home.microsoft.com/lookup/services.asp. 

 

Search the Web 

Connects your web browser to the Microsoft Web Search page: 
http://www.msn.com/access/allinone.asp. 

 

Web Tutorial 

Connects your web browser to the Microsoft Web Tutorial page: 
http://home.microsoft.com/tutorial/default.html. 

 

Microsoft Home Page 

Connects your web browser to the Microsoft Home page: www.microsoft.com. 

 

About Microsoft Image Composer 

Displays information about your copy of Microsoft Image Composer, including the version number, 
and the copyright, legal, and licensing notices. 

 

Help 

Turns your mouse pointer into a context-sensitive Help pointer. When you click an item with the Help 
pointer, a context-sensitive Help topic appears for that item. 

 

Inserting Password-Protected Images From Photo CD 
 

Images can be protected by passwords to ensure copyright protection. Such images are encrypted 
and are available only to authorized users. To unlock protected images, you must enter a password in 
the Password box and click Unlock. The password is provided with your Photo CD. 

If you do not have the password and want to view the image, click Ignore. The image displayed 
contains a watermark of copyright symbols overlaid on the protected image. 

 

Photoshop (.psd) File Save Options dialog box 
 

You can save your Microsoft Image Composer composition as an Adobe Photoshop version 3.0 .psd 
file. Each sprite becomes an image object. 

Save the composition space as the background layer  

Saves a .psd file with a background layer that is the size and color of the composition space. If you 



clear this check box, the file does not include the composition space as a background layer. 

Save the sprites outside of the composition space 

Saves all sprites regardless of their position relative to the composition space. If you clear this check 
box, only the sprites and portions of sprites that are within the area of the composition space are 
saved in the file. 

 

File Format Limitation dialog box 
 

The Microsoft Image Composer (.mic) and Adobe Photoshop (.psd) file formats are the only formats 
that keep individual sprites as separate objects in a composition, whether or not these sprites are 
within the composition space. When you save a composition to any other file format, all sprites are 
combined, or flattened, into a single composition-wide sprite. If you plan to make any changes to the 
individual sprites in a composition, be sure to save the composition as either a .mic or .psd file. 

 

Lock Composition Guides 

Locks the composition guides at their current location so that the composition space size is also 
locked. 

 

True Color 

Displays a composition in true color. 

 

Web (Dithered) 

Displays a composition using the colors in the Web (Dithered) palette. 

 

Gray Ramp 

Displays a composition using the colors in the Gray Ramp palette. 

 

Web (Solid) 

Displays a composition using the colors in the Web (Solid) palette. 

 

Color Format 

Displays the color palettes that are available for a composition. The list includes any custom color 
palettes that are available for the active composition. 

 

Zoom to 50% 

Displays a composition at 50% of its actual size. 

 



 Clip Art 

Displays the Microsoft Clip Gallery containing dozens of clip art pictures. 

 

WordArt 

Displays the WordArt interface you can use to apply effects not available in Image Composer. 

 

Bring Before 

Moves the selected sprite one position in front of the source sprite, which is surrounded by solid black 
handles. 

 

Send Behind 

Moves the selected sprite one position in back of the source sprite, which is surrounded by solid black 
handles. 

 

View Color Format dialog box 
 

The View Color Format dialog box displays the name of the color palette attached to your 
composition. You can switch palettes to preview your composition and choose the best palette for 
your target display system. For more information, see Working with color. 

 To attach a different color palette to your composition 

1 Select a different palette from the list: 

• Click True Color if your target display system supports 24-bit color. 

• Click Gray Ramp for black and white compositions that use up to 236 shades of gray. 

• Click Web (Dithered) for compositions that use up to 216 colors and allow dithering. 

• Click Web (Solid) for line art or solid-colored art that uses up to 216 colors and doesn’t allow 
dithering. 

 

2 Click OK. 

 

Text 

Displays the Text palette from which you can change formatting of a selected text sprite. 

 

Object command 

Applies to the selected object. Common commands include: 

Edit. Displays tools and commands for the program that created the object. 

Open. Opens the object with the program that created it. 

Play. Displays an interface for playing the object. 

 

From File 



Displays the Insert From File dialog box, from which you can choose a file to insert into the active 
composition. 

 

From Photo CD 

Displays the Insert From Photo CD dialog box, from which you can choose a Photo CD image to 
insert into the active composition. 

 

Button 

Starts the Button Wizard. Use this wizard to create buttons for Web sites or for other uses.  

 

Object 

Displays the Insert Object dialog box, from which you can use other products, such as Microsoft 
Office products, to create a sprite that is based on a new OLE object or that comes from an existing 
OLE object.  

 

Insert From Photo CD dialog box 
 

You can use the Insert From Photo CD dialog box to choose a photo from a collection of thumbnails 
and insert it into your composition. 

Available CD-ROM devices  

Click an item from this list to choose a CD-ROM drive, network connection, or other location of the 
CD-ROM photos. 

List of photos  

Double-click a photo from the collection of thumbnails to insert that photo into your composition. Upon 
insertion, the photo becomes a sprite and is placed in the upper-left corner of the composition space. 

When you double-click a photo thumbnail, or click a photo and then click Insert, you see another 
dialog box named Insert from Photo CD. Click a value in the Resolution box for the image based on 
this photo in your composition. 

 

Insert From Photo CD 

Inserts the image you selected in the dimensions you specify onto the composition space. 

 

Inserting Password-Protected Images From Photo CD 

Images can be protected by passwords to ensure copyright protection. Such images are encrypted 
and are available only to authorized users. To unlock protected images, you must enter a password in 
the Password box and click Unlock. The password is provided with your Photo CD. 

If you do not have the password and want to view the image, click Ignore. The image displayed 
contains a watermark of copyright symbols overlaid on the protected image. 

 



Color Picker 

Displays or hides the Color Picker dialog box, where you can view color palettes, set the current 
color, or create a custom color. 

 

 

Repeat Last Plug-In 

Reapplies the most recently selected plug-in effect to a selection. This command is available only 
when a sprite is selected. 

 

Impressionist 

Loads Impressionist, a plug-in program that contains effects and filters you can use to change the 
look of your sprite. This command is available only when a sprite is selected. 

 

Center on Composition Space 

Centers the composition space in the view. 

 

Center On Selection 

Repositions the selection in the center of the active view window. 

 

Fit Composition Space to Selection 

Places the composition space around a selected sprite or group of sprites and resizes it to fit them.  

 

Composition Guides 

Displays or hides the composition guides, which are the dotted lines that you drag to resize the 
composition space.  

 

Toggle Palette View 

Displays or hides the active tool palette. 

 

Zoom In 

Enlarges the composition view. 

 

Zoom Out 

Shrinks the composition view. 

 



Actual Size 

Resets the image in the active view window to 100 percent of its original size. 

 

Color Format 

Displays the color palettes that are available for a composition. The list includes any custom color 
palettes that are available for the current composition. 

 

Zoom Percent 

Displays the range of zoom percentages for the composition view. At zoom percentages greater than 
100 percent, individual pixels become apparent, leading to a jagged appearance. Also, a sprite may 
appear to move out of the workspace view, requiring you to scroll to see some areas of the sprite. At 
zoom percentages less than 100 percent, differing opacities of border pixels make a sprite's edges 
appear smooth. 

 

Selection Tool 

Returns Microsoft Image Composer to selection mode, so that you can easily select sprites. To select 
more than one sprite at a time, drag a selection rectangle around the sprites. 

 

Arrange 

Displays the Arrange tool palette. 

 

Cutout 

Displays the Cutout tool palette. 

 

Text 

Displays the Text tool palette. 

 

Shapes 

Displays the Shapes tool palette. 

 

Paint 

Displays the Paint tool palette. 

 

Effects 

Displays the Effects tool palette. 

 



Texture Transfer 

Displays the Texture Transfer tool palette. 

 

Zoom 

Switches Microsoft Image Composer to zoom mode, so that 
you can enlarge or shrink the composition view. 

 To enlarge the composition view 

• On the Tools menu, click Zoom, and then click anywhere 
in the view window. 

 

 To shrink the composition view 

• On the Tools menu, click Zoom, and then press CTRL and 
click anywhere in the view window. 

 
 

Pan 

Switches Microsoft Image Composer to pan mode, so that you can reposition your work in the active 
view window. 

 

Color Tuning 

Displays the Color Tuning tool palette. 

 

Color Picker 

Displays the Color Picker dialog box, which you use for setting the current color or creating a custom 
color. The Color Picker has two tabbed dialogs: True Color or Custom Palette. The current tab is 
the tab most recently used. 

 

Options 

Displays the Options dialog box. 

 

Color Swatch 

Displays the Color Picker dialog box for setting the current color or creating a custom color. The 
Color Picker has two tabbed dialogs: True Color or Custom Palette. The current tab is the tab most 
recently used. You can drag colors between the Color Swatch and the smaller color chips on the tool 
palettes. 

 

Toolbars 

Displays the Toolbars dialog box, which you can use to hide or display the Toolbar, Toolbox, Color 
Swatch, and Status Bar. 

 

New Window 



Opens a new window with the same contents as the active window. 

 

Cascade 

Arranges windows in a cascade formation so that the windows overlap one another with the title of 
each window showing. 

 

Tile 

Arranges windows in a tile formation so that the windows fill the screen. 

 

Arrange Icons 

Arranges all window icons along the bottom edge of current view window. 

 

Most Recently Used Window 

Switches to the composition and makes it active. 

 

 

 

 

Brush Selection grid 

Displays a set of standard brushes. To design custom brushes, double-click on a brush in the grid to 
open the Brush Designer dialog box. 

 

Brush size slider 

Adjusts the size of the selected brush. Move the slider left to decrease brush size and right to 
increase brush size. 

 

Brush size box 

Displays the pixel size value of the current brush. To change the value, select the current value and 
type a new number or click the arrows to set a new value. 

 

Brush display box 

Displays the size and type of brush selected. 

 

Lock Tool check box 

Maintains the current tool selection as you move from one sprite to the other. 

 



Radius Factor (%) box 

Specifies the percentage of pixels in the current sprite that will be scaled into the Mesa portion of a 
warp. To change the value, select the current value and type a new number or click the arrows to set 
a new value from 0 to 100. 

 

Warp Direction 

In specifies a concave effect as you paint on the current sprite. Out specifies a convex effect as you 
paint on the current sprite. 

 

Angle box 

Specifies the value for the angle of rotation for the Vortex tool in the selected area of the of the 
current sprite. To change the value, select the current value and type a new number or click the 
arrows to set a new value. The value must be between -180 and 180. Negative values produce 
counter-clockwise rotation. Positive values produce clockwise rotation. A value of 0 produces no 
result. 

 

Value box 

Specifies the percentage value of the current sprite that will be affected by the Spoke Inversion 
effect. For example, at a value of 33 percent, the effect will be applied to the inner third of the 
selected portion of the current sprite before it is inverted. To change the value, select the current 
value and type a new number or click the arrows to set a new value. The value must be between 1 
and 100.  

 

Paintbrush 

Creates a paintbrush stroke effect as you drag the pointer. This tool uses the current color. The effect 
increases as you drag the pointer repeatedly over an area. 

 

Airbrush 

Creates an airbrush stroke effect as you drag the pointer. This tool uses the current color. The effect 
increases as you drag the pointer repeatedly over an area. 

 

Pencil 

Draws a pencil-like stroke as you drag the pointer. This tool uses the current color. The effect 
increases as you drag the pointer repeatedly over an area.  

 

Smear 

Smears the colors of the current sprite as you drag the pointer across it. This tool uses the color and 
texture at the pointer location. The effect increases as you drag the pointer repeatedly over an area. 

 

Impression 



Creates a smudged, impressionistic effect as you drag the pointer. This tool uses the color at the 
pointer location. 

 

Erase 

Turns the current paintbrush into an eraser, turning the pixels transparent as you drag the pointer 
across the current sprite. Use the Opacity control to vary the level of transparency. 

 

Tint 

Uses the current paintbrush to apply a translucent wash of the current color to the current sprite as 
you drag the pointer across it. This tool uses the current color. 

 

Colorize 

Uses the current paintbrush to apply the current color without affecting the dark and light intensity 
values of the current sprite. This tool uses the current color 

 

Dodge and Burn 

Lightens or darkens the area of the current sprite when the current brush is dragged across it. You 
can adjust the Dodge/Burn slider to the left to darken or to the right to lighten the effect. 

 

Contrast 

Adjusts the contrast of the area on the current sprite where the current paintbrush is dragged. 
Increase or decrease the degree of contrast by using the Contrast slider or box. 

 

Rubber Stamp 

Copies the non-transparent pixels from a source area to a destination area. The size of the source 
area is defined by the size of the current paintbrush. After clicking the source area, each time you 
click on a destination area, the same pixels from the source area are copied to the destination. The 
destination can be the same, or a different, sprite. 

 

Transfer 

Copies pixels from one area to another, while maintaining the relative offset of the source and 
destination areas. Each time you click on a destination, a different section of pixels the size of the 
current brush are copied from the source area to the destination. The destination can be the same, or 
a different, sprite. 

 

Mesa 

Causes the pixels of the current sprite to appear to be wrapped around a truncated cone pointing out 
of or into the shape of the current brush. 

 



Vortex 

Rotates the pixels of the current sprite around the center of the current brush while maintaining the 
orientation of the pixels at its borders. 

 

Spoke Inversion 

Inverts every spoke of an imaginary disk that just fits within the size of the current brush. The spoke is 
inverted by flipping its center end to the outside and flipping its outside end toward the center. 

 

Use Brush 

Specifies that a paintbrush will be used as a painting tool. This is the default setting. When Use 
Brush is selected, you can then click the paintbrush you want from the Paintbrush Selection Grid to 
apply a paint effect. 

 

Use Template 

Specifies that a template brush will be used as a painting tool. Sprites must measure 100 x 100 pixels 
or less to be used as a paintbrush template. You must first create a template from a selected sprite by 
using Set Template. 

 

Set Template 

Allows you to choose a sprite as a template brush. When you click Set Template, the currently 
selected sprite is used as a template brush to apply a paint effect. Click Use Template to apply paint 
tools in the shape of the sprite on which the template is based. 

 

Over 

Specifies how paint strokes are applied to sprites. When this button is selected, paint can be applied 
to all pixels within a sprite’s bounding box. When not selected, paint can be applied only to the 
opaque pixels of a sprite. 

 

Continuous Strokes 

Specifies whether the paint stroke is rendered with a solid, even flow of paint or with a slow buildup. 
When selected, Continuous Strokes delivers a smooth, solid paint stroke. When not selected, paint 
strokes are applied unevenly. 

 

New Brush 

Displays the Brush Designer dialog box.  

 

Delete Brush 

Deletes the current brush. 

 



Reset to Defaults 

Resets all brush settings to their default settings. Deletes all custom brushes. 

 

Start page (Save for the Web Wizard) 
 

This first page asks you to determine the content of the saved file.  

 To save all sprites, or a group of sprites, contained only within the composition space 

• Click All sprites inside the composition space. 

Sprites not completely within the composition space are cropped to its dimensions. This is the 
default if no sprites are currently selected. 

 

 To save all selected sprites or group of sprites 

• Click The selected sprite or Group.  

The composition space is not saved. This is the default when one or more sprites are currently 
selected. 

 

For more information on the composition space, see The composition space. For more information on 
selecting and grouping sprites, see Selecting sprites, tools, and colors.. 

You can click Finish on this, or on any subsequent page, to display the Save As dialog box and save 
the image you have chosen. 

 

Working with transparent areas (Save for the Web Wizard) 
 

Most sprites contain some transparent areas. If the currently selected sprites contain transparent 
pixels, choose one of these options to determine how transparency is dealt with. 

 To retain transparent areas of saved sprites 

• Click Let the web page background show through. 

This choice lets the background of the your Web page show through the transparent areas of the 
sprites you save. The resulting image will have an irregular shape. 

 

 To replace transparent areas of saved sprites with a background color 

• Click Fill them with a background color. 

This choice replaces the transparent areas of the saved sprites with a solid background color. The 
resulting image has a rectangular shape. 

 

The sample image below each button shows how a stock sprite would be rendered according to each 
choice. 

For more information on the working with transparency and opacity, see Opacity and transparency. 

 

Filling transparent areas with color (Save for the Web Wizard) 
 

You have chosen to fill the transparent areas of the sprites you are saving with a solid background 
color. Your choice produces a rectangular image. The color you specify on this page becomes the 
background when the image is saved.  

Any completely transparent pixels will be replaced by the color you choose. Partially transparent 
pixels will be blended with the color you choose. 



 To accept the color shown in the color chip  

• Click Next or Finish. 

Clicking Next leads you to the next page of the wizard. Clicking Finish leads you to the Save As 
dialog box.  

 

 To change the color that fills in the transparent areas 

• Click the color chip or the Color button. 

Either action displays the Color Picker. For more information on the using the Color Picker, see 
True Color. 

 

The Sample image shows a stock sample sprite against the color you have chosen for the 
background. 

 

Choosing a background type (Save for the Web Wizard) 
 

You have chosen to let the background of your Web page show through the transparent areas of the 
selected sprites. Now choose whether the image is saved with a soft or a hard edge, depending on 
the background of the Web page. Both choices avoid the halo around the image that can result when 
the edge is not properly blended with the background. 

 To save an image for a web page with a solid color 

• Click My web page's background is the following solid color. 

Click either the color chip or the Color button to display the Color Picker, which you use to pick a 
new color for the background. To accept the default color, click Next or Finish. 

 

 To save an image for a web page with a textured background 

• Click My web page's background is a tiled image.  

This choice adds a somewhat jagged edge to the image, but this result will not be a distraction 
against a tiled background. A tiled background is one in which a image has been applied 
repeatedly to fill the background space. 

 
 

Choosing image size and quality (Save for the Web Wizard) 
 

When you save a rectangular image for use on the Web, you can choose to match a modem 
connection speed with the file type that provides what you feel is the best quality image for the speed.  

 To choose a connection speed  

• In the Connection Speed box, select the connection speed for the download time you want. 

Select the speed you want to use as the basis for the download times shown in the samples for 
different file types and options. 

 

The Uncompressed (Original) box displays a rendered sample of the upper-left corner of the 
selected sprite or group you are saving. Use this image as a guide when you select a file type and 
quality for the image you are saving. You can pan the image in this box to see everything it contains. 

The image sample box shows samples of both .gif and .jpg versions of the selected image. For .jpg 
files, the box shows effects of differing levels of compression. 

 To choose a file type, and for JPEG files, a level of compression 

• Click the image in the image sample box that most closely resembles what you want to display on 
your Web page. 

For more information on saving different file types, see Opening and saving files overview. 
 
 



Summary page (Save for the Web Wizard) 
 

This final page of the Save for the Web Wizard summarizes the choices you have made in the 
previous pages. This page tells you which options to specify if you had used the File Save command 
in place of this wizard. 

 To accept the choices you have made  

• Click Finish.  

This action leads you to the Save As dialog box in which you specify a name and location for the 
file. 

 

 To change the choices you have made  

• Click Back until you reach the page that contains the information you want to change. 
 

For more information about saving images to files, see Opening and saving files overview. 

 

Rectangle 

On the Shapes palette, creates a rectangular sprite in the current color. 

On the Cutout palette, creates a rectangular selection that you can erase or cut out to create a new 
sprite. Erasing alters your original sprite; cutting out doesn’t affect your original sprite. 

 

Oval 

On the Shapes palette, creates a round or oval sprite in the current color. 

On the Cutout palette, creates a round or oval selection that you can erase or cut out to create a new 
sprite. Erasing alters your original sprite; cutting out doesn’t affect your original sprite. 

 

Curve 

On the Shapes palette, creates a freeform shape with curved lines in the current color. 

On the Cutout palette, creates a freeform selection with curved lines that you can erase or cut out to 
create a new sprite. Erasing alters your original sprite; cutting out doesn’t affect your original sprite. 

 

Polygon 

On the Shapes palette, creates a freeform shape with straight lines in the current color. 

On the Cutout palette, creates a freeform selection with straight lines that you can erase or cut out to 
create a new sprite. Erasing alters your original sprite; cutting out doesn’t affect your original sprite. 

 

Opacity slider 

Adjusts the percentage of opacity for the shape or cutout you are creating. To create a completely 
opaque shape or cutout, move the slider all the way to the right; to create a completely transparent 
shape or cutout, move the slider all the way to the left. 

 

Opacity box 



Specifies the percentage of opacity for the shape or cutout you are creating. To create a completely 
opaque shape or cutout, type 100; to create a completely transparent shape or cutout, type 0. 

 

Edge slider 

Adjusts how much of the edge of the shape or cutout will be feathered or blurry. For clean, crisp 
edges, move the slider toward Hard; for blurrier edges, move the slider toward Soft. The blurrier the 
edge, the better the sprite will blend with the other sprites behind it or the workspace. 

 

Close 

Specifies whether the shape you create with the Curve or Polygon tool is open or closed. If the 
Close check box is selected, the curved shape is closed. You can change this setting before you click 
Curve or Polygon. 

 

Fill 

Specifies whether the closed shape you create with the Curve or Polygon tool is filled with the 
current color. This check box is available only when the Close check box is selected. You can change 
this setting before you click Curve or Polygon. 

 

Line Width slider 

Adjusts the line width, in pixels, of the open shape you create with the Curve or Polygon tool. To 
change the line width, move the slider to the right. You can change the line width only when the Fill 
check box is empty. 

 

Line Width box 

Specifies the line width, in pixels, of the open shape you create with the Curve or Polygon tool. To 
change the line width, type a number from 1 to 20. You can change the line width only when the Fill 
check box is empty. 

 

Move Points 

Lets you adjust a shape you are drawing with the Curve or Polygon tool by clicking on the 
workspace to create points in the shape. To move the points in a new shape before you click Create, 
click this button and then drag any point in the shape to its new location. To move the points in a copy 
of an existing shape, click Recall Copy. Then drag any point in the shape to its new location, and 
click Create. 

 

Add Points 

Lets you add points to a shape you are drawing with the Curve or Polygon tool by clicking on the 
workspace to create points in the shape. To add points to a new shape before you click Create, click 
this button and then click on the shape where you want to add points. To add points in a copy of an 
existing shape, click Recall Copy. Then click on the shape where you want to add points, and click 
Create. 



 

Delete Points 

Lets you delete points from a shape you are drawing with the Curve or Polygon tool by clicking on 
the workspace to create points in the shape. To delete points from a new shape before you click 
Create, click this button and then click the points you want to delete. To delete points from a copy of 
an existing shape, click Recall Copy. Then click the points you want to delete, and click Create. 

 

Recall Copy 

Displays an editable outline of the last shape you created with the Curve or Polygon tool. You can 
then adjust the shape by using the Move Points, Add Points, and Delete Points buttons. 

 

Lock Tool 

Maintains the selected tool and its current settings so that you can draw more than one shape without 
reselecting the Rectangle, Oval, Curve, or Polygon tool and resetting the options you want to use. 

 

Create 

Creates a sprite in the shape you drew with the Rectangle, Oval, Curve, or Polygon tool. The 
current color is used to create the shape. 

 

Sprite Properties dialog box 
 

In the Sprite Properties dialog box, you can change the name of a sprite or view information about 
its size, screen position, and color model. 

Name   Shows the name of the selected sprite or displays (Multiple Selection) if you have more 
than one sprite or a group selected. If you inserted a sprite from a file, the sprite name matches the 
file name; otherwise, the sprites are numbered. If you selected a single sprite, you can change the 
name of the sprite by typing over the current name. 

Thumbnail   Displays a reduced version of the sprite or sprites. 

Width   Displays the number of pixels the sprite (or selection of sprites) extends from side to side. 

Height   Displays the number of pixels the sprite (or selection of sprites) extends from top to bottom. 

X   Displays the sprite’s location on the x-axis. When a sprite’s bounding box is aligned with the 
upper-left corner of the composition space, its x coordinate is 0. 

Y   Displays the sprite’s location on the y-axis. When a sprite’s bounding box is aligned with the 
upper-left corner of the composition space, its y coordinate is 0. 

Color model   Indicates which color model is used by the sprite. 

Has alpha   Indicates whether the alpha channel is used for transparency by this sprite. 

Num. channels   Displays the number of color channels in the sprite. For example, 4 indicates that 
the red, blue, green, and alpha channels are present in the current sprite or selection. 

Bits per channel   Displays the number of bits used to represent color in a single pixel of the sprite. 

OK   Closes this dialog box and saves any changes you made to the name of a sprite. 

Cancel   Closes this dialog box without saving changes you have made. 

Apply   Saves the changes you made to the sprite's name.  

Help   Displays the Sprite Properties Help topic. 



 
 

Composition Properties dialog box 
 

The Composition Properties dialog box allows you to view the size and color of the composition 
space, the composition's color model, and a list of the sprites in the composition. 

Width   Displays the number of pixels the composition space extends from side to side. 

Height   Displays the number of pixels the composition space extends from top to bottom. 

Thumbnail   Displays a reduced version of the composition. 

Color model   Indicates the color model that is used by the composition. 

Num. channels   Displays the number of color channels that are present in the composition. For 
example, 4 indicates that the red, blue, green, and alpha channels are present in the composition. 

Has alpha   Indicates whether the alpha channel is used for transparency by the composition. 

Bits per channel   Displays the number of bits used to represent color in a single pixel of the 
composition. 

Composition space color   Displays the current color of the composition space.  

Sprite list   Displays the names of the sprites in the composition. You can display the properties for 
each sprite by double-clicking the sprite's name. 

OK   Closes this dialog box and saved any changes you made to the width or height of the 
composition space. 

Cancel   Closes this dialog box without saving changes you have made. 

Help   Displays the Composition Properties Help topic. 
 
 

Toolbars dialog box 
 

The Toolbars dialog box allows you to select which toolbars appear in Microsoft Image Composer 
and to change some of their display properties. 

Toolbars   Specifies the available toolbars and allows you to select which toolbars appear. Select 
the box to display or clear the box to hide each item in the list. 

• Toolbar   Shows or hides the standard Image Composer toolbar that is located above the 
workspace. 

• Toolbox   Shows or hides the toolbox that you use to display the tool palettes. 

• Color Swatch   Shows or hides the Color Swatch that you use to select a new color or to 
display the Color Picker dialog box. 

• Status Bar   Shows or hides the area that displays mouse pointer position and other 
information at the bottom of the Image Composer window. 

Color buttons   Displays colored buttons on the standard toolbar. 

Large icons   Enlarges the buttons on the standard toolbar so that they are easier to see. 

Show ToolTips   Displays on-screen descriptions of the standard toolbar buttons when the pointer 
pauses on them. 

Auto hide palettes between uses   Automatically hides tools and effects palettes from the screen 
while you work. To show the palette again, move your pointer over the status bar. 

OK   Closes this dialog box and saves the changes you have made. 

Cancel   Closes the dialog box without saving the changes you have made. 

Help   Displays the Toolbars Help topic. 
 
 

Smoothing 

Applies smoothing to a text sprite. Smoothing results from blending transparencies at the edges of the 
sprite and may result in a slightly fuzzy-looking text sprite for small fonts. For crisper text sprites, clear 



this check box. 

 

Underline 

Applies an underline the text sprite. 

 

Font 

Displays the Font dialog box. Click any scaleable font installed on your computer. 

 

Size 

Specifies the size of the font of the text sprite. 

 

Style 

Specifies the style of the font of the text sprite. 

 

Script 

Specifies the type of script for the text sprite. 

 

Color 

Displays the Color Picker from which you choose the text sprite's color. 

 

Align Left 

Aligns the text sprite with the left side of the text entry box. 

 

Align Center  

Aligns the text sprite with the center of the text entry box. 

 

Align Right 

Aligns the text sprite with the right side of the text entry box. 

 

 

Texture Transfer list 

Displays the texture transfers that let you copy properties, such as the color, shape, or transparency, 
of a source sprite to other selected sprites. To apply a texture transfer, select a source sprite and one 
or more destination sprites. Then click a texture transfer in this list and click Apply. 

 



Opacity slider/box 

Adjusts the amount of opacity in the source sprite that will be transferred onto the destination sprite. 
Low opacity values create a more transparent result, retaining more of the destination sprite's original 
look. High opacity values transfer more of the source sprite’s original look. To decrease the amount of 
opacity, move the slider to the left or enter a smaller number in the Opacity box, and then click 
Apply. The number in the box must be between 0 and 100. 

 

Threshold 

Specifies the intensity value that is compared with the portion of the destination sprite that overlaps 
the source sprite for the Map Color and Map Intensity texture transfers. If the intensity value of the 
source sprite is higher than the Threshold value, the intensity of the transferred pixels increases and 
the colors of those pixels appear brighter. If the intensity value of the source sprite is lower than the 
Threshold value, the intensity of the transferred pixels decreases and the colors of those pixels 
appear darker. The default value is 127. To change the value, enter a number between 0 and 255, 
and then click Apply. 

 

Horizontal tile spacing 

Specifies the horizontal spacing between tiled copies of the source sprite on the destination sprite. 
The value represents the number of pixels between a tile and the next tile to its right. To change the 
value, type a number between -100 and 100, and then click Apply. A value of 0 lets the edges of the 
tiled sprites touch. A positive value adds space between tiles; a negative value causes tiles to 
overlap. 

 

Vertical tile spacing 

Specifies the vertical spacing between tiled copies of the source sprite on the destination sprite. The 
value represents the number of pixels between a tile and the next tile below it. To change the value, 
type a number between -100 and 100, and then click Apply. A value of 0 lets the edges of the tiled 
sprites touch. A positive value adds space between tiles; a negative value causes tiles to overlap. 

 

Use Default 

Resets the controls for the selected texture transfer to their default values. 

 

Apply 

Applies the selected texture transfer without closing the palette. 

 

View tab (Options dialog box) 
 

The View tab allows you to control the scroll bars and hint dialog boxes that appear in your 
workspace. If you’re running Image Composer on a high-color display system, you can also use 
high-color dithering so your images look better on the screen. 

Show scroll bars 

Removes or displays horizontal and vertical scroll bars. 



Show Hint dialogs 

Removes or displays Hint dialog boxes that provide additional information about a tool. You can also 
choose to hide specific Hint dialog boxes by clearing the Always show this message check box 
when the Hint dialog box appears. 

Dither high color displays 

Turns dithering on or off for high-color (16-bit) displays. High-color dithering can make the colors in 
your images look better when you view them in Image Composer. This is especially true of gradients, 
where colors may look banded instead of smoothly blended if they aren’t dithered. High-color 
dithering does not affect actual file output; rather, it improves the way you view the images within 
Image Composer. 

Note   You may want to clear this check box if you’re concerned with system speed, because 
high-color dithering can slow down system performance. 

Reset Hints 

Restores all Hint dialog boxes in Image Composer. If you clear the Always show this message 
check box in a Hint dialog box, clicking Reset Hints causes the hint dialog to appear again. 

 
 

Plug-Ins tab (Options dialog box) 
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The Plug-Ins tab allows you to specify a path and folder for plug-in  programs in addition to the 
default path. To use a specific plug-in with Image Composer, the plug-in must be located in one of 
these two paths. 

Microsoft Image Composer Plug-In directory 

Displays the default path for plug-in software. This path is read-only. You can manually copy plug-in 
program files to this directory, but you must restart Image Composer before you can access the 
software from the Plug-Ins menu. 

Additional Plug-In directory 

Specifies a path to a folder containing additional plug-in programs. If you have plug-ins that you want 
to use with Image Composer, type the path to the folder that contains their program files, or click 
Browse to find the folder. Any plug-ins located in this folder appear on the Plug-Ins menu.  

Browse button 

Displays the Choose Plug-In Directory dialog box, where you can select a new plug-ins folder. 

 

Gamma Tab (Options dialog box) 
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With the Gamma tab, you can specify the setting that determines the overall brightness of an image. 
Because of differences in gamma settings, an image that looks perfectly fine on your screen may look 
washed out or too dark when viewed on another display system or computer platform. Image 
Composer performs gamma processing on image input and output operations so that images viewed 
on different output devices (computer monitors, video monitors, printers, etc.) look similar. 

Gamma 

Specifies the gamma value that Image Composer uses for output operations. This setting must be a 
positive value between 0.0 and 10.0. (At 1.0, gamma correction is turned off.) The default of 2.2 is 
designed to compensate for gamma differences in output devices, so you don't need to change this 
value unless you know the specific gamma settings for a particular monitor or printer. 

Note   Gamma can affect color values as well as brightness. For example, when you set RGB 
values in the Color Picker dialog box, you may notice that the values change slightly when you 
reopen the dialog box. This behavior is caused by an internal color conversion process within Image 
Composer. While the values may be slightly different, the color shift is not visible to the eye. 
 

Defaults button 

Resets the gamma setting to its default value. 

 

Edit Tab (Options dialog box) 
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The Edit tab allows you to specify the minimum and maximum distance a selected sprite moves when 
you use the ARROW keys to manipulate sprites in your composition. 

Small offset (arrow key) 

Specifies the distance that a selected sprite moves when you press the ARROW key. This value must 
be an integer between 1 and 100. 

X   Specifies how far (in pixels) the selected sprite moves on the horizontal axis (x-axis) when the 
LEFT ARROW or RIGHT ARROW keys are pressed. The default is 1. 

Y   Specifies how far (in pixels) the selected sprite moves on the vertical axis (y-axis when the UP or 
DOWN keys are pressed. The default is 1. 

Large offset (Ctrl + arrow key) 

Specifies the distance that a selected sprite moves when you press the CTRL + ARROW key. This value 
must be an integer between 1 and 1000. 

X   Specifies how far (in pixels) the selected sprite moves on the horizontal axis (x-axis) when CTRL + 
the LEFT or RIGHT ARROW keys are pressed. The default is 50. 

Y   Specifies how far (in pixels) the selected sprite moves on the vertical axis (y-axis) when CTRL + 
the UP or DOWN keys are pressed. The default is 50. 

 

Rectangle  
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Rectangle creates a selection in the shape of a rectangle. If used with SHIFT, Rectangle creates a 
selection in the shape of a square. 

Where to find this item 

Rectangle is available on the Cutout palette in the Cutout Tools tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 

Before you draw the bounding box for a cutout, you can: 

• Make the sprite more opaque by moving the Opacity  slider to the right or by entering a larger 
number in the Opacity box. The number in this box must be between 0 and 100. To allow more of 
the background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch on the toolbox and choosing a different 
color. When you erase the selection, the rectangle is filled with the current color. 

 

After you draw the bounding box of a cutout but before you click Cut Out or Erase, you can adjust the 
size and shape of the bounding box. 

 

Oval  
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Oval creates a selection in the shape of an oval. If used with SHIFT, Oval creates a selection in the 
shape of a circle. 

Where to find this item 

Oval is available on the Cutout palette in the Cutout Tools tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 



Before you draw the bounding box for a cutout, you can: 

• Make the sprite more opaque by moving the Opacity  slider to the right or by entering a larger 
number in the Opacity box. The number in this box must be between 0 and 100. To allow more of 
the background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch on the toolbox and choosing a different 
color. When you erase the selection, the oval is filled with the current color. 

 

After you draw the bounding box of a cutout but before you click Cut Out or Erase, you can adjust the 
size and shape of the bounding box. 

 

Curve  
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Curve creates a freeform selection with curved edges that are connected by points that you specify. 
You can edit these points to adjust the overall shape of the selection. 

Where to find this item 

Curve is available on the Cutout palette in the Cutout Tools tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 

Before you draw the bounding box for a cutout, you can: 

• Make the sprite more opaque by moving the Opacity  slider to the right or by entering a larger 
number in the Opacity box. The number in this box must be between 0 and 100. To allow more of 
the background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch in the toolbox and choosing a different 
color. When you erase the selection, the freeform shape is filled with the current color. 

 

After you draw the bounding box of a freeform cutout but before you click Cut Out or Erase, you can 
adjust the size and shape of the bounding box by using Move Points , Add Points , and Delete 
Points . 

 

Polygon  
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Original sprite Selection erased Selection cut out 

 

Polygon creates a selection with straight edges that are connected by points that you specify. You 
can edit these points to adjust the overall shape of the selection. 

Where to find this item 

Polygon is available on the Cutout palette in the Cutout Tools tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 

Before you draw the bounding box for a cutout, you can: 

• Make the sprite more opaque by moving the Opacity  slider to the right or by typing a larger 
number in the Opacity box. The number in this box must be between 0 and 100. To allow more of 
the background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch in the toolbox and choosing a different 
color. When you erase the selection, the polygon is filled with the current color. 

 

After you draw the bounding box of a freeform cutout but before you click Cut Out or Erase, you can 
adjust the size and shape of the bounding box by using Move Points , Add Points , and Delete 
Points . 

 

Stencil  
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Original sprite Stencil 

 

Stencil creates a reverse copy of the selected sprite by filling the transparent pixels inside the sprite’s 
bounding box with the current color. The new sprite contains opaque pixels where the selected sprite 
was transparent, and transparent pixels where the selected sprite was opaque. 

Where to find this item 

Stencil is available on the Cutout palette in the Cutout Tools tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 



Change the current color by clicking the Color Swatch on the toolbox and choosing a different color. 

Tip   Stencil works best on sprites that have distinct transparent areas. If the sprite has partially 
transparent areas, those areas in the cutout will also be partially transparent. If you use Stencil on a 
sprite with no transparent pixels, the new sprite will be completely transparent and therefore not 
visible in the workspace. 
 
 

Select Color Region 
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Select Color Region selects the pixel you click in a sprite, as well as the other pixels in the sprite that 
match its hue, whitenesss, and blackness values. Selecting pixels with this tool has a cumulative 
effect: Each time you click a different pixel in a sprite, more pixels are added to your selection. You 
can also click a pixel to delete pixels with similar hue, whiteness, and blackness values from your 
selection. 

Where to find this item 

Select Color Region is available on the Cutout palette in the Select Color Region tab. 

How to apply this item 

Click a picture to learn how to create the cutout. 

How to vary the results 

• To select pixels with the same hue, move the Hue slider to the left or enter a smaller number in the 
Hue box. To select pixels that have less similar hue values, move the Hue slider to the right or 
enter a larger number in the Hue box. If you type a number in the box, it must be between 0 and 
100. 

• To select pixels with the same whiteness value, move the Whiteness slider to the left or enter a 
smaller number in the Whiteness box. To select pixels that have less similar whiteness values, 
move the Whiteness slider to the right or enter a larger number in the Whiteness box. If you type 
a number in the box, it must be between 0 and 100. 

• To select pixels with the same blackness value, move the Blackness slider to the left or enter a 
smaller number in the Blackness box. To select pixels that have less similar blackness values, 
move the Blackness slider to the right or enter a larger number in the Blackness box. If you type 
a number in the box, it must be between 0 and 100. 

• To select neighboring pixels that match the Hue, Whiteness and Blackness settings, set the 
Search Mode to Local. To select any pixels in the sprite that match these settings, set the mode 
to Global   

• If you want the pixels you cut out or erase to exactly match the pixels you selected, move the Edge 
slider to the left. If you want to blur the edges of the pixels you cut out or erase, move the slider to 
the right. 

 
 

Cutout overview 
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Cutout palette 

 

With the tools on the Cutout palette, you can erase or copy areas of a sprite in a rectangular, oval, 
polygonal, or freeform shape. When you use one of the Cutout tools to select an area of a sprite, you 
can erase the selected pixels so that they are transparent, or you can create a new sprite from the 
selection. 

The Cutout palette provides two methods for creating a selection: 

• Use a tool on the Cutout Tools tab to select a portion of a sprite in a specific shape: 
 

 Rectangle creates a rectangular selection. You can also use 
Rectangle with the SHIFT key to create a square selection. 

 Oval creates an oval selection. You can also use Oval with the 
SHIFT key to create a round selection. 

 Curve creates a selection in a freeform shape with curved edges. 
After you create a shape with the Curve tool, you can edit its 
points to adjust the overall shape of the selection. 

 Polygon creates a selection in a freeform shape with straight 
edges. After you create a shape with the Polygon tool, you can 
edit its points to adjust the overall shape of the selection. 

 Stencil creates a new sprite that is an inverse of the selected 
sprite. The transparent pixels within the bounding box of the 
selected sprite are filled with the current color in the new sprite, 
and the opaque pixels in the selected sprite are transparent in the 
new sprite. 

 

• Use the tool on the Select Color Region tab to select a portion of a sprite where the pixels have 
the same or a similar color. 

 

 

 Select Color Region selects the pixel that you click on as well as 
the surrounding pixels that have the same color. You can adjust 
the settings for this tool to: 

• Include pixels in your selection that are similar to, but not 
exactly the same as, the color of the pixel you click on. 

• Add to or delete from your selection when you select 
additional color regions in the sprite. 

• Search the entire sprite for pixels that match the color of the 
pixel you click on, or search just its neighboring pixels. 

• Smooth the edges of your selection to avoid jagginess.  
 
 

Creating rectangular and oval cutouts from a sprite 
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Create a rectangular or oval cutout of a sprite when you want to duplicate a portion of a sprite in the 
shape of a rectangle, square, oval, or circle. 



For example, if you want to create an oval portrait of a rectangular photograph, you can create an 
oval cutout. You can create rectangular cutouts as an alternative to cropping sprites: Instead of 
trimming away the excess portion of a sprite with the Crop/Extend tool, you can draw a rectangle 
around the area you want to keep. You can then turn that rectangle into a new sprite without affecting 
the original sprite. 
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 To create a rectangular or oval cutout from a sprite 

1 Select the sprite you want to create a cutout from. 

2 On the toolbox, click Cutout . 

3 On the Cutout Tools tab: 

• Click Rectangle  if the area you want to cut out can be encompassed best in a square or 
rectangular shape. 

• Click Oval  if the the area you want to cut out can be encompassed best in an oval or circular 
shape. 

 

4 If you want the cutout to be more transparent than the selected sprite, move the Opacity  slider to 
the left. You can also set the opacity by typing a number between 0 and 100 in the Opacity box. 

5 Set the Edge slider to the desired position. For a crisp edge, move the slider all the way to the left; 
to blend the edge of the cutout with the background, move the slider toward the right. 

Tip   Softer edges make it easier to blend the new sprite with other sprites in new compositions or 
in a different area of the current composition. 

 

6 Place the pointer on or near the sprite, and then drag a selection outline. To create a square or 
circle, hold down SHIFT while dragging. 

7 To move the selection outline, position the pointer in the center of the outline until a small square 
appears, and then drag the outline to its new location. To resize the selection outline, position the 
pointer over an edge of the outline until a small square appears, and then drag that edge or corner 
to its new position. 

8 Click Cut Out. 

9 Move the sprites apart to see the result. 
 
 

Creating freeform cutouts from a sprite 
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Create a freeform cutout of a sprite when you want to duplicate a portion of a sprite in an irregular 
shape. You can create a freeform cutout with curved or straight edges. 

For example, if you want to cut out a flower from its background, you can click around its petals and 
make that selected area into a new sprite. You can also create freeform cutouts as an alternative to 
erasing background images: Instead of erasing pixels in a sprite with the Erase tool, you can select 
the area you want to keep and turn that selection into a new sprite without affecting the original sprite. 
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 To create a freeform cutout from a sprite 

1 Select the sprite you want to create a cutout from. 

2 On the toolbox, click Cutout . 

3 On the Cutout Tools tab: 

• Click Curve  if you want the cutout to have curved edges. 

• Click Polygon  if you want the cutout to have straight edges. 

4 If you want the cutout to be more transparent than the selected sprite, move the Opacity  slider to 
the left. You can also set the opacity by typing a number between 0 and 100 in the Opacity box. 

5 Set the Edge slider to the desired position. For a crisp edge, move the slider all the way to the left; 
to blend the edge of the cutout with the background, move the slider toward the right. 

Tip   Softer edges make it easier to blend the new sprite with other sprites in new compositions or 
in a different area of the current composition. 

 

6 Click on the selected sprite or the workspace to create the first point of the curve or polygon. 
Continue to click where you want to add each new point to the selection outline. The outline of the 
freeform cutout is automatically drawn as you specify each point. 

7 To change the selection outline, click a button under Edit curve or polygon: 

• To move a point, click Move Points . Then position the pointer over a point until a small square 
appears, and drag that point to its new position. 

• To add a point, click Add Points . Then click on the pixel in the sprite where you want to add 
the new point. 

• To delete a point, click Delete Points . Then position the pointer over a point until a small 
square appears, and click that point to delete it. 

 

Tip   Be sure to click one of these buttons before you try to edit the points in a curve or polygon, 
or each click in the sprite will add a new point to the selection outline. 

 

8 Click Cut Out. 

9 Move the sprites apart to see the result. 
 
 

Erasing rectangular and oval areas in a sprite 
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You can partially or totally erase areas of a sprite in the shape of a rectangle or oval. For example, if 
you want to create a hole in a sprite so that another image shows through, you can create a circular 
cutout. 
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 To erase a rectangular or oval area in a sprite 

1 Select the sprite you want to edit. 

2 On the toolbox, click Cutout . 

3 On the Cutout Tools tab: 

• Click Rectangle  if the area you want to erase is a square or rectangular shape. 

• Click Oval  if the the area you want to erase is an oval or circular shape. 
 

4 If you want the erased area to be more transparent, move the Opacity  slider to the left. You can 



also set the opacity by typing a number between 0 and 100 in the Opacity box. 

5 Set the Edge slider to the desired position. For a crisp edge, move the slider all the way to the left; 
to blend the edge of the cutout with the background, move the slider toward the right. 

6 Place the pointer on or near the sprite, and then drag a selection outline. To create a square or 
circle, hold down SHIFT while dragging. 

7 To move the selection outline, position the pointer in the center of the outline until a small square 
appears, and then drag the outline to its new location. To resize the selection outline, position the 
pointer over an edge of the outline until a small square appears, and then drag that edge or corner 
to its new position. 

8 Click Erase. 
 
 

Erasing freeform areas in a sprite 
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You can partially or totally erase areas of a sprite in a freeform shape. For example, if you want to 
place a sprite of a window over a sprite of a landscape, you could partially erase the window panes so 
that they’re semi-transparent and the landscape sprite shows through. 

Erasing freeform areas is also useful when you want to erase nonrectangular or nonelliptical areas of 
a sprite, such as triangles, hexagons, and shapes with many curves. 

   

Original sprite Selection outline on 
sprite 

Result 

 

 To erase a freeform area in a sprite 

1 Select the sprite you want to edit. 

2 On the toolbox, click Cutout . 

3 On the Cutout Tools tab: 

• Click Curve  if you want to erase an area with curved edges. 

• Click Polygon  if you want to erase an area with straight edges. 
 

4 If you want the erased area to be more transparent, move the Opacity  slider to the left. You can 
also set the opacity by typing a number between 0 and 100 in the Opacity box. 

5 Set the Edge slider to the desired position. For a crisp edge, move the slider all the way to the left; 
to blend the edge of the cutout with the background, move the slider toward the right. 

6 Click on the selected sprite or the workspace to create the first point of the curve or polygon. 
Continue to click where you want to add each new point to the selection outline. 

7 To change the selection outline, click a button under Edit curve or polygon: 

• To move a point, click Move Points . Then position the pointer over a point until a small square 
appears, and drag that point to its new position. 

• To add a point, click Add Points . Then click on the pixel in the sprite where you want to add 
the new point. 

• To delete a point, click Delete Points . Then position the pointer over a point until a small 
square appears, and click that point to delete it. 

 

Tip   Be sure to click one of these buttons before you try to edit the points in a curve or polygon, 
or each click in the sprite will add a new point to the selection outline. 

 

8 Click Erase. 
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Creating a complementary shape of a sprite creates a copy of the sprite that contains opaque pixels 
where the original sprite was transparent, and transparent pixels where the original sprite was 
opaque. 

You can create a complementary shape of a sprite as an alternative to: 

• Using the Curve or Polygon tools when you want to erase an area of a completely opaque sprite 
that has many intricate, irregular edges and a solid background. Setting the current color to the 
sprite’s background color and creating a complementary shape produces the same result as 
erasing the freeform area. 

• Using the Color Bounding Box effect, which colors all the opaque and transparent pixels within a 
sprite’s bounding box. 

 

  

Original sprite Result 

 

 To create a complementary shape of a sprite 

1 Select the sprite you want to create a complementary shape of. 

2 In the toolbox, click Cutout . 

3 On the Cutout Tools tab, click Stencil . 

4 Move the sprites apart to see the result. 
 
 

Selecting color regions of a sprite 
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You can select a portion of a sprite that has distinct areas of color by using the Select Color Region 
tool. When you click on a sprite with this tool, the color of the pixel you clicked on is compared with 
the color of its neighboring pixels. If the colors match, those pixels are added to the selection. For 
example, you can use this tool to select the eye color of a subject in a scanned photograph so that 
you can change that color without affecting the rest of the image. 

You can set options for this tool to define: 

• How similar the colors in the neighboring pixels must be to the selected pixel in order for them to 
also be selected.  

• Whether matching pixels will be added to or deleted from the selection. 

• Whether to search neighboring pixels only or the entire sprite. 

• If you create a new sprite from the selected color region, how crisp or fuzzy you want the edges in 
the new sprite to appear. 

 

Hue, Whiteness, and Blackness 

You can specify the degree of similarity, on a scale from 0 to 100, between the hue, whiteness, and 
blackness of the pixel you clicked and the pixels surrounding it. If all three settings are close to 0, the 



hue, whiteness and blackness values of the neighboring pixels must be nearly identical to the 
selected pixel. If these settings are close to 100, the match does not need to be very precise. 

Tip   A good starting position is to set the Hue to 0, and set the Whiteness and Blackness to 100. 
You can then increase the Hue gradually to broaden the selection. 
 

Search and Selection modes 

You can set the Search Mode for the Select Color Region tool so that clicking a pixel selects all the 
neighboring pixels that match its color. Set the Search Mode to Local for this type of result. To 
broaden the scope of the search to every pixel in the sprite, set the Search Mode to Global. A global 
search compares the pixel you click on with every other pixel in the sprite. 

You can also specify whether you want to add the matching pixels to your selection or remove them 
from your selection. Selecting color regions has a cumulative effect: Each time you click a different 
pixel in the sprite, more pixels are added to or removed from your selection. Thus, you can change 
the Selection setting to Add or Delete before each click. By clicking on different parts of the sprite, 
adjusting the Hue, Whiteness, and Blackness settings, and switching selection modes, you can 
precisely define the region you want to select. 

If you want to undo the results of your last click, switch selection modes and click Redo Last. For 
example, if you were in Add mode and clicked a pixel that added pixels to your selection that you 
don’t want to include, you would click Delete and then click Redo Last to remove those pixels. 
Conversely, if you were in Delete mode and removed a group of pixels you wanted to keep in your 
selection, you would click Add and then click Redo Last to reselect them. 

Opacity and smoothness of copied sprites 

When you cut out the selected color region to create a new sprite, you can define the opacity of that 
sprite as well as the smoothness of its edges: 

• An Opacity setting of 0 makes the new sprite completely transparent, and thus invisible; an opacity 
setting of 100 makes the sprite completely opaque. 

• You can adjust the amount of fuzziness around the edges in the new sprite by moving the Edge 
setting toward Hard for crisper edges or toward Soft for fuzzy edges. 

 

Tip   Softer edges make it easier to blend the new sprite with other sprites in new compositions or 
in a different area of the current composition. 

 
 

Copying color regions of a sprite 
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Original sprite New sprite New sprite with 
smooth edges 

 

When you want to duplicate a portion of a sprite that has distinct areas of color, you can use the 
Select Color Region tool. This tool copies the color region you select to a new sprite without 
affecting the original sprite. 

If the portion you want to duplicate is harder to select than the rest of the sprite, you can duplicate the 
entire sprite and then use the Select Color Region tool to select the portion you want to erase. For 
details, see Erasing selected colors in a sprite. 

 To copy a color region of a sprite 



1 Select the sprite that you want to copy a portion of. 

2 On the toolbox, click Cutout . 

Tip   Before continuing, verify that the Opacity  setting on the Cutout Tools tab is correct. If you 
want to the new sprite to be completely opaque, move the slider all the way to the right or enter 
100 in the box. 

3 On the Select Color Region tab, click Select Color Region . 

4 Set the desired options: 

To Do this 
 

Define the degree of similarity 
between the hue, whiteness, and 
blackness of the pixel you clicked 
and the pixels surrounding it. 

Move the Hue, Whiteness, and 
Blackness sliders or enter a 
number between 0 and 100 in their 
corresponding boxes. 

Specify a more precise match. Move the Hue, Whiteness, and 
Blackness sliders closer to the left 
or enter smaller numbers in the 
boxes. 

Add matching pixels to your 
selection. 

Under Selection, click Add. 

Remove matching pixels from your 
selection. 

Under Selection, click Delete. 

Search only neighboring pixels for 
matching Hue, Whiteness, and 
Blackness values. 

Under Search Mode, click Local. 

Search every pixel in the sprite for 
matching values. 

Under Search Mode, click Global. 

 

5 Click inside the selected sprite on the color region you want to select. Matching pixels appear in 
the current color. 

Tip   To undo the result of your last click, change the Selection option and click Redo Last. 
 

6 Repeat steps 4 and 5 to add pixels to your selection or remove them from your selection. 

7 Move the Edge slider if you want to reduce the appearance of jagged edges in the new sprite. 

Tip   Softer edges make it easier to blend the new sprite with other sprites in new compositions or 
in a different area of the current composition 

 

8 Click Cut Out. 

9 Move the sprites apart to see the result. 
 
 

Local Search Mode 

Marks only color pixels that match the specified color range and touch or connect to each other within 
an area. 

 

Global Search Mode 

Marks all color pixels that match the specified color range within the entire sprite. 

 

Erasing selected colors in a sprite 
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Original sprite Color region 
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Result 

 

When you want to erase pixels in a sprite that are the same as or similar to a specific color, you can 
use the Select Color Region tool. This tool searches the sprite for pixels that match the color of the 
pixel you click on, and creates a color region that you can erase. When you erase the selected pixels, 
they become transparent. Erasing selected colors in a sprite is particularly useful when you create an 
image for a Web page and you want the page’s background to show through a portion of the image. 

You can use Select Color Region as an alternative to the Erase tool when you want to erase pixels 
with the same color that are either clustered together or scattered throughout a sprite.  

 To copy a color region of a sprite 

1 Select the sprite that you want to erase a portion of. 

2 On the toolbox, click Cutout . 

Tip   Before continuing, verify that the Opacity  setting on the Cutout Tools tab is correct. If you 
want to the new sprite to be completely opaque, move the slider all the way to the right or enter 
100 in the box. 

 

3 On the Select Color Region tab, click Select Color Region . 

4 Set the desired options: 

To Do this 
 

Define the degree of similarity 
between the hue, whiteness, and 
blackness of the pixel you clicked 
and the pixels surrounding it. 

Move the Hue, Whiteness, and 
Blackness sliders or enter a 
number between 0 and 100 in their 
corresponding boxes. 

Specify a more precise match. Move the Hue, Whiteness, and 
Blackness sliders closer to the left 
or enter smaller numbers in the 
boxes. 

Add matching pixels to your 
selection. 

Under Selection, click Add. 

Remove matching pixels from your 
selection. 

Under Selection, click Delete. 

Search only neighboring pixels for 
matching Hue, Whiteness, and 
Blackness values. 

Under Search Mode, click Local. 

Search every pixel in the sprite for 
matching values. 

Under Search Mode, click Global. 

 

5 Click inside the selected sprite on the color region you want to select. Matching pixels appear in 
the current color. 

Tip   To undo the result of your last click, change the Selection option and click Redo Last. 
 

6 Repeat steps 4 and 5 to add pixels to your selection or remove them from your selection. 

7 Click Erase. 
 
 

Arts & Crafts effects 
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The Arts & Crafts category allows you to apply specialized effects to sprites to generate a specific 
result. For example, you can make sprites that seem to be created: 

• From pieces of stained glass. 

• From pieces of tile, like a mosaic. 

• By an ink stamp. 
 

   Click the effect you want to read about: 

   

Original sprite Cutout Flocking 

   

Mosaic Poster Sandpaper 

   

Stained Glass Stamp Stone Print 

   

Torn Edges   

 
 

Cutout 
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Original sprite Cutout 

 

Cutout creates the appearance that the sprite is composed of roughly cut pieces of colored paper. 
High-contrast sprites appear to be silhouetted, while colored images appear to be composed of 
several layers of colored paper. Cutout can also look like a linoleum block print, especially when 
applied to a simple high-contrast sprite. 

Where to find this effect 

Cutout is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Cutout picture to find out how to apply this effect. 

How to adjust the results 

• For more levels of color, move the Number of levels slider to the right or enter a larger number in 
the Number of levels box. The number must be between 2 and 8. Higher settings create greater 
detail. 

• To simplify the cutout edge, move the Edge simplicity slider to the right or enter a larger number 
in the Edge simplicity box. The number must be between 0 and 10. 



• To depress the cutout edges and retain the fidelity of the shapes in the sprite, move the Edge 
fidelity slider or enter a larger number in the Edge fidelity box. To create a more distorted 
representation of the sprite, move the slider to the left or enter a smaller number in the box. The 
number must be between 1 and 3. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tip   For more depth and overlap of the layers created with Cutout, try following it with the Emboss 
effect. 
 
 

Flocking 

(Called Note Paper in Microsoft Image Composer 1.0) 
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Original sprite Flocking 

 

Flocking creates the appearance that the sprite was imprinted on embossed paper, such as blotting 
paper. 

The dark areas in the original sprite become the embossed areas, which use the current color. The 
light areas become the rough paper surface, which takes on the color of the composition space. 

Where to find this effect 

Flocking is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Flocking picture to find out how to apply this effect. 

How to adjust the results 

• To increase the number of dark areas in the sprite, which will become embossed regions, move 
the Image balance slider to the right or enter a larger number in the Image balance box. To 
increase the number of light areas in the sprite, which will become rough paper areas, move the 
slider to the left or enter a smaller number in the box. The number must be between 0 and 50. 

• For grainier paper, move the Graininess slider to the right or enter a larger number in the 
Graininess box. The number must be between 0 and 20. 

• To increase embossing, move the Relief slider to the right or enter a larger number in the Relief 
box. The number must be between 0 and 25. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• To incorporate textures other than simple grain, apply Flocking with Graininess set to 0. Then 
apply Rough Textures with your choice of texture. 

• Enliven black-and-white sprites by applying Flocking with different colors in the Color Swatch and 
composition space. 



 
 

Mosaic 
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Original sprite Mosaic 

 

Mosaic creates the appearance that the sprite is made of small, square tiles laid on a flat surface. 
The squares are shadowed to indicate varying degrees of depth. 

Where to find this effect 

Mosaic is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Mosaic picture to find out how to apply this effect. 

How to adjust the results 

• For larger squares, move the Square size slider to the right or enter a larger number in the Square 
size box. For smaller squares and a pebbly appearance, move the slider to the left or enter a 
smaller number in the box. The number must be between 0 and 10. 

• For greater depth and contrast, move the Relief slider to the right or enter a larger number in the 
Relief box. For a flatter appearance, move the slider to the left or enter a smaller number in the 
box. The number must be between 0 and 25. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• After applying Mosaic, you can create a needlepoint look by using Rough Textures with a fabric 
texture (for example, Canvas or another scanned cloth texture). 

• To give the features of a sprite more definition, try adjusting the contrast before applying Mosaic. 
When contrast is high, large areas of the sprite flatten out and don’t show the three-dimensional 
surface features characteristic of this effect. 

 
 

Poster 
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Original sprite Poster 

 



Poster reduces the number of color shades in a sprite and adds dark lines along its edges. Large, 
broad areas have simple shading, while fine, dark detail is distributed throughout the sprite. 

Where to find this effect 

Poster is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Poster picture to find out how to apply this effect. 

How to adjust the results 

• To make the added edges thicker, move the Edge thickness slider to the right or enter a larger 
number in the Edge thickness box. The number must be between 0 and 10. 

• To make edge outlining more apparent, move the Edge intensity slider to the right or enter a 
larger number in the Edge intensity box. The number must be between 0 and 10. 

• To increase the number of colors in the sprite, move the Posterization slider to the right or enter a 
larger number in the Posterization box. The number must be between 0 and 6. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tip   Before applying Poster, try sharpening the sprite and adjusting the brightness and contrast. 
For details, see Color controls overview. 
 
 

Sandpaper 
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   To learn how to apply this effect, click a picture. 

  

Original sprite Sandpaper 

 

Sandpaper creates the appearance that the sprite was imprinted on rough-grained paper, such as 
sandpaper. This effect renders the darker areas of the sprite with dense clumps of dark emulsion and 
the lighter areas with stippled grain. 

The dark areas in the original sprite use the current color. Midtones and highlights use tints of color 
from the composition space. 

Where to find this effect 

Sandpaper is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Sandpaper picture to find out how to apply this effect. 

How to adjust the results 

• For denser stippling, move the Density slider to the right or enter a larger number in the Density 



box. The number must be between 0 and 50. 

• To increase the areas taking on the current color, move the Black level slider to the right or enter 
a larger number in the Black level box. The number must be between 0 and 50. 

• To increase the areas taking on the color of the composition space, move the White level slider to 
the right or enter a larger number in the White level box. The number must be between 0 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• You can create a range of evocative effects by applying Diffuse Glow before applying Sandpaper. 
Try adding just a little of the Glow amount setting. 

• Try using the Sandpaper effect to add background paper texture and grain to a composition. 
  
 

Stained Glass 
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Original sprite Stained Glass 

 

Stained Glass creates the illusion that the sprite is made up of small pieces of colored glass lit from 
behind. You can vary the strength of the light shining through the glass from an even glow to a 
focused brilliance. The borders around the pieces of glass are rendered in the current color. 

Where to find this effect 

Stained Glass is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Stained Glass picture to find out how to apply this effect. 

How to adjust the results 

• For bigger stained-glass pieces, move the Cell size slider to the right or enter a larger number in 
the Cell size box. The number must be between 1 and 50. 

• For wider borders around the glass pieces, move the Border thickness slider to the right or enter 
a larger number in the Border thickness box. The number must be between 1 and 20. 

• To brighten the light that shines through the glass pieces, move the Light intensity slider to the 
right or enter a larger number in the Light intensity box. The number must be between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• By applying Poster or Cutout before applying the Stained Glass effect, you can create larger 
areas of common color to enhance this effect. 

• To make the sprite appear to be viewed through leaded glass, reduce the Opacity setting, choose 
a dark color for the borders, and reduce the Light intensity setting. 



• To give the sprite an antique look, apply the Ripple effect with low Ripple magnitude and Ripple 
size settings. 

• To further enhance the aged quality of the sprite, add a bit of grain by using the Grain effect before 
applying Ripple. 
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Original sprite Stamp 

 

Stamp creates a sprite that looks like the monochrome imprint of a wooden or rubber stamp. 

The dark areas in the original sprite use the current color. Midtones and highlights use tints of color 
from the composition space. 

Where to find this effect 

Stamp is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Stamp picture to find out how to apply this effect. 

How to adjust the results 

• To increase the areas of the sprite that use the current color, move the Light/Dark balance slider 
to the right or enter a larger number in the Light/Dark balance box. The number must be between 
0 and 50. 

• To increase the overall smoothness of the sprite, move the Smoothness slider to the right or enter 
a larger number in the Smoothness box. The number must be between 1 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• Try applying the Rough Textures effect after applying Stamp to add texture to the solid areas of 
color on the sprite. 

• To create a stamp-pad look, apply the Grain effect after the Stamp effect to break up flat areas in 
the selection. 

• To reduce unwanted texture in the lighter areas of the sprite, increase the brightness and contrast. 
For details, see Color controls overview. 
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Original sprite Stone Print 

 

Stone Print redraws the sprite as a two-color image resembling a photocopy of the original, using 
colors you select. Large dark areas tend to copy only around their edges, and midtones become solid 
colors. 

The darks in the original sprite use the current color. Midtones and highlights use tints of color from 
the composition space. 

Where to find this effect 

Stone Print is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Stone Print picture to find out how to apply this effect. 

How to adjust the results 

• For more detail in the sprite, move the Detail slider to the right or enter a larger number in the 
Detail box. The number must be between 1 and 24. 

• To increase the amount of darkness in the sprite, move the Darkness slider to the right or enter a 
larger number in the Darkness box. The number must be between 1 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• Simulate the effect of photocopying an image several times by applying Stone Print to an image 
twice. The first time, use the default settings. Apply the effect again on the resulting image, but this 
time decrease the Detail setting to the point where amounts of the black areas (created in the first 
application of the effect) start to dissolve. 

• Try applying the Colored Pencil effect after applying Stone Print twice to create an excellent 
pencil sketch effect. Increase the brightness and contrast of the resulting image to create the look 
you desire. For details, see Color controls overview. 
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Original sprite Torn Edges 

 

Torn Edges creates the appearance that the sprite was imprinted with a sponge or stamp to make 
the edges of the sprite look ragged. This effect works best with text or with simple high-contrast 
graphical sprites. 

The dark areas in the original sprite use the current color. Midtones and highlights use tints of color 
from the composition space. 

Where to find this effect 



Torn Edges is available on the Effects palette in the Arts & Crafts category. 

How to apply this effect 

Click the Torn Edges picture to find out how to apply this effect. 

How to adjust the results 

• To emphasize the darker areas of the original sprite, move the Image balance slider to the right or 
enter a larger number in the Image balance box. To emphasize the areas of midtones and 
highlights, move the slider to the left or enter a lower number in the box. The number must be 
between 0 and 50. 

• For a smoother result, move the Smoothness slider to the right or enter a larger number in the 
Smoothness box. The number must be between 1 and 15. 

• For higher contrast, move the Contrast slider to the right or enter a larger number in the Contrast 
box. The number must be between 1 and 25. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. 

 

Tips 

• Try this effect as a final touch after applying Stamp or Stone Print. 

• This is a great effect to use if you want to roughen type in a text sprite. 
 
 

Color Enhancement effects 
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Color Enhancement effects change a sprite by altering its original colors. You can apply these 
effects to one sprite or to a selection set of sprites. 

   Click the effect you want to read about: 

   

Original sprite Color Bounding Box Dye 

   

Grayscale Transparent Tint 

 
 

Color Bounding Box 

(Called Color Over in Microsoft Image Composer 1.0) 
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Original sprite Color Bounding Box 

 



Color Bounding Box applies the current color to all pixels in the sprite, including clear pixels. 

Where to find this effect 

Color Bounding Box is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Color Bounding Box picture to learn how to apply this effect. 

How to vary this effect 

To blend more of the effect with the original sprite, move the Opacity  slider to the right or type a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. If you set opacity 
below 100, the color builds up as you reapply this effect. 

 

Dye 

(Called Colorize in Microsoft Image Composer 1.0) 
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Original sprite Dye 

 

Dye applies the current color to the sprite without affecting its dark and light values. Dye changes the 
color values of all pixels, with the exception of pure black or white pixels. 

Where to find this effect 

Dye is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Dye picture to learn how to apply this effect. 

How to vary this effect 

To blend more of the effect with the original sprite, move the Opacity  slider to the right or type a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. If you set opacity 
below 100, the color builds up as you reapply this effect. 
 

Tip   Dye is especially good for coloring monochrome images. It’s also useful for changing the color 
of an article of clothing in a photograph after you select it with the Select Color Region tool. 

 
 

Grayscale 

(Called Luminance in Microsoft Image Composer 1.0) 
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Topics Overview 

 

  

Original sprite Grayscale 

 

Grayscale converts a color sprite to grayscale (shades of black and white). 

Where to find this effect 

Grayscale is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Grayscale picture to learn how to apply this effect. 

 

Transparent 

(Called Wash in Microsoft Image Composer 1.0) 

{button ,AL("color 
enhancement 
effects")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

  

Original sprite Transparent 

 

Transparent increases the transparency of the pixels in a sprite. The result varies from partially 
transparent (as in the picture above) to totally transparent, depending on how you set the Opacity 
slider. 

Where to find this effect 

Transparent is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Transparent picture to learn how to apply this effect. 

How to vary this effect 

Adjust the Opacity  slider or enter a number between 0 and 100 in the Opacity box. The lower the 
setting, the more transparent the sprite becomes when you click Apply. If you set opacity to 0, all 
opaque pixels in the sprite are erased, and the image becomes totally transparent. 

Note   You cannot make a sprite less transparent by applying an effect. 
 

Tip   Transparent makes the whole sprite translucent. To make only a part of the sprite translucent, 
use the Erase button on the Paint palette. 
 
 

Tint 

{button ,AL("color 
enhancement 
effects")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 



 

  

Original sprite Tint 

 

Tint applies a transparent wash of the current color to the selected sprite. 

Where to find this effect 

Tint is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Tint picture to learn how to apply this effect. 

How to vary this effect 

To blend more of the effect with the original sprite, move the Opacity  slider to the right or type a 
larger number in the Opacity box. The number must be between 0 and 100. Lower opacity settings 
blend a smaller proportion of the effect, retaining more of the sprite's original look. If you set opacity 
below 100, the color builds up as you reapply this effect. 

Note   Tint is similar to the Dye effect, except that Tint changes the shades of the sprite’s existing 
colors, whereas Dye changes the colors to different colors. Also, Tint affects pure black or white 
pixels, whereas Dye does not. 
 
 

Creating an antique photograph effect 
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Original sprite In process 

  

In process Result 

 

You can give a sprite the appearance of a sepia tint photograph by applying a sequence of effects to 
it. 

 To create an antique photograph effect 

1 Select a sprite. 

2 Convert the sprite to grayscale. For details, see Converting a color sprite to grayscale. 

3 Change the current color to brown sepia (Red 57, Green 22, Blue 1). For details, see Selecting the 
colors for an effect. 

4 On the toolbox, click Effects . 

5 In the Category list, click Color Enhancement. 

6 Select the Color Bounding Box effect. 

7 On the Details tab, set the Color opacity to 65, and then click Apply. 

8 On the toolbox, click Color Tuning . 

9 Click the Dynamic Range tab. 



10 Move the right bar to the middle of the Histogram window, and then click Apply. 

11 On the toolbox, click Effects . 

12 In the Category list, click Photographic. 

13 Select the Film Grain effect, and then click Apply. 
 

Tips 

• Try adjusting the options available for the Film Grain effect on the Details tab to create variations 
of the examples pictured above. Click the Result picture to view the option settings used to create 
the example. 

• Create a rectangular or oval cutout with blurred edges from the finished version of the sprite to 
enhance its antique appearance. For details, see Creating rectangular and oval cutouts from a 
sprite. 

 
 

Film Grain settings 

Grain:  2 

Highlight Area:  1 

Highlight Intensity:  10 

Opacity:  100 

 

Creating a cartoon-like pencil sketch 
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Original sprite Result 

 

You can convert a sprite into a cartoon-like sketch by combining an effect with a color adjustment. 

 To create a cartoon-like pencil sketch 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Arts & Crafts. 

4 Select the Stone Print effect. 

5 Click Apply. 

Tip   For best results, apply the Stone Print effect to the sprite twice. 

6 Select the colors you want to use in the Color Swatch and the composition space. For details, see 
Selecting the colors for an effect. 

7 Click Apply. 

8 Adjust the dynamic range on the Dynamic Range tab of the Color Tuning palette until you get the 
look you want. 

 

Tip   Try adjusting the options available for the Stone Print effect on the Details tab to create 
variations of the example pictured above. Click the Result picture to view the option settings used to 



create the example. 
 
 

Stone Print settings 

Detail:  5 

Darkness:  50 

 

Creating a pencil sketch effect 
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Original sprite In process Result 

 

You can create the appearance that a sprite was sketched on paper by applying a sequence of 
effects to it. 

 To create a pencil sketch effect 

1 Select a sprite. 

2 Convert the sprite to grayscale. For details, see Converting a color sprite to grayscale. 

3 On the toolbox, click Effects . 

4 In the Category list, click Sketch. 

5 Select the Colored Pencil effect. 

Tip   For best results, set Paper brightness to its maximum value (50) on the Details tab. 

6 Click Apply. 

7 On the toolbox, click Color Tuning . 

8 On the Color Controls tab, adjust the Contrast slider to the desired position, or enter a number 
between -100 and 100 in the Contrast box. 

9 Click Apply. 
 

Tip   Try adjusting the options available for the Colored Pencil effect and Contrast to create 
variations of the example pictured above. Click the In process picture to view the option settings used 
to create the example. 
 
 

Colored Pencil settings 

Pencil Width:  4 

Stroke Pressure:  8 

Paper Brightness:  42 

Opacity:  100 

 

Creating an oil painting effect 
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Original sprite In process Result 

 

You can give a sprite the appearance of an oil painting by applying a sequence of effects to it. 

 To create an oil painting effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Surface. 

4 Select the Emboss effect. Make sure to use the default settings on the Details tab. 

5 Click Apply. 

6 In the Category list, click Paint. 

7 Select the Fresco effect. 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Emboss settings 

Relief:  11 

Light Position:  Top Right 

 

Fresco settings 

Brush Size:  1 

Brush Detail:  10 

Texture:  3 

 

Creating an artistic paint effect 

{button ,AL("accents 
effect;dry brush 
effect")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

   

Original sprite In process Result 

 

You can create your own artistic paint style by applying a sequence of Paint effects to a sprite. For 
example, you can accentuate a sprite’s edges and also soften its overall appearance by combining 
two different effects. 

 To create an artistic paint effect 



1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Accents effect. Make sure to use the default settings on the Details tab. 

5 Click Apply. 

6 Select the Dry Brush effect. Make sure to use the default settings on the Details tab. 

7 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Accents settings 

Edge Width:  2 

Edge Brightness:  38 

Smoothness:  5 

Opacity:  100 

 

Dry Brush settings 

Brush Size:  2 

Brush Detail:  8 

Texture:  1 

Opacity:  100 

 

Creating a hand-colored effect 
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Original sprite In process Result 

 

You can create the appearance that a sprite was colored by hand by applying a sequence of effects 
to it. 

 To create a hand-colored effect 

1 Select a sprite. 

2 In the Edit menu, click Duplicate. 

3 On the toolbox, click Effects . 

4 In the Category list, click Photographic. 

5 Select the Diffuse Glow effect. 



6 Select the original sprite, and then click Apply. 

7 In the Category list, click Color Enhancement. 

8 Select the Grayscale effect, and then click Apply.  

9 Move the grayscale sprite on top of the duplicate sprite. 

10 On the toolbox, click Texture Transfer . 

11 Select the Transfer Shape effect, and set the Opacity  slider to 50 (by moving the slider or by 
typing the number directly in the box). Then click Apply. 

12 Click the duplicate sprite, and then move the two sprites apart. 
 
 

Creating a hand-rendered effect 
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Original sprite In process Result 

 

You can create the appearance that a sprite was hand-rendered by applying a sequence of effects to 
it. 

 To create a hand-rendered effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Accents effect. 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Rough Textures effect. 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Accents settings 

Edge Width:  2 

Edge Brightness:  18 

Smoothness:  5 

Opacity:  100 

 

Texture Control settings 

Type:  Canvas 

Light position:  Top Right 

Scaling:  62 



Relief:  4 

 

Creating a rough-surface chalk effect 
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Original sprite In process Result 

 

You can give a sprite the appearance of a chalk drawing on rough sketch paper by applying a 
sequence of effects to it. 

 To create a rough-surface chalk effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Sketch. 

4 Select the Colored Pencil effect. 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Rough Textures effect. 

8 Click Texture Controls, select a texture type, and then click OK. 

Tip   The Sandstone texture works well with the Colored Pencil effect. 

9 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Colored Pencil settings 

Pencil Width:  2 

Stroke Pressure:  14 

Paper Brightness:  50 

Opacity:  100 

 

Texture Control setting 

Type:  Sandstone 

 

Effects overview 
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Topics 

 

   Click a picture to see more samples of the effects in that category. 

   

Original sprite Arts & Crafts Color Enhancement 

   

Distort Gradient Outlines 

   

Paint Patterns Photographic 

   

Sketch Surface  

 

With three or four clicks, the effects in Microsoft Image Composer can transform an ordinary 
composition into a compelling image. Whether your project needs a soft, artistic treatment or an 
over-the-top, neon-lit extravaganza, you’ll find exactly the look you want among the dozens of effects 
available on the Effects palette. 

Effects are grouped into categories by the media they emulate, such as: 

• Arts & Crafts 

• Paint 

• Patterns 

• Photographic 

• Sketch 
 

Other effects are grouped according to the characteristic of the sprite that they alter, such as: 

• Color Enhancement 

• Distort 

• Gradient 

• Outlines 

• Surface 
 

Also included in the Effects palette are a Popular category, which gives you an alternative way of 
accessing some of the most frequently used effects, and an All Effects category, which lets you 
choose from an alphabetical listing of all the effects available in Image Composer. 

Effects transform a sprite by replacing or distorting its pixels. You can also view and adjust the 
specific properties of each effect, such as its opacity, by choosing the Details tab in the Effects 
palette. As you experiment, you can undo the most recent application of an effect in two ways: 

• If you applied the effect from the Effects tab or the Details tab, click Undo . This action undoes 
the effect and takes you back to the Effects tab. 

• If you applied the effect from the Details tab, change the settings and click Apply. This action 
undoes the effect and reapplies it with the new settings. If you want to undo an effect after you 
leave the Details tab, you must click Undo. 

You can apply most effects to a sprite or to a selection set of sprites. Effects work best with 
high-quality scanned images that have a broad range of colors, light areas, and dark areas. 

 

Applying an effect 
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Apply an effect when you want to enhance a sprite’s appearance, distort its shape, or give it a 
completely new look. You can view and adjust the specific properties of an effect, such as its opacity 
and softness, by choosing the Details tab in the Effects palette. When you apply the effect, either 
from the Effects tab or the Details tab, the current settings for that effect are used. 

If you want to apply an effect repeatedly so that each application of the effect is layered on top of the 
previous application, click Apply on the Effects tab. For example, clicking Transparent on the 
Effects tab many times gradually makes the selected sprite completely transparent. To undo the 
most recent application of the effect, you must click Undo . 

However, if you want to experiment with the different settings of an effect and see how each change 
looks on your original sprite, click Apply on the Details tab. Each consecutive application of an effect 
from the Details tab undoes the previous application and reapplies it with the current settings. For 
example, you can apply a paint effect each time you adjust the brush size to see how the effect will 
look on your original sprite. Once you leave the Details tab, the effect is permanently applied and you 
must click Undo to undo it. 

 To apply an effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, select a category of effects: 

• All Effects lists, in alphabetical order, all the effects available in Microsoft Image Composer. 

• Arts & Crafts effects emulate different types of crafts media such as cutouts, rubber stamps, 
and stained glass. 

• Color Enhancement effects let you alter the color of a sprite as well as the area within the 
sprite’s bounding box. 

• Distort effects change the proportions of a sprite so that it appears warped. 

• Gradient effects fill a sprite with a gradual blending of color, and include a predefined set of 
color blends that you can choose from. 

• Outlines change the pixels around the border of a sprite without altering its shape. 

• Paint effects emulate different styles of paint applied in light or sprayed strokes, with a palette 
knife or sponge, and so on. 

• Patterns contains geometric patterns, such as stripes and checkerboards, and random patterns 
that you can use to fill a sprite. 

• Photographic effects emulate the results that are typically produced using photographic 
techniques that alter the focus or light diffusion of a sprite. 

• Popular effects are those that are most commonly used in Image Composer. Each effect in this 
category also appears in one of the other categories that characterize the type of effect. 

• Sketch effects emulate the different media, such as crayons, charcoal, and ink, used to sketch 
images. 

• Surface effects give a sprite the appearance that it was created on a specific material or 
surface, such as chrome, glass, plaster, or water. 

 

4 Select the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Selecting the colors for an effect 
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Some of the effects that you can apply from the Effects palette change a sprite's original colors. 
Those effects frequently use the current color shown in the Color Swatch, the color of the 
composition space, or both. You should select these colors before you apply the effect. 

 To set the current color 

1 On the toolbox, click the Color Swatch. 

2 In the Color Picker dialog box, click the True Color tab if your composition uses the True Color 
palette, or click the Custom Palette tab if your composition uses any other palette. 

3 Select the color you want to use: 

• To select a true color, click inside the color matrix on the True Color tab. For details, see 
Selecting a true color. 

• To select a color from another palette, select the name of the palette that has the color you want 
to use from the Color Palette box on the Custom Palette tab. Then click a color entry in the 
palette. 

4 Click OK. 
 

 To change the color of the composition space for the active composition 

1 On the File menu, click Composition Setup. 

2 On the Current Compositon tab, click Color. 

3 Choose a color from the Color Picker dialog box, and then click OK. 

4 Click OK. 
 

The composition space color is saved with the active composition only. If you want to change the 
default composition space color for future compositions, use the New Composition tab instead. 
Saved compositions continue to use the composition space color that they were saved with. 

Tips 

• To maintain the original relationship of darks to midtones and highlights, choose a darker Color 
Swatch color and a lighter composition space color. 

• Media effects such as Charcoal and Stone Print work best with the Color Swatch set to black 
and the composition space set to white. 

 
 

Applying a color enhancement effect 
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Apply a color enhancement effect when you want to modify the color of an existing sprite. The type of 
effect you apply will change the sprite’s hue, its dark and light values, or its transparency values. 

 To apply a color enhancement effect 



1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Color Enhancement. 

4 Select the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Filling a sprite with a solid color 
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Fill a sprite with a solid color when you want to change the opaque pixels of a sprite to one color 
without affecting its brightness or saturation. 

 To fill a sprite with a solid color 

1 Select a sprite. 

2 Set the current color to the color you want to fill the sprite with. For details, see Setting the current 
color. 

3 Click the Color Fill button  on the toolbar. 
 

As an alternative to using the Color Fill button, you can apply the Dye effect on the Effects palette to 
fill a sprite with a solid color. Both methods yield the same result. 

 To apply the Dye effect to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Color Enhancement. 

4 Select the Dye effect. 

5 Set the current color to the color you want to fill the sprite with. For details, see Setting the current 
color. 

6 To change the opacity of the fill, click the Details tab, and then move the Opacity  slider.  

• To retain more of the original sprite, move the slider to the left. 

• To apply a more solid fill, move the slider to the right.  

• To completely replace the sprite’s original colors with the current color, set the opacity to 100. 

7 Click Apply. 
 
 

Converting a color sprite to grayscale 
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Convert a color sprite to grayscale when you want to reduce all the colors in the sprite to shades of 
gray. This conversion is useful when you plan to use the sprite in a black-and-white document. 

 To convert a color sprite to grayscale 



1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, choose Color Enhancement. 

4 Select the Grayscale effect. 

5 Click Apply. 
 

Tip   Increase the contrast of the image to create a more black-and-white look. 
 
 

Distorting a sprite 
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Apply a distort effect when you want to change the shape and proportions of an existing sprite. 

 To distort a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Distort. 

4 Select the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Applying a gradient effect to a sprite 
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Apply a gradient effect to a sprite when you want to fill the sprite’s opaque pixels with a gradual blend 
of up to four colors. Microsoft Image Composer provides one type of gradient effect with several 
predefined variations. You can select one of these predefined gradients or create your own. For 
details, see Saving a custom gradient. 

 To apply a gradient effect to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Gradient, and then click the Details tab. 

4 In the Gradient name list, click the effect that you want to apply. 

5 If you want to increase the transparency for this effect, move the Opacity  slider to the left. 

6 Click Apply. 
 

Note   You can apply a gradient effect to just one sprite at a time; you can’t apply this effect to a 
group or selection set. 
 
 

Saving a custom gradient 
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Microsoft Image Composer provides several sample gradients for you to use. You can create your 
own gradient and add it to the list of samples. 

 To save a custom gradient 

1 On the toolbox, click Effects . 

2 In the Category list, click Gradient, and then click the Details tab. 

3 To use an existing gradient as a starting point, click the gradient in the Gradient name list. 

4 Select the colors for your custom gradient. For details, see Changing the colors in a gradient effect. 

5 If you want to increase the transparency for this effect, move the Opacity  slider to the left. 

6 In the Gradient name list, type a new name for this gradient. 

7 Click Save . 
 

Note   Image Composer can save up to 20 custom gradients. 
 
 

Deleting a gradient from the list 

{button ,AL("gradient 
effect how")} 
Related Topics 

{button 
,AL("gradient 
effect ovr")} 
Overview 

 

 

Microsoft Image Composer provides several sample gradients for you to use. In addition, it can save 
up to 20 custom gradients that you created. If you have already saved 20 gradients, and you want to 
add another gradient to the list, you must first delete one of the existing gradients. 

 To delete a gradient from the list 

1 On the toolbox, click Effects . 

2 In the Category list, click Gradient, and then click the Details tab. 

3 In the Gradient name list, click the gradient that you want to delete. 

4 Click Delete . 
 

 

Warning   Deleting a gradient from the Gradient name list permanently removes that gradient from 
Image Composer. 

 

 
 

Changing the colors in a gradient 
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You can change the colors in any of the gradients that are provided with Microsoft Image Composer, 
or that you created and saved in the Effects palette. 

 To change the colors in a gradient 

1 On the toolbox, click Effects . 

2 In the Category list, click Gradient, and then click the Details tab. 

3 In the Gradient name list, click the gradient that you want to change. If you’re creating a custom 
gradient, you can use any existing gradient as a starting point. 



4 Click a color chip in one of the corners of the gradient square. 

5 In the Color Picker dialog box, pick the color you want for that corner of the gradient, and then 
click OK. 

• To create an up or down gradient, pick one color for the two top color chips, and pick a second 
color for the two bottom color chips.  

• To create a left or right gradient, pick one color for the two left color chips, and pick a second 
color for the two right color chips. 

 

Tip   You can drag and drop a color from one color chip to another color chip. 
 

6 Repeat steps 4 and 5 for the remaining color chips. 

7 To save your changes, click Save . If you quit Microsoft Image Composer without saving your 
changes, the default colors for that gradient will be restored. 

 
 

Outlining a sprite 
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Add an outline around a sprite when you want to sharpen its edges or create a more pronounced 
distinction between the sprite and its background. 

 To outline a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Outlines. 

4 Click the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Creating a drop shadow 
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Original sprite Drop Shadow with 
default settings 

 

Add a drop shadow to a sprite when you want to add the appearance of depth. A drop shadow makes 
a sprite stand out against its background. 

 To create a drop shadow 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Outlines, and then click the Drop Shadow effect. 

4 If you want to change the settings for Drop Shadow, click the Details tab: 

• To change the direction of the drop shadow, click one of the direction buttons. The direction of 
the drop shadow depends on whether the light source is facing east (0°), northeast (45°), north 



(90°), northwest (135°), west (180°), southwest (225°), south (270°), or southeast (315°). To 
specify a different angle, type a number between 0 and 359 in the Angle box. 

• To increase the number of pixels that the drop shadow is offset from the selected sprite, move 
the Distance slider to the right. To decrease the amount, move the slider to the left. 

• To soften the edges of the drop shadow so that it blends more gradually with the background, 
move the Softness slider to the right. For a crisper edge, move the slider to the left. 

• To change the color of the drop shadow, click the color chip. Choose a color from the Color 
Picker, and then click OK. 

 

Tip   To select a color quickly, right-click the color chip and then click a color. 
 

• To increase the transparency of the drop shadow, move the Opacity  slider to the left. To 
create a completely opaque drop shadow, set the opacity to 100 percent. 

• To restore the default settings, click Use Default. 
 

5 Click Apply. 
 
 

Placing a border around a sprite 
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Place a border around a sprite when you want to separate it from its background with a line of color. 
You can also make a sprite appear to glow against a darker background by adding a thin, 
light-colored border around the sprite. 

 To place a border around a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Outlines, and then click the Edge effect. 

4 If you want to change the default settings for Edge, click the Details tab: 

• To increase the width of the border, increase the Thickness setting. For the thinnest edge, set 
the thickness to 1. 

• To change the color of the border, click the color chip. Choose a color from the Color Picker, 
and then click OK. 

 

Tip   To select a color quickly, right-click the color chip and then click a color. 
 

• To increase the transparency of the border, move the Opacity  slider to the left. To create a 
completely opaque border, set the opacity to 100 percent. 

To restore the default settings, click Use Default. 

5 Click Apply. 
 

Tip   If you want to outline the sprite and erase the pixels inside the outline, apply the Edge Only 
effect instead. For details, see Creating an outline of a sprite. 

 

Creating an outline of a sprite 
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Create an outline of a sprite when you want an outline of its shape, but you want the original sprite to 
be transparent. 

 To create an outline of a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Outlines, and then click the Edge Only effect. 

4 If you want to change the default settings for Edge Only, click the Details tab: 

• To increase the width of the outline, increase the Thickness setting. For the thinnest edge, set 
the thickness to 1. 

• To change the color of the border, click the color chip. Choose a color from the Color Picker, 
and then click OK. 

 

Tip   To select a color quickly, right-click the color chip and then click a color. 
 

• To increase the transparency of the outline, move the Opacity  slider to the left. To create a 
completely opaque outline, set the opacity to 100 percent. 

To restore the default settings, click Default. 

1 Click Apply. 
 

If you want to outline the sprite without affecting its pixels, apply the Edge effect instead. For details, 
see Placing a border around a sprite. 

 

Applying a paint effect 
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Apply a paint effect when you want to give a sprite the appearance that it was created using 
traditional painting techniques. 

If you want to experiment with the different settings of an effect and see how each change looks on 
your original sprite, make sure you apply the effect from the Details tab. Each consecutive application 
of an effect from the Details tab undoes the previous application and reapplies it with the current 
settings. For example, you can apply the Watercolor effect each time you adjust the brush size to 
see how the effect will look on your original sprite. Once you leave the Details tab, the effect is 
permanently applied and you must click Undo to undo it. 

 To apply a paint effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Applying a pattern to a sprite 
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Apply a pattern to a sprite when you want to uniformly blend or replace the opaque pixels in a 
selected sprite with dots, squares, stripes, or an array of colors.  

If you want to experiment with the different settings of an effect and see how each change looks on 
your original sprite, make sure you apply the effect from the Details tab. Each consecutive application 
of an effect from the Details tab undoes the previous application and reapplies it with the current 
settings. For example, you can apply the Stripes effect each time you adjust the stripe width to see 
how the effect will look on your original sprite. Once you leave the Details tab, the effect is 
permanently applied and you must click Undo to undo it. 

 To apply a pattern to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Patterns. 

4 Click the effect that you want to apply. 

5 If you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Applying a pattern to part of a sprite 
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Apply a pattern to only part of a sprite when you want to preserve areas of the original sprite. For 
example, you can apply a striped pattern to a sprite of an umbrella without affecting the pixels in the 
umbrella’s handle. 

 To apply a pattern to part of a sprite 

1 Create a shape and then fill it with a pattern. For details, see Shapes overview and Applying a 
pattern to a sprite.. 

2 Select the sprite that you want to apply the pattern to, and move it on top of the patterned shape so 
that the portion you want to apply the pattern to overlaps the shape. 

3 Add the second sprite to the selection by pressing SHIFT and clicking it. 

4 On the toolbox, click Texture Transfer . 

5 In the Texture Transfer palette, click Map Color. 

6 Click Apply. 

7 Move the two sprites apart to see the result. 
 

The patterned sprite is imprinted on the second sprite in the area where the two sprites overlapped. 

 

Applying a checkered pattern to a sprite 
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You can apply a checkerboard pattern to a sprite when you want to uniformly blend or replace the 
opaque pixels in the sprite with one color. 



 To apply a checkered pattern to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Patterns. 

4 In the Effects list, click Checkerboard. 

5 If you want to change the default settings for Checkerboard, click the Details tab: 

• To let the sprite’s opaque pixels show through the colored checkers, move the Opacity  slider 
to the left. To completely replace the sprite’s opaque pixels with the colored checkers, set the 
opacity to 100 percent. 

• To change the color of the checkers, click the Color Swatch on the toolbox. Select the color you 
want from the Color Picker dialog box, and then click OK. 

• To vary the size of the checkers, set new Width and Height values (in pixels). To keep the 
checkers perfectly square, click Match width and height. 

6 Click Apply. 
 
 

Applying stripes to a sprite 
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You can apply a striped pattern to a sprite when you want to uniformly blend or replace the opaque 
pixels in the sprite with stripes of one color. 

 To apply a checkered pattern to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Patterns. 

4 In the Effects list, click Stripes. 

5 If you want to change the default settings for Stripes, click the Details tab: 

• To let the sprite’s opaque pixels show through the colored stripes, move the Opacity  slider to 
the left. To completely replace the sprite’s opaque pixels with the colored stripes, set the opacity 
to 100 percent. 

• To change the color of the stripes, click the Color Swatch on the toolbox. Select the color you 
want from the Color Picker dialog box, and then click OK. 

• To change the width of the colored stripes, set a new Width value (in pixels). 

• To change the spacing between the colored stripes, set a new Spacing value (in pixels). To 
keep all the stripes the same width, click Match width and spacing. 

6 Click Apply. 
 
 

Applying a photographic effect 
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Apply a photographic effect when you want to give a sprite the appearance that it was modified by 
photographic techniques like using light filters, adjusting the focus, and applying film grains. 



If you want to experiment with the different settings of an effect and see how each change looks on 
your original sprite, make sure you apply the effect from the Details tab. Each consecutive application 
of an effect from the Details tab undoes the previous application and reapplies it with the current 
settings. For example, you can apply the Grain effect each time you change the grain type to see 
how the effect will look on your original sprite. Once you leave the Details tab, the effect is 
permanently applied and you must click Undo  to undo it. 

 To apply a photographic effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Photographic. 

4 Click the effect that you want to apply. 

5 If you want to change the default settings for the effect, click the Details tab. 

6 Click Apply. 
 
 

Applying a surface texture to a sprite 
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Apply a surface texture to a sprite when you want to give a sprite the appearance that it was created 
on a specific artistic material or surface. For example, you can make a sprite appear to be made of 
chrome, glass, or plaster, or you can make it appear to be underwater. 

 To apply a surface texture to a sprite 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Surface. 

4 Click the effect you want to apply. 

5 if you want to change the default settings for this effect, click the Details tab. 

6 Click Apply. 
 
 

Creating a custom texture type 
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You can create your own texture type and select it from the Texture Controls dialog box when you 
apply the Rough Textures effect. The textures that are available with Microsoft Image Composer are 
Brick, Burlap, Canvas, and Sandstone. 

 To create a custom texture type 

1 Create a new composition. 

Tip   If you want to use an existing texture as a starting point, the textures that are available in 
Image Composer are stored in the \PlugIns\Impressionist Accessories\Paper folder. 

 

2 Create the sprite that you want to save as a surface texture. You can create the texture by starting 



with a simple image and then applying a sequence of effects to it. For example, to create a granite 
texture: 

• Create a solid-colored square. 

• Apply the Rough Textures effect using the Canvas texture type. 

• Apply the Ripple effect. 

• Apply the Grayscale effect in the Color Enhancement category to convert the sprite to black 
and white. Only sprites that are grayscale or use the RGB color model can be applied as rough 
textures. 

3 On the File menu, click Save Selection As. Make sure that the sprite is positioned on the 
composition space. 

4 Click TIFF in the Save as type list, and then click Save. 
 

When you apply Rough Textures, you can select TIFF File in the Type list on the Details tab to 
select your custom texture. 

 

Distort effects 
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Distort effects change the shape of a sprite. You can apply the Rectangular and Wave effects to 
only one sprite at a time. You can apply any of the other Distort effects to one sprite or to a set of 
selected sprites. 

   Click the picture of the effect you want to read about. 

   

Original sprite Bulge Fisheye 

   

Mesa Radial Sweep Rectangular 

   

Spoke Inversion Vortex Wave 

 
 

Bulge 
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Original sprite Bulge 

 

Bulge causes the middle area of a sprite to swell, as if it were wrapped around a concave or convex 
hemisphere. 

Where to find this effect 

Bulge is available on the Effects palette in the Distort category. 



How to apply this effect 

Click the Bulge picture to learn how to apply this effect. 

How to vary this effect 

In the Warp direction box, click In or Out to specify a concave or a convex warp, respectively. 

 

Fisheye 

(Called Escher in Microsoft Image Composer 1.0) 

{button ,AL("distort 
effects")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

  

Original sprite Fisheye 

 

Fisheye causes the center of the sprite to spread, crowding the area near its borders. 

Where to find this effect 

Fisheye is available on the Effects palette in the Distort category. 

How to apply this effect 

Click the Fisheye picture to learn how to apply this effect. 

How to vary this effect 

In the Spread amount box, type a value between 0 and 1000. The default setting of 150 percent 
causes the center of the sprite to grow to one-and-a-half times its original size. A setting of 100 
percent has no effect. A setting of 50 percent squeezes the center of the sprite to half its original size. 

 

Mesa 
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Original sprite Mesa 

 

Mesa causes the sprite to appear to be wrapped around a flat-topped cone pointing out of or into the 
picture plane. 

Where to find this effect 

Mesa is available on the Effects palette in the Distort category. 

How to apply this effect 



Click the Mesa picture to learn how to apply this effect. 

 

Radial Sweep 
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Original sprite Radial Sweep 

 

Radial Sweep scales the center line of pixels to half the diameter of the sprite, and then sweeps the 
line around to form a disk. 

Where to find this effect 

Radial Sweep is available on the Effects palette in the Distort category. 

How to apply this effect 

Click the Radial Sweep picture to learn how to apply this effect. 

How to vary this effect 

To specify the angle of the sampling line, type a value between -180 and 180 in the Angle box. At the 
default value of 0, the line is horizontal. Positive angle values rotate the line clockwise; negative 
values rotate the line counterclockwise. 

Note   If you apply Radial Sweep to images that have blank pixels at their center — such as the 
image above — it samples a clear line at the center of the sprite and then sweeps it around, resulting 
in a blank hole in the middle. 
 
 

Rectangular 
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Original sprite Rectangular 

 

Rectangular squeezes the sides of the sprite while expanding the center, or it squeezes the center 
while expanding the sides. Microsoft Image Composer uses a mathematical function to rearrange the 
pixels on each of the horizontal scanlines, and then on each of the vertical scanlines. 

You can apply the Rectangular effect to only one sprite at a time. 

Where to find this effect 

Rectangular is available on the Effects palette in the Distort category. 

How to apply this effect 



Click the Rectangular picture to learn how to apply this effect. 

How to vary this effect 

Try experimenting with the x-axis, y-axis, or both axes to vary the results for Sine, Cosine, and 
Linear Knee. For examples, see Rectangular effect variations. 
 
 

Rectangular effect variations 

{button 
,AL("rectangle 
distory effect")} 
Related Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

These examples show the results of applying the Rectangular effect at some typical settings. Click a 
picture to see the specific settings for each example. 

Linear Knee function 
    

Sine function 
    

Cosine function 
    

 
 

Rectangular effect settings 

Function: Linear Knee 

Linear knee %: 70 

Axis: X only  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Linear Knee 

Linear knee %: 70 

Axis: X only  

Symmetrical: No 

 

Rectangular effect settings 

Function: Linear Knee 

Linear knee %: 70 

Axis: Y only  

Symmetrical: Yes 

 

Rectangular effect settings 



Function: Linear Knee 

Linear knee %: 70 

Axis: Both X and Y  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Sine 

Axis: X only  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Sine 

Axis: X only  

Symmetrical: No 

 

Rectangular effect settings 

Function: Sine 

Axis: Y only  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Sine 

Axis: Both X and Y  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Cosine 

Axis: X only  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Cosine 

Axis: X only  

Symmetrical: No 

 



Rectangular effect settings 

Function: Cosine 

Axis: Y only  

Symmetrical: Yes 

 

Rectangular effect settings 

Function: Cosine 

Axis: Both X and Y  

Symmetrical: Yes 

 

Spoke Inversion 
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Original sprite Spoke Inversion 

 

Spoke Inversion inverts every spoke of an imaginary disk that just fits within the shape of the sprite. 
The spoke is inverted by flipping its center end to the outside and flipping its outside end toward the 
center. 

Where to find this effect 

Spoke Inversion is available on the Effects palette in the Distort category. 

How to apply this effect 

Click the Spoke Inversion picture to learn how to apply this effect. 

How to vary this effect 

In the Value box, specify the percentage of the image that you want sampled. This must be a number 
between 1 and 100. 

For example, at the default setting of 100 percent, spokes are created from the entire image. At a 
setting of 25 percent, spokes are created from the top-left quarter of the image; at a setting of 50 
percent, spokes are created from the top half of the image. 

 

Vortex 
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Original sprite Vortex 

 

Vortex twists the sprite around its center while maintaining the orientation of the pixels at its borders. 

Where to find this effect 

Vortex is available on the Effects palette in the Distort category. 

How to apply effect 

Click the Vortex picture to learn how to apply this effect. 

How to vary this effect 

In the Angle box, specify a positive value for the number of degrees of a clockwise twist, or a 
negative value for a counterclockwise twist. This must be a number between -180 and 180. 

 

Wave 
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Original sprite Wave 

 

Wave applies a sine wave profile to the image. 

Compare Wave to the Sine variation of the Rectangular effect, which rearranges only the pixels on a 
scanline while maintaining the overall outline of the image. For details, see Rectangular effect 
variations. 

Where to find this effect 

Wave is available on the Effects palette in the Distort category. 

How to apply a effect 

Click the Wave picture to learn how to apply this effect. 

How to vary this effect 

• To increase the number of waves generated in a sprite, increase the value in the Frequency % 
box. This must be a number between 1 and 1000. 

• To increase the height of the individual waves generated in a sprite, increase the value in the 
Amplitude % box. This must be a number between 1 and 50. 

 

For examples, see Wave effect variations. 

 

Wave effect variations 
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Overview 

 

These examples show the results of applying the Wave effect at some typical settings. Click a picture 
to see the specific settings for each example. 

   

Original sprite Example 1 Example 2 

   

Example 3 Example 4 Example 5 

   

Example 6 Example 7  

 
 

Wave effect settings 

Wave axis: Y only 

Frequency %: 100  

Amplitude %: 25  

Symmetrical: No 

 

Wave effect settings 

Wave axis: X only 

Frequency %: 100  

Amplitude %: 25  

Symmetrical: No 

 

Wave effect settings 

Wave axis: Both X and Y 

Frequency %: 100  

Amplitude %: 25  

Symmetrical: No 

 

Wave effect settings 

Wave axis: Both X and Y 

Frequency %: 100  

Amplitude %: 25  

Symmetrical: Yes 

 

Wave effect settings 

Wave axis: X only 



Frequency %: 100  

Amplitude %: 25 

Symmetrical: Yes 

 

Wave effect settings 

Wave axis: Both X and Y 

Frequency %: 50 

Amplitude %: 25  

Symmetrical: Yes 

 

Wave effect settings 

Wave axis: Both X and Y 

Frequency %: 25 

Amplitude %: 50 

Symmetrical: Yes 

 

Enhancing the Paint Daubs effect 
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Original sprite In process Result 

 

You can create the appearance that a sprite was painted on canvas by applying a sequence of effects 
to it. 

 To enhance the Paint Daubs effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Paint Daubs effect. Options for this effect can have the following values: 

• Brush size: a number between 1 and 50 

• Sharpness: a number between 0 and 40 

• Opacity: a number between 0 and 100 
 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Rough Textures effect. Options for this effect can have the following values: 

• Opacity: a number between 0 and 100 

• Scaling % (on the Texture Controls dialog): a number between 50 and 200 



• Relief: a number between 0 and 50 
 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Paint Daubs settings 

Brush Size:  9 

Brush Type:  Simple 

Sharpness:  23 

Opacity  100 

 

Texture Controls settings 

Type:  Canvas 

Light position:  Top Right 

Scaling:  50 

Relief:  3 

 

Enhancing the Sponge effect 
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Original sprite In process Result 

 

You can enhance the sponge effect to give a sprite the uneven texture that is typical of sponge 
painting. 

 To enhance the sponge effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Sponge effect. Options for this effect can have the following values: 

• Brush size: a number between 0 and 10 

• Definition: a number between 0 and 25 

• Smoothness: a number between 1 and 15 

• Opacity: a number between 0 and 100 
 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Rough Textures effect. Options for this effect can have the following values: 



• Opacity: a number between 0 and 100 

• Relief: a number between 0 and 50 

• Click Texture Controls, select a texture type, and then click OK. The Scaling % box must 
contain a number between 50 and 200. 

 

Tip   The Sandstone texture works well with the Sponge effect. 
 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Sponge settings 

Brush Size:  2 

Definition:  12 

Smoothness:  5 

Opacity:  100 

 

Texture Control settings 

Type:  Sandstone 

Light Position:  Top Right 

Scaling:  100 

Relief:  10 

 

Enhancing the Watercolor effect 
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Original sprite In process Result 

 

You can enhance the results of applying the Watercolor effect to a sprite by combining it with other 
Paint effects. 

 To enhance the Watercolor effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 From the Category list, click Paint. 

4 Select the Sprayed Strokes effect. Options for this effect can have the following values: 

• Stroke length: a number between 0 and 20 

• Spray radius: a number between 0 and 25 

• Opacity: a number between 0 and 100 
 



5 Click Apply. 

6 Select the Watercolor effect. Options for this effect can have the following values: 

• Brush detail: a number between 1 and 14 

• Shadow intensity: a number between 0 and 10 

• Texture: a number between 1 and 3 

• Opacity: a number between 0 and 100 
 

7 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Sprayed Strokes settings 

Stroke Length:  8 

Direction:  Right Diagonal 

Radius:  20 

Opacity:  100 

 

Watercolor settings 

Brush Detail:  9 

Shadow Intensity:  1 

Texture:  1 

Opacity:  100 

 

Enhancing the Emboss effect 
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Original sprite In process Result 

 

You can draw attention to the details of a sprite by applying a Paint effect to it before you apply the 
Emboss effect. This action gives the sprite more complex texture than applying the Emboss effect 
alone. 

 To enhance the Emboss effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Watercolor effect. Options for this effect can have the following values: 

• Brush detail: a number between 1 and 14 



• Shadow intensity: a number between 0 and 10 

• Texture: a number between 1 and 3 

• Opacity: a number between 0 and 100 
 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Emboss effect. Options for this effect can have the following values: 

• Relief: a number between 0 and 25 

• Opacity: a number between 0 and 100 
 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Watercolor settings 

Brush Detail:  9 

Shadow Intensity:  1 

Texture:  1 

Opacity:  100 

 

Emboss settings 

Relief:  11 

Light Position:  Top Right 

Opacity:  100 

 

Enhancing the Dry Brush effect 
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Original sprite In process Result 

 

You can blend the areas of a sprite and then give it a three-dimensional appearance by applying a 
sequence of effects to it. 

 To enhance the Dry Brush effect 

1 Select a sprite. 

2 On the toolbox, click Effects . 

3 In the Category list, click Paint. 

4 Select the Dry Brush effect. Options for this effect can have the following values: 

• Brush size: a number between 0 and 10 

• Brush detail: a number between 0 and 10 



• Texture: a number between 1 and 3 

• Opacity: a number between 0 and 100 
 

5 Click Apply. 

6 In the Category list, click Surface. 

7 Select the Emboss effect. Options for this effect can have the following values: 

• Relief: a number between 0 and 25 

• Opacity: a number between 0 and 100 
 

8 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Dry Brush settings 

Brush Size:  2 

Brush Detail:  8 

Texture:  1 

Opacity:  100 

 

Emboss settings 

Relief:  11 

Light Position:  Top Right 

Opacity:  100 

 

Enhancing the Broken Tile effect 
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Original sprite In process Result 

 

You can enhance the results of applying the Broken Tile effect to a sprite by combining it with other 
Surface effects. 

 To enhance the Broken Tile effect 

1 Select a sprite. 

2 On the toolbox, click Effects button . 

3 From the Category list, click Surface. 

4 Select the Broken Tile effect. Options for this effect can have the following values: 

• Tile size: a number between 2 and 100 

• Grout width: a number between 1 and 15 

• Lighten grout: a number between 0 and 10 



• Opacity: a number between 0 and 100 
 

5 Click Apply. 

6 Select the Emboss effect. Options for this effect can have the following values: 

• Relief: a number between 0 and 25 

• Opacity: a number between 0 and 100 
 

7 Click Apply. 
 

Tip   Try adjusting the options available for both effects on the Details tab to create variations of the 
examples pictured above. Click the In process or Result picture to view the option settings used to 
create the example. 
 
 

Broken Tile settings 

Tile Size:  12 

Grout Width:  3 

Lighten Grout:  8 

Opacity:  100 

 

Emboss settings 

Relief:  6 

Light Position:  Top Right 

Opacity:  100 

 

Gradient effects 
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The Gradient (Square) effect in the Gradient category fills the opaque pixels of a sprite with a 
gradual blend of up to four colors. You can apply the Gradient (Square) effect to just one sprite at a 
time; you can’t apply this effect to a group or selection set. 

Microsoft Image Composer provides several sample gradients for you to use. You can change the 
name and colors of these gradients. You can also delete them. 

Note   Deleting a gradient cannot be undone. 
 

   

Blue Green 45% Cool Steel Copper 

   

Gold Grayscale Down Grayscale Left 

   

Grayscale Right Grayscale Up Night Sky 

   



Red Blue Green  Red Green Blue 
Yellow 

Red to Blue 45% 

   

Sunrise Tequila Sunset Tie Dye 

   

Tile Bottom Left Tile Bottom Right Tile Top Left 

   

Tile Top Right   

 

Where to find this effect 

The Gradient (Square) effect is available on the Effects palette in the Gradient category. Click the 
Details tab to select a specific gradient. 

How to vary this effect 

To change the colors in a sample gradient, click one or more of the color chips in the corners of the 
gradient square. 

 

Making a sprite transparent 
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You can make an existing sprite transparent to allow sprites behind it, or the composition background, 
to show through. By using the Transparent effect, you can change the opacity of the image. Lower 
opacity values create a more transparent sprite. 

1 In your composition, click the sprite you want to make transparent. 

2 In the toolbox, click Effects . 

3 From the Categories list, select Color Enhancement. 

4 Select Transparent . 

5 Click the Details tab. 

6 Adjust the Opacity slider, or type a number in the Opacity box, to specify the amount of 
transparency you want. Then click Apply. 

The number in the Opacity box must be between 0 and 100. A value of 0 gives a fully transparent 
sprite; a value of 100 gives an opaque sprite. 

 

Note   If you are not sure what setting to use, start with a high value and apply that setting. Then you 
try lower opacity settings until you achieve the effect you were looking for. 
 
 

Making an area of a sprite transparent 
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another;A_To make 
an existing sprite 
transparent")} 
Related Topics 

Overview 

 

You can make an area of a sprite semi-transparent or invisible to allow other sprites behind it, or the 
composition background, to show through. For example, if you want to make two rings appear to be 
interlocked, you can overlap two sprites of a ring and erase the portions of one ring that would not be 
visible if the rings were interlocked. 

Use Erase, found on the Paint tool palette, to change the opacity of an area of a sprite. Higher opacity 
values increase the transparency of the area. If you erase with the opacity set at 100, the areas 
where you apply Erase become completely transparent. If you apply Erase with a lower setting 
repeatedly to the same area, the area becomes more and more transparent. 

1 In your composition, click the sprite that has the parts you want to make transparent. 

2 On the toolbox, click Paint {bmc paint_button.bmp). 

3 On the Paint tool palette, click Erase  in the Paint Effect Grid on the left side of the palette. 

4 In the Brush grid, click a brush with a hard edge, or use the Brush Size slider. 

5 Adjust the Opacity slider or type a number in the Opacity box to specify the amount of 
transparency you want. Then click Apply. 

The number in the Opacity box must be between 0 and 100. A value of 0 leaves the parts of the 
sprite you erase; a value of 100 erases them completely and leaves them transparent. 

6 In the selected sprite, drag over the area you want to make transparent. 
 
 

Mapping transparency from one sprite to another 
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You can map the transparent pixels from one sprite to another so that the shape of the other sprite 
appears in the first sprite as transparent pixels. 

1 In your composition, position the sprite to use as the source of transparent pixels so that it is on top 
of the destination sprite you want to add the transparent pixels to. 

2 Hold down the Shift key and click the destination sprite, the one you want to add transparent pixels 
to. 

3 On the toolbox, click Texture Transfer . 

4 Select Map Transparency , then click Apply. 

5 To see the results, click the composition space outside the selected sprites, and move the source 
sprite off the sprite you wanted to change. 

 
 

Outline effects 
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Outline effects change the pixels around the border of a sprite. You can apply these effects to one 
sprite or to a selection set of sprites. 

   Click the effect you want to read about: 

   

Original sprite Drop Shadow Edge 

   

Edge Only Recess Relief 

 
 

Drop Shadow 

(Called Shadow in Microsoft Image Composer 1.0) 
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Original sprite Drop Shadow 

 

Drop Shadow adds a drop shadow to the sprite, based on the sprite's silhouette and the size of the 
shadow you specify. 

Where to find this effect 

Drop Shadow is available on the Effects palette in the Outlines category. 

How to apply this effect 

Click the Drop Shadow picture to learn how to apply this effect. 

How to vary this effect 

• To change the placement of the drop shadow, change the direction of the light source. A drop 
shadow can be cast in one of eight directions: north, northeast, east, southeast, south, southwest, 
west, or northwest. You can also enter a number of degrees between 0 and 359 in the Angle box. 

• To increase the number of pixels that the drop shadow will be offset from the selected sprite, move 
the Distance slider to the right or enter a larger number in the Distance box. The number must be 
between 0 and 100. 

• To change the color of the drop shadow, click the color chip to open the Color Picker, and then 
select a color. 

• For a more solidly colored edge, move the Opacity  slider to a high number or enter a high 
number in the Opacity box. A lower number creates a more transparent edge. The number in the 
Opacity box must be between 0 and 100. 

• To change the blurriness of the drop shadow, move the Softness slider toward Soft, or move it 
toward Hard for a crisp edge. A softness setting slightly to the right of Hard creates the 
appearance that the sprite is floating above its background. 

 
 

Edge 
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Original sprite Edge 

 

Edge outlines the sprite in a color you specify and expands the sprite by increasing the thickness of 
its edge. 

Where to find this effect 

Edge is available on the Effects palette in the Outlines category. 

How to apply this effect 

Click the Edge picture to learn how to apply this effect. 

How to vary this effect 

• For a more solidly colored edge, move the Opacity  slider to a high number or enter a high 
number in the Opacity box. A lower number creates a more transparent edge. The number in the 
Opacity box must be between 0 and 100. 

• For the thinnest edge, set the Thickness option to 1; for a thicker edge, set a higher number. The 
number in the Thickness box must be between 1 and 100. 

• To select a color for the edge, click the color chip to open the Color Picker. 
 
 

Edge Only 
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Original sprite Edge Only 

 

Edge Only outlines the sprite in a color you specify, and then erases the original image, leaving only 
the edge. 

Where to find this effect 

Edge Only is available on the Effects palette in the Outlines category. 

How to apply this effect 

Click the Edge Only picture to learn how to apply this effect. 

How to vary this effect 

• For a more solidly colored edge, move the Opacity  slider to a high number or enter a high 
number in the Opacity box. A lower number creates a more transparent edge. The number in the 
Opacity box must be between 0 and 100. 

• For the thinnest edge, set the Thickness option to 1; for a thicker edge, set a higher number. The 
number in the Thickness box must be between 1 and 100. 

• To select a color for the edge, click the color chip to open the Color Picker. 
 
 



Recess 
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Original sprite Recess 

 

Recess highlights the lower-right edges of the sprite and darkens the upper-left edges. The sprite 
looks recessed after you apply this effect. 

Where to find this effect 

Recess is available on the Effects palette in the Outlines category. 

How to apply this effect 

Click the Recess picture to learn how to apply this effect. 

Tip   Put the sprite you want to recess on top of another sprite, and then apply a surface texture to it 
before applying the Recess effect. The sprite appears set into the sprite that is behind it. 

 

Relief 
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Original sprite Relief 

 

Relief highlights the upper-left edges of the sprite and darkens the lower-right edges, raising the 
sprite slightly above the picture plane. 

Where to find this effect 

Relief is available on the Effects palette in the Outlines category. 

How to apply this effect 

Click the Relief picture to learn how to apply this effect. 

 

Paint effects 
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Paint effects allow you to create specific artistic results characteristic of using paint as a medium. For 
example, you can make the sprite appear to have been painted with: 



• Watercolors 

• A palette knife 

• A spatter airbrush technique 

• A sponge 
 

   Click the effect you want to read about. 

   

Original sprite Accents Dark Strokes 

   

Dry Brush Fresco Paint Daubs 

   

Palette Knife Spatter Sponge 

   

Sprayed Strokes Sumi-e Underpainting 

   

Watercolor Wet Paper  

 
 

Accents 
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Original sprite Accents 

 

Accents adds highlights to the edges of a sprite. When you increase the Edge brightness setting, 
the accents resemble white chalk; when you decrease this setting, the accents resemble black ink. 

Where to find this effect 

Accents is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Accents picture to learn how to apply this effect. 

How to vary this effect 

• To make the edges wider, move the Edge width slider to the right or enter a larger value in the 
Edge width box. If you enter a number in the box, it must be between 1 and 14. 

• To make the edges brighter, move the Edge brightness slider to the right or enter a larger value in 
the Edge brightness box. To make them darker, move the slider to left or enter a smaller value in 
the Edge brightness box. If you enter a number in the box, it must be between 0 and 50. 

• To make the overall result smoother, move the Smoothness slider to the right or enter a larger 
value in the Smoothness box. To retain more detail, move the slider to left or enter a smaller value 
in the Smoothness box. If you enter a number in the box, it must be between 1 and 15. 



• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• Try applying this effect before some of the other effects (such as Dry Brush, Watercolor, or 
Rough Textures in the Surface category) to make the result even more paint-like. 

• When Accents is applied with a low Edge width to a high-resolution sprite, the result is similar to 
egg tempera. 

 
 

Dark Strokes 
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Original sprite Dark Strokes 

 

Dark Strokes paints the sprite with diagonal black-and-white brush strokes. The lighter areas are 
whitened and painted with long strokes that are visible in areas that are not solid white. The darker 
areas are blackened and are painted with short, tight strokes. 

Where to find this effect 

Dark Strokes is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Dark Strokes picture to learn how to apply this effect. 

How to vary this effect 

• The Balance slider changes the proportions of the areas affected by each of the two painting 
strokes. To increase the area to be painted with short, dark strokes, move the slider to the right or 
enter a larger value in the Balance box. To increase the area to be pained with longer, white 
strokes, move the slider to the left or enter a smaller value in the box. If you enter a number in the 
Balance box, it must be between 0 and 10. 

• To increase the intensity of black painted on the sprite, move the Black intensity slider to the right 
or enter a larger value in the Black intensity box. If you enter a number in the box, it must be 
between 0 and 10. 

• To increase the intensity of white painted on the sprite, move the White intensity slider to the right 
or enter a larger value in the White intensity box. If you enter a number in the box, it must be 
between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tip   After applying Dark Strokes, try sharpening the sprite by using the Sharpen or Sharpen Lite 
effect in the Photographic category. 
 
 



Dry Brush 
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Original sprite Dry Brush 

 

Dry Brush paints the edges of the sprite by using a dry brush technique that simplifies the sprite into 
areas of common color. Reapplying the effect further reduces color detail. 

Where to find this effect 

Dry Brush is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Dry Brush picture to learn how to apply this effect. 

How to vary this effect 

• To paint with a smaller brush and create a greater amount of detail, move the Brush size slider to 
the left or enter a smaller value in the Brush size box. To paint with a larger brush and simplify the 
effect, move the Brush size slider to the right or enter a larger value in the box. If you enter a 
number in the box, it must be between 0 and 10. 

• To increase the amount of detail in the individual paint strokes and dabs, move the Brush detail 
slider to the right or enter a larger value in the Brush detail box. If you enter a number in the box, 
it must be between 0 and 10. 

• For a smoother texture, move the Texture slider to the left or enter a smaller value in the Texture 
box. For a rougher texture, move the Texture slider to the right or enter a larger value in the 
Texture box. If you enter a number in the box, it must be between 1 and 3. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tips 

• After you apply the Dry Brush effect, try the Emboss effect in the Surface category for more 
depth. 

• Try sharpening the result by using the Sharpen or Sharpen Lite effects in the Photographic 
category. 
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Original sprite Fresco 

 



Fresco paints the sprite in a coarse painting style by using short, rounded dabs. 

Where to find this effect 

Fresco is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Fresco picture to learn how to apply this effect. 

How to vary this effect 

• To paint with a finer brush, move the Brush size slider to the left or enter a smaller value in the 
Brush size box. To paint with a finer brush, move the Brush size slider to the right or enter a 
larger value in the box. If you enter a number in the box, it must be between 0 and 10. 

• To give more detail within each stroke or dab, move the Brush detail slider to the right or enter a 
larger value in the Brush detail box. If you enter a number in the box, it must be between 0 and 
10. 

• For a smoother texture, move the Texture slider to the left or enter a smaller value in the Texture 
box. For for a rougher texture, move the Texture slider to the right or enter a larger value in the 
Texture box. If you enter a number in the box, it must be between 1 and 3. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 
 

Paint Daubs 
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Original sprite Paint Daubs 

 

Paint Daubs is a suite of effects that give a sprite the appearance that it was created with a series of 
paint strokes. The results of applying a Paint Daub effect vary depending on the paintbrush style and 
size that you select. 

Where to find this effect 

Paint Daubs is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Paint Daubs picture to learn how to apply this effect. 

How to vary this effect 

• For a larger brush size, move the Brush size slider to the right or enter a larger value in the Brush 
size box. Larger brush sizes smooth and simplify images, while smaller brush sizes accentuate 
fine details. If you enter a number in the box, it must be between 1 and 50. 

• Choose a different brush type from the Brush type list. 

• For sharper details, move the Sharpness slider to the right or enter a larger value in the 
Sharpness box. If you enter a number in the box, it must be between 0 and 40. 



• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• Experiment with the different combinations of brush type and size to achieve the effect you want 
before applying other effects. 

• For large brush sizes, try moving the Sharpness slider all the way to the right (or entering 40 in the 
box). This brings out the small color details of the resulting sprite. These colors can be accentuated 
even more by applying other variations of the Paint Daubs effect. 

• Most of the styles created by the Paint Daubs effect benefit from a final application of the Rough 
Textures effect in the Surface category, which creates the impression that the sprite was painted 
on a textured background. 
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Original sprite Palette Knife 

 

Palette Knife creates rough, irregular patches of color that appear to have been applied by a palette 
knife. 

Where to find this effect 

Palette Knife is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Palette Knife picture to learn how to apply this effect. 

How to vary this effect 

• For broader knife strokes, move the Stroke size slider to the right or enter a larger value in the 
Stroke size box. If you enter a number in the box, it must be between 1 and 50. 

• To preserve more of the original sprite’s detail, move the Stroke detail slider to the right or enter a 
larger value in the Stroke detail box. If you enter a number in the box, it must be between 1 and 3. 

• For softer edges, move the Softness slider to the right or enter a larger value in the Softness box. 
If you enter a number in the box, it must be between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• For a special effect, apply the Poster effect in the Arts & Crafts category or the Accents effect to 
the selection before applying Palette Knife. 

• For an authentic look of paint manually applied on a canvas, apply the Rough Textures effect in 
the Surface category after you apply Palette Knife. Try using the Canvas texture type. 



• If the paint strokes created by Watercolor are too small (especially when working with large 
sprites), first apply Palette Knife with a high Stroke size setting. Then apply Watercolor for the 
final watercolor style. 
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Original sprite Spatter 

 

Spatter paints the sprite in a pointillist style using a spatter airbrush technique. 

Where to find this effect 

Spatter is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Spatter picture to learn how to apply this effect. 

How to vary this effect 

• To add smaller, tighter spatters, move the Spray radius slider to the right or enter a larger value in 
the Spray radius box. To add fewer, broader spatters, move the Spray radius slider to the left or 
enter a smaller value in the box. If you enter a number in the box, it must be between 0 and 25. 

• To create a smoother effect, move the Smoothness slider to the right or enter a larger value in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 
 

Sponge 

{button ,AL("paint, 
ae effect")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

  

Original sprite Sponge 

 

Sponge roughly dabs or blots the colors in a sprite. This effect is characterized by highly textured 
areas of contrasting color. 

Where to find this effect 

Sponge is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Sponge picture to learn how to apply this effect. 



How to vary this effect 

• For a larger brush size, move the Brush size slider to the right or enter a larger value in the Brush 
size box. If you enter a number in the box, it must be between 0 and 10. 

• For more highly delineated textured areas, move the Definition slider to the right or enter a larger 
value in the Definition box. If you enter a number in the box, it must be between 0 and 25. 

• To create a smoother effect, move the Smoothness slider to the right or enter a larger value in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• To enhance the Sponge effect, apply the Rough Textures effect in the Surface category after 
applying Sponge. The Sandstone or Brick textures work well. 

• To create the appearance of depth, apply the Emboss effect in the Surface category after 
applying Sponge. 

• For some sprites, the combination of the Sponge effect followed by the Fine Marker effect in the 
Sketch category can create a strong impression of age and wear. 
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Original sprite Sprayed Strokes 

 

Sprayed Strokes paints a sprite in disjointed strokes of adjustable length and direction. 

Where to find this effect 

Sprayed Strokes is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Sprayed Strokes picture to learn how to apply this effect. 

How to vary this effect 

• For longer strokes, move the Stroke length slider to the right or enter a larger value in the Stroke 
length box. If you enter a number in the box, it must be between 0 and 20. 

• To change the direction of the sprayed strokes, select a different item in the Stroke direction list. 

• To create more disjointed strokes, move the Spray radius slider or enter a different value in the 
Spray radius box. If you enter a number in the box, it must be between 0 and 25. For a more 
dramatic, striated effect, move the Spray Radius all the way to the right (or type 25 in the box). 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tip   To make the sprite more paint-like, try applying Sprayed Strokes before you apply some of the 



other paint effects (such as Dry Brush or Watercolor). 
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Original sprite Sumi-e 

 

Sumi-e gives a sprite the appearance that it was painted with a wet brush that is heavily loaded with 
ink. This effect adds rich blacks with soft, blurry edges to the sprite and gives it the appearance that it 
was painted on a textured, highly absorbent ground, such as rice paper. 

Where to find this effect 

Sumi-e is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Sumi-e picture to learn how to apply this effect. 

How to vary this effect 

• For a broader stroke, move the Stroke width slider to the right or enter a larger value in the 
Stroke width box. If you enter a number in the box, it must be between 3 and 15. 

• To increase the pressure of the stroke, move the Stroke pressure slider to the right or enter a 
larger value in the Stroke pressure box. If you enter a number in the box, it must be between 0 
and 15. 

• For more contrast, move the Contrast slider to the right or enter a larger value in the Contrast 
box. If you enter a number in the box, it must be between 0 and 40. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Underpainting 

 

Underpainting roughly paints the image of the sprite on an underlying surface texture, such as brick 
or burlap, and then paints another image of the sprite over the first image. 

Where to find this effect 

Underpainting is available on the Effects palette in the Paint category. 



How to apply this effect 

Click the Underpainting picture to learn how to apply this effect. 

How to vary this effect 

• To increase the brush size and to create more heavily accented contours, move the Brush size 
slider to the right or enter a larger value in the Brush size box. If you enter a number in the box, it 
must be between 0 and 40. 

• To increase the area of the sprite that receives underlying texture, move the Texture coverage 
slider to the right or enter a larger value in the Texture coverage box. If you enter a number in the 
box, it must be between 0 and 40. 

• Adjust the texture type and direction of light in the Texture Controls dialog box. Click Texture 
Controls, and then select items in the Type and Light position lists. For more information, see 
Texture Controls. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tip   Try creating your own textures of wood, paper, or other materials that you can select from the 
Texture Controls dialog box before you apply Underpainting. For details, see Creating a custom 
texture type. 
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Original sprite Watercolor 

 

Watercolor paints the sprite in a watercolor style by using a medium brush that is loaded with water 
and color. The color appears to have dried on smooth paper, leaving dark concentrations of pigment 
around the edges of the paint dabs. 

Where to find this effect 

Watercolor is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Watercolor picture to learn how to apply this effect. 

How to vary this effect 

• To paint with a greater amount of detail, move the Brush detail slider to the right or enter a larger 
value in the Brush detail box. If you enter a number in the box, it must be between 1 and 14. 

• To add heavier shadows, move the Shadow intensity slider to the right or enter a larger value in 
the Shadow intensity box. If you enter a number in the box, it must be between 0 and 10. 

• For a smoother texture, move the Texture slider to the left or enter a smaller value in the Texture 
box. For for a rougher texture, move the slider to the right or or enter a larger value in the box. If 
you enter a number in the box, it must be between 1 and 3. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 



larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tips 

• Try applying the Emboss effect in the Surface category after you apply the Watercolor effect. 

• If the paint strokes created by Watercolor are too small, try first applying the Palette Knife effect 
with a large Stroke setting. Then apply Watercolor to the sprite. 
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Original sprite Wet Paper 

 

Wet Paper renders a sprite with blotchy daubs of color that appear to have been painted on damp 
paper. The painted colors appear blurred and seem to run along the fibers of the paper, softening and 
extending the original outlines of the sprite. 

Where to find this effect 

Wet Paper is available on the Effects palette in the Paint category. 

How to apply this effect 

Click the Wet Paper picture to learn how to apply this effect. 

How to vary this effect 

• For longer paper fibers, move the Fiber length slider to the right or enter a larger value in the 
Fiber length box. If you enter a number in the box, it must be between 3 and 50. 

• For brighter colors, move the Brightness slider to the right or enter a larger value in the 
Brightness box. If you enter a number in the box, it must be between 0 and 100. 

• For higher contrast, move the Contrast slider to the right or enter a larger number in the Contrast 
box. If you enter a number in the box, it must be between 0 and 100. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tips 

• To give a sprite a more authentic painting look, apply Wet Paper before you apply other effects 
from the Paint palette. 

• Use the Rough Textures effect in the Surface category to enhance the impression of damp 
paper. Any texture, when used with a low Relief value, makes the streaks created with Wet Paper 
look like they were naturally created during the painting process. 

• Use the Ripple effect in the Surface category at a low Ripple size setting to create the impression 
that the paint separated as it was blotched on the damp paper. 
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Pattern effects replace a sprite's opaque pixels with the pattern you select. Although you can choose 
the color for some of the patterns, other patterns use a fixed palette of colors or grays. 

You can apply a pattern to only one sprite at a time. 

   Click the effect you want to read about. 

   

Original sprite Checkerboard Color Array 

   

Color Bars Color Noise Gray Noise 

   

Grayscale Array  Hue/Blackness Hue/Whiteness 

   

Stripes   
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Original sprite Checkerboard at 
100% opacity 

  

Original sprite Checkerboard at 
50% opacity 

 

Checkerboard replaces the opaque pixels of a selected sprite with a checkered pattern of 
transparent and opaque squares. You can specify the color and size of the opaque tiles. 

Where to find this effect 

Checkerboard is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Checkerboard picture to learn how to apply this effect. 

How to vary this effect 

• Change the size of the squares by setting new Width and Height values. These values must be 
numbers between 1 and 120. 



• Change the color of the opaque squares by clicking the Color Swatch. 

• To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the squares 
in the pattern replace the opaque pixels in the sprite. 

 

Tip   You can use the Stencil tool in the Cutout palette to reverse the squares in the checkerboard. 
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Original sprite  Color Array at 100% 
opacity 

  

Original sprite Color Array at 50% 
opacity 

 

Color Array covers the selected sprite with a 16 x 16 array of gradient color squares separated by 
transparent lines. 

Where to find this effect 

Color Array is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Color Array picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the squares of 
the pattern replace the opaque pixels in the sprite. 
 

Tip   The Color Array effect is a good test image for the Distort effects. 
 
 

Color Bars 

{button ,AL("patterns 
effect ")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

  

Original sprite  Color Bars at 100% 
opacity 

  



Original sprite Color Bars at 50% 
opacity 

 

Color Bars replaces the opaque pixels of the selected sprite with a color test pattern. This test 
pattern consists of eight vertical bars of color: the three primary colors, the three secondary colors, 
and black and white. The bars are created at 75 percent brightness to avoid over-saturating 
broadcast video devices. They are arranged, left to right, in decreasing luminance. 

Where to find this effect 

Color Bars is available on the Effects palette in the Patterns category.  

How to apply this effect 

Click the Color Bars picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the bars in the 
pattern replace the opaque pixels in the sprite. 
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Color Noise replaces the opaque pixels of the selected sprite with random color pixels. 

Where to find this effect 

Color Noise is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Color Noise picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the colors in 
the pattern replace the opaque pixels in the sprite. 
 

Tip   Set a low Opacity value to add a speckled quality to a digitized image that has become overly 
smooth from editing. 
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Original sprite Gray Noise at 100% 
opacity 

  

Original sprite Gray Noise at 50% 
opacity 

 

Gray Noise replaces the opaque pixels of the selected sprite with random gray pixels. 

Where to find this effect 

Gray Noise is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Gray Noise picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the colors in 
the pattern replace the opaque pixels in the sprite. 
 

Tip   Set a low Opacity value to add a speckled quality to a digitized image that has become overly 
smooth from editing. 
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Original sprite Grayscale Array at 
100% opacity 

  

Original sprite Grayscale Array at 
50% opacity 

 

Grayscale Array covers the selected sprite with a 16 x 16 array of gradient gray squares separated 
by transparent lines. 

Where to find this effect 



Grayscale Array is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Grayscale Array picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the squares of 
the pattern replace the opaque pixels in the sprite. 
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Original sprite  Hue/Blackness at 
100% opacity 

  

Original sprite  Hue/Blackness at 
50% opacity 

 

Hue/Blackness replaces the opaque pixels of the selected sprite with an array of colors. The hues in 
the array vary horizontally and increase in blackness vertically. The hues at the top of the array are 
pure, while those at the bottom are completely black. 

Where to find this effect 

Hue/Blackness is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Hue/Blackness picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the colors of 
the pattern replace the opaque pixels in the sprite. 
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Original sprite Hue/Whiteness at 
100% opacity 

  

Original sprite Hue/Whiteness at 
50% opacity 

 

Hue/Whiteness replaces the opaque pixels of the selected sprite with an array of colors. The hues in 
the array vary horizontally and increase in whiteness vertically. The hues at the top of the array are 
pure, while those at the bottom are completely white. 

Where to find this effect 

Hue/Whiteness is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Hue/Whiteness picture to learn how to apply this effect. 

How to vary this effect 

To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the colors of 
the pattern replace the opaque pixels in the sprite. 
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Original sprite Stripes at 100% 
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Original sprite Stripes at 50% 
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Stripes replaces the opaque pixels of a selected sprite with alternating transparent and opaque 
horizontal stripes. You can specify the color, width, and spacing of the opaque stripes. 

Where to find this effect 

Stripes is available on the Effects palette in the Patterns category. 

How to apply this effect 

Click the Stripes picture to learn how to apply this effect. 

How to vary this effect 

• Change the pixel width of the opaque stripes by specifying a new Width value. This value must be 



a number between 1 and 120. 

• Change the spacing between opaque stripes by specifying a new Spacing value.This value must 
be a number between 1 and 120. 

• Change the color of the opaque stripes by clicking the Color Swatch. 

• To blend less of the effect with the sprite's opaque pixels so that more of the sprite’s details show 
through, move the Opacity  slider to the left or enter a smaller number in the Opacity box. If you 
enter a number in the box, it must be between 0 and 100. At an opacity setting of 100, the colors of 
the pattern replace the opaque pixels in the sprite. 

 
 

Photographic effects 

{button 
,AL("photographic 
effects")} Related 
Topics 

{button 
,AL("effects 
palette ovr")} 
Overview 

 

 

Photographic effects allow you to give a sprite the appearance that it was manipulated using 
traditional photographic techniques, such as adjusting the focus or using filters. For example, you can 
create the appearance of: 

• Light diffusion on an image. 

• Soft focus of an image. 

• Film-grain texture applied to an image. 

You can apply Photographic effects to one sprite or to a selection set of sprites. 

   Click the effect you want to read about: 

   

Original sprite Blur Diffuse Glow 

   

Film Grain Grain Halftone Screen 

   

Transparent Negative Neon Glow 

   

Sharpen Sharpen Lite Soften 
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Original sprite Blur 

 

Blur softens the edges and interior of the sprite, resulting in an unfocused look. 

Where to find this effect 



Blur is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Blur picture to learn how to apply this effect. 

How to vary this effect 

To specify a different number of pixels by which the sprite expands on each side when you blur it, 
change the Horizontal and Vertical settings. These settings must be numbers between 0 and 100. 

For example, a Vertical setting of 2 and a Horizontal setting of 3 expand the sprite by two pixels at 
the top and two at the bottom, plus three pixels on the left and three on the right. Higher settings 
cause more detail from the original sprite to be lost. 
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Original sprite  Diffuse Glow 

 

Diffuse Glow makes the selected sprite look as if it were viewed through a soft diffusion filter. 
Brighter areas glow with diffused light, while other areas are muted with soft granularity. 

The composition space color is used for the diffuse glow color. 

Where to find this effect 

Diffuse Glow is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click on the Diffuse Glow picture to learn how to apply this effect. 

How to vary this effect 

• To increase the grain in the image, move the Graininess slider to the right or enter a larger value 
in the Graininess box. If you enter a number in the box, it must be between 0 and 10. 

• To increase the amount of the sprite that is affected by the glow, move the Glow amount slider to 
the right, or enter a larger value in the Glow amount box. If you enter a number in the box, it must 
be between 0 and 20. 

• To decrease the amount of the sprite that is affected by the glow, move the Clear amount slider to 
the right or enter a larger value in the Clear amount box. If you enter a number in the box, it must 
be between 0 and 20. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Film Grain 

 

Film Grain adds a film-grain texture to the selection. An even pattern is added to the dark areas and 
midtones; a smoother, more saturated pattern is added to the sprite's lighter areas. 

Where to find this effect 

Film Grain is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click on the Film Grain picture to learn how to apply this effect. 

How the vary this effect 

• To increase the grain in the image, move the Grain slider to the right or enter a larger value in the 
Grain box. If you enter a number in the box, it must be between 0 and 20. 

• For more white highlights, move the Highlight area slider to the right or enter a larger value in the 
Highlight area box. If you enter a number in the box, it must be between 0 and 20. 

• For less intense highlights, move the Highlight intensity slider to the left or enter a smaller value 
in the Highlight intensity box. If you enter a number in the box, it must be between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Grain 

 

Grain adds one of ten different grain types to the selected sprite. 

Where to find this effect 

Grain is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click on the Grain picture to learn how to apply this effect. 

How to vary this effect 

• For a grainier effect, move the Graininess slider to the right or enter a larger value in the 
Graininess box. If you enter a number in the box, it must be between 0 and 100. 



• Change the type of grain by clicking a different item in the Grain type list. For samples, see Grain 
Types. 

• For more contrast, move the Contrast slider to the right or enter a larger value in the Contrast 
box. If you enter a number in the box, it must be between 0 and 100. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tips 

• You can use the different grain types to add texture to a sprite before applying other effects. This 
technique works especially well on images that have been created by paint programs, by 3-D 
graphics programs, or with typography. Adding a small amount of grain to a sprite generally yields 
better results with most effects. 

• You can match the amount of visible grain in a set of sprites generated from different sources by 
applying the same grain type to all of them. 

• Try experimenting with different grain types to simulate the appearance of old photographs. The 
effect is enhanced if you change the colors to a sepia tone (yellow-brown) by using the 
hue/saturation controls on the Color Tuning palette. For a more realistic look, try adding small 
speckles of paint by using the Paint tools to simulate bits of dirt. Also, you may want to randomly 
blur areas of the sprite by using the Blur effect. 
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Grain types are available when you apply the Grain effect to a sprite or to a selection set of sprites. 
You can select the type of grain you want to apply by clicking Grain in the Photographic category on 
the Effects palette, and then selecting an item from the Grain type list on the Details tab. 

The Stippled grain type uses the current color and color from the composition space. The Sprinkles 
grain type uses color from the composition space. Other grain types use the original colors of the 
sprite or black. 

   

Original sprite Clumped Contrasty 

   

Enlarged Horizontal Regular 

   

Soft Speckle Sprinkles 

   

Stipple Vertical  
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Original sprite Halftone Screen 

 

Halftone Screen creates the appearance that the sprite’s gradations of light were obtained by the 
relative darkness and density of tiny dots produced by photographing it through a fine screen. Unlike 
digital halftones, this effect displays the continuous tones of an image as smoothly varying dots, lines, 
or circles that blend together like those created by an analog halftone screen. 

The dark areas in the original sprite use the current color. Midtones and highlights use tints of the 
composition space color. 

Where to find this effect 

Halftone Screen is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Halftone Screen picture to find out how to apply this effect. 

How to vary this effect 

• To increase the size of the circles, dots, or lines in the halftone screen, move the Size slider to the 
right or enter a larger value in the Size box. If you enter a number in the box, it must be between 1 
and 12. 

• Change the type of screen used by selecting a different item from the Screen type list. 

• For more contrast, move the Contrast slider to the right or enter a larger value in the Contrast 
box. If you enter a number in the box, it must be between 0 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tips 

• To add a halftone edge to a high-contrast sprite such as text, apply the Blur effect before you 
apply Halftone Screen. 

• Try applying Halftone Screen to posterized sprites or to sprites processed with the Cutout effect 
in the Arts & Crafts category. This technique creates uniform halftone dots in the large flat areas 
of common color. 
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Original sprite Transparent 

 

Transparent increases the transparency of the pixels in a sprite. The result varies from partially 



transparent (as in the picture above) to totally transparent, depending on how you set the Opacity 
slider. 

Where to find this effect 

Transparent is available on the Effects palette in the Color Enhancement category. 

How to apply this effect 

Click the Transparent picture to learn how to apply this effect. 

How to vary this effect 

Adjust the Opacity  slider or enter a number between 0 and 100 in the Opacity box. The lower the 
setting, the more transparent the sprite becomes when you click Apply. If you set opacity to 0, all 
opaque pixels in the sprite are erased, and the image becomes totally transparent. 

Note   You cannot make a sprite less transparent by applying an effect. 
 

Tip   Transparent makes the whole sprite translucent. To make only a part of the sprite translucent, 
use the Erase button on the Paint palette. 
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Original sprite Negative 

 

Negative changes all the colors in the sprite to their complement colors, resulting in a color negative. 

Where to find this effect 

Negative is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Negative picture to learn how to apply an effect. 
 

Tip   You can undo this effect by reapplying it. 
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Neon Glow adds various types of glows to the selected sprites. This effect can be used to create 
neon effects or to give an object the appearance of radiating light and heat. This effect is particularly 
useful for text sprites or simple, high-contrast graphical sprites. 

This effect uses the current color and color from the composition space. 

Where to find this effect 

Neon Glow is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click on the Neon Glow picture to learn how to apply this effect. 

How to vary this effect 

• You can move the Glow size slider over the range of positive and negative values -24 to 24 (or 
enter a value in this range in the box). Positive Glow size settings create glows on the outside of 
dark areas and on the inside of light areas, while negative settings create glows on the inside of 
dark areas and on the outside of light areas. Greater settings create larger glow effects. 

• To increase the brightness of the glow, move the Glow brightness slider to the right or enter a 
larger value in the Glow brightness box. If you enter a number in the box, it must be between 0 
and 50. 

• To select a color for the glow in the Color Picker dialog box, click the Glow color box. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the sbox. To blend a smaller proportion of the effect and retain more of the 
sprite’s original look, move the slider to the left or enter a smaller number in the box. If you enter a 
number in the box, it must be between 0 and 100. 

 

Tip   Neon Glow can produce both outline and inline glow variations. An outline glow appears to be 
around the outside of the sprite; for example, around the outside of a letter. An inline glow appears to 
be on the inside of the letter. When the inside areas are small, the Glow size and Glow brightness 
settings should be adjusted accordingly. 
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Original sprite Sharpen 

 

Sharpen makes the sprite look more distinct by increasing the contrast between neighboring pixels. 
You can intensify the effect by applying this filter repeatedly. 

Where to find this effect 

Sharpen is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Sharpen picture to learn how to apply the effect. 

Tips 

• Repeated applications of Sharpen can make a sprite look grainy. For a subtler result, try the 



Sharpen Lite effect. 

• You can achieve the opposite effect by using the Soften effect. 
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Original sprite Sharpen Lite 

 

Sharpen Lite is a softer version of the Sharpen effect. It makes the sprite look more distinct by subtly 
increasing the contrast between neighboring pixels. You can intensify the effect by applying this effect 
repeatedly. 

Where to find this effect 

Sharpen Lite is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Sharpen Lite picture to learn how to apply this filter. 

Tip   You can achieve the opposite effect by using the Soften effect. 
 
 

Soften 
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Original sprite Soften 

 

Soften unfocuses the sprite slightly by decreasing the contrast between neighboring pixels. You can 
increase the effect by applying it repeatedly. 

Where to find this effect 

Soften is available on the Effects palette in the Photographic category. 

How to apply this effect 

Click the Soften picture to learn how to apply this filter. 

Tips 

• You can achieve an even more unfocused result by using the Blur effect. 

• You can achieve the opposite effect by using the Sharpen or Sharpen Lite effects. 
 
 

Popular effects 
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Popular effects include some of the most frequently used effects in Microsoft Image Composer. Each 
of the effects in this category also appears in one other effects category. They are combined in the 
Popular category for quick and easy access. 
 

   Click the effect you want to read about: 

   

Original sprite Blur Emboss 

   

Rough Textures Drop Shadow Sharpen 

 
 

Sketch effects 

{button ,AL("sketch 
effects")} Related 
Topics 

{button 
,AL("effects 
ovr")} 
Overview 

 

 

Sketch effects give a sprite the appearance that it was drawn in a medium typically used by artists for 
sketching, such as: 

• Charcoal 

• Pastel colored chalk 

• A technical pen 

• Ink 
 

   Click the effect you want to read about: 

   

 Original sprite Angled Strokes Chalk and Charcoal 

   

Charcoal Color Edges Colored Pencil 

   

Conté Crayon Crosshatch Fine Marker 

   

Rough Pastels Smudge Stick Technical Pen 

 
 

Angled Strokes 

{button ,AL("sketch 
effects")} Related 
Topics 

{button 
,AL("effects 
ovr")} 
Overview 

 

 

  



Original sprite Angled Strokes 

 

Angled Strokes paints the selection in bidirectional diagonal strokes. The lighter areas of the sprite 
are painted in strokes in one direction, while the darker areas are painted in strokes in the opposite 
direction. 

Where to find this effect 

Angled Strokes is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Angled Strokes picture to learn how to apply this effect. 

How to vary this effect 

• To increase the proportion of right diagonal strokes, move the Direction balance slider to the right 
or enter a larger number in the Direction balance box. To increase the proportion of left diagonal 
strokes, move the slider to the left or enter a smaller number in the box. The number in must be 
between 0 and 100. 

• To make the strokes longer, move the Stroke length slider to the right or enter a number in the 
Stroke length box. The number must be between 3 and 50. 

• To increase the detail of the sprite, move the Sharpness slider to the right or enter a larger 
number in the Sharpness box. To increase the softness of the sprite, move the slider to the left or 
enter a smaller number in the box. The number must be between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 

 

Tip   To create an exaggerated version of this effect, scale the selection down to 50 percent or 25 
percent, apply Angled Strokes, and then scale the selection back up to its original size. You can 
sharpen the result to make the strokes more apparent. 
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Original sprite Chalk and Charcoal 

 

Chalk and Charcoal transforms the sprite using coarse diagonal strokes on a solid medium-gray 
background. 

The charcoal is drawn using the current color and the chalk is drawn using the color of the 
composition space. 

Where to find this effect 

Chalk and Charcoal is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Chalk and Charcoal picture to learn how to apply this effect. 



How to vary this effect 

• To increase the amount of dark areas drawn with charcoal, move the Charcoal area slider to the 
right or enter a larger number in the Charcoal area box. The number must be between 0 and 20. 

• To increase the amount of light areas drawn with chalk, move the Chalk area slider to the right or 
enter a larger number in the Chalk area box. The number must be between 0 and 20. 

• To increase the intensity of the charcoal and chalk strokes, move the Stroke pressure slider to the 
right or enter a larger number in the Stroke pressure box. The number must be between 0 and 5. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 
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Original sprite Charcoal 

 

Charcoal gives a sprite the appearance that it was sketched on a rough, paper surface. Clearly 
delineated edges are drawn boldly, while midtones are sketched using a series of diagonal strokes. 

Charcoal areas use the current color. The paper color is the color of the composition space. 

Where to find this effect 

Charcoal is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Charcoal picture to learn how to apply this effect. 

How to vary this effect 

• To draw thicker lines, move the Charcoal thickness slider to the right or enter a larger number in 
the Charcoal thickness box. The number must be between 1 and 7. 

• To preserve more of the sprite’s original detail, move the Detail slider to the right or enter a larger 
number in the Detail box. The number must be between 0 and 5. 

• To apply the charcoal more heavily, move the Light/Dark balance slider to the right or enter a 
larger number in the Light/Dark balance box.To apply the charcoal more lightly, move the slider to 
the left or enter a smaller number in the box. The number must be between 0 and 100. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 
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Original sprite  Colored Pencil 

 

Colored Pencil draws an image using colored pencils on a solid background. Clearly delineated 
edges are retained and given a rough, crosshatched appearance, while the solid background is 
allowed to show through the smoother areas of the sprite, simulating rough gray sketch paper. 

Where to find this effect 

Colored Pencil is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Colored Pencil picture to learn how to apply this effect. 

How to vary this effect 

• To widen the pencil stroke, move the Pencil width slider to the right or enter a larger number in 
the Pencil width box. The number must be between 1 and 24. 

• To increase the intensity of the pencil stroke, move the Stroke pressure slider to the right or enter 
a larger number in the Stroke pressure box. The number must be between 0 and 15. 

• To increase the brightness of the background paper, move the Paper brightness slider to the right 
or enter a larger number in the Paper brightness box. The number must be between 0 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 
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Original sprite  Conté Crayon 

 

Conté (pronounced CON-tay) Crayon sketches the sprite in highly textured, soft strokes on a rough 
textured background, using colors you select. 

The dark areas in the original sprite use the current color. Midtones and highlights use tints of color 
from the composition space. 

Where to find this effect 

Conté Crayon is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Conté Crayon picture to learn how to apply this effect. 

How to vary this effect 

• To apply the current color to more of the sprite, move the Foreground level slider to the right or 



enter a larger number in the Foreground level box. To reveal more of the textured background, 
move the slider to the left or enter a smaller number in the box. The number must be between 1 
and 15. 

• To apply more of the color from the composition space to the textured background, move the 
Background level slider to the right or enter a larger number in the Background level box.. The 
number must be between 1 and 15. 

• Change the light position and texture type in the Texture Controls dialog box. For more 
information, see Texture Controls. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 

 

Tips 

• For authenticity, try foreground colors such as black, sepia (yellow-brown), or sanguine (blood red) 
to emulate the colors of real Conté crayons. 

• If you want your sprite to resemble a nineteenth-century Conté drawing, use the Sandstone 
texture type. 
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Original sprite  Crosshatch 

 

Crosshatch sketches the sprite using fine-hatched strokes in the existing colors. This effect 
preserves the features of the original sprite and adds texture and roughness to the edges of the 
colored areas. 

Where to find this effect 

Crosshatch is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Crosshatch picture to learn how to apply this effect. 

How to vary this effect 

• For longer strokes, move the Stroke length slider to the right or enter a larger number in the 
Stroke length box. The number must be between 3 and 50. 

• For sharper, harder hatching, move the Sharpness slider to the right or enter a larger number in 
the Sharpness box. The number must be between 0 and 20. 

• To indicate the number of times you want the effect to be applied in succession, move the 
Strength slider or enter a number between 1 and 3 in the Strength box. More iterations 
strengthens the results of this effect. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 
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(Called Ink Outlines in Microsoft Image Composer 1.0) 
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Original sprite  Fine Marker 

 

Fine Marker draws the details of the sprite in fine, narrow lines and uses crosshatches in the midtone 
areas to create a corroded pen-and-ink look. 

Where to find this effect 

Fine Marker is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Fine Marker picture to learn how to apply this effect. 

How to vary this effect 

• For longer crosshatch strokes, move the Stroke length slider to the right or enter a larger number 
in the Stroke Length box. The number must be between 1 and 50. 

• To increase the amount of dark areas, move the Dark intensity slider to the right or enter a larger 
number in the Dark intensity box. The number must be between 0 and 50. 

• To increase the amount of light areas, move the Light intensity slider to the right or enter a larger 
number in the Light intensity box. The number must be between 0 and 50. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 

 

Tips 

• You can vary the textures that Fine Marker creates by first applying one of the Paint Daubs 
effects. 

• Try adding texture by applying one of the Grain effects before you apply Fine Marker. 

• If the result of applying Fine Marker is too harsh, blur the sprite slightly with the Blur effect in the 
Photographic category, and then adjust the brightness and contrast. 

• High-contrast versions of Fine Marker, achieved by using increased Dark intensity and Light 
intensity settings, tend to look more like pen-and-ink drawings. If these high-contrast sprites are 
blurred successively with a few small blurs, they look like soft-pencil sketches. 

• For a softened pen-and-ink effect, try applying the Wet Paper effect with a small Fiber length 
setting after you apply Fine Marker. 
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Original sprite Rough Pastels 

 

Rough Pastels sketches the sprite in rough strokes of colored pastel chalk on a textured 
background. In areas of bright color, the chalk is thick with little texture; in darker areas, the chalk is 
thinner and thus reveals the background texture. 

Where to find this effect 

Rough Pastels is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Rough Pastels picture to learn how to apply this effect. 

How to vary this effect 

• For longer strokes, move the Stroke length slider to the right or enter a larger number in the 
Stroke length box. The number must be between 0 and 40. 

• For more clearly defined strokes, move the Stroke detail slider to the right or enter a larger 
number in the Stroke detail box. The number must be between 1 and 20. 

• Change the light position and texture type in the Texture Controls dialog box. For more 
information, see Texture Controls. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 
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Original sprite Color Edges 

 

Color Edges sketches the smooth areas of a sprite in rough strokes of pure black or white, and adds 
colored highlights to its edges. This effect gives the sprite the appearance that it was created by 
placing sketch paper over a raised surface and rubbing the paper gently with colored charcoal or 
chalk. 

Where to find this effect 

Rubbing is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Rubbing picture to learn how to apply this effect. 

Tip   This effect works best on sprites with solid areas of contrasting colors, but it can also produce 
interesting results on digitized or dithered sprites. 



 
 

Smudge Stick 
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Original sprite Smudge Stick 

 

Smudge Stick smears the darker areas of the sprite with short diagonal strokes and brightens its 
lighter areas. 

Where to find this effect 

Smudge Stick is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Smudge Stick picture to learn how to apply this effect. 

How to vary this effect 

• To increase the stroke length, move the Stroke length slider to the right or enter a larger number 
in the Stroke length box. The number must be between 0 and 10. 

• To increase the areas being whitened, move the Highlight area slider to the right or enter a larger 
number in the Highlight area box. The number must be between 0 and 20. 

• To increase the transparency of the brightened sprite, which allows more of the original sprite to 
show through, move the Highlight intensity slider to the left or enter a smaller number in the 
Highlight intensity box. The number must be between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 

 
 

Technical Pen 

(Called Graphic Pen in Microsoft Image Composer 1.0) 
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Original sprite Technical Pen 

 

Technical Pen captures the details of a sprite in fine, linear ink strokes, as if drawn on paper on a 
fine-grained wood surface. The stroke density increases in darker areas and is less evident in the 
lighter areas of the sprite. 

The current color is used for the ink color, and the color of the composition space is used for the 
paper color. 

Where to find this effect 



Technical Pen is available on the Effects palette in the Sketch category. 

How to apply this effect 

Click on the Technical Pen picture to learn how to apply this effect. 

How to vary this effect 

• To lengthen the strokes, move the Stroke length slider to the right or enter a larger number in the 
Stroke length box. The number must be between 1 and 15. 

• To change the direction of the strokes, select a different item in the Stroke direction list. 

• For a higher proportion of ink to paper, move the Light/Dark balance slider to the right or enter a 
larger number in the Light/Dark balance box. The number must be between 0 and 100. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. The 
number must be between 0 and 100. 

Tips 

• For better results, try increasing the contrast of the sprite before applying Technical Pen. 

• After applying the effect, blur the sprite with the Blur effect in the Photographic category to 
smooth the pen lines. 

 
 

Surface effects 
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Surface effects give a sprite the appearance that it was created on a specific artistic material or 
surface.  

For example, you can: 

• Create a smooth metallic surface over an image. 

• Create the appearance of water rippling above an image. 

• Create an image that seems to be composed of small tiles. 
 

You can apply these effects to one sprite or to a selection set of sprites. 

   Click the effect you want to read about. 

   

Original sprite Bas Relief Broken Tile 

   

Chrome Cracked Varnish Emboss 

   

Glass Glowing Accents Plaster 

   

Plastic Wrap Ripple Rough Textures 
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Original sprite Bas Relief 

 

Bas Relief makes a sprite appear to have been carved in low relief and lit to accent the surface 
modulations of the sprite. 

The dark areas in the original sprite take on the current color. Midtones and highlights take on tints 
from the composition space. 

Where to find this effect 

Bas Relief is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Bas Relief picture to learn how to apply this effect. 

How to vary this effect 

• To increase the surface detail of the sprite, move the Detail slider to the right or enter a larger 
number in the Detail box. If you enter a number in the box, it must be between 1 and 15. 

• Change the location of the light source in the Light position list. 

• For a smoother surface, move the Smoothness slider to the right or enter a larger number in the 
Smoothness box. For a rougher surface, move the slider to left or enter a smaller number in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Broken Tile 

 

Broken Tile makes the sprite appear to be composed of small, irregularly shaped chips or tiles laid 
down on a flat surface. The chips are lit from the side to enhance their texture. 

Where to find this effect 

Broken Tile is available on the Effects palette in the Surface category. 



How to apply this effect 

Click the Broken Tile picture to learn how to apply this effect. 

How to vary this effect 

• To increase the size of each tile, move the Tile size slider to the right or enter a larger number in 
the Tile size box. This setting represents the maximum height and width of each tile measured in 
pixels. If you enter a number in the box, it must be between 2 and 100. 

• To increase the amount of space between the tiles, move the Grout width slider to the right or 
enter a larger number in the Grout width box. If you enter a number in the box, it must be between 
1 and 15. This setting represents the minimum number of pixels between tiles; the grout width in 
some areas will exceed this number because the tiles are irregularly shaped. 

• To lighten the color of the spaces between the tiles, move the Lighten grout slider to the right or 
enter a larger number in the Lighten grout box. If you enter a number in the box, it must be 
between 0 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Chrome 

 

Chrome covers the sprite with a highly polished, smooth metallic surface. Image features of the sprite 
are represented as hills and valleys in the reflecting surface. This effect also changes a color sprite to 
grayscale. 

Where to find this effect 

Chrome is available on the Effects palette in the Surface category. 

How to apply this effect 

Click on the Chrome picture to learn how to apply this effect. 

How to vary this effect 

• To see more detail reflected in the chrome surface, move the Detail slider to the right or enter a 
larger number in the Detail box. If you enter a number in the box, it must be between 0 and 10. 

• For a smoother surface, move the Smoothness slider to the right or enter a larger number in the 
Smoothness box. For a rougher surface, move the slider to left or enter a smaller number in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 



• After you apply Chrome to a sprite, increase its brightness and contrast to enhance its reflective 
quality. 

• Move the Detail slider all the way to the right (or enter 10 in the box) and move the Smoothness 
slider all the way to the left (or enter 0 in the box) to simulate an aluminum foil surface. Reapply 
this effect to crumple the aluminum foil. 
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Original sprite Cracked Varnish 

 

Cracked Varnish covers the sprite with a high-relief plaster-like surface, producing a fine network of 
cracks that follow the contours of the sprite. 

Where to find this effect 

Cracked Varnish is available on the Effects palette in the Surface category. 

How to apply this effect 

Click on the Cracked Varnish picture to learn how to apply this effect. 

How to vary this effect 

• To increase the amount of space between cracks, move the Crack spacing slider to the right or 
enter a larger number in the Crack spacing box. If you enter a number in the box, it must be 
between 2 and 100. 

• To increase the depth of the cracks, move the Crack depth slider to the right or enter a larger 
number in the Crack depth box. If you enter a number in the box, it must be between 0 and 10. 

• To increase the brightness of the cracks, move the Crack brightness slider to the right or enter a 
larger number in the Crack brightness box. If you enter a number in the box, it must be between 0 
and 10. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• The Cracked Varnish effect works best on sprites that contain a broad range of color or grayscale 
values. Flat areas take on a grid-like look. 

• Very low Crack spacing settings create groups of small, highlighted nuggets in the tones of the 
sprite. 
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Original sprite Emboss 

 

Emboss gives the sprite a three-dimensional appearance. 

Where to find this effect 

Emboss is available on the Art Effects palette in the Surface category. 

How to apply this effect 

Click the Emboss picture to learn how to apply this effect. 

How to vary this effect 

• To increase the amount of embossing, move the Relief slider to the right or enter a larger number 
in the Relief box. If you enter a number in the box, it must be between 0 and 25. 

• Change the location of the light source in the Light position list. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tip   To exaggerate another effect, apply that effect first and then apply Emboss. 
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Original sprite Glass 

 

Glass distorts a sprite to make it appear as if it is viewed through glass. You can choose from a 
variety of glass types, or you can specify custom image files for the glass surface. 

Where to find this effect 

Glass is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Glass picture to learn how to apply this effect. 

How to vary this effect 

• To increase the amount of distortion caused by the glass surface, move the Distortion slider to the 
right or enter a larger number in the Distortion box. If you enter a number in the box, it must be 
between 0 and 20. 

• To make the result smoother, move the Smoothness slider to the right or enter a larger number in 
the Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• Change the glass surface by clicking Surface Controls and selecting a surface from the Type list. 



For details about the Glass Surface Controls dialog box, see Glass Surface controls. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• When creating an image for a custom Glass surface, remember that any shapes that are defined 
in your surface image will bend and refract the areas of a sprite that surround those shapes. For 
example, if you have a square in your surface image, the sprite that you apply Glass to will change 
the area around the edges of the square only. 

• You can combine the Glass effects to create effects that are not available by just applying the 
effect once. For example, apply the Glass effect using one surface texture, and then apply the 
effect again using a different surface texture. 

• If any areas of the sprite show too much detail after you apply Glass, try applying the Blur effect in 
the Photographic category using values of 1 or 2 for Horizontal and Vertical to smooth these 
areas. 

• To enhance the appearance of the Frosted surface, try applying the Blur effect with large 
Horizontal and Vertical settings, or with several applications of smaller Horizontal and Vertical 
settings. 

• For a surrealistic look, apply the Blur or Diffuse Glow effect multiple times to the original sprite 
before applying Glass. 
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When you use the Glass effect, you can select the type of glass surface you want to apply. You can 
also create your own glass surface file saved as a .tif file, and apply it from the Effects palette. 

Type   Select a glass surface from the list. If you want to specify a .tif file that doesn’t appear in this 
list, click TIFF File, and then select your own glass surface file from the Open dialog box. Surfaces 
with dominant light and dark colors work best. 

Scaling %   Move the slider to the right or enter a larger number in the Scaling % box to increase 
the size of the surface pattern. For example, if you select the Brick surface, you can increase the 
size of each brick by using a higher scaling number. If you enter a number in the box, it must be 
between 50 and 200. 

Invert texture   Select this option to change from a relief effect to a recessed effect. 
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Original sprite Glowing Accents 

 



Glowing Accents amplifies the edges of a sprite in bright, luminous colors. 

Where to find this effect 

Glowing Accents is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Glowing Accents picture to learn how to apply this effect. 

How to vary this effect 

• Move the Edge width slider to the right or enter a larger number in the Edge width box to make 
the edges wider. If you enter a number in the box, it must be between 1 and 14. 

• To increase the smoothness of the edges, move the Smoothness slider to the right or enter a 
larger number in the Smoothness box. If you enter a number in the box, it must be between 1 and 
15. 

• To make the edges stronger and brighter, move the Edge brightness slider to the right or enter a 
larger number in the Edge brightness box. If you enter a number in the box, it must be between 0 
and 20. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tip   To enhance the colors in the final sprite, increase the contrast of the sprite on the Color 
Tuning palette before you apply Glowing Accents. Increasing the contrast can also create edges. 
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Original sprite  Plaster 

 

Plaster makes the sprite look like it is molded from three-dimensional plaster. The dark areas of a 
sprite are raised into bumps and plateaus, while lighter areas are flattened into valleys. This effect 
works especially well on text or on simple, high-contrast objects. 

The dark areas in the original sprite take on the current color. Midtones and highlights take on tints of 
color from the composition space. 

Where to find this effect 

Plaster is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Plaster picture to learn how to apply this effect. 

How to vary this effect 

• To increase the areas of the image that appear as valleys, and to decrease the areas that appear 
as bumps and plateaus, move the Image balance slider to the right or enter a larger number in the 
Image balance box. If you enter a number in the box, it must be between 0 and 50. 



• Change the location of the light source in the Light position list. 

• For a smoother effect, move the Smoothness slider to the right or enter a larger number in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• For a more realistic result, try increasing the contrast of your sprite before you apply Plaster. 

• For an interesting variation, apply the Negative effect in the Photographic category before you 
apply Plaster.  
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Original sprite Plastic Wrap 

 

Plastic Wrap creates the appearance that the sprite is wrapped in shiny plastic that accentuates the 
surface detail of the sprite. 

Where to find this effect 

Plastic Wrap is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Plastic Wrap picture to learn how to apply the effect. 

How to vary this effect 

• For stronger highlights, move the Highlight strength slider to the right or enter a larger number in 
the Highlight strength box. If you enter a number in the box, it must be between 0 and 20. 

• To increase the amount of detail from the original sprite that will be used to create the shine in the 
final image, move the Detail slider to the right or enter a larger number in the Detail box. If you 
enter a number in the box, it must be between 1 and 15. 

• For a smoother result, move the Smoothness slider to the right or enter a larger number in the 
Smoothness box. If you enter a number in the box, it must be between 1 and 15. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 
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Original sprite Ripple 

 

Ripple adds randomly spaced waves to the surface of the sprite, creating the appearance that the 
sprite is underwater with the wind rippling the water. 

Where to find this effect 

Ripple is available on the Effects palette in the Surface category. 

How to apply this effect 

Click the Ripple picture to learn how to apply this effect. 

How to vary this effect 

• To make the ripples larger, move the Ripple size slider to the right or enter a larger number in the 
Ripple size box. If you enter a number in the box, it must be between 1 and 15. 

• To increase the distortion of the ripples, move the Ripple magnitude slider to the right or enter a 
larger number in the Ripple magnitude box. If you enter a number in the box, it must be between 
0 and 20. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

 

Tip   For highly detailed sprites, lower the Ripple size and Ripple magnitude settings; for sprites 
without intricate details, use higher settings. 
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Original sprite Rough Textures 

 

Rough Textures gives a sprite the appearance that it was created on a roughly textured surface, 
such as canvas, burlap, or sandstone. You can select a surface texture from the Texture Controls 
dialog box. You can also add your own .tif file to the list of textures. 

Where to find this effect 

Rough Textures is available on the Effects palette in the Surface category. 

How to apply this effect 

Click on the Rough Textures picture to learn how to apply this effect. 

How to vary this effect 



• To apply a different surface texture, click Texture Controls and change the setting in the Type list. 
To vary the direction of the light source, change the Light position setting. For details about the 
Texture Controls dialog box, see Texture Controls. For information about creating your own 
texture, see Creating a custom texture type. 

• To blend more of the effect with the original sprite, move the Opacity  slider to the right or enter a 
larger number in the Opacity box. To blend a smaller proportion of the effect and retain more of 
the sprite’s original look, move the slider to the left or enter a smaller number in the box. If you 
enter a number in the box, it must be between 0 and 100. 

Tips 

• Use Rough Textures to create a randomly textured pattern. In the Texture Controls dialog box, 
choose Sandstone from the Type list, and set Relief to 50. The resulting random noise pattern 
can be applied to a white or black background for a fancy appearance. You also can get good 
results by using it on text sprites. 

• For maximum texturing, choose a light source direction perpendicular to the dominant direction of 
the texture. Textures that are parallel to the light source direction tend to show little relief. 

 
 

Texture Controls 
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When you use the Rough Textures effect, you can select the type of texture you want to apply. You 
can also create your own texture file saved as a .tif file, and apply it from the Effects palette. 

Type   Select a texture from the list. If you want to specify a .tif file that doesn’t appear in this list, 
click TIFF File, and then select your own texture file from the Open dialog box. Textures with 
dominant light and dark colors work best. 

Light Position   Select the direction of the light source in relation to the sprite. 

Scaling %   Move the slider to the right or enter a larger number in the Scaling % box to increase 
the size of the surface pattern. For example, if you select the Brick surface, you can increase the 
size of each brick by using a higher scaling number. If you enter a number in the box, it must be 
between 50 and 200. 

Relief   Move the slider to the right or enter a larger number in the Relief box for higher relief and 
depth of the texture. If you enter a number in the box, it must be between 0 and 50. 

Invert texture   Select this option to change from a relief effect to a recessed effect. 
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Use the tools on the Paint Palette to apply effects that appear to have been applied by a brush, 
airbrush, pencil, sprite, or even your finger.   

Before using a paint tool, you must select a sprite and a brush. Regardless of which tool you choose, 
the effect is applied in a specific size and shape defined as a brush. You can work with brushes in the 
following ways: 

Button Icon Clicked  (Pushed In) Not Clicked 



Use Brush  Applies effects in the 
size and type of brush 
from brush grid. 

Applies effects 
with template. 

Use Template  Applies effects in a 
template the size and 
shape of a sprite.  

Applies effects 
with brush. 

Set Template  Selects a sprite to be 
used as a brush 
template. 

Applies effects 
with brush. 

Over   Applies effect to all 
pixels within a sprite's 
bounding box. (Can be 
used with Continuous.) 

Applies effects 
only to opaque 
areas of sprite. 

Continuous  Applies effect in 
smooth, continuous 
strokes. (Can be used 
with Over.) 

Applies effects 
unevenly. 

 
 

Use the Brush Designer to define and work with brushes of varied sizes, shapes, angles, and edge 
softness. In addition, you can create brush templates in the shapes of sprites. When you use a 
template as your brush, a thumbnail of the template is displayed in the Brush Display box. 

The Paintbrush, Airbrush, Pencil, Tint, and Colorize tools all use the color shown in the color swatch. 
Other tools, such as the Impressionist tool, apply an effect without changing the color of the area they 
are applied to.  

Click an area on the following figure for more information about the Paint  tools palette. 

Paint Palette 

 
 

Image Composer paint tools 

Click the tool below that you want to learn about. 

   

Paintbrush Airbrush Pencil 

   

Smear Impression Eraser 

   

Tint Colorize Dodge/Burn 

   

Contrast Rubber Stamp Transfer 

   

Mesa Vortex Spoke Inversion 

   

Use Brush Use Template Set Template 

   

Over Continuous Strokes New Brush 
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To use a paint tool to apply an effect, you must first select a sprite. 

 To use a paint tool 

1 On the toolbox, click Paint . 

2 On the left side of the Paint tool palette, click the paint tool you want.  

3 Click a brush from the paintbrush selection grid, or use Set Template to choose a selected sprite 
as a template. 

4 Click the brush application methods you want to use.  

Click either Use Brush or Use Template. Click Over or Continuous or both. 

5 Hold down the left mouse button and drag the brush pointer over the area of the sprite you want to 
paint. 
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Use tools on the Paint palette to apply effects that appear as if applied by a brush, airbrush, pencil, or 
a variety of other tools. Regardless of which tool you choose, the effect is applied in a specific size 
and shape defined as a brush. You can specify certain aspects of the brush by using the Brush 
DesignerIDH_Brush_Designer. 

 To choose a paint brush 

1 On the toolbox, click Paint . 

2 On the Paintbrush Selection grid, click the brush size and type you want.  

The brush size and slider reflect the brush size you click in the grid.  

 

If you want to work with a brush shape other than a circle, double click a brush in the selection grid 
to display the Brush Designer. Use the brush designer to work with a brush size, shape, rotation, 
and softness that you specify.  

3 Hold down the left mouse button and drag the brush over the sprite to paint it. 

 

Working with a brush template 
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In addition to the brush sizes and shapes available through the Brush Designer, you can also create a 
brush template in the shape of a sprite of your choosing. This shape is then used to apply whichever 
paint effect you want. The sprite used to generate the template cannot be larger than 100 pixels wide 



by 100 pixels high. You must select a sprite to use the paint tools, including creating a brush 
template. 

 To work with a brush template 

1 Click a sprite to use as a template. 

2 On the toolbox, click Paint . 

3 On the Paint palette, click Set Template.  

4 Click the sprite you want to apply a paint effect to. 

5 Click the paint effect you want to use to paint the current sprite. 

6 Click Use Template . 

7 Drag the pointer over the current sprite to apply the effect. 
 

Note   If you modify the shape of the sprite you use as a template, the paintbrush template changes 
as well. Once you select a sprite to use as a paintbrush template, the shape of the sprite is retained 
as the current template until another sprite is selected. 
 
 
 

Paintbrush 

Paintbrush uses the brush selected in the Paintbrush grid as the current paintbrush tool. The 
selected brush appears in the Paintbrush display box on the right portion of the Paint tool palette. 
This paint tool uses the current color. You can set the transparency level of this effect by using the 
Opacity control.  

   
 
 

Airbrush 

Airbrush behaves the same as Paintbrush, except that it produces an airbrushed effect in which the 
effect is more dispersed. This paint tool uses the current color. You can set the transparency level of 
this effect by using the Opacity control. 

   
 
 

Pencil 

Pencil draws a line, in the current color, wherever you drag the pointer. Specify a line width by using 
the Brush Size slider or box. This paint tool uses the current color. Set the transparency level of this 
effect by using the Opacity control. 

   
 
 

Smear 

Smear blends the sprite's colors, much the way you could smear fresh paint with your finger. This 
effect uses the color and texture at the location of the pointer to create a textured smudge effect on 
the sprite. Set the transparency level of this effect by using the Opacity control. 

   
 
 

Impression 

Impression can create a smudged, impressionistic effect as you drag the pointer. This effect uses 
the color at the location of the pointer to create a smoothly smudged result. Set the transparency level 
of this effect by using the Opacity control.  

   



 
 

Erase 

Erase turns the current brush into an eraser. It turns all the color pixels transparent as you drag 
across a sprite or composition. Set the transparency level of the erase tool by using the Opacity 
control. 

   
 
 

Tint 

Tint applies a translucent wash of the current color to the current sprite or composition, using the 
current brush. This tool uses the current color. Set the transparency level of this effect by using the 
Opacity control.  

   
 
 

Colorize 

Colorize applies the current color without affecting the dark and light intensity values of the sprite. 
This tool uses the current color. Set the transparency level of this effect by using the Opacity control. 

   
 
 

Dodge-Burn 

Dodge-Burn allows you to lighten or darken a specific area of a sprite to change the color saturation 
of an area. Move the Dodge-Burn slider to the left to darken an area of a sprite, and to the right to 
lighten an area. 

   
 

   
 
 

Contrast 

Contrast allows you to increase or decrease the contrast in a specific area of a sprite. Move the 
Contrast slider to the left to decrease the contrast and produce a flatter look, or to the right to 
increase contrast and produce a sharper, more defined look. 

   
 
 

Rubber Stamp 

Rubber Stamp allows you to copy a portion of a sprite into a non-transparent area of the same or 
another sprite. To use this tool, select a paintbrush size, shape, and opacity and click Rubber Stamp. 
Then use the Rubber Stamp to click on a source area (the dog's head), defined by the paintbrush. 
You then click on a destination area (the world map) and each time you click, you stamp the source 
area onto the destination area.   

This tool is similar to the Transfer tool, but rather than copying a different paintbrush-sized portion of 
the source each time you click, Rubber Stamp copies the same portion. Set the transparency level of 
this effect by using the Opacity control. 

   
 
 

Transfer 



Transfer allows you to copy a sprite into a non-transparent area of the same sprite or to a different 
sprite. To use this tool, select a paintbrush size, shape, and opacity and click Transfer. Then use the 
Transfer tool to click on a source area at the place where you want to copy to begin. You then click 
on a destination area (the world map) at the place where you want the copy to begin. Each time you 
click, you transfer another portion of the source defined by the paintbrush, the contents of which are 
relative to where you click. 

This tool is similar to the Rubber Stamp tool, but rather than copying the same paintbrush-sized area 
each time you click, Transfer copies a new portion of the source sprite. Set the transparency level of 
this effect by using the Opacity control. 

   
 
 

Mesa 

This paintbrush effect allows you to warp the pixels within the brush area, giving the appearance of 
wrapping them around a truncated cone. 

The first example was created with the In option of Warp Direction selected. It shows the original 
sprite at left. The Mesa paintbrush effect was first applied with a soft-edged brush (center example) 
and then with a hard-edged brush (right example). 

   
 

The second example was created with the Out option of Warp Direction selected. It shows the 
original sprite at left. The Mesa paintbrush effect was first applied with a soft-edged brush (center 
example) and with a hard-edged brush (right example). 

   
 
 

Vortex 

This paintbrush effect allows you to warp the pixels within the brush area, making them appear as 
though they are twisted toward the center of the brush area. Note that this paintbrush effect is similar 
to the Vortex effect on the Effects tool palette. 

   
 
 

Spoke Inversion 

This paintbrush effect inverts every spoke of an imaginary disk that fits within the diameter of the 
paintbrush. Note that this paintbrush effect is similar to the Spoke Inversion effect on the Effects tool 
palette. 

   
 
 

Use Brush 

Click use Use Brush to work with a brush chosen from the Paintbrush Selection Grid or a custom 
brush you created. In this example, the current color is red. This color is "brushed" over the green 
oval work area. 

  
 
 

Use Template 

Click Use Template to work with a brush based on a sprite rather than using a brush from the brush 
selection grid. In this example, the first sprite, a rose, is used as a brush template. The template was 
"clicked" onto the work area (the green oval) for a silhouette effect. You can also drag the template 



brush for a different brush-stroke effect. 

   
 
 

Set Template 

You can use a sprite as a paintbrush by making the sprite a template. You first select a sprite then 
click Set Template. The sprite you select as a template must not be larger than 100 x 100 pixels. To 
use the template, click Use Template. 

 

 

Over 

This option determines how paint strokes are applied to a sprite. When Over is not selected, paint 
can be applied only to the non-transparent pixels of the current sprite. When Over is selected, paint 
can be applied to both the transparent and the non-transparent pixels of the current sprite within the 
bounding box. 

The example below displays the original sprite (left), paint strokes applied to the sprite while Over is 
not selected (center), and paint strokes applied to the sprite while Over is selected. 

   
 
 

Continuous Strokes 

The Continuous Strokes option determines whether the paint stroke is rendered with a solid, even 
flow of paint or with a slow buildup of paint. 

The example below displays the original sprite (top). When Continuous Strokes is selected, the 
paint flow is even and smooth as the sprite is used as a brush template (middle). When Continuous 
Strokes is not selected, the paint flow appears intermittent (bottom) and will build up only when the 
brush is not moved. 

 

 

New Brush 

Displays the Brush Designer dialog box. 

 

Paint Effects grid 

At the left on the Paint tool palette, the Paint Effects grid contains 15 different paint tools. 

 

Paintbrush Selection grid 

Displays the array of brushes available on the Paint tool palette. When you create new brushes, they 
are added to the Paintbrush Selection grid. You can also delete brushes from this grid by clicking 
Delete Brush, below the selection grid. 

 

Brush utilities 



Consists of the New Brush, Delete Brush, and Reset To Defaults buttons. 

 

Brush size tools 

Consists of the Brush size slider and Brush size box. Move the slider to specify the size of the brush 
you want. As you move the slider, the value in the Brush size box changes. You can also select the 
current Brush size value and type the new value you want, or click the arrows to select a new value. 

 

Paint opacity tools 

Consists of the Opacity slider and Opacity box. Move the slider to the right to make the paint effect 
more opaque, and to the left to make the effect more transparent. As you move the slider, the value in 
the Opacity box changes. You can also select the current opacity value and type the new value you 
want, or click the arrows to select a new value. 

 

Brush size display 

Displays the size of the current brush. When you choose a brush size larger than 50, the display 
shows that the brush size is scaled by the factor indicated, such as 1:2, indicating that the image in 
the display is one-half its actual size. 

 

Lock Tool 

When selected, Lock Tool maintains the current tool selection after you perform an operation from 
the Paint or any other palette. 

 

Using the Dodge-Burn tool 
 

Dodge-Burn creates effects similar to those used by photographers when printing or enlarging 
pictures. Tools for creating these effects are located on the Paint palette. 

A dodge effect is the result of placing an object between the light source and the photographic paper 
so that a specific portion of the picture gets less light than the rest of the picture resulting in a lighter 
area. 

Typically, a photographer uses a small dodge object and moves it around as light from the enlarger 
falls on the paper. You can use Dodge to recreate that effect by using a paintbrush as the dodge 
object and dragging it over a portion of a sprite to lighten that portion. 

A burn effect is just the opposite of a dodge effect, so that a portion of the photograph gets more light 
than the rest of the sprite and consequently appears darker. You can use Burn to recreate that effect 
by using a paintbrush as the burn object and dragging it over a portion of a sprite to darken that 
portion. 

 

Lightening a portion of a sprite 
 

Photographers lighten or “dodge” a portion of a photograph when printing by directing more light from 
the light source onto the print paper. The Dodge-Burn tool in Microsoft Image Composer 
accomplishes the same purpose. 



 To lighten a portion of a sprite 

1 Click the sprite you want to modify. 

2 On the toolbox, click Paint . 

3 On the Paint palette, click Dodge-Burn . 

The Dodge-Burn slider  appears. 

4 On the Paintbrush Selection grid, click a brush. 

5 To lighten the sprite, move the Dodge-Burn slider to the right or enter a larger value in the 
Dodge-Burn box. If you enter a value in the box, it must be between -100 and 100. Entering a 
value of 0 has no effect on the lightness of a sprite. 

6 Drag the brush over the area of the sprite you want to lighten. 

To increase the burn effect, move the slider farther to the right, or enter a higher number in the box 
and drag the brush over the sprite again. Each time you want to lighten an area by a greater 
degree, you must increase the value and drag the brush. 

 
 

Darkening a portion of a sprite 
 

Photographers darken or “burn” a portion of a photograph when printing by placing an object between 
the light source and the print paper. The Dodge-Burn tool in Microsoft Image Composer 
accomplishes the same purpose. 

 To darken a portion of a sprite 

1 Click the sprite you want to modify. 

2 On the toolbox, click Paint . 

3 On the Paint palette, click Dodge-Burn . 

The Dodge-Burn slider  appears. 

4 In the Paintbrush Selection grid, click a brush. 

5 To darken the sprite, move the Dodge-Burn slider  to the left or enter a smaller value in the 
Dodge-Burn box. If you enter a number in the box, it must be between -100 and 100. Lower 
negative numbers make the area darker. Entering a value of 0 has no effect on darkening the 
sprite. 

6 Drag the brush over the area of the sprite you want to darken. 

To increase the dodge effect, move the slider farther to the left, or enter a lower number in the box 
and drag the brush over the sprite again. Each time you want to darken an area by a greater 
degree, you must decrease the value and drag the brush. 

 
 

Adjusting the contrast of a sprite 
 

 To adjust the contrast for a portion of a sprite 

1 Click the sprite you want to modify. 

2 On the toolbox, click Paint . 

3 On the Paint palette, click Contrast .  

The Contrast slider appears. 

4 In the Paintbrush Selection grid, click a brush. 

5 To lessen contrast, move the Step Contrast slider  to the left or enter a smaller value in the Step 
Contrast box. To increase contrast, move the slider to the right or enter a larger value in the Step 
Contrast box. If you enter a number in the box, it must be between -100 and 100. 

6 Drag the brush over the area of the sprite you want to adjust. 

Each time you want to change the contrast in  an area, you must change the value and drag the 
brush. 

 



 To adjust the contrast for the entire sprite 

1 Click the sprite you want to modify. 

2 On the toolbox, click Color Tuning , and then click the Color Controls tab. 

3 To increase contrast, move the Contrast slider to the right or enter a larger value in the Contrast 
box. To decrease contrast, move the slider to the left or enter a smaller value. Acceptable values 
range from -100 to 100. 

4 Click Apply. 
 

You can experiment with levels of contrast by applying a value, choosing a new level of contrast and 
applying that value. Each new value is applied to the original sprite, not to the version of the sprite to 
which the previous level was applied. You can experiment in this manner until you select a different 
sprite. 

 

Adjusting the brightness of a sprite 
 

1 Click the sprite you want to modify. 

2 On the toolbox, click Color Tuning , and then click the Color Controls tab. 

3 To make the sprite brighter, move the Brightness slider to the right or enter a larger number in the 
Brightness box. To make the sprite darker, move the Brightness slider to the left or enter a 
smaller number in the box. Acceptable values range from -100 to 100. 

4 Click Apply. 
 

You can experiment with levels of brightness by applying a value, choosing a new level of brightness 
and applying that value. Each new value is applied to the original sprite, not to the version of the 
sprite to which the previous level was applied. You can experiment in this manner until you select a 
different sprite. 
 
 

Shapes overview 
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Shapes palette 

 

With the Shapes tools, you can create rectangular and oval sprites. In addition, you can use the 
Curve and Polygon tools to create sprites that are freeform shapes. 

 Rectangle creates a rectangular sprite in the current color on the 
workspace. You can use Rectangle to create rectangles and 
squares that are opaque or transparent, and that have hard or soft 
edges. 

 Oval creates a round sprite in the current color on the workspace. 
You can use Oval to create ovals and circles that are opaque or 
transparent, and that have hard or soft edges. 

 Curve creates freeform shapes with curved lines in the current color 
on the workspace. You can use Curve to create open or closed 
sprites with a line width you specify, or closed sprites that are 
completely filled with the current color. The shapes can be opaque 
or transparent, and can have hard or soft edges. 

 Polygon creates freeform shapes with straight lines in the current 
color on the workspace. You can use Polygon to create open or 



closed sprites with a line width you specify, or closed sprites that are 
completely filled with the current color. The shapes can be opaque 
or transparent, and can have hard or soft edges. 

 
 

Creating rectangles and squares 
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Create a rectangle or square when you want to add a rectangular shape in the current color to your 
composition. When you create the shape, you can specify its color, opacity, and edge softness. 

  

Square Rectangle 

 

 To create a rectangle or square 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, click Rectangle . 

3 Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider all 
the way to the right. 

4 Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the left; 
to blend the edge of the shape with its background, move the slider toward the right. 

5 Place the pointer on the workspace, and then drag until the bounding box is the desired size. To 
create a square, hold down SHIFT while dragging. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its fill color or pattern by applying the effects in 
the Effects palette. You can also fill it with the current color by clicking the Color Fill button  on the 
toolbar. In addition, you can change the size of the sprite by dragging its resize handles, or rotate it by 
dragging its rotation handle in the upper-right corner of the bounding box. 

 

Creating ovals and circles 
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Create an oval or circle when you want to add a round shape in the current color to your composition. 
When you create the shape, you can specify its color, opacity, and edge softness. 

  

Circle Oval 

 

 To create an oval or circle 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, click Oval . 

3 Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider all 
the way to the right. 

4 Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the left; 



to blend the edge of the shape with its background, move the slider toward the right. 

5 Place the pointer on the workspace, and then drag until the bounding box is the desired size. To 
create a circle, hold down SHIFT while dragging. The shape you create will fit exactly inside the 
bounding box. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its fill color or pattern by applying the effects in 
the Effects palette. You can also fill it with the current color by clicking the Color Fill button  on the 
toolbar. In addition, you can change the size of the sprite by dragging its resize handles, or rotate it by 
dragging its rotation handle in the upper-right corner of the bounding box. 

 

Creating freeform shapes 
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You can create two types of freeform shapes in Microsoft Image Composer: curves and polygons. 

• Curves are either lines or closed shapes that have curved edges. You create curves by using the 
Curve tool. Click the pictures below to learn how to create each type of curve: 

   

Open-ended Curve Closed Curve Filled Curve 
 

• Polygons are either lines or closed shapes that have straight edges. You create polygons by using 
the Polygon tool. Click the pictures below to learn how to create each type of polygon: 

   

Open-ended Polygon Closed Polygon Filled Polygon 

 

Creating open-ended curves 
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Create an open-ended curve when you want to add a curved line in the current color to your 
composition. When you create the sprite, you can specify its color, opacity, edge softness, and line 
thickness.  

To create a similar sprite with straight lines, use the Polygon tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting Sprite 

 

 To create an open-ended curve 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, clear the Close check box. 

3 Click Curve . 



4 Adjust the following settings: 

• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

• Adjust the Line Width slider to the desired line thickness, which is measured in pixels. 

5 Click on the workspace to create the first point of the curve, and then continue to click on the 
workspace where you want to add each new point to the curve. The curve is automatically drawn 
between each pair of points. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 
resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 

 

Creating closed curves 
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Create a closed curve when you want to add a hollow shape in the current color with curved edges to 
your composition. When you create the shape, you can specify its color, opacity edge softness, and 
line thickness. 

To create a similar shape with straight lines, use the Polygon tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting sprite 

 

 To create a closed curve 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, select the Close check box, and make sure the Fill check box is cleared. 

3 Click Curve . 

4 Adjust the following settings: 

• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

• Adjust the Line Width slider to the desired line thickness, which is measured in pixels. 

5 Click on the workspace to create the first point of the curve, and then continue to click on the 
workspace where you want to add each new point to the curve. The curved shape is automatically 
drawn as you specify each point. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 



resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 

 

Creating filled curves 
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Create a filled curve when you want to add a solid shape in the current color with curved edges to 
your composition. When you create the shape, you can specify its color, opacity, and edge softness. 

To create a similar shape with straight edges, use the Polygon tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting Sprite 

 

 To create a filled curve 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, select the Close check box. 

3 Select the Fill check box to fill the shape with the current color. To change the color, click the 
Color Swatch. 

4 Click Curve . 

5 Adjust the following settings: 

• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

6 Click on the workspace to create the first point of the curve, and then continue to click on the 
workspace where you want to add each new point to the curve. The curved shape is automatically 
drawn as you specify each point. 

7 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 
resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 

 

Creating open-ended polygons 
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Create an open-ended polygon when you want to add a straight line in the current color to your 
composition. When you create the sprite, you can specify its color, opacity, edge softness, and line 
thickness.  



To create a similar sprite with curved lines, use the Curve tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting Sprite 

 

 To create an open-ended polygon 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, clear the Close check box. 

3 Click Polygon . 

4 Adjust the following settings: 

• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

• Adjust the Line Width slider to the desired line thickness, which is measured in pixels. 

5 Click on the workspace to create the first point of the polygon, and then continue to click on the 
workspace where you want to add each new point to the polygon. The line is automatically drawn 
between each pair of points. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 
resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 

 

Creating closed polygons 

{button 
,AL("polygon 
how;shapes how")} 
Related Topics 

{button 
,AL("shapes 
ovr")} 
Overview 

 

 

Create a closed polygon when you want to add a hollow shape in the current color with straight edges 
to your composition. When you create the sprite, you can specify its color, opacity, edge softness, 
and line thickness.  

To create a similar shape with curved lines, use the Curve tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting Sprite 

 

 To create a closed polygon 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, select the Close check box and make sure the Fill check box is cleared. 

3 Click Polygon . 

4 Adjust the following settings: 



• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

• Adjust the Line Width slider to the desired line thickness, which is measured in pixels. 

5 Click on the workspace to create the first point of the polygon, and then continue to click on the 
workspace where you want to add each new point to the polygon. The shape is automatically 
drawn as you specify each point. 

6 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 
resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 

 

Creating filled polygons 
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Create a filled polygon when you want to add a straight-edged shape in the current color to your 
composition. When you create the sprite, you can specify its color, opacity, and edge softness. 

To create a similar shape with curved edges, use the Curve tool instead. 

  

Step 1 Step 2 

  

Step 3 Resulting Sprite 

 

 To create a filled polygon 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, select the Close check box. 

3 Select the Fill check box to fill the shape with the current color. To change the color, click the 
Color Swatch. 

4 Click Polygon . 

5 Adjust the following settings: 

• Set the Opacity  slider to the desired position. For a completely opaque sprite, move the slider 
all the way to the right. 

• Set the Edge slider to the desired position. For a crisp line, move the slider all the way to the 
left; to blend the edge of the shape with its background, move the slider toward the right. 

6 Click on the workspace to create the first point of the polygon, and then continue to click on the 
workspace where you want to add each new point to the polygon. The shape is automatically 
drawn as you specify each point. 

7 Click Create. 
 

Once the sprite is on your workspace, you can change its color by applying the Dye effect or using 
the Color Fill button  on the toolbar. In addition, you can change the size of the sprite by dragging its 
resize handles, or rotate it by dragging its rotation handle in the upper-right corner of the bounding 
box. To duplicate the sprite and edit its points, see Recalling curves and polygons. 



 

Recalling curves and polygons 
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You can recall the last curve or polygon that you added to your composition, even if you have since 
deleted that shape from the workspace. When you recall a curve or polygon, an exact copy of it 
appears with the same points that you specified for the original shape. You can move, add, or delete 
the points on a recalled shape, and then create it without affecting the original sprite that it was copied 
from. 

 To recall a curve or polygon 

1 On the toolbox, click Shapes . 

2 On the Shapes palette, click Recall Copy. 

A copy of the last curve or polygon appears in the workspace. 

3 Edit the shape as follows: 

• Click Move Points  to move one of the existing points in the shape. Then position the pointer 
over the point you want to move and drag it to a new location. 

• Click Add Points  to add a new point to the shape. Then click on the workspace where you 
want to add the new point. 

• Click Delete Points  to delete a point from the shape. Then click the point you want to delete. 

Note   Deleting a point also deletes the line segment(s) attached to it. If you delete a point that 
connects to two other points, those two points will be connected to each other with a new line 
segment. 

4 Click Create. 
 

Note   You cannot recall a rectangle or oval after you have created it. 
 
 

Rectangle  
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Square Rectangle 

 

Rectangle creates rectangular sprites. If used with SHIFT, Rectangle creates perfectly square sprites. 

Where to find this item 

Rectangle is available on the Shapes palette. 

How to apply this item 

Click a picture to learn how to create the shape. 

How to vary the results 

Before you draw the bounding box of a rectangle, you can: 



• Make the sprite more opaque by moving the Opacity  slider to the right or by typing a larger 
number in the Opacity box. The number must be between 0 and 100. To allow more of the 
background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch on the toolbox and choosing a different 
color. 

 

After you draw the bounding box of a rectangle but before you click Create, you can adjust the size 
and shape of the bounding box. 

 

Oval  
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Circle Oval 

 

Oval creates oval sprites. If used with SHIFT, Oval creates perfectly round sprites. 

Where to find this item 

Oval is available on the Shapes palette. 

How to apply this item 

Click a picture to learn how to create the shape. 

How to vary the results 

Before you draw the bounding box of an oval, you can: 

• Make the sprite more opaque by moving the Opacity  slider to the right or by typing a larger 
number in the Opacity box. The number must be between 0 and 100. To allow more of the 
background to show through, move the slider to the left or enter a smaller value. 

• Create a crisp edge by moving the Edge slider to the left. To create a softer edge that blends with 
the background, move the slider to the right. 

• Change the current color by clicking the Color Swatch on the toolbox and choosing a different 
color. 

 

After you draw the bounding box of an oval but before you click Create, you can adjust the size and 
shape of the bounding box. 

 

Curve  
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Open-ended Curve Closed Curve Filled Curve 

 

Curve creates sprites with curved edges that are connected by points that you specify. You can edit 
these points to adjust the overall shape of the sprite. The type of curve you create depends on the 
settings you choose in the Shapes palette. 

Where to find this item 

Curve is available on the Shapes palette. 

How to apply this item 

Click a picture to learn how to create the shape. 

How to vary the results 

Before you specify the points in a curve on the workspace, you can: 

• Increase or decrease the outline thickness of open-ended curves by adjusting the Line Width 
slider. 

• Generate an exact, editable, copy of the last curve you created by clicking Recall Copy after you 
create the curve. 

 

After you draw the bounding box of a curve but before you click Create, you can adjust the size and 
shape of the bounding box by using Move Points , Add Points , and Delete Points . 

 

Polygon  
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Open-ended 
Polygon 

Closed Polygon Filled Polygon 

 

Polygon creates sprites with straight edges that are connected by points that you specify. You can 
edit these points to adjust the overall shape of the sprite. The type of polygon you create depends on 
the settings you choose in the Shapes palette. 

Where to find this item 

Polygon is available on the Shapes palette. 

How to apply this item 

Click a picture to learn how to create the shape. 

How to vary the results 

Before you specify the points in a polygon on the workspace, you can: 

• Increase or decrease the outline thickness of open-ended polygons by adjusting the Line Width 
slider. 

• Generate an exact, editable, copy of the last polygon you created by clicking Recall Copy after 
you create the polygon. 

 



After you draw the bounding box of a polygon but before you click Create, you can adjust the size 
and shape of the bounding box by using Move Points , Add Points , and Delete Points . 

 

Text sprite overview 
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If a picture is worth a thousand words, imagine the value of a picture composed of words! The text 
tool in Image Composer is not a word processor, but rather a tool to create exciting text images in any 
font installed on your computer. 

Text sprites are like any other sprites with respect to applying effects, resizing, and other tasks. Text 
sprites have special formatting attributes that you can modify after you create a text sprite, including 
the content of the text, font, and more. The following figure shows a text sprite and an edited, 
modified version of that sprite. 

 

Creating text sprites with different formatting 

When you create a text sprite, the formatting you specify is applied to the entire text sprite. If you want 
one word or group of characters to have a different font or color from the rest of the text sprite, you 
must create another text sprite containing those characters with the different formatting. 

Controlling text smoothing 

By default, text sprites are created with smoothing enabled. Smoothing is the result of anti-aliasing 
which means that the edges of the letters are rendered with varying degrees of transparency to 
eliminate jagged edges. Smoothing lends an even, non-jagged, appearance to text that is generally 
desirable, but can lead to fuzzy-looking characters for small text sprites. To produce sharp edges, 
clear the Smoothing check box on the Text palette. In the following figure, the text sprite on the left 
has smoothing turned on; the sprite on the right has smoothing turned off. 

 

Determining the length of text sprites 

When you create a text sprite, the default size of the text edit box limits the number of characters you 
can enter. To increase the size of the edit box and thus, the number of characters you can enter, drag 
one of the sides to an appropriate size, then increase it again if you need to. If the edit box is larger 
than necessary to accommodate the text, the bounding box of the sprite is adjusted to an exact fit 
when you render the sprite. 

Editing text sprites 

You can apply any effect or tool to a text sprite. However, when you edit a text sprite, you lose any 
effects you have applied previously to that sprite. Be sure that the text and its formatting are what you 
want before you apply any effects to that sprite. However, if you make edits that are not what you 
want, you can undo the edits to return the text sprite to its pre-edited state. In addition, it is a good 
idea to keep track of the effects you applied to a text sprite so that you can duplicate your work. 

 



Creating text sprites 
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Text sprites are like other sprites with respect to applying effects, but have the following formatting 
properties that you specify in the Text palette: 

• Font. Image Composer supports any scaleable fonts that you have installed on your computer, 
including the sample fonts installed with this product. 

• Style. Select a style from Regular, Bold, Bold Italic, and Italic. 

• Size. Select a size from 1 to 1638 points.  

• Alignment. Click an alignment button to Align Left , Align Center , or Align Right . 

• Opacity. Move the Opacity slider to the setting you want for the text sprite. Or type a value 
between 0 and 100 in the Opacity box. Smaller values make the text more transparent; larger 
values make the text more opaque. 

• Underlining. Select the Underline check box to underline the text. 

• Smoothing. Select the Smoothing check box to enable anti-aliasing. 

When smoothing is enabled, jagged edges are blended with varying levels of transparency to 
create a smooth effect. For very small fonts, smoothing can lead to text that might appear fuzzy. 
To create sharp-edged text sprites, clear the Smoothing check box. 

• Color. Click the color chip to display the Color Picker, from which you choose a text color. 

Note  When you create a text sprite, the formatting you specify is applied to the entire text sprite. If 
you want one word or group of characters to have different formatting from the rest of the text sprite, 
you must create another text sprite containing those characters with the different formatting. 

 To create a text sprite 
 

1 On the toolbox, click Text . 

Image Composer displays the text cursor and the Text palette. 

2 On the Text palette, choose the sprite's properties. 

3 Click within the workspace at the place you want the sprite to appear. 

Image Composer displays the text entry box at the location of the text cursor. The text sprite is 
rendered at this location. 

You can enlarge the entry box by dragging the resize handles. When you increase the height of the 
text entry box beyond the next line of text, the text you enter wraps to a new line if space permits, 
or you can press ENTER to start a new line. 

4 Enter the text you want the sprite to contain. 

Make any changes to text properties before you render the text sprite. 

TIP  The text edit box has a white background. For white or very light text, the characters might be 
hard to see. If you have trouble seeing the characters, select the text. It will stand out against the 
dark background of the selection. Be careful to deselect the selected text before you add or delete 
any characters or the entire selected text will be deleted. 

5 Click outside the text entry box in the workspace to render the text sprite.  
 

After you have created text sprites, you can edit their content to change the text, font, color, or any 
other attribute. However, when you edit a text sprite, you lose any effects you have applied to it. For 
more information, see Editing Text Sprites. 

In addition to creating text sprites, you can also insert text created with WordArt. You can use 
WordArt to perform actions such as changing spacing between characters, creating vertical text, and 



more. For more information, see Inserting WordArt. 
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You can create justified text, such as justified lists, in the following ways: 

• Increasing the size of the text sprite edit box and creating the list as a single text sprite. 

• Creating separate sprites for each item in the list and then aligning the sprites. 
 

 To create justified text with a single sprite 

1 On the toolbox, click Text . 

2 Click the Align Left , Align Center , or Align Right  button, depending on whether you want the 
text justified left, centered, or justified right. 

3 Drag the top or bottom resize handle of the text sprite edit box to increase the height of the edit 
box. 

4 Type the first item in the list and press ENTER to begin a new line.  

Repeat for each item in the list.  

5 Increase or decrease the height of the text sprite entry box to accommodate the list. 

6 Click outside of the text entry box in the workspace to render the sprite.  
 

 To create justified text with separate sprites 

1 Create one text sprite for each item in the list.  

2 Arrange the text sprites in the top-to-bottom spacing you want for the list. 

3 Press and hold the SHIFT key and select all the text sprites; this creates a temporary selection set. 

4 On the toolbox, click Arrange . 

5 In the Align grid, click Left Sides  for a left-justified list, Right Sides  for a right-justified list, or 
Centers Vertically  for a center-justified list. 

 
 

Editing text sprites 
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You can edit an existing text sprite to change the content of the text, font, size, color, opacity, or any 
other text sprite attribute. However, when you edit a text sprite, you lose any effects that you have 
previously applied to that sprite. Be sure that the text sprite is the way you want it before applying 
effects. However, if you make edits that you are not satisfied with, you can undo the edits to return the 
text sprite to its pre-edited state. 

When you edit a text sprite, it moves to the top of the stack no matter what its actual position is in the 



stack. When you have finished editing the text, the text sprite returns to its actual position in the stack. 

 To edit a text sprite 

1 Double-click the text sprite you want to edit.  

The text sprite edit box and the Text palette are displayed. 

2 In the text sprite edit box, add or delete text. 

3 On the Text palette, change the text sprite formatting. 

4 Click outside the text sprite edit box in the workspace to render the edited text sprite. 
 

 To undo an edit to a text sprite 

• On the Edit menu, click Undo Text Edit. 
 
 

Glue 
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Glue replaces the pixels of a destination sprite with the opaque pixels of a source sprite where the 
two sprites overlap. Glue changes both the opaque and the transparent pixels of the destination 
sprite, as if the source sprite were glued on top of it. 

  

Destination sprite Source sprite 

  

Position sprites and 
apply transfer 

Result 

 

Where to find this effect 

Glue is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

Tips 

• Instead of using Glue, you can permanently combine two or more sprites into a single sprite by 
grouping them and then clicking Flatten Selection on the Arrange menu. 

• To replace only the opaque pixels of the destination sprite, use Transfer Shape instead of Glue. 
 
 

Map Color 

(Called Color Map in Microsoft Image Composer 1.0) 
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Map Color copies the color values of a source sprite to the opaque pixels of a destination sprite. The 
intensity values of the destination sprite are unchanged. 

Where to find this effect 

Map Color is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

How to vary the results 

To brighten or darken the result of the texture transfer, type an intensity value between 0 and 255 in 
the Threshold box. The default value is 255. The intensity value is compared with the portion of the 
destination sprite that overlaps the source sprite: 

• If the intensity value of the source sprite is higher than the Threshold value, the intensity of the 
transferred pixels increases and the colors of those pixels appear brighter. For example, if your 
source sprite is bright and you set a low Threshold value, the portion of the destination sprite that 
is altered by the transfer appears brighter than the source sprite. 

• If the intensity value of the source sprite is lower than the Threshold value, the intensity of the 
transferred pixels decreases and the colors of those pixels appear darker. For example, if your 
source sprite is bright and you set a high Threshold value, the portion of the destination sprite that 
is altered by the transfer appears as dark as, or darker than, the source sprite. 

 
 

Map Intensity 

(Called Intensity Map in Microsoft Image Composer 1.0) 
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Map Intensity copies the intensity values of a source sprite to the destination sprite. The original 
colors of the destination sprite remain unchanged. 

For example, if a source sprite is a gradient of dark to light gray and the destination sprite is a 
rainbow, the rainbow colors are blended from dark to light, picking up the intensity of the gray on the 
source sprite. If the destination sprite is a solid red square, the result is a blend of dark to light reds. 

Where to find this effect 

Map Intensity is available on the Texture Transfer palette. 



How to apply this effect 

Click the Result picture to learn how to apply this effect. 

How to vary the results 

To brighten or darken the result of the texture transfer, type an intensity value between 0 and 255 in 
the Threshold box. The default value is 255. The intensity value is compared with the portion of the 
destination sprite that overlaps the source sprite: 

• If the intensity value of the source sprite is higher than the Threshold value, the intensity of the 
transferred pixels increases and the colors of those pixels appear brighter. For example, if your 
source sprite is bright and you set a low Threshold value, the portion of the destination sprite that 
is altered by the transfer appears brighter than the source sprite. 

• If the intensity value of the source sprite is lower than the Threshold value, the intensity of the 
transferred pixels decreases and the colors of those pixels appear darker. For example, if your 
source sprite is bright and you set a high Threshold value, the portion of the destination sprite that 
is altered by the transfer appears as dark as, or darker than, the source sprite. 

 
 

Map Saturation 

(Called Saturation Map in Microsoft Image Composer 1.0) 
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Map Saturation changes the saturation of the destination sprite based on the intensity of the source 
sprite. 

White source pixels produce full saturation, while darker pixels reduce the saturation toward gray. 
Thus, if the source sprite is a grayscale gradient, the destination sprite retains its original saturation at 
the white end and gradually desaturates toward the black end of the source sprite. 

Where to find this effect 

Map Saturation is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

 

Map Transparency 

(Called Transparency Map in Microsoft Image Composer 1.0) 
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Overview 
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Map Transparency changes the transparency of the destination sprite based on the intensity of the 
source sprite. 

For example, if the source sprite is a grayscale gradient, the destination sprite is transparent where 
the source is black and grows increasingly opaque toward the white end of the source sprite. 

Where to find this effect 

Map Transparency is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

 

Snip 
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Snip deletes the opaque pixels of the destination sprite where they touch the opaque pixels of the 
source sprite. 

Where to find this effect 

Snip is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

Tip   You can manually delete a sprite's opaque pixels by using Erase on the Paint palette. 
 
 

Tile 
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Overview 
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Tile applies repeated copies of a source sprite to the opaque pixels of a destination sprite. 

Where to find this effect 

Tile is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

How to vary the results 

Adjust the spacing of the tiled copies of the source sprite on the destination sprite by changing the 
Horizontal tile spacing and Vertical tile spacing values. In Horizontal tile spacing, type the 
number of pixels to leave between a tile and the next tile to its right. In Vertical tile spacing, type the 
number of pixels to leave between a tile and the next tile below it. 

The default value for Horizontal tile spacing and Vertical tile spacing is 100. If you change both 
values to 0, the edges of the tiled sprites will touch. A positive value adds space between tiles; a 
negative value causes tiles to overlap. The maximum positive value is 100, and minimum negative 
value is -100. 

Tip   The source and destination sprites do not need to overlap. However, the starting point of the 
tile pattern is based on the position of the source sprite. For the greatest accuracy, position the 
source sprite where you want the first tile in the pattern to appear on the destination sprite. 
 
 

Transfer Full 
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Transfer Full replaces a destination sprite's opaque pixels with the pixels of a source sprite where 
the two sprites overlap. Both the opaque and the transparent pixels of the source sprite are copied 
onto the destination sprite. The transparent pixels of the destination sprite are not changed. 

Where to find this effect 

This tool is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

Tip   Compare this texture transfer with Transfer Shape and Glue. 



 
 

Transfer Shape 
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Transfer Shape replaces a destination sprite's opaque pixels with those of an intersecting source 
sprite where the two sprites overlap. The transparent pixels of the destination sprite are not changed. 

Where to find this effect 

This tool is available on the Texture Transfer palette. 

How to apply this effect 

Click the Result picture to learn how to apply this effect. 

Tips 

• You can soften the edges of the destination sprite by applying the Blur effect before you use 
Transfer Shape. The softness of the edges depends on the amount of blur effect that you apply. 

• To replace the transparent pixels as well as the opaque pixels of the destination sprite, use Glue 
instead of Transfer Shape. 

 
 

Texture Transfer overview 

(Called Sprite to Sprite in Microsoft Image Composer 1.0) 
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With texture transfers, you can  use a source sprite to change the shape or appearance of one or 
more destination sprites. You can transfer the following properties of a source sprite: 

• Color 

• Intensity 

• Saturation 

• Shape 

• Transparency 
 

You can vary the opacity of the result by adjusting the Opacity  slider before you click Apply. 

   Click the texture transfer you want to read about: 

   

Glue Map Color Map Intensity 



   

Map Saturation Map Transparency Snip 

   

Tile Transfer Full Transfer Shape 

 

Notes 

• Only one sprite at a time can be a source sprite. 

• You can transfer properties from one source sprite to multiple destination sprites at once, as long 
as the destination sprites are in a selection set and not in a group. 

• Except for Tile, a texture transfer requires that the source sprite and the destination sprites 
overlap. 

• The order of the source and destination sprites in the stack does not affect the results. 

• If the source sprite is directly underneath and totally obscured by the destination sprite, you must 
first extend the bounding box of the source sprite beyond the perimeter of the destination sprite. 
Then you can select the source sprite. For information on extending a bounding box, see Cropping 
a Sprite. 

 
 

Applying a texture transfer 
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Apply a texture transfer when you want to copy a property of one sprite to one or more destination 
sprites. These properties include: 

• Color 

• Intensity 

• Saturation 

• Shape 

• Transparency 
 

For example, you can blend the appearances of two dissimilar sprites by copying the color, 
saturation, and transparency of one sprite to the other sprite. You can also superimpose a sprite on 
another sprite and copy the pixels of the superimposed sprite onto the opaque and/or transparent 
pixels of the other sprite. 

Applying a texture transfer alters the pixels of each destination sprite, but it does not affect the source 
sprite. 

 To apply a texture transfer 

1 Select a source sprite and overlap it with one or more destination sprites so that it intersects them 
in the area you want to modify. The source sprite does not need to be on top of the destination 
sprite as long as the two sprites overlap. 

Tip   You can identify the source sprite by the solid black squares around its bounding box; each 
destination sprite has hollow squares around its bounding box. If the source sprite is completely 
covered by the destination sprite, press the TAB key to select the source sprite. Then, hold down 
SHIFT and click the destination sprite to add it to the selection set. If both sprites are the same size 
and one sprite obscures the other, draw a bounding box around both sprites to select them. 

2 In the toolbox, click Texture Transfer . 

3 Click the transfer you want to apply. 



4 If you want to adjust the opacity, move the Opacity  slider to the right or type a larger number in 
the Opacity box to blend more of the source sprite with the destination sprite. Move the slider to 
the left or type a smaller number to allow more of the destination sprite to show through. 

5 Click Apply. 

6 Separate the two sprites to view the results. 
 
 
 

Copying a sprite onto another sprite 

{button ,AL("texture 
transfer how")} 
Related Topics 

{button 
,AL("texture 
transfer ovr")} 
Overview 

 

 

You can copy a sprite onto a portion of another sprite by overlapping the two sprites and applying a 
texture transfer. The pixels of the source sprite replace those pixels in the destination sprite that 
overlap the source sprite. The texture transfer that you apply depends on whether you want to: 

• Replace only the opaque pixels of the destination sprite. For an example, see Transfer Shape. 

• Replace the opaque and transparent pixels of the destination sprite. For an example, see Glue. 

• Replace the opaque and transparent pixels of the destination sprite, as well as the pixels in its 
bounding box that overlap the source sprite. For an example, see Transfer Full. 

 

Applying a texture transfer alters the pixels of each destination sprite only; it does not affect the 
source sprite. 

 To copy a sprite onto another sprite 

1 Select a source sprite and overlap it with one or more destination sprites. A texture transfer alters 
only the portion of the destination sprite that overlaps the source sprite. 

Tip   You can identify the source sprite by the solid black squares around its bounding box; each 
destination sprite has hollow squares around its bounding box. If the source sprite is completely 
covered by the destination sprite, press the TAB key to select the source sprite. Then, hold down 
SHIFT and click the destination sprite to add it to the selection set. If both sprites are the same size 
and one sprite obscures the other, draw a bounding box around both sprites to select them. 

2 In the toolbox, click Texture Transfer . 

3 Select a texture transfer to replace the pixels in the destination sprite: 

• To replace its opaque pixels only, click Transfer Shape. 

• To replace its opaque and transparent pixels, click Glue. 

• To replace both types of pixels as well as the pixels in its bounding box, click Transfer Full. 
 

4 To adjust the opacity of the pixels copied from the source sprite, use the Opacity  slider. Move the 
slider to the right or type a larger number in the Opacity box to blend more of the source sprite 
with the destination sprite. Move the slider to the left or type a smaller number to allow more of the 
destination sprite to show through. 

5 Click Apply. 

6 Separate the two sprites to view the results. 
  
 

Copying the color or intensity of a sprite to another sprite 
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When you copy one sprite onto another sprite, the hue, saturation, and intensity value of the source 



sprite are copied to the destination sprite. However, you can isolate the color (hue and saturation) 
from the intensity value when you apply a texture transfer by:  

• Copying only the color pixels of a source sprite to the overlapping pixels in the destination sprite. 
For an example, see Map Color. 

• Copying only the intensity value of a source sprite to the overlapping pixels in the destination 
sprite. For an example, see Map Intensity. 

 

To brighten or darken the result of these the Map Color or Map Intensity texture transfers, you can set 
a Threshold intensity value. This value is compared with the portion of the destination sprite that 
overlaps the source sprite: 

• If the intensity value of the source sprite is higher than the Threshold value, the intensity of the 
transferred pixels increases and the colors of those pixels appear brighter. For example, if your 
source sprite is bright and you set a low Threshold value, the portion of the destination sprite that 
is altered by the transfer appears brighter than the source sprite. 

• If the intensity value of the source sprite is lower than the Threshold value, the intensity of the 
transferred pixels decreases and the colors of those pixels appear darker. For example, if your 
source sprite is bright and you set a high Threshold value, the portion of the destination sprite that 
is altered by the transfer appears as dark as, or darker than, the source sprite. 

 

 To copy the color or intensity of a sprite to another sprite 

1 Select a source sprite and overlap it with one or more destination sprites. Only the portion of the 
destination sprite that overlaps the source sprite is altered by a texture transfer. 

Tip   You can identify the source sprite by the solid squares around its bounding box; each 
destination sprite has hollow squares around its bounding box. If the source sprite is completely 
covered by the destination sprite, press the TAB key to select the source sprite. Then, hold down 
SHIFT and click the destination sprite to add it to the selection set. If both sprites are the same size 
and one sprite obscures the other, draw a bounding box around both sprites to select them. 

2 In the toolbox, click Texture Transfer . 

3 To map the hue and saturation of the source sprite to the destination sprite, click Map Color. To 
map the intensity of the source sprite to the destination sprite, click Map Intensity. 

4 To adjust the intensity of the transferred pixels, type a number between 0 and 255 in the 
Threshold box. A low number brightens the result of the transfer; a high number darkens the 
result. 

5 Click Apply. 

6 Separate the two sprites to view the results. 
 
 

Erasing pixels in the shape of another sprite 
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You can erase the opaque pixels of a sprite where they overlap the opaque pixels of another sprite. 
The result looks like you used a stencil in the shape of the second sprite to erase the opaque pixels. 

You can use this technique as an alternative to creating a freeform cutout from a sprite when the 
shape you want to cut out already exists as a separate sprite. 

 To erase pixels in the shape of another sprite 

1 Select a source sprite and overlap it with one or more destination sprites. Only the portion of the 
destination sprite that overlaps the source sprite will be erased. 

Tip   You can identify the source sprite by the solid squares around its bounding box; each 
destination sprite has hollow squares around its bounding box. If the source sprite is completely 



covered by the destination sprite, press the TAB key to select the source sprite. Then, hold down 
SHIFT and click the destination sprite to add it to the selection set. 

2 In the toolbox, click Texture Transfer . 

3 Click Snip. 

4 To adjust the opacity of the pixels erased from the destination sprite, use the Opacity  slider. 
Move the slider to the right or type a larger number in the Opacity box to completely erase the 
pixels. Move the slider to the left or type a smaller number in the box to retain more of the 
destination sprite’s original pixels. If you type a number, it must be between 0 and 100. 

5 Click Apply. 

6 Separate the two sprites to view the results. 
  
 

GIF Animator overview 
 

With Microsoft GIF Animator, you can create animated GIF files that add eye-catching motion to your 
Web pages. Animated GIF files contain one or more images that display sequentially to produce an 
animated effect, much like a traditional cartoon flipbook. 

GIF Animator includes a toolbar, an animation (frames) display column, a scroll bar, and three tabs:  

• The Options tab, which controls the way GIF Animator manages your files. 

• The Animation tab, which controls characteristics of your animation. 

• The Image tab, which controls characteristics of individual frames in your animation. 
 

You can add an image to the animation display column by: 

• Dragging it in from the Image Composer workspace 

• Pasting it from the Clipboard into a frame 

• Opening an existing GIF file from within GIF Animator. 
 

You can add as many images to an animation as your computer memory allows. Before you add 
images to your animation, you should set the Import Color Palette options in the Options tab. You 
can use the scroll bar to view all the images in the current animation.  

Note   The display and other functionality of GIF Animator files depends on the capabilities of the 
browser used to view the files. Large files increase download times and might also display interrupted 
sequencing on computers with low memory. 
 
 

Toolbar 
 

The GIF Animator toolbar includes the following buttons. 

 

Button Name Description 
 

 New Creates a new file. 

 Open Opens an existing file. If you use this while a file 
is open, GIF Animator warns that current 
changes will be lost and prompts you to save 
your changes. 

 Save Saves changes to the active file. 

 Insert Inserts an additional .gif file into the current 
animation. The file is inserted before the current 
selected frame. 

 Save As Saves changes to a new file name. 

 Cut Removes the selected image and copies it to 



the Clipboard. 

 Copy Copies the selected image to the Clipboard. 

 Paste Places a cut or copied image from the Clipboard 
at the insertion point. 

 Delete Removes the selected image without copying to 
the Clipboard. 

 Select All Selects all images in the current animation. 

 Move 
Up/Down 

Positions the selected image one frame closer 
to the beginning or to the end of the current 
animation. 

 Preview Plays the results of your work without saving it. 

 Help Opens this Help file. 
 

To cancel the opening or saving of files, press ESC. 

 

Options tab 
 

Use the Options tab to specify the palette that GIF Animator uses to represent the images within the 
animation. You can also use this tab to control the how the colors are represented in your saved 
image. 

Thumbnails Reflect Image Position   Select this check box to see each image in the animation 
space that you specify in the Animation tab instead of as a full-frame image. 

Main Dialog Window Always on Top   Select this check box to enable the GIF Animator window to 
remain the frontmost window on your desktop. Note that selecting this option disables 
drag-and-drop operations to GIF Animator. 

Import Color Palette   Allows you to choose between the Browser palette, which provides a direct 
match to the most common Web browsers, and an “optimal” palette that you specify by clicking the 
dialog button to locate the Windows .pal file you want to use. 

 

Browser Palette
  

GIF Animator uses a single palette that best 
matches the whole animation. Most efficient. 

Optimal Palette GIF Animator creates a separate palette for each 
frame. High overhead; very good quality. 

 [Load] GIF Animator uses the palette you specify in the 
Open dialog.  

 

Import Dither Method   Allows you to choose a drawing method from the following list to best 
represent your color palette. 

 

Solid Chooses closest indexed color. Fast and good for 
line art and images with few colors. 

Pattern Calculates colors using a small pattern that is fast 
though coarse. Fast speeds for images with 
moderate number of colors. 

Random Calculates colors using a large pattern that 
produces finer results than Pattern dithering. 
Moderate speeds for images with moderate to 
large number of colors.  

Error Diffusion Calculates colors by finely mixing colors over a 
small area. Offers good results, but slower speed. 

 
 



Animation tab 
 

The Animation tab in GIF Animator lets you control the size, duration, and transparency attributes of 
an animation. 

Animation Width   Allows you to specify the width of the space in which the animation plays. GIF 
Animator supplies a default value that you can modify. Specify a wider space for frames that move 
horizontally. 

Animation Height   Allows you to specify the height of the space in which the animation plays. GIF 
Animator supplies a default value that you can modify. Specify a taller space for frames that move 
vertically. 

Image Count   Displays the number of frames in the current animation. More images with smaller 
movements provide smoother motion, but create larger files and longer download times. 

Looping   Select this check box if you want your animation to repeat. 

Repeat Count   Allows you to specify the number of times you want your animation to repeat. 

Trailing Comment   Allows you to attach a comment to the animation. 

 

Image tab 
 

The Image tab of GIF Animator lets you control the characteristics of individual images within the 
animation. 

Image Width   Displays the width of the selected image. 

Image Height   Displays the height of the selected image. 

Left   Allows you to specify the position of the left edge of the selected image within its frame. 

Top   Allows you to specify the position of the top edge of the selected image within its frame. 

Duration (1/100 s)   Allows you to specify the amount of time, in 1/100 of a second increments, that 
the selected image appears during the animation sequence. Varying duration throughout an 
animation can enhance the appearance of starts and stops and other effects. 

Undraw Method   Allows you to specify how frames appear in the animation. 
 

Undefined Directs the browser to do nothing to the 
background before displaying the next image. 

Leave Directs the browser to leave the previous graphic 
image as the next is drawn. This choice can 
create a shadowing effect. 

Restore Background Directs the browser to redraw the original 
background as the current image is drawn. 

Restore Previous Directs the browser to redraw the previous image 
as the current image is drawn. 

 

Transparency   Select this check box if you want to specify that one color in your animation will not 
display. 

Transparent Color   Select the color chip to display a palette from which you can choose a color 
that GIF Animator treats as the transparent portion of the image. You can choose only one 
transparent color. 

Comment   Allows you to attach a comment to the active frame. 

 

Brush Designer 
 



Diameter 

Specifies the diameter of the brush you are designing. Higher Diameter values create larger brushes. 
You can move the slider to create the brush diameter you want, or you can select the current value 
and type a number between 1 and 100. The default value is 2. 

Aspect 

Specifies the shape of the brush you are designing. The Aspect value determines the ratio of height 
to width of the brush. Lower Aspect values create oval to flat brush shapes, while higher values 
create rounder brush shapes. You can move the slider to create the brush shape you want, or you 
can select the current value and type a number between 1 and 100. The default value is 100. 

Rotation 

Specifies the angle of rotation of the brush you are designing. Rotation is not a factor in your brush 
design unless the Aspect value is less than 100. You can move the slider to create the brush shape 
you want, or you can select the current value and type a number between 0 and 360. The default 
value is 0. 

Softness 

Specifies the edge softness of the brush you are designing. Higher Softness values create softer 
brush edges. You can move the slider to determine the brush edge softness you want, or you can 
select the current value and type a number between 1 and 100. The default value is 99. 

 

 

Color format 

Specifies the color palettes that are available for each file format. The default for most file formats is 
True Color, a 24-bit (16.7 million) color palette. If you choose to save your work as a .bmp, .gif, or 
.png file, you can select from a number of color palettes, including your own custom 8-bit (256 or 
fewer color) palettes. 

 

Keep transparency 

Stores images with the Alpha, or transparent, channel included. The image is then an RGBA (Red, 
Green, Blue, Alpha) image. 

 

Transparent color/Alpha as color 

• The Transparent color check box allows you to designate a palette color as the transparent color 
of the composition or selection to be saved in .gif or .png files. If you select the Transparent color 
check box, you can assign a color for the transparent color by clicking the color chip. To determine 
which pixels are changed to the designated transparent color, move the Threshold slider. 

• The Alpha as color check box allows you to map the alpha channel transparency information of a 
composition or selection to a single color. If you clear the Alpha as color check box, your 
composition or selection blends with the background that is set as the color of the composition 
space. If you select the Alpha as color check box, you can assign the color by clicking the color 
chip. To determine which pixels are changed to the designated transparent color, move the 
Threshold slider. Some programs read this solid color and turn it into true transparency. 

 
 

color chip 



Allows you to choose a color for the alpha channel or transparent colors in a composition. Click the 
color chip to display the Color Picker dialog box, or right-click the color chip to display the shortcut 
color menu. 

 

Compression 

Allows you to reduce the size of the file by reducing the size of its contents. For JPEG files, you can 
adjust the amount of compression by adjusting the Amount slider. 

 

Write premultiplied alpha 

Designates that Alpha is premultiplied for you when the Keep transparency check box is also 
selected. The image is then saved as a premultiplied RGBA (Red, Green, Blue, Alpha) image. Not all 
programs can read premultiplied RGBA images. 

 

Threshold slider/box 

Determines the transparency levels that will be changed to the color in the color chip next to the 
Transparent color or Alpha as color check box. All pixels with a transparency value below the 
designated Threshold appear fully transparent (that is, mapped to the color in the color chip) when 
viewed in the designated file format. All pixels that have a transparency level higher than the one in 
the Threshold box appear fully opaque when viewed in the designated file format. The number in the 
Threshold box must be between 0 and 255. 

 

Amount slider/box 

Specifies the compression ratio applied to a composition when saved in the JPEG (*.jpg) file format. 
To achieve high image quality, set a low compression amount. High compression amounts reduce the 
file size but can cause some image quality deterioration. The number in the Amount box must be 
between 1 and 100. 

 

 

 

Cut Out 

Creates a new sprite from the selected rectangular, oval, or freeform area of a sprite. Cutting out does 
not affect the original sprite. 

 

Erase 

Removes the color from the pixels in the rectangular, oval, or freeform cutout you drew. 

 

Stencil 

Creates a reverse copy of the selected sprite by filling the transparent pixels inside the sprite’s 
bounding box with the current color, and by replacing the opaque pixels in the sprite with transparent 
pixels. 



 

Select Color Region 

Selects the pixel you click in a sprite, as well as the other pixels in the sprite that match its hue, 
whiteness, and blackness values. The selected pixels are highlighted in the current color. 

 

Hue slider 

Adjusts the hue tolerance for selecting color pixels in a sprite. To select pixels that have the same hue 
value as the pixel you click with the Select Color Region tool, move the slider to the left. To select 
pixels that have less similar hue values, move the slider to the right.  

For example, if this setting is close to 0, only pixels whose hue values are nearly identical to the pixel 
you click will be selected. If this setting is close to 100, pixels whose hue values are not a close match 
to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 

 

Hue box 

Specifies the hue tolerance for selecting color pixels in a sprite. To select pixels that have the same 
hue value as the pixel you click with the Select Color Region tool, type 0. To select pixels that have 
less similar hue values, type a number from 1 to 100. 

For example, if this setting is close to 0, only pixels whose hue values are nearly identical to the pixel 
you click will be selected. If this setting is close to 100, pixels whose hue values are not a close match 
to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 

 

Whiteness slider 

Adjusts the whiteness tolerance for selecting color pixels in a sprite. To select pixels that have the 
same whiteness value as the pixel you click with the Select Color Region tool, move the slider to the 
left. To select pixels that have less similar whiteness values, move the slider to the right. 

For example, if this setting is close to 0, only pixels whose whiteness values are nearly identical to the 
pixel you click will be selected. If this setting is close to 100, pixels whose whiteness values are not a 
close match to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 

 

Whiteness box 

Specifies the whiteness tolerance for selecting color pixels in a sprite. To select pixels that have the 
same whiteness value as the pixel you click with the Select Color Region tool, type 0. To select 
pixels that have less similar whiteness values, type a number from 1 to 100. 

For example, if this setting is close to 0, only pixels whose whiteness values are nearly identical to the 
pixel you click will be selected. If this setting is close to 100, pixels whose whiteness values are not a 
close match to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 



 

Blackness slider 

Adjusts the blackness tolerance for selecting color pixels in a sprite. To select pixels that have the 
same blackness value as the pixel you click with the Select Color Region tool, move the slider to the 
left. To select pixels that have less similar blackness values, move the slider to the right. 

For example, if this setting is close to 0, only pixels whose blackness values are nearly identical to the 
pixel you click will be selected. If this setting is close to 100, pixels whose blackness values are not a 
close match to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 

 

Blackness box 

Specifies the blackness tolerance for selecting color pixels in a sprite. To select pixels that have the 
same blackness value as the pixel you click with the Select Color Region tool, type 0. To select 
pixels that have less similar blackness values, type a number from 1 to 100. 

For example, if this setting is close to 0, only pixels whose blackness values are nearly identical to the 
pixel you click will be selected. If this setting is close to 100, pixels whose blackness values are not a 
close match to the pixel you click will be selected. 

Tip   A good starting position is to set the Hue to 0 and the Whiteness and Blackness to 100. You 
can then increase the hue gradually to broaden the selection. 

 

Add 

Adds the pixels you will select with the Select Color Region tool to the color region you already 
selected. 

 

Delete 

Subtracts the pixels you will select with the Select Color Region tool from the color region you 
already selected. 

 

Local 

Specifies that only the pixels that touch the pixel you will click with the Select Color Region tool can 
be selected. 

 

Global 

Specifies that any pixel in the current sprite can be selected with the Select Color Region tool if its 
Hue, Whiteness, and Blackness values match the pixel you will click. 

 

Edge slider 

Adjusts how much of the edge of the shape or cutout will be feathered or blurry. For clean, crisp 
edges, move the slider toward Hard; for blurrier edges, move the slider toward Soft. The blurrier the 
edge, the better the sprite blends with the other sprites behind it or the workspace. 



 

Redo Last 

Reselects the set of pixels you last selected with the Select Color Region tool. To undo the results of 
your last click, switch Selection modes and then click Redo Last. For example, to remove the last 
set of pixels you added to your selection, switch to Delete mode and then click Redo Last. 

 

Current Composition tab 
(Composition Setup dialog box) 
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Related Topics 

  

 

You can use the Current Composition tab to change the size and color of the composition space. for 
the active composition only. If you want to change the defaults for all future compositions, use the 
New Composition Defaults tab instead. 

Width 

Specifies the number of pixels the composition space extends from side to side. The Image 
Composer default setting for width is 420. To change the width for the active composition, enter a 
number between 3 and 4096. 

Height 

Specifies the number of pixels the composition space extends from top to bottom. The Image 
Composer default setting for height is 275. To change the height for the active composition, enter a 
number between 3 and 4096. 

Composition space color 

Displays the current color of the composition space. When you click either the color chip or the Color 
button, the Color Picker dialog box appears, in which you can select a new color. You can also 
right-click the color chip to access the Quick Color Picker. 

Use Default 

Reverts to the settings specified on the New Composition Defaults tab. 

 

New Composition Defaults tab  
(Composition Setup dialog box) 

{button 
,AL("composition 
space topic")} 
Related Topics 

  

 

You can use the New Composition Defaults tab to set a default size and color for the composition 
space for all future compositions. If you want to make changes to the active composition, use the 
Current Composition tab instead. 



Width 

Specifies the number of pixels the composition space extends from side to side. The Image 
Composer default setting for width is 420. To change the width for new compositions, enter a number 
between 3 and 4096. 

Height 

Specifies the number of pixels the composition space extends from top to bottom. The Image 
Composer default setting for height is 275. To change the height for new compositions, enter a 
number between 3 and 4096. 

Composition space color 

Displays the composition space color to be used for all future compositions. When you click either the 
color chip or the Color button, the Color Picker dialog box appears, in which you can select a new 
color.  You can also right-click the color chip to access the Quick Color Picker. 

Use Current 

Replaces the size and color settings in the New Composition Defaults tab with the settings from the 
Current Composition tab. 

 

 

 

Group  
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Selected sprites Grouped sprite 

 

Group combines a set of sprites into one sprite. Grouped sprites are treated the same as a single 
sprite when you position or arrange them in a composition, or order them in the stack. 

Where to find this item 

Group is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to group sprites. 

Note   Certain actions, such as rotating, resizing, cutting out, and applying effects or texture 
transfers, cannot be performed on a group. You must first ungroup the sprites or flatten the selection. 
For details, see Ungrouping sprites and Flattening a selection. 
 
 

Ungroup  
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Overview 

 

  

Grouped sprite Ungrouped sprites 

 

Ungroup separates a grouped sprite and places the sprites in a selection set. If the group consists of 
smaller groups, those smaller groups remain grouped. 

Where to find this item 

Ungroup is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to ungroup a sprite. 

 

Explode  
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Grouped sprite Exploded sprites 

 

Explode separates a grouped sprite and places the individual sprites in a selection set. If the group 
consists of smaller groups, those smaller groupings are not retained. To preserve smaller groupings, 
use Ungroup instead of Explode. 

Where to find this item 

Explode is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to explode a grouped sprite. 

 

Flatten Selection  
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item")} Related 
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Selected sprite Flattened selection 

 

Flatten Selection permanently converts a selection of sprites to a single sprite. Flattening is similar to 
grouping in that both actions combine a selection set of sprites. However, flattening is a permanent 
action, whereas a group of sprites can be ungrouped. 

Where to find this item 



Flatten Selection is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to flatten a selection into a single sprite. 

Note   Certain actions, such as rotating, resizing, cutting out, and applying effects or texture 
transfers, cannot be performed on a group but can be performed on a flattened selection. 
 
 

Set Home Position  
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Selected sprite with home 
position set 

Rearranged sprites 

  

Selected sprite returned to 
home position 

 

 

Set Home Position stores the current screen position of the selected sprite. 

Where to find this item 

Set Home Position is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to set the home position for a selected sprite, and how to return that sprite 
to its home position. 

 

Return to Home Position  

{button ,AL("arrange 
item")} Related 
Topics 
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Selected sprite with home 
position set 

Rearranged sprites 

  

Selected sprite returned to 
home position 

 

 

Return to Home Position moves the selected sprite to the screen position that you stored for it with 
Set Home Position. 

Where to find this item 



Return to Home Position is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to return a selected sprite to its home position, and how to return that 
sprite to its home position. 

 

Lock/Unlock Position  
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item")} Related 
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Selected sprite 
locked 

Sprites aligned  

 

Lock/Unlock Position toggles the locked state of the selected sprite. Locking a sprite fixes it at its 
current screen position so that it cannot be moved. If the sprite is already locked, Lock/Unlock 
Position unlocks the sprite so that it can be moved. 

Where to find this item 

Lock/Unlock Position is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to lock or unlock a selected sprite. 

 

Align 
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Selected sprites Aligned sprites 

 

The Align buttons line up the selected sprites by their tops, bottoms, left or right sides, or by one of 
their four corners, centers, or edges. The source sprite is the anchor that the other selected sprites 
are aligned to. If the sprites are aligned relative to the composition space, the composition space 
anchors the alignment. 

Where to find this item 

The Align buttons are available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to align a set of selected sprites. For information about aligning sprites 
with the composition space, see Aligning sprites with the composition space. 

 



Order 
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Selected sprite in 
middle of stack 

Selected sprite at 
top of stack 

 

Order changes the position of the selected sprite in the stack. You can move a sprite one step 
forward or backward in the stack, or send it to the front or the back of the stack. 

Where to find this item 

Order is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to order a selected sprite. 

 

Flip 
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Original sprite Sprite flipped 
vertically 

 

Flip changes the orientation of the selected sprite. You can flip a sprite horizontally, vertically, or both. 

Where to find this item 

Flip is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to flip a sprite. 

 

Rotate 
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Original sprite Sprite rotated by 90 
degrees 



 

Rotate turns the selected sprite about its center. You can rotate a sprite in increments of 90 degrees, 
or define any angle of rotation between -360 and 360. 

Where to find this item 

Rotate is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to rotate a sprite. 

 

Resize 
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Original sprite Sprite resized 
horizontally by 50% 

 

Resize shrinks or enlarges the selected sprite by the number of pixels or the percentage that you 
specify. 

Where to find this item 

Resize is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to rotate a sprite. 

 

Fit Bounding Box  
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Bounding box 
extended 

Bounding box fitted 

 

Fit Bounding Box tightens the bounding box around a sprite after the bounding box has been 
extended. 

Where to find this item 

Fit Bounding Box is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to tighten the bounding box of a sprite. 



 

Crop/Extend  
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Original sprite Cropped sprite Extended sprite 

 

Crop decreases the size of the bounding box around a sprite and trims the excess area of the sprite. 
Extend enlarges the bounding box around a sprite and creates a margin of transparent pixels around 
the sprite. 

Where to find this item 

Crop/Extend is available on the Arrange palette. 

How to apply this item 

Click a picture to learn how to crop a sprite or how to extend its bounding box. 

 

Bilinear  
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Original sprite Bilinear 

 

Bilinear warps a sprite by remapping its bounding box after first adjusting the position of one or more 
corners of the box. 

Where to find this item 

Bilinear is available on the Arrange palette. 

How to apply this item 

Click the Bilinear picture to learn how to warp a sprite. 

Tips 

• You can achieve a false perspective effect using the Bilinear warp, as shown in the picture above. 
Compare this example with the example for the Perspective warp. 

• You can achieve a truer perspective transformation by applying the Bilinear warp and then 
applying the Rectangular effect with the Sine or Cosine function for the x-axis or y-axis only. 

 
 

Skew  
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Original sprite Skew 

 

Skew tilts a sprite by shearing its opposing sides in opposite directions around its center. 

Where to find this item 

Skew is available on the Arrange palette. 

How to apply this item 

Click the Skew picture to learn how to apply this item. 

 

Perspective  
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Original sprite Perspective 

 

Perspective applies two-point perspective to the selected sprite. This warp makes the selected sprite 
appear as if it goes off into the distance. 

Where to find this item 

Perspective is available on the Arrange palette. 

How to apply this item 

Click the Perspective picture to learn how to apply this item. 

Notes 

• Perspective works by scaling the pixels of the sprite toward the vanishing points, resulting in true 
two-point perspective. For example, if you scale a picket fence so that it appears to point into the 
distance, the spacing between its pickets is greater toward the front than toward the back. 

• Compare this warp with the Bilinear warp, in which the distance between the pickets remains 
constant. 
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You can insert images from a great variety of sources outside of Image Composer as part of a 
composition. When you insert an image into a composition, it becomes a sprite.  

Sources include: 

• Files in popular image formats, including .bmp, .gif, .psd, .jpg, and many more. 

• Images from Photo CDs, if installed. 

• OLE objects, such as Excel Charts or Microsoft Word documents, depending on which applications 
are installed. 

• Clip Art from the Microsoft Clip Gallery 3.0, if installed. 

• Buttons created with the Button Wizard. 

• Images scanned using the Twain interface, if scanner installed. 
 

You can insert images in any of the following ways: 

• The Insert menu for files, Photo CDs, OLE objects, Clip Art images, and buttons. 

• The File menu for scanned images. 

• Drag and drop from the Windows Explorer or other applications. 

• Cut and paste images from the Clipboard. 
 
 

Inserting files 
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Use the Insert From File command to insert a file from your hard disk, a network drive, or floppy disk 
into a composition. 

 To insert a file 

1 On the Insert menu, click From File. 

2 In the Inserts an image file dialog box, click a folder in the Look in box.  

3 In the Files of type list, click a file format. 

4 In the file list, click a file name, or type a name in the File name box.  

5 Click OK. 
 

The file is inserted into the upper-left corner of the composition space. 
 
 



Inserting Photo CD images 
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You can insert an image from a Photo CD into your composition. Be sure that you have put the Photo 
CD into the appropriate drive. 

 To insert an image from a Photo CD 

1 On the Insert menu, click From Photo CD.  

Image Composer displays the Insert from Photo CD dialog box.  

2 In the Available CD-ROM devices list, click the drive containing the images you want to insert.  

3 In images list, click the image you want to insert in your composition.  

4 In the file list, click a file name, or type a name in the File name box.  

5 Click OK. 

Image Composer displays the second Insert from Photo CD dialog box. 

6 In the Resolution list, click the resolution you want the image to be rendered in Image Composer.  

This dialog box also displays copyright information about the image you have selected. 

7 Click OK. 
 

The image is inserted into the upper-left corner of the composition space. 

 

Inserting OLE objects overview 
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Your composition can contain OLE objects created by Microsoft Office applications and other 
programs installed on your computer, including:  

• New OLE objects you create within Image Composer by using other applications.  

• Existing OLE objects from Microsoft Office or other applications. 
 

When you create or insert an OLE object, that object becomes a special kind of sprite. Such sprites 
retain their OLE properties, so you can re-activate these objects in Image Composer by 
double-clicking them. 

For example, if you want to enliven the appearance of an Excel chart, you can insert that chart into 
Image Composer, apply effects and colors, return it to Excel, include it in a report, or send it as part of 
an email message. 

Editing data in OLE objects 

When you work with an existing OLE object, you can edit the data in the object, but the changes are 
not propagated to the program that created the object. When the data changes in the program that 



created it, these changes are not propagated to the object in Image Composer. 

When you click an existing OLE object in Image Composer, the application that created it takes over 
from the Image Composer interface. Then you can work with an existing object in its native 
environment. For example, if you insert an image created in Microsoft Paint, the Paint tools and tool 
bars are displayed for your use. Some programs that create OLE objects, such as Clip Gallery, create 
separate windows. Image Composer continues to display information in its status bar. 

Saving OLE objects 

When you save an OLE object in .MIC (Microsoft Image Composer) file format, you create a sprite 
that has preserved the OLE properties. Such sprites can be reactivated as OLE objects. Saving to 
another file type removes the OLE properties and creates an ordinary sprite. 

 

Working with OLE objects 
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You can create images based on OLE objects created by Microsoft Office and other applications 
installed on your computer.  

 To create an image from a new OLE object  

1 On the Insert menu, click Object. 

2 In the Insert Object dialog box, click Create New to create a new image object based on the OLE 
object.  

3 In the Object Type list, click an object type to insert.  

The list is generated from the applications that are currently installed on your computer. Different 
computers will likely have different lists. The application that creates the object now takes over 
from Image Composer, allowing you to create a new object that will be part of your composition.  

Some applications create new windows that appear in front of Image Composer. Other applications 
display menus, toolbars, and special dialog boxes. Image Composer continues to display 
information in the status bar. 

4 Click OK. 
 

 To create an image from an existing OLE object  

1 On the Insert menu, click Object. 

2 Click Create from File, to create a new image object based on the contents of a file.  

3 In the File box, enter a name, or click Browse to locate a file, then click the file name.  

4 Click OK. 
 

 To edit an OLE image object  

1 Double-click the object.  

The application that created the object takes over the Image Composer interface so you can edit 
that object in its native environment.  

2 Click outside the object to render it as a sprite. 
 
 



Inserting clip art 
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You can insert an image from Microsoft Clip Gallery into a composition when Clip Gallery is installed 
on your computer. 

 To insert a clip art image 

1 On the Insert menu, click Clip Art.  

The Microsoft Clip Gallery dialog box displays.  

2 In the Microsoft Clip Gallery dialog box, click the Clip Art tab. 

3 In the Clip Art list, click a category. 

4 In the image pane, click the image you want to insert into your composition. 

5 Click Insert. 
 

The file you chose is inserted into the upper-left corner of the composition space. 

 

Creating and modifying buttons 
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Use the Button Wizard to create buttons with interesting shapes, textures, colors, and text for your 
web sites. After you create the buttons, use the Button Editor to edit the text, or apply effects or 
change colors. 

 To create a button using the Button Wizard 

1 On the Insert menu, click Button to display the Button Wizard. 

2 Follow the instructions provided by the wizard. 
 

The button you created is inserted into the upper-left corner of the composition space. Buttons are a 
special type of sprite. Each button is actually a group of sprites comprising a shape, text, and, if 
specified, an image. To modify a button and preserve its properties, use the Button Editor. If you save 
a button to a file type other than .MIC, the button loses its properties.  

 To modify a button created with the Button Wizard  

1 Click the button. 

2 On the Edit menu, click Button to display the Button Editor. 

3 Click the tab for the properties you want to change and make the necessary changes. 

4 Click OK. 
 
 

Inserting scanned images 
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You can insert images from a scanner directly into Image Composer by using the TWAIN interface.  

 To insert a scanned image 

1 On the File menu, click Scan Image, then Select Scan Source. 

2 In the Select Scan Source dialog box, click a scanner from the list. 

3 Click Select. 

4 On the File menu, click Acquire Scan. 

5 From the TWAIN dialog box for your scanner, choose from available settings, such as type of 
color, path (if you want to scan to a file and not to Image Composer), brightness, contrast, and 
scale.  

Use the settings in this dialog box to make any changes to the image before you insert it into your 
composition. 

6 Click Final. 
 

The image you scanned is inserted into the upper-left corner of the composition space. 

 

Cutting, copying, and pasting images 
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You can cut images from within, or from outside, Image Composer, and paste them into your 
composition by using the Clipboard. In addition to the usual Clipboard behavior, Image Composer 
provides the Paste Special command so you can determine the format of the image being pasted into 
your composition.  

 To cut and paste an image 

1 Click the file, image, or data you want to insert into your composition. 

2 On the Edit menu, click Copy or Cut. 

3 On the File menu, click Paste. 

The image is inserted into the upper-left corner of the current view. 
 
 

Using the Paste Special command 
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Related Topics Overview 

 

You can cut and paste objects from within and from outside Image Composer by using the Paste 
Special command. Use this command to specify the format in which you paste the object, such as 
bitmap or enhanced metafile.  

The object that you paste into your composition becomes a sprite. When you paste OLE objects, their 
properties will persist. The Source field displays information about the contents you are pasting. 

 To use the paste special command 

1 Copy or cut an object from Image Composer or another application to place it on the Clipboard. 

2 On the Edit menu, click Paste Special. Image Composer displays the Paste Special dialog box. 

3 Click OK. 
 
 

Dragging and dropping images 
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Dragging and dropping is an easy way to add images to a composition. You can use drag-and-drop 
insertions to copy images from your hard disk, a network drive, or even from a Web site, if you have 
permission to use a specific image.  

However, be aware that any image you might copy by using drag and drop might be copyrighted. Be 
certain to check that you have permission to use any image you want to include in a composition. 

 To drag and drop an image 

1 In Windows Explorer, click the file containing the image you want to insert into your compostion. 

2 Drag the image to the Image Composer workspace and release the mouse button. 
 
 

Using full drag 
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Full drag is a technique that you use when you need to see the contents of a sprite that you are 
dragging to a new location in your composition. When you drag a sprite by using regular drag, you 
see only the outline of the sprite. 

Full drag is useful when you need to align something inside the sprite with other sprites. When you 
use the align buttons on the Arrange palette, sprites are aligned by their outlines. When you use full 
drag, you can align the interiors of the sprites. 

When you use full drag, you cannot duplicate a sprite as you can with CTRL+Drag. 

 To use full drag to move a sprite 

1 Click and hold the sprite; do not move the pointer.  

2 Drag the sprite. You will see the full contents of the sprite when you drag it as opposed to seeing 



only the outline. 
 
 

Inserting WordArt 

Microsoft WordArt is installed as part of a typical Image Composer installation. Images that you create 
with WordArt are treated as objects by Image Composer. When you have finished your work in 
WordArt, the image is a sprite to which you can apply any of Image Composer's effects and tools.  

Typically, you create text in WordArt that you can shape and curve, then modify with Image 
Composer effects, such as art effects, gradients, or texture transfers. 

 To insert WordArt 

1 On the Insert menu, click WordArt. 

The Image Composer interface is taken over by the WordArt toolbars and environment. 

2 In the Enter Your Text Here dialog box, type the text for your want in your composition.. 

3 Click Update Display when you are ready to insert the WordArt.  

4 Modify the text by clicking one of the buttons on the WordArt toolbar.  

5 Click outside the new WordArt to insert the new text into your composition. 

The Image Composer interface takes over the screen display. 
 

 To edit the text of WordArt 

1 Double-click the WordArt sprite to display the Enter Your Text Here dialog box. 

2 Change the text as needed.  

3 Click Update Display. 

4 Click outside the WordArt. 
 
 

Style tab (Button Editor) 
 

On this tab, you can choose a new style for the button that you selected. A thumbnail picture of the 
style you selected to edit appears in the Sample window. 

A button style includes text formatting, shape, and fill. 

You can keep a button's style and change any of its attributes. For example, you can choose the 
Earth style, which is a maple leaf by default, and change the button's shape to a fish while retaining 
the original color, font, and fill. Once you change an attribute, the button style changes to <Custom>. 
When you change styles, however, the button's label text is not affected. 

 To choose a new button style 

1 In the Button Styles list, click a style.  

Image Composer displays a sample of that style in the Sample window. 

2 Click OK. 
 
 

Label and Image tab (Button Editor) 
 

Use this tab to make changes to the text label of a button, to the label's font, and to the placement 
and content of any images you have placed on the button. 

 To edit the text label of a button 

1 In the Label box, select the current label. 

2 Enter the text for the new label. 

3 Click OK. 

If the new label is longer than the size of the button, the Button Editor increases the size of the 



button to accommodate the new label. If the new label is shorter than the button, the Button Editor 
shrinks the size of the button. 

 

 To change the font of a label 

1 Click the Font button. 

2 On the Font dialog box, change the attributes you want to edit.  

3 On the Font dialog box, click OK. 

4 Click OK. 
 

 To add a button image 

1 Select the Image checkbox.  

2 Click Browse to display the Inserts an image file dialog box. 

3 Choose an image as a button image. The button image can be any type of supported file format. 

4 On the Inserts an image file  dialog box, click OK.  

5 Click OK. 
 

 To delete a button image 

1 Clear the Image check box.  

2 Click OK. 
 

 To change label and button image alignment 

1 On the alignment grid, click the button for the alignment you want.  

Choose from placing the button image above, below, to either side, or directly under the label. If 
the new alignment is larger or smaller than the original alignment, the button is resized to 
accommodate the new alignment.  

For example, if the button image was originally to the left of the text label and you change the 
alignment to place the button image under the label, the Button Editor shortens the button if exact 
fit was specified when the button was created. 

2 Click OK. 
 
 

Shape tab (Button Editor) 
 

Use this tab to modify the shape of a button and the direction of light upon it. You can change the 
shape of a button while retaining its other properties, such as color and fill. 

 To change a button's shape 

1 In the Category list, click a group of shapes. 

2 In the Shape box, click a shape. 

3 Click OK. 
 

 To change the direction of light on a button 

1 On the Light direction grid, click a direction. 

The center block of the Light direction grid shows where the shadows will fall. 

2 Click OK. 
 
 

Fill tab (Button Editor) 
 

Use this tab to change the fill of a button.  

 To fill a button with a texture 

1 In the Fill list, click Texture. 



2 In the Fill Attributes list, click a texture.  

The fill preview window shows a tiled picture of the texture you have clicked. If you do not find a 
texture in the list that you like, click Other Texture. Image Composer displays the Inserts an 
Image File dialog box, where you can choose from other textures you have created. Choose from 
.bmp, .jpg, and .dib files. 

3 Click OK. 
 

 To change the color of a button 

1 In the Fill list, click Color. 

2 Click the Fill Color chip to display the Color Picker.  

3 In the Color Picker dialog box, select a new color for the button. 

4 Click OK. 

5 On the Fill page, click OK. 
 

 To add a gradient to a button 

1 In the Fill list, click Gradient. Image Composer displays the gradient. 

In the gradient, click corners to display Color Picker. Choose a color for each corner to blend in the 
gradient. For more information on changing the colors in a gradient, see Changing the colors in a 
gradient. 

– or – 

In the Gradient name list, click a predefined gradient.  

1 Click OK. 
 
 

Size tab (Button Editor) 
 

Use this tab to change the size of the selected button. 

The Width and Height boxes indicate the selected button's current size and the minimum size it must 
be to accommodate any label text and button image you have included in the button. If you choose to 
make a button with a custom size, the button cannot be smaller than the minimum size indicated to 
accommodate the text and button image, but it can be larger. 
 

 To change the size of a button to an exact size 

1 Click Exact fit to have the button fit the label text and button image precisely. 

2 Click Preview to see a full preview of the button. 

Resize the button if necessary. 

3 Click OK. 
 

 To change the size of a button to a custom fit 

1 Click Custom fit. 

2 In the Width box, select the current value and enter a new value. 

3 In the Height box, select the current value and enter a new value,. 

4 Click Preview to see a full preview of the button. 

Resize the button if necessary. 

5 Click OK.  
 
 

Start page (Button Wizard) 
 

Use this wizard to create buttons for Internet sites, CD-ROMs, or other uses. When you want to 
modify a button, use the Button Editor. 



Buttons are a special type of sprite that have attributes associated with them, such as the button 
style, shape, and layout of text. These properties are preserved when you save a button as an .mic 
file, but are lost when you save a button to any other format. 

 To select a button style 

• In the Button style list, click the style for the buttons you are creating.  

If you want to create buttons in more than one style, complete all the buttons for a particular style, 
then restart the wizard and create more buttons in another style 

 

The Sample window shows a sample button in the style you have clicked in the list. 

Note   The buttons you create with this wizard are images only, and have no special properties, such 
as links to URLs or animations, when included on a Web page. The buttons must be made active 
using another program, such as FrontPage. 

 To move to the next page 

• Click Next. 
 

 To create a button with the default text (Home) 

• Click Finish. 
 

 To quit the Button Wizard without creating any buttons 

• Click Cancel. 

 

Number of buttons page (Button Wizard) 
 

You can create from 1 to 20 buttons in a single session of the Button Wizard. To create more 
buttons, run the Button Wizard one more time. 

 To specify the number of buttons 

• In the How many buttons would you like to create? box, type a number from 1 to 20. 

– or – 

Click the arrows until you see the number you want. 
 

 To move to the next page 

• Click Next. 
 

 To move to the previous page 

• Click Back. 
 

 To create a small button with default text (home) 

• Click Finish. 
 
 

Text and button image page (Button Wizard) 
 

You can create separate text for each button you create with this wizard. In addition to text, you can 
also place an image on the button. If you create a button that does not have either text or an image, 
you will not be able to edit that button. 

Each button style has a specific font associated with it. To change a font, create the button using its 
default font, then edit that button with the Button Editor. 

 To create text for a button 

• In the Enter the text label for button 1 box, type the text you want the button to contain. 

If you are creating more than one button, each time you click Next, the text is selected. The Enter 



the text label for the button box title tells you which number button you are entering text for. 
 

After you have entered the text, you can click Next to move to the next screen or Finish to create the 
buttons. 

 To include a button image on the button 

• Click the Image box. Image Composer displays a thumbnail of the image in the sample image box. 
Click Browse to search your hard disk, network drive, or other source of images.  

 

 To move to the next page 

• Click Next. 
 

 To move to the previous page 

• Click Back. 
 

 To create a button  

• Click Finish. 
 

 To quit the Button Wizard without creating any buttons 

• Click Cancel. 
 
 

Button size page (Button Wizard) 
 

Specify the size for each of the buttons you are creating. Press the Size Preview button to see an 
exact-size image of the buttons you are creating.  

 To create buttons that each are the precise size to fit their individual text labels 

• Click Exact fit for each button.  

When you click this button, the Button Wizard computes the correct size for you. Each button may 
be a different size. 

 

 To create buttons that each are large enough to fit the longest text label of any button 

• Click Same size for all buttons.  

When you click this button, you can specify the width and height you want the buttons to be. The 
Button Wizard displays the minimum width and height in pixels that the buttons must be to 
accommodate the longest text label. Buttons can be larger than the minimum, but not smaller. 

 

 To move to the next page 

• Click Next. 
 

 To move to the previous page 

• Click Back. 
 

 To create a button  

• Click Finish. 
 

 To quit the Button Wizard without creating any buttons 

• Click Cancel. 
 
 

Summary page (Button Wizard) 
 

You can click Finish to create all the buttons you have specified by using the Button Wizard, or 
move back to a previous page to make changes before you create the buttons. After you have 
created a button using the Button Wizard, use the Button Editor to modify the button. 

 To move to the previous page 



• Click Back. 

 To create a button  

• Click Finish. 

 To quit the Button Wizard without creating any buttons 

• Click Cancel. 

 To modify a button created by the Button Wizard 

1 In the workspace, click the button you want to modify. 

2 On the Edit menu, click Button. 

– or – 

Double-click the button. 
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Welcome to Microsoft Image Composer 

Image Composer makes it easy to create images for on-screen 
delivery to Web sites, CD-ROMs, videos, and more. 

The stamp in the upper-left corner was created in Image Composer 

from a photo taken with a digital camera. In fact, every image you 
see in this introduction was created with Image Composer. 

With Image Composer, you can: 

• Work with varied sources, including scanned images, clip art, 

digital camera photographs, OLE objects, original art you create 
within Image Composer, and much more. 

• Create professional-looking art with hundreds of effects, from 

high-tech warps to classic impressionism, with just a click of a 
mouse button. 

• Produce quick results, like the buttons on each page of this 

introduction, with tools like the new Button Wizard. 

• Save your results in most popular formats, and let Image 

Composer help you with the Save for the Web Wizard. 
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Image objects 

Compositions are collections of image objects. In Image Composer, 

image objects are called Sprites. 

A sprite has shape and transparency, as shown in the figure below. 
Because sprites are objects, you can use your mouse to move them 
in the workspace like you move icons on your Windows desktop. 

 

 
 

Each sprite is surrounded by a rectangular space called a bounding 
box. This box provides a frame of reference and the handles show 

what you can do with the sprite, such as resizing or rotating, as 
shown in the preceding figure. You can combine sprites temporarily or 
permanently. 
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Transparency 

Sometimes, what you cannot see is as important as what you can. 
With Image Composer, what you see depends on transparency, which 
is a property of sprites. 

 

Transparency is specified in levels of opacity, from 0%, completely 

transparent, to 100%, completely opaque. It is carried in the alpha 
channel, which carries opacity like the red, green, and blue channels 
carry color. Many effects and tools have opacity controls. 

You can use transparency in a variety of ways, including: 

• Using transparency to paint with as if it were a color. 

• Erasing portions of a sprite with varying percentages of opacity. 

• Letting a Web page background show through a sprite. 
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The work cycle 

Working with Image Composer is simple, intuitive, and encourages 
you to experiment. The following figure illustrates the work cycle. 

 

1 The first step in working with Image Composer is to insert or 

open an image, or create a new sprite.  

2 The next step is to select the sprite. 

3 Then, choose the effect or tool that you want to use. 

4 For most effects and tools, click Apply as the final step. If you are 

unhappy with the results, click Undo and apply new effects. 
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Colors provide drama, emotion, and information at a glance in a way 
that few other things can. In Image Composer, you work with a 
current color for many applications, including many effects. 

The Color Swatch at the bottom of the toolbox shows the current 
color. Changing the current color does not affect the color you see in 

your current sprite until you perform an action. 
 

To change the current color, follow these steps: 

1 Right-click the Color Swatch to display the compact Color Picker, 
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shown in the following figure. Left-click the Color Swatch to 
display the full-size Color Picker. 

 

2 Click the circle in the middle of the color matrix and drag it to the 

color you want to change to. 

3 Click OK. The new color you set to be the current color will be 

applied to all future actions that use the current color. 
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Making cutouts 

A common task in creating images is cutting out a portion of the 
sprite. Use the cutout as a separate sprite, as a mask while applying 

effects, as a base for animations, and more. 

Like most tools, cutout tools are on a tool palette. Click the Cutout 
button on the toolbox to activate the Cutout tool palette. Create 
cutouts in common shapes or freeform shapes. The following figure 
shows the original photo, a cutout made with the oval tool, and a 
cutout made with the curve tool over a new sprite. 

 

The steps involved in creating cutouts are simple. Select the object 

you want to cut out a portion from. Then click the cutout button on 
the toolbox. Select a cutout tool to use. Select the portion you want, 
cut out that portion, and you are done! 
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Creating shadows 

One of the easiest ways to add depth and impact to an image is to 
use a drop shadow, one that closely follows the outline of a sprite.  

With Image Composer, you can easily create drop shadows in any 

color, level of transparency, angle of light source, and degree of 
hardness. The following figure shows several variations, starting with 
the default drop shadow at the left. 

 

To create a drop shadow, select a sprite, then: 

1 On the toolbox, click Effects. 

2 In the Category box, click Outlines, then click Drop Shadow. 

3 On the Details tab, customize the shadow, then click Apply. 
 
 

 

 
 



 

 

Making the sprite background transparent 
 

A transparent background in a sprite allows other images to show through. Transparent backgrounds 
are of particular use for Web sites, but are also useful for any on-screen delivery of images. 

The basic approaches to creating a transparent background are: 

• Erasing areas of a sprite while you work on it by using the Erase tool on the Paint palette, any of 
the Cutout tools. 

• Selecting a color in a sprite and making all areas with that color transparent when you save the 
composition or sprite. 

 

In the following figure, the image on the left shows the composition as it appears in Image Composer 
before saving; the figure on the right, as it appears on a Web site. 

 

Erasing areas of a sprite while working on it 

You can set a transparent background for a sprite in a composition while you work on it to give the 
sprite a distinct and irregular shape. Use one of the following methods: 

• The Select Color Region tool to make same-color areas of a sprite transparent. For more 
information, see Erasing selected colors in a sprite. 

• The tools on the Cutout Palette. For more information, see Erasing freeform areas in a sprite, 
and Erasing rectangular and oval areas in a sprite. 

• The erase tool on the Paint palette. For more information, see Making an area of a sprite 
transparent. 

• The Transparent effect on the Effects palette. For more information, see Making a sprite 
transparent. 

 

Setting a transparent background when saving a sprite 
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The next step 

Now that you have had a taste of what you can cook up with Image 

Composer, you can head straight for the creative kitchen. The 
following list includes topics to help enrich your knowledge of Image 
Composer and enrich the compositions you create. 

• Tutorial 

• What's new in Image Composer 1.5 

• Sample sprites catalog 

• Effects overview 

• Gif Animator 

• Impressionist plug-in 

• Creating a Web image from FrontPage 
 

This Introduction is displayed only the first time you run Image 
Composer after installing it. For future viewings, click Learning Image 

Composer on the Help menu, then click Introduction to Microsoft 
Image Composer. 

 
 

 



You can set a transparent background for a composition when you save it by using: 

• One of the Save commands. 

• The Save for the Web wizard. 

See Setting a transparent background when saving compositions for more information. 

 

Setting a transparent background when saving compositions 
 

You can set a transparent background for an entire composition when you save it. By setting a 
transparent background, you allow other images on a  to show through the composition on Web sites 
or other on-screen delivery methods. 

You use the Save for the Web wizard to help you choose the background for your composition, or 
use one of the Save commands to exercise more control. 

 To save a composition by using the Save for Web wizard 

1 Complete the work on your composition to your satisfaction. 

2 On the File menu, click Save for the Web. 

3 Follow the instructions in the wizard. 
 

 To set a transparent background for a composition when saving it 

1 On the File menu click Save Copy As to save the sprites in the composition space. or click Save 
Selection As to save the selected sprites or groups. 

2 In the Save as type list, click the file format you want to save the composition to. The most 
common file formats for images for Web sites are .gif, .jpg, and .png. 

3 In the Color format list, click a format if you are saving to .gif, .png, or .tif formats. 

4 Select the Keep transparency check box. 

When you select this check box, all the transparent areas of the sprites remain transparent, such 
as the area from the sprite's outline to the bounding box. 

– or – 

1. Select the Transparent color check box. 

2. Click the Transparent color color chip to display the Color Picker. 

3. In the Color Picker, select the color that you want to specify as transparent and click OK. 

4. Select a threshold for transparent pixels by using the Threshold slider or box. 

Any pixels that are below the threshold will be completely transparent and any pixels above the 
threshold will be completely opaque. The threshold refers to the value assigned the alpha channel, 
from 0 (completely transparent) to 255 (completely opaque). 

5 In the File name box, enter a name for the file to contain this composition. 

6 Click Save. 


